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はじめに
このマニュアルでは、Ultra Light J のプログラミングインタフェースについて説明します。Ultra
Light J を使用すると、Android および BlackBerry のスマートフォン用のデータベースアプリケー
ションを開発し、これらのスマートフォンに配備できます。

Copyright © 2013, SAP AG or an SAP affiliate company. - SAP Sybase SQL Anywhere 16.0 vii



viii Copyright © 2013, SAP AG or an SAP affiliate company. - SAP Sybase SQL Anywhere 16.0



システムの要件とサポート対象プラットフォー
ム

開発プラットフォーム

Ultra Light J アプリケーションを開発するには、以下が必要です。

●Eclipse などの Java IDE

●Java SE 1.6 以降

ターゲットプラットフォーム

Ultra Light J は、次のターゲットプラットフォームをサポートしています。

●「Android スマートフォン」

●OS 4.2 以降を実行している 「BlackBerry スマートフォン」

●コンピュータまたはデバイス上で実行する Java SE 1.6 以降

Ultra Light がサポートしているプラットフォームの詳細については、http://www.sybase.com/
detail?id=1002288 を参照してください。

Copyright © 2013, SAP AG or an SAP affiliate company. - SAP Sybase SQL Anywhere 16.0 1
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Ultra Light J アプリケーションの開発

Ultra Light J API は、Java アプリケーションにデータベース機能と同期を提供します。特に
Android と BlackBerry のスマートフォンと連動するように設計されていますが、Java SE プラッ
トフォームとも互換性があります。この API には、Ultra Light Java Edition データベースまたは
Android 用 Ultra Light データベースに接続し、スキーマ操作を実行し、SQL 文を使用してデータ
を管理するために必要なすべてのメソッドが含まれています。データの暗号化や同期などの高
度な操作もサポートされています。

注意

Android スマートフォン用の開発では、Ultra Light J API は、他のプラットフォーム用の Ultra Light
と共通の C++ コードを共有しており、その動作は他のプラットフォームの動作と同様です。
Android で提供されていない API 用に SQL 文を使わずにテーブルとローにアクセスできるいく
つかの機能が存在します。

参照

●「Ultra Light 概要」『Ultra Light データベース管理とリファレンス』
●「Windows Mobile 用の Ultra Light API の利点」『Ultra Light データベース管理とリファレンス』

Ultra Light J アプリケーション開発のクイックスター
トガイド

Ultra Light J アプリケーションを作成するときは、一般にアプリケーションコードで次のデータ
管理タスクを実行します。

1. Ultra Lght J API パッケージをユーザの Java ファイルにインポートします。

Ultra Light J パッケージの名前とロケーションは、アプリケーション開発の対象デバイスに
よって異なります。

2. 新しい Configuration オブジェクトを作成して、データベースを作成するか、データベースに
接続します。

Configuration オブジェクトは、クライアントデータベースの保存場所または作成先を定義し
ます。また、データベースへの接続に必要なユーザ名とパスワードを指定します。異なるデ
バイスや非永続データベースストア用にさまざまな Configuration オブジェクトがあります。

3. 新しい Connection オブジェクトを作成します。

Connection オブジェクトは、Configuration オブジェクトで定義されている指定内容に従って
クライアントデータベースに接続します。

4. SQL 文を使用してデータベーススキーマを作成または変更し、PreparedStatement インタ
フェースを使用してデータベースを問い合わせます。
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SQL 文を使用して、データベースのテーブル、インデックス、外部キー、パブリケーション
を作成または更新できます。

PreparedStatement オブジェクトは、Connection オブジェクトに関連付けられているデータ
ベースを問い合わせます。引数には、サポートされている SQL 文を文字列として指定しま
す。PreparedStatement オブジェクトを使用して、データベースの内容を更新できます。

5. ResultSet オブジェクトを生成します。

ResultSet オブジェクトは、SQL SELECT 文を含む PreparedStatement が Connection オブジェ
クトによって実行されたときに作成されます。ResultSet オブジェクトを使用して、データ
ベースのテーブルの内容を確認するために、クエリ結果のローを取得できます。

参照

●「Android と BlackBerry のセットアップの考慮事項」4 ページ
● Configuration インタフェース [Ultra Light J]100 ページ
● Connection インタフェース [Ultra Light J]103 ページ
●「Ultra Light SQL 文」『Ultra Light データベース管理とリファレンス』
● PreparedStatement インタフェース [Ultra Light J]179 ページ
● ResultSet インタフェース [Ultra Light J]195 ページ

Android と BlackBerry のセットアップの考慮事項
Android または BlackBerry スマートフォン用のアプリケーションを開発する前に、Ultra Light API
の次の考慮事項に留意してください。

JAR リソースファイル

Ultra Light J API のアプリケーションを設定する場合、適切な UltraLiteJ16.jar または
UltraLiteJNI16.jar ファイルが使用されるようにプロジェクトが正しく設定されていることを確
認してください。

Android 用 Ultra Light J API は、SQL Anywhere インストール環境の UltraLite¥UltraLiteJ¥Android
¥UltraLiteJNI16.jar ファイルに格納されています。Android 開発プロジェクトを設定し、クラスパ
スに UltraLiteJNI16.jar ファイルを含める必要があります。 詳細については、「チュートリアル：
Android アプリケーションの構築」41 ページを参照してください。

Android 開発の場合は、次の文を使用して、Ultra Light J パッケージを Java ファイルにインポー
トします。

import com.ianywhere.ultralitejni16.*;

Ultra Light J API for BlackBerry および Java SE は、SQL Anywhere インストール環境の UltraLite
¥UltraLiteJ¥ ディレクトリにあります。また、各ターゲットプラットフォームのサブディレクト
リと UltraLiteJ16.jar ファイルがあります。BlackBerry 開発プロジェクトを設定し、クラスパス
に UltraLiteJNI16.jar ファイルを含める必要があります。 詳細については、「チュートリアル：
BlackBerry アプリケーションの構築」49 ページを参照してください。

BlackBerry 開発の場合は、次の文を使用して、Ultra Light J パッケージを Java ファイルにインポー
トします。

Ultra Light J アプリケーションの開発
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import com.ianywhere.ultralitej16.*;

このマニュアル内のすべてのサンプルコードとチュートリアルでは、上記の文が指定されている
こと、開発者が Eclipse での Java アプリケーション開発に精通していることを前提としていま
す。

Java SE アプリケーション

Java SE アプリケーションは、UltraLiteJNI.jar ファイルでサポートされません。UltraLite
¥UltraLiteJ¥J2SE¥UltraLiteJ16.jar ファイルを使用する必要があります。

Ultra Light データベースと Ultra Light Java Edition データベース

Android スマートフォンでは、Ultra Light J は、Windows Mobile、iPhone、Windows に提供されて
いるものと同じ Ultra Light データベース管理システムへのインタフェースを提供します。
BlackBerry スマートフォンでは、Ultra Light J は、Ultra Light Java Edition データベース管理シス
テムへのインタフェースを提供します。Ultra Light Java Edition は、Ultra Light と似た機能を備え
てはいますが、同一ではありません。Ultra Light Java Edition データベースは、Ultra Light データ
ベースと互換性がありません。

Android スマートフォンがサポートするのは、Ultra Light データベースだけです。これらは、
Sybase Central または Ultra Light のコマンドラインユーティリティを使用して作成できます。
Ultra Light データベースの作成についての詳細は、「Ultra Light データベースの作成方法」『Ultra
Light データベース管理とリファレンス』 を参照してください。

BlackBerry スマートフォンがサポートするのは、Ultra Light Java Edition データベースだけです。
Ultra Light Java Edition データベースの作成または使用の詳細については、「Ultra Light および
Ultra Light Java Edition のデータベースの作成および接続方法」5 ページ を参照してください。

参照

●「Windows Mobile 用の Ultra Light API の利点」『Ultra Light データベース管理とリファレンス』
●「Ultra Light、Ultra Light Java Edition、SQL Anywhere の機能比較」『Ultra Light データベース管

理とリファレンス』
●「Ultra Light および Ultra Light Java Edition データベースの制限事項」『Ultra Light データベー

ス管理とリファレンス』

Ultra Light および Ultra Light Java Edition のデータ
ベースの作成および接続方法

Java アプリケーションでデータを操作するには、先にデータベースに接続する必要があります。
この項では、Ultra Light J API を使用し、指定のパスワードで Ultra Light データベースまたは Ultra
Light Java Edition データベースを作成するか、またはこれらのデータベースに接続する方法につ
いて説明します。

Ultra Light および Ultra Light Java Edition のデータベースの作成および接続方法
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注意

Ultra Light J API を使用しないで Ultra Light データベースを作成する場合は、Sybase Central また
は Ultra Light のコマンドラインユーティリティを使用できます。 「Ultra Light データベースの作
成方法」『Ultra Light データベース管理とリファレンス』を参照してください。

Ultra Light J API を使用しないで Ultra Light Java Edition データベースを作成するには、次のいず
れかのタスクを実行します。

●uljload ユーティリティを使用してデータベースを作成します。 「Ultra Light Java Edition デー
タベースロードユーティリティ (uljload)」『Ultra Light データベース管理とリファレンス』を参
照してください。

●ulunload および uljload ユーティリティを使用して、Ultra Light データベースを変換します。
「Ultra Light データベースのアンロードユーティリティ (ulunload)」『Ultra Light データベース管
理とリファレンス』 を参照してください。

●Ultra Light Java データベースを SD カードにコピーするか、ファイル転送メカニズムを使用し
てデータベースを Mobile Link から転送することによって、BlackBerry スマートフォンに Java
SE アプリケーションを配備します。 「Mobile Link ファイル転送」『Ultra Light データベース
管理とリファレンス』 を参照してください。

Ultra Light データベースと Ultra Light Java Edition データベースの相違の詳細については、「Ultra
Light データベースと Ultra Light Java Edition データベース」5 ページ を参照してください。

データベースストアを設定するには、Configuration オブジェクトを使用します。Configuration オ
ブジェクトは、いくつかの方法で実装できます。Ultra Light J API でサポートされているデータ
ベースストアのタイプごとに固有の実装があります。各実装には、データベースストアの設定に
使用するメソッドのセットがあります。

次の表に、サポート対象データベースストアで利用できる Configuration オブジェクトの実装を
示します。

ストアの型 Ultra Light J API のサポート

Android ファイルシステム ConfigFileAndroid インタフェース [Android]
[Ultra Light J] を参照してください。

RIM オブジェクト (BlackBerry) ConfigObjectStore インタフェース
[BlackBerry] [Ultra Light J] を参照してくださ
い。

Java SE ファイルシステム ConfigFile インタフェース [Ultra Light J] を参
照してください。

非永続型 (メモリ内) ConfigNonPersistent インタフェース
[BlackBerry] [Ultra Light J] を参照してくださ
い。

Ultra Light J アプリケーションの開発
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Configuration オブジェクトを作成して設定した後、Connection オブジェクトを使用してデータ
ベースを作成するか、データベースに接続します。また、Connection オブジェクトを使用して、
次の操作を実行できます。

● トランザクション トランザクションは、コミットまたはロールバックの間の一連のオペ
レーションです。永続的なデータベースストアの場合、コミット操作は、最後のコミットま
たはロールバックの実行後に行われたすべての変更を永続的にします。ロールバック操作
は、最後にコミットが呼び出されたときの状態にデータベースを戻します。

Ultra Light のトランザクションとローレベルの操作は、それぞれアトミックです。複数のカ
ラムを対象とした挿入操作では、すべてのカラムにデータが挿入されるか、どのカラムにも
データが挿入されないかのいずれかです。

トランザクションは、Connection オブジェクトの commit メソッドを使用してデータベースに
コミットする必要があります。

● SQL 準備文 SQL 文を処理するメソッドが PreparedStatement インタフェースに用意されて
います。PreparedStatement は、Connection オブジェクトの prepareStatement メソッドを使用し
て作成できます。

● 同期 Connection オブジェクトから、Mobile Link の同期を管理するオブジェクトのセットに
アクセスできます。

参照

●「Java SE の例：データベースの作成」31 ページ
● Connection インタフェース [Ultra Light J]103 ページ
● DatabaseManager クラス [Ultra Light J]136 ページ

データベースの作成とデータベースへの接続
データベースの作成またはデータベースへの接続には、Ultra Light J API と Java アプリケーショ
ンを使用します。

前提条件

Ultra Light J API を実装する Android または BlackBerry スマートフォン用の既存の Java アプリ
ケーションであること

♦ タスク

1. データベース名を参照し、プラットフォームに適した新しい Configuration を作成します。

次の例では、config が Configuration オブジェクトの名前で、DBname がデータベースの名前
です。

Android スマートフォンの場合：

ConfigFileAndroid config = 
    DatabaseManager.createConfigurationFileAndroid(

Ultra Light および Ultra Light Java Edition のデータベースの作成および接続方法
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        "DBname.udb",
        getApplicationContext()
    );

BlackBerry スマートフォンの場合：

ConfigObjectStore config = 
    DatabaseManager.createConfigurationObjectStore("DBname.ulj");

Java SE プラットフォームの場合：

ConfigFile config = 
    DatabaseManager.createConfigurationFile("DBname.ulj");

任意のプラットフォームの場合、非永続的なデータベースの Configuration オブジェクトを作
成できます。

ConfigNonPersistent config = 
    DatabaseManager.createConfigurationNonPersistent("DBname.ulj");

2. Configuration オブジェクトのメソッドを使用して、データベースプロパティを設定します。

たとえば、setPassword メソッドを使用して新しいデータベースパスワードを設定できます。

config.setPassword("my_password");

Android スマートフォンの場合は、setCreationString メソッドと setConnectionString メソッドを
使用して、それぞれ追加の作成パラメータと接続パラメータを設定できます。

作成パラメータと接続パラメータの詳細については、以下を参照してください。

●「Ultra Light 作成パラメータ」『Ultra Light データベース管理とリファレンス』
● ConfigPersistent.setCreationString メソッド [Android] [Ultra Light J]97 ページ
●「Ultra Light 接続パラメータ」『Ultra Light データベース管理とリファレンス』
● ConfigPersistent.setConnectionString メソッド [Android] [Ultra Light J]97 ページ

3. データベースを作成する、またはデータベースに接続するために、Connection オブジェクト
を作成します。

たとえば、次のコードでは新しいデータベースが作成されます。

Connection conn = DatabaseManager.createDatabase(config);

DatabaseManager.createDatabase メソッドによりデータベースが作成され、そのデータベース
への接続が返されます。

また、既存のデータベースに接続するには次のコードを使用します。

Connection conn = DatabaseManager.connect(config);

connect メソッドはデータベース接続処理を完了します。データベースが存在しない場合は、
エラーがスローされます。

Ultra Light J アプリケーションの開発
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結果

Java アプリケーションから SQL 文を実行すると、データベースにテーブルとインデックスを作
成できますが、データベース名、パスワード、ページサイズなどの特定のデータベース作成パラ
メータを変更することはできません。

参照

● DatabaseManager クラス [Ultra Light J]136 ページ
● ConfigFileAndroid インタフェース [Android] [Ultra Light J]
● ConfigObjectStore インタフェース [BlackBerry] [Ultra Light J]
● ConfigFile インタフェース [Ultra Light J]
● ConfigNonPersistent インタフェース [BlackBerry] [Ultra Light J]

スキーマ操作とデータ管理のクイックスタートガイド
SQL 文とクエリを使用してデータベースのテーブル、インデックス、外部キー、パブリケーショ
ン、ローの作成、更新、取得を行います。

注意

一部の SQL 文は BlackBerry スマートフォンではサポートされていません。

スキーマ操作によってデータを管理する場合、一般的にアプリケーションコードで次のタスクを
実行します。

1. スキーマ操作を実行します。

データベース接続に対して CREATE TABLE または CREATE INDEX などの SQL 文を使用
することで、スキーマを管理し変更します。

2. ロー操作を管理します。

データベース接続に対して INSERT、UPDATE、または DELETE などの SQL 文を使用する
ことで、テーブル内のデータを管理します。

3. 結果セットにローデータを取得します。

SELECT 文を使用して結果セットを取得してから、結果セットのナビゲーションメソッド
(previous および next など) を使用し、ローデータをトラバースします。

例：Android スマートフォンに対するデータベース操作の管理
次の例は Android アプリケーションのサンプルクラスです。Ultra Light J API を使用して次の操
作を実行します。

●データベースにテーブルを作成します。

スキーマ操作とデータ管理のクイックスタートガイド
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●テーブルに新しいローを挿入します。

●テーブル内のローを更新します。

●テーブルからローを削除します。

●データベースへの変更をコミットします。

●結果セットを作成することによって、テーブルのすべてのローを選択します。

●結果セットをトラバースしてデータベースのローを表示します。

このクラスには、これらの操作に加え、正常な動作をログに出力するために使用される、PrintText
という名前のメソッド (Eclipse の [LogCat] タブ) や、Ultra Light J API 操作の実行中に発生する可
能性のあるエラーのレポートに使用される HandleError メソッドがあります。

package com.sampleapp;

import android.app.Activity;
import android.os.Bundle;
import android.util.Log;
import com.ianywhere.ultralitejni16.*;

public class NewUltraLiteJAppActivity extends Activity {
    Connection _conn = null;
    ResultSet _departments = null;
    PreparedStatement _inserter = null;
    PreparedStatement _updater = null;
    PreparedStatement _deleter = null;
    PreparedStatement _preparer = null;

    public void PrintText(String strText) {
        Log.i("NewUltraLiteJAppActivity", strText);
    }

    public void HandleError(ULjException err) {
        Log.w("NewUltraLiteJAppActivity", "Exception: " + err.toString());
    }

    public Connection GetDatabase(String strFilename) {
        ConfigFileAndroid config = null;
        Connection dbConnection = null;

        try {
            config = DatabaseManager.createConfigurationFileAndroid(
                    strFilename, getApplicationContext()
            );
            dbConnection = DatabaseManager.connect(config);
            PrintText("Successfully connected to the database at: " 
                    + strFilename);
        } catch(ULjException ex) {
            if (config != null) {
                try {
                    dbConnection = DatabaseManager.createDatabase(config);
                    PrintText("Successfully created a new database at: "
                            + strFilename);
                } catch(ULjException exception) {
                    HandleError(exception);
                }
            }

Ultra Light J アプリケーションの開発
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            HandleError(ex);
        }
        return dbConnection;
    }

    public void Commit() {
        try {
            _conn.commit();
        } catch (ULjException e1) {
            HandleError(e1);
        }
    }

    public void CloseDatabase() {
        try {
            _conn.release();
        } catch (ULjException e) {
            HandleError(e);
        }
    }

    public void ExecuteSQLStatement(String strSQLstmt) {
        PreparedStatement ps;
        try {
            ps = _conn.prepareStatement(strSQLstmt);
            ps.execute();
            ps.close();
            PrintText("Successfully executed: " + strSQLstmt);
        } catch (ULjException e) {
            HandleError(e);
        }
    }

    public void InitStatements() {
        String stmt;
        try {
            stmt = "INSERT INTO Department(dept_no, name) VALUES (?,?)";
            _inserter = _conn.prepareStatement(stmt);
            stmt = "UPDATE Department SET dept_no = ? WHERE dept_no = ?";
            _updater = _conn.prepareStatement(stmt);
            stmt = "DELETE FROM Department WHERE dept_no = ?";
            _deleter = _conn.prepareStatement(stmt);
        } catch (ULjException e) {
            HandleError(e);
        }
    }

    public void FiniStatements() {
        try {
            _departments.close();
            _inserter.close();
            _updater.close();
            _deleter.close();
            _preparer.close();
        } catch (ULjException e) {
            HandleError(e);
        }
    }

    public void AddDepartment(int deptID, String deptName) {
        try {
            _inserter.set(1, deptID);
            _inserter.set(2, deptName);
            _inserter.execute();

スキーマ操作とデータ管理のクイックスタートガイド
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            PrintText("Successfully executed:"
                    + " INSERT INTO Department(dept_no, name)" 
                    + " VALUES (" + deptID + "," + deptName + ")");
        } catch (ULjException e) {
            HandleError(e);
        }
    }

    public void UpdateDepartment(int deptIDold, int deptIDnew) {
        try {
            _updater.set(1, deptIDnew);
            _updater.set(2, deptIDold);
            _updater.execute();
            PrintText("Successfully executed:"
                    + " UPDATE Department SET dept_no = " + deptIDnew 
                    + " WHERE dept_no = " + deptIDold);
        } catch (ULjException e) {
            HandleError(e);
        }
    }

    public void DeleteDepartment(int deptID) {
        try {
            _deleter.set(1, deptID);
            _deleter.execute();
            PrintText("Successfully executed:"
                    + " DELETE FROM Department WHERE dept_no = " + deptID);
        } catch (ULjException e) {
            HandleError(e);
        }
    }

    public ResultSet SelectDepartmentRows() {
        String stmt = "SELECT * FROM Department ORDER BY dept_no";
        _preparer = null;
        _departments = null;
        try {
            _preparer = _conn.prepareStatement(stmt);
            _departments = _preparer.executeQuery();
            PrintText("Successfully executed: " + stmt);
        } catch (ULjException e) {
            HandleError(e);
        }
        return _departments;
    }

    /** Called when the activity is first created. */
    @Override
    public void onCreate(Bundle savedInstanceState) {
        super.onCreate(savedInstanceState);

        PrintText("Starting application...");
        
        _conn = GetDatabase("test.udb");
        if (_conn == null) {
            return;
        }
        
        String[] stmt = new String[3];
        
        stmt[0] = "CREATE TABLE Department("
                + "dept_no INT PRIMARY KEY, "
                + "name CHAR(50) NOT NULL)";
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        stmt[1] = "CREATE TABLE Employee("
            + "id INT PRIMARY KEY, "
            + "last_name CHAR(50) NOT NULL, "
            + "first_name CHAR(50) NOT NULL, "
            + "dept_id INT NOT NULL, "
            + "NOT NULL FOREIGN KEY(dept_id) "
            + "REFERENCES Department(dept_no))";

        stmt[2] = "CREATE INDEX ON Employee(last_name, first_name)";
        
        for(int i = 0; i< stmt.length; i++) {
            ExecuteSQLStatement(stmt[i]);
        }

        InitStatements();

        AddDepartment(101, "Electronics");
        AddDepartment(105, "Sales");
        AddDepartment(109, "Accounting");

        UpdateDepartment(101, 102);

        DeleteDepartment(102);

        Commit();

        _departments = SelectDepartmentRows();
        if (_departments != null) {
            try {
                while(_departments.next()) {
                    int dept_no = _departments.getInt(1);
                    String dept_name = _departments.getString(2);
                    PrintText("Department no.:" + dept_no
                            + " Department name: " + dept_name);
                }
            } catch (ULjException e) {
                HandleError(e);
            }
        }
    
        FiniStatements();

        CloseDatabase();

        PrintText("Closing application...");
        finish();
    }
}

スキーマ操作とデータ管理のクイックスタートガイド
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参照

● DatabaseManager クラス [Ultra Light J]136 ページ
● DatabaseManager.createConfigurationFileAndroid メソッド [Ultra Light J]139 ページ
● Connection.prepareStatement メソッド [Ultra Light J]116 ページ
● PreparedStatement インタフェース [Ultra Light J]179 ページ
● PreparedStatement.set メソッド [Ultra Light J]187 ページ
● PreparedStatement.execute メソッド [Ultra Light J]181 ページ
● PreparedStatement.executeQuery メソッド [Ultra Light J]181 ページ
● Connection.commit メソッド [Ultra Light J]108 ページ
● Connection.rollback メソッド [Ultra Light J]118 ページ
● ResultSet インタフェース [Ultra Light J]195 ページ
● ResultSet.afterLast メソッド [Android] [Ultra Light J]198 ページ
● ResultSet.beforeFirst メソッド [Android] [Ultra Light J]198 ページ
● ResultSet.first メソッド [Android] [Ultra Light J]198 ページ
● ResultSet.last メソッド [Android] [Ultra Light J]212 ページ
● ResultSet.next メソッド [Ultra Light J]213 ページ
● ResultSet.previous メソッド [Ultra Light J]213 ページ
● ResultSet.relative メソッド [Android] [Ultra Light J]213 ページ
●「Ultra Light SQL 文」『Ultra Light データベース管理とリファレンス』

スキーマの操作
次の一般的なタスクによってスキーマ操作を実行します。

1. 文字列変数に SQL 文を作成します。

2. 文字列変数を Connection.prepareStatement メソッドに渡して PreparedStatement オブジェクト
を作成します。

3. PreparedStatement.execute メソッドを呼び出してデータベースの操作を実行します。

4. PreparedStatement オブジェクトを閉じてリソースを解放します。

例

この例に示したコードは、Ultra Light J API を使用してスキーマやデータを管理する基本操作を
実行する方法を紹介している完全なコードサンプルの一部です。 「例：Android スマートフォン
に対するデータベース操作の管理」を参照してください。

個々の CREATE TABLE 文と CREATE INDEX 文が組み立てられ、ExecuteSQLStatement という名
前のカスタムメソッドに渡されて、必要なスキーマ操作がすべて実行されます。

String[] stmt = new String[3];

stmt[0] = "CREATE TABLE Department("
    + "dept_no INT PRIMARY KEY, "
    + "name CHAR(50) NOT NULL)";

stmt[1] = "CREATE TABLE Employee("
    + "id INT PRIMARY KEY, "
    + "last_name CHAR(50) NOT NULL, "
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    + "first_name CHAR(50) NOT NULL, "
    + "dept_id INT NOT NULL, "
    + "NOT NULL FOREIGN KEY(dept_id) "
    + "REFERENCES Department(dept_no))";

stmt[2] = "CREATE INDEX ON Employee(last_name, first_name)";
        
for(int i = 0; i< stmt.length; i++) {
    ExecuteSQLStatement(stmt[i]);
}

ExecuteSQLStatement メソッドは次のコードで構成されています。

public void ExecuteSQLStatement(String strSQLstmt) {
    PreparedStatement ps;
    try {
        ps = _conn.prepareStatement(strSQLstmt);
        ps.execute();
        ps.close();
        PrintText("Successfully executed: " + strSQLstmt);
    } catch (ULjException e) {
        HandleError(e);
    }
}

参照

● Connection.prepareStatement メソッド [Ultra Light J]116 ページ
● PreparedStatement インタフェース [Ultra Light J]179 ページ
● PreparedStatement.set メソッド [Ultra Light J]187 ページ
● PreparedStatement.execute メソッド [Ultra Light J]181 ページ

ロー操作の管理
次の一般的なタスクを実行して、ロー操作を管理します。

1. 文字列変数に SQL 文を作成します。

2. 文字列変数を Connection.prepareStatement メソッドに渡して PreparedStatement オブジェクト
を作成します。

3. ホスト変数を設定します (? 文字で表し、PreparedStatement.set メソッドを使用します)。

各ホスト変数は文内の位置を表す序数で参照できます。たとえば、最初の ? は 1 として、2
番目は 2 として参照されます。下記の例に示されている set メソッドでは、変数の位置を表
す序数を参照し、新しい値を指定できます。

4. PreparedStatement.execute メソッドを呼び出してデータベースの操作を実行します。

5. Connection.commit メソッドを呼び出してデータベースへの変更をコミットし、永続的な変更
にするか、または Connection.rollback メソッドを呼び出します。

トランザクションは、Connection インタフェースでサポートされているメソッドを使用して
明示的にコミットまたはロールバックする必要があります。

スキーマ操作とデータ管理のクイックスタートガイド
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6. PreparedStatement オブジェクトを閉じてリソースを解放します。

例

この例に示したコードは、Ultra Light J API を使用してスキーマやデータを管理する基本操作を
実行する方法を紹介している完全なコードサンプルの一部です。 「例：Android スマートフォン
に対するデータベース操作の管理」を参照してください。

グローバルの PreparedStatement オブジェクトが定義され、InitStatements メソッドの呼び出しに
よってインスタンス化されます。データの挿入、更新、削除の操作はそれぞれ、AddDepartment、
UpdateDepartment、DeleteDepartment のカスタムメソッドで実行されます。Commit メソッドは
ロー操作を永続的なものにします。FiniStatements メソッドは、グローバルの PreparedStatement
オブジェクトを閉じて、リソースを解放します。

Connection _conn = null;
ResultSet _departments = null;
PreparedStatement _inserter = null;
PreparedStatement _updater = null;
PreparedStatement _deleter = null;
PreparedStatement _preparer = null;

public void InitStatements() {
    String stmt;
    try {
        stmt = "INSERT INTO Department(dept_no, name) VALUES (?,?)";
        _inserter = _conn.prepareStatement(stmt);
        stmt = "UPDATE Department SET dept_no = ? WHERE dept_no = ?";
        _updater = _conn.prepareStatement(stmt);
        stmt = "DELETE FROM Department WHERE dept_no = ?";
        _deleter = _conn.prepareStatement(stmt);
    } catch (ULjException e) {
        HandleError(e);
    }
}

public void FiniStatements() {
    try {
        _departments.close();
        _inserter.close();
        _updater.close();
        _deleter.close();
        _preparer.close();
    } catch (ULjException e) {
        HandleError(e);
    }
}

public void AddDepartment(int deptID, String deptName) {
    try {
        _inserter.set(1, deptID);
        _inserter.set(2, deptName);
        _inserter.execute();
        PrintText("Successfully executed:"
                + " INSERT INTO Department(dept_no, name)" 
                + " VALUES (" + deptID + "," + deptName + ")");
    } catch (ULjException e) {
        HandleError(e);
    }
}

public void UpdateDepartment(int deptIDold, int deptIDnew) {
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    try {
        _updater.set(1, deptIDnew);
        _updater.set(2, deptIDold);
        _updater.execute();
        PrintText("Successfully executed:"
                + " UPDATE Department SET dept_no = " + deptIDnew 
                + " WHERE dept_no = " + deptIDold);
    } catch (ULjException e) {
        HandleError(e);
    }
}

public void DeleteDepartment(int deptID) {
    try {
        _deleter.set(1, deptID);
        _deleter.execute();
        PrintText("Successfully executed:"
                + " DELETE FROM Department WHERE dept_no = " + deptID);
    } catch (ULjException e) {
        HandleError(e);
    }
}

public void Commit() {
    try {
        _conn.commit();
    } catch (ULjException e1) {
        HandleError(e1);
    }
}

注意

1 回しか実行する必要のない SQL 文を作成する場合は、ホスト変数に文字列連結を利用するこ
とをおすすめします。

たとえば、次のコードは、DeleteDepartment メソッドの置換に使用できるコードですが、文字列
連結で SQL 文が作成されています。

public void DeleteDepartment(int deptID) {
    String stmt = "DELETE FROM Department WHERE dept_no = " + deptID;
    PreparedStatement deleter;
    try {
        deleter = _conn.prepareStatement(stmt);
        deleter.execute();
        deleter.close();
        PrintText("Successfully executed: " + stmt);
    } catch (ULjException e) {
        HandleError(e);
    }
}

参照

● Connection.prepareStatement メソッド [Ultra Light J]116 ページ
● PreparedStatement インタフェース [Ultra Light J]179 ページ
● PreparedStatement.set メソッド [Ultra Light J]187 ページ
● PreparedStatement.execute メソッド [Ultra Light J]181 ページ

スキーマ操作とデータ管理のクイックスタートガイド
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ローデータの検索
次の一般的なタスクを実行して、テーブルからローデータを取り出します。

1. 文字列変数で SELECT SQL 文を作成します。

2. 文字列変数を Connection.prepareStatement メソッドに渡して PreparedStatement オブジェクト
を作成します。

3. PreparedStatement.executeQuery メソッドを呼び出して、クエリ結果を ResultSet オブジェクト
に割り当てます。

4. ナビゲーションメソッドを使用して ResultSet オブジェクトをトラバースし、ローデータを
取り出します。

結果セットのトラバースには、次のナビゲーションメソッドを使用できます。

● afterLast1 カーソルを最後のローの直後に配置します。

● beforeFirst1 最初のローの直前に配置します。

● first1 最初のローに移動します。

● last1 最後のローに移動します。

● next 次のローに移動します。

● previous 前のローに移動します。

● relative(offset)1 現在のローを基準にして、符号付きオフセット値で指定された数だけ
ローを移動します。 オフセット値を正の値で指定すると、現在の結果セットのポインタ
位置から前方に移動します。負の値で指定すると後方に移動します。オフセット値が 0
の場合、カーソルは現在のロケーションから移動しませんが、ローバッファが再配置さ
れます。

1 このメソッドは、Ultra Light Java Edition データベースではサポートされていません。

5. ResultSet オブジェクトと PreparedStatement オブジェクトを閉じてリソースを解放します。

例

この例に示したコードは、Ultra Light J API を使用してスキーマやデータを管理する基本操作を
実行する方法を紹介している完全なコードサンプルの一部です。 「例：Android スマートフォン
に対するデータベース操作の管理」を参照してください。

カスタム SelectDepartmentRows メソッドで結果セットが取り出されます。

public ResultSet SelectDepartmentRows() {
    String stmt = "SELECT * FROM Department ORDER BY dept_no";
    _preparer = null;
    _departments = null;
    try {
        _preparer = _conn.prepareStatement(stmt);
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        _departments = _preparer.executeQuery();
        PrintText("Successfully executed: " + stmt);
    } catch (ULjException e) {
        HandleError(e);
    }
    return _departments;
}

next ナビゲーションメソッドを使用して結果セットをトラバースすることで、ローデータが取り
出されます。

_departments = SelectDepartmentRows();
if (_departments != null) {
    try {
        while(_departments.next()) {
            int dept_no = _departments.getInt(1);
            String dept_name = _departments.getString(2);
            PrintText("Department no.:" + dept_no
                    + " Department name: " + dept_name);
        }
    } catch (ULjException e) {
        HandleError(e);
    }
}

参照

● PreparedStatement.executeQuery メソッド [Ultra Light J]181 ページ
● ResultSet インタフェース [Ultra Light J]195 ページ
● ResultSet.afterLast メソッド [Android] [Ultra Light J]198 ページ
● ResultSet.beforeFirst メソッド [Android] [Ultra Light J]198 ページ
● ResultSet.first メソッド [Android] [Ultra Light J]198 ページ
● ResultSet.last メソッド [Android] [Ultra Light J]212 ページ
● ResultSet.next メソッド [Ultra Light J]213 ページ
● ResultSet.previous メソッド [Ultra Light J]213 ページ
● ResultSet.relative メソッド [Android] [Ultra Light J]213 ページ

スキーマ情報へのアクセス
データベーススキーマの記述は、プログラムを使用して取得できます。これらの記述は、「スキー
マ情報」と呼ばれ、システムテーブルおよび Ultra Light J API スキーマインタフェースを使用し
てアクセスできます。

システムテーブルを使用したスキーマ情報へのアクセス

データベースのスキーマ情報は、Ultra Light または Ultra Light Java Edition のシステムテーブルに
格納されます。この情報にアクセスするには、正規 SQL クエリを実行して適切なシステムテー
ブルから所定の情報を選択し、結果セットにアクセスします。

スキーマインタフェースを使用したスキーマ情報へのアクセス

一部のスキーマ情報は、システムテーブルの代わりにスキーマインタフェースを使用してアクセ
スできます。Ultra Light J API には、次のスキーマインタフェースが含まれています。

スキーマ情報へのアクセス

Copyright © 2013, SAP AG or an SAP affiliate company. - SAP Sybase SQL Anywhere 16.0 19



● TableSchema カラムとインデックスの設定に関する情報を返します。

● IndexSchema インデックス内のカラムに関する情報を返します。IndexSchema オブジェク
トは、TableSchema オブジェクトから取得できます。

● ColumnSchema テーブル内のカラムに関する情報を返します。ColumnSchema オブジェク
トは、TableSchema オブジェクトから取得できます。

参照

●「ローデータの検索」18 ページ
●「Ultra Light のシステムテーブル」『Ultra Light データベース管理とリファレンス』
●「Ultra Light Java Edition システムテーブル」『Ultra Light データベース管理とリファレンス』
● TableSchema インタフェース [Ultra Light J]278 ページ
● IndexSchema インタフェース [Ultra Light J]177 ページ
● ColumnSchema インタフェース [Ultra Light J]79 ページ

エラー処理
ULjException クラスおよび SQLCode クラスを使用して、エラーを処理できます。ほとんどの
Ultra Light メソッドは、ULException エラーをスローします。ULjException.getErrorCode メソッド
を使用して、エラーに割り当てられた SQLCode 値を取得できます。ULjException.toString メソッ
ドを使用して、エラーの説明文を取得できます。SQLCode エラーは、エラー型を示す負数で、
ULjException.SQLE_INDEX_NOT_FOUND などの定数を使用して参照できます。

例

次の例は、Ultra Light Java Edition データベースへの接続時に発生する可能性があるエラーを、
ULjException クラスを使用して処理する Java クラスを示しています。

import com.ianywhere.ultralitej16.*;
import net.rim.device.api.ui.component.*;
import java.util.*;

class DataAccess {
    DataAccess() {
    }
    
    public static synchronized DataAccess getDataAccess(boolean reset) 
        throws Exception
    {   
        if (_da == null) {
            _da = new DataAccess();
            ConfigObjectStore config = DatabaseManager.createConfigurationObjectStore("HelloDB");
            if (reset) {
                _conn = DatabaseManager.createDatabase(config);
                // _da.createDatabaseSchema();
            } 
            else {
                try {
                    _conn = DatabaseManager.connect(config);
                }
                catch (ULjException uex1) {
                    if (uex1.getErrorCode() != ULjException.SQLE_ULTRALITE_DATABASE_NOT_FOUND) {
                        Dialog.alert("Exception: " + uex1.toString() + ". Recreating database...");

Ultra Light J アプリケーションの開発
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                    }
                    _conn = DatabaseManager.createDatabase(config);
                    // _da.createDatabaseSchema();
                }
            }
        }
        return _da;        
    }
    private static Connection _conn;
    private static DataAccess _da;
}

参照

● ULjException クラス [Ultra Light J]284 ページ
● ULjException.getErrorCode メソッド [Ultra Light J]285 ページ
●「SQL Anywhere のエラーメッセージ (SQLCODE 順)」『エラーメッセージ』

Mobile Link データ同期
Ultra Light Java Edition 管理システムには、データベースの変更が同期されるように変更トラッキ
ングシステムが組み込まれています。

データの同期は、HTTP ネットワークプロトコルまたは HTTPS ネットワークプロトコルを使用
して実行できます。HTTPS 同期を使用すると、Mobile Link サーバに安全な暗号化が提供されま
す。

データを同期するには、アプリケーションで次の手順を実行する必要があります。

1. 統合データベースに関する情報 (サーバ名、ポート番号)、同期するベータベース名、同期す
るテーブルの定義を含む syncParms オブジェクトをインスタンス化します。

2. syncParms オブジェクトを渡した接続オブジェクトから synchronize メソッドを呼び出して、
同期を実行します。

同期するデータはテーブルレベルで定義できます。テーブルの一部分を同期するように設定す
ることはできません。

参照

● SyncParms クラス [Ultra Light J]248 ページ
● SyncResult クラス [Ultra Light J]266 ページ
●「チュートリアル：Android アプリケーションの構築」41 ページ

例

次の例は、Ultra Light J アプリケーションを使用したデータの同期を示しています。この例は、
%SQLANYSAMP16%¥UltraLiteJ¥J2SE¥Sync.java にあります。

package com.ianywhere.ultralitej.demo;
import com.ianywhere.ultralitej16.*;
/**
 * Sync: sample program to demonstrate Database synchronization.
 *

Mobile Link データ同期
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 * Requires starting the MobiLink Server Sample using start_ml.bat
 */
public class Sync
{
    /**
     * mainline for program.
     *
     * @param args command-line arguments
     *
     */
    public static void main
        ( String[] args )
    {
        try {
            Configuration config = DatabaseManager.createConfigurationFile( "Demo1.ulj" );
            Connection conn = DatabaseManager.createDatabase( config );

            PreparedStatement ps = conn.prepareStatement(
                "CREATE TABLE ULCustomer" +
                "( cust_id int NOT NULL PRIMARY KEY" +
                ", cust_name VARCHAR(30) NOT NULL" +
                ")"
            );
            ps.execute();
            ps.close();

            //
            // Synchronization
            //

            SyncParms syncParms = conn.createSyncParms( SyncParms.HTTP_STREAM, "50", "custdb 
16.0" );
            syncParms.getStreamParms().setPort( 9393 );
            conn.synchronize( syncParms );
            SyncResult result = syncParms.getSyncResult();
            Demo.display(
                    "*** Synchronized *** bytes sent=" + result.getSentByteCount()
                    + ", bytes received=" + result.getReceivedByteCount()
                    + ", rows received=" + result.getReceivedRowCount()
                );

            conn.release();

        } catch( ULjException exc ) {
            Demo.displayException( exc );
        }
    }
}

CustDB を統合データベースとして Mobile Link サーバを起動するには、%SQLANYSAMP16%
¥J2SE¥UltraLiteJ ディレクトリから start_ml.bat を実行します。

Android スマートフォンでは、統合データベースとして CustDB を使用したチュートリアルを利
用できます。

Ultra Light J アプリケーションの開発
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BlackBerry スマートフォンでのデータ同期
BlackBerry 環境では、データはデバイスと BlackBerry Enterprise Server (BES) 間で常に暗号化され
ます。HTTPS は、BES と Mobile Link サーバ間で暗号化が必要な場合、またはデバイスが BES
で管理されていないときに役立ちます。

同時同期処理

通常、Ultra Light ランタイムでは、一度に 1 つのスレッドだけが許可されます。しかし、同期中
はこの規則に例外が発生します。1 つの接続で同期操作を実行しているときに、他の接続で Ultra
Light ランタイムにアクセスできます。ただし、同期操作の実行中は、同期中のデータベースに
対して他のスレッドから同期メソッドを呼び出すことはできません。

Ultra Light は独立性レベル 0 で動作するので、接続により、実行中の同期が失敗した場合に消去
される可能性のあるダウンロードされたローに、同期中 (ローがコミットされる前) にアクセス
できます。同期によって後から変更されるローが、同期中に接続によって修正されると、同期は
失敗します。同期によって変更されたローを、同期中に接続によって修正しようとすると、その
試行は失敗します。

Ultra Light J 同期ストリームのネットワークプロトコルのオプ
ション

Mobile Link サーバと同期するときは、アプリケーション内でネットワークプロトコルを設定す
る必要があります。各データベースはネットワークプロトコルを通じて同期されます。Ultra
Light J では、HTTP と HTTPS の 2 つのネットワークプロトコルを使用できます。

設定したネットワークプロトコルでは、対応するプロトコルオプションのセットから選択するこ
とによって、Ultra Light J アプリケーションが Mobile Link サーバを特定して通信できるようにし
ます。ネットワークプロトコルのオプションは、アドレス情報 (ホストとポート) やプロトコル
固有の情報などを提供します。

HTTP ネットワークプロトコルの設定

HTTP ネットワークプロトコルは、Ultra Light J API の StreamHTTPParms インタフェースを使用
して設定します。インタフェースのメソッドを使用して、Mobile Link サーバで定義されている
ネットワークプロトコルのオプションを指定します。

HTTPS ネットワークプロトコルの設定

HTTPS ネットワークプロトコルは、Ultra Light J API の StreamHTTPSParms インタフェースを使
用して設定します。インタフェースのメソッドを使用して、Mobile Link サーバで定義されてい
るネットワークプロトコルのオプションを指定します。

参照

●「Mobile Link クライアントネットワークプロトコルオプション」『Mobile Link クライアント管
理』

● StreamHTTPParms インタフェース [Ultra Light J]223 ページ
● StreamHTTPSParms インタフェース [Ultra Light J]236 ページ

Mobile Link データ同期
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BlackBerry スマートフォンでの CustDB アプリケーションの
同期

CustDB (顧客データベース) は、SQL Anywhere と同時にインストールされるサンプルデータベー
スであり Ultra Light J アプリケーションです。CustDB データベースは、販売注文用の簡単なデー
タベースです。

アプリケーションの検索と配備

Ultra Light J には、CustDB データベースに基づいたサンプルの BlackBerry アプリケーションが含
まれています。このアプリケーションの名前は CustDB で、ソースコードと関連ファイルは、
%SQLANYSAMP16%¥UltraLiteJ¥BlackBerry¥CustDB¥ フォルダにあります。CustDB ディレクトリ
には、BlackBerry JDE を使用して開くことのできるプロジェクトファイルが含まれています。
CustDB アプリケーションに関するアプリケーション情報については、readme.txt を参照してくだ
さい。

CustDB アプリケーションの構築後、CustDB16.cod と必要なファイルをシミュレータまたはデバ
イスに配備します。

CustDB アプリケーションの関連ファイル

CustDB プロジェクトの次のファイルには、データベースアクセスコードが含まれています。

● CustDB.java このファイルには、基本的なデータベースアクセスメソッドがすべて含まれ
ています。これらのメソッドには、データベースの作成、データベースへの接続、注文の挿
入、削除、更新などのメソッドがあります。このファイルには、バックエンドサーバと通信
するデータベース呼び出しの多くが含まれています。

● SchemaCreator.java このファイルには、Ultra Light J を使用してデバイス上にテーブルを
作成するコードが含まれています。

CustDB アプリケーションの使用

%SQLANYSAMP16%¥UltraLiteJ¥BlackBerry¥CustDB¥mobilink.bat を実行して、ローカルの Mobile
Link サーバを起動します。

CustDB プログラムは、最初の起動時に、CustDB データベースをホストするサーバと対話するた
めに必要な情報を収集します。ここで、クエリに使用する Employee ID (50 を推奨します)、デー
タベースをホストするサーバのホスト名または IP アドレス、サーバとの接続に使用するポート
番号を指定します。

Ultra Light J アプリケーションの開発
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これらの値が指定されて設定が保存されると ([Menu] » [Save])、アプリケーションは指定された
サーバと同期します。アプリケーションは、指定した従業員番号 (50) に対応する Employee ID と
一致する注文だけをサーバからダウンロードします。オープン状態になっている注文のみが選
択されます (注文のステータスは、Open、Approved、Denied のいずれかです)。

それぞれの注文が、顧客名、注文品、数量、価格、割引の情報とともに画面に表示されます。ま
た、画面には注文の現在のステータス (Status) とその注文に関するメモ (Notes) も表示されます。

この画面では、注文にメモを書き加えたり、注文のステータスを Approved や Denied に変更した
りすることができます。[Next] ボタンと [Previous] ボタンを使用して注文をナビゲーションで
きます。

CustDB プログラムでも、データベースに新しい注文を追加できます。新しい注文を追加するに
は、[Menu] » [New Order] をクリックします。

Mobile Link データ同期
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数量と割引の値を入力します。

アプリケーションを終了する前に、メインメニューで [Synchronize] をクリックして、変更内容
と新しい注文を統合データベースと同期します。

参照

●「Ultra Light J アプリケーションの構築と配備」27 ページ

Ultra Light Java Edition データベース接続の終了方法
同時接続がすべて解放されると、Ultra Light Java Edition データベースは終了します。接続はすべ
て、DatabaseManager.release メソッドを使用してリリースできます。

Ultra Light J アプリケーションの開発
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注意

現在の接続を解放するには、Connection.release メソッドを使用します。

アクティブなデータベース接続が解放される前に BlackBerry アプリケーションがクラッシュし
た場合、アプリケーションがデータベースに再接続しようとすると、ULjException オブジェクト
が SQLE_FILE_IN_USE エラーコードとともにスローされることがあります。このような場合、
アプリケーションを再接続するには、スマートフォンをリブートする必要があります。

リブートを回避するには、キャッチオール例外ハンドラを使用して、emergencyShutdown メソッ
ドを呼び出し、接続が解放されるようにします。

たとえば、BlackBerry アプリケーションで次のキャッチオール例外ハンドラを使用すると、回復
不能なエラーが発生した場合に emergencyShutdown メソッドを呼び出すことができます。

try { 
    // top level application code 
    // release all connections in a normal termination 
} catch( Exception e ) { 
    conn.emergencyShutdown();
    throw e;
} 

この例の conn オブジェクトは、Ultra Light Java Edition データベースへのアクティブな接続を表
しています。

参照

● DatabaseManager.release メソッド [Ultra Light J]143 ページ
● Connection.release メソッド [Ultra Light J]117 ページ

Ultra Light J アプリケーションの構築と配備
Ultra Light J アプリケーションは、Android および BlackBerry スマートフォンに配備できます。
Ultra Light J アプリケーションが正常に実行されるためには、配布ファイルとともに Ultra Light J
API も配備する必要があります。

参照

●「Ultra Light アプリケーションのビルドと配備の仕様」『Ultra Light データベース管理とリファ
レンス』

Android 用 Ultra Light J アプリケーションの配備
適切な作成パラメータ、接続パラメータ、同期パラメータ、プロトコルオプション、メソッド呼
び出し、配備ファイルを指定して、Ultra Light J アプリケーションが Android スマートフォンで
正常に実行されるようにします。

前提条件

この作業を実行するための前提条件はありません。

Ultra Light J アプリケーションの構築と配備
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♦ タスク

1. 次のファイルを Android プロジェクトに追加します。

●%SQLANY16%¥UltraLite¥UltraLiteJ¥Android¥UltraLiteJNI16.jar

●%SQLANY16%¥UltraLite¥UltraLiteJ¥Android¥ARM¥libultralitej16.so

2. 次のパラメータを指定します。

●難読化を使用している場合は、データベース作成時に作成パラメータ obfuscate=1 を設定
します。

●AES 暗号化を使用する場合は、データベース作成時または接続時に接続パラメータ
DBKEY=encryption-key を設定します。

これらのパラメータを設定するには、setCreationString メソッドと setConnectionString メソッ
ドを使用します。

3. Ultra Light アプリケーションで同期を使用する場合は、パラメータを適切に設定してくださ
い。

同期タイプ パラメータの設定

TCP/IP Stream 同期パラメータを "tcpip" に設定し
ます。

HTTP Stream 同期パラメータを "http" に設定しま
す。

RSA TLS Stream 同期パラメータを "tls" に設定しま
す。

RSA HTTPS Stream 同期パラメータを "https" に設定し
ます。

4. RSA エンドツーエンド暗号化 (RSA E2EE) を使用している場合は、プロトコルオプション
e2ee_public_key=key-file を設定します。

5. ZLIB 圧縮を使用している場合は、プロトコルオプション compression=zlib を設定します。

6. AES 暗号化を使用している場合は、ConfigPersistent.EnableAesDBEncryption メソッドを呼び出
します。

7. RSA TLS、RSA HTTPS、または RSA E2EE を使用している場合は、%SQLANY16%¥UltraLite
¥UltraLiteJ¥Android¥ARM¥libmlcrsa16.so を配備します。

結果

Ultra Light J アプリケーションは配備先の Android デバイスで正常に稼動します。

Ultra Light J アプリケーションの開発
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次の手順

アプリケーションが配備された Android モバイルデバイスに Ultra Light データベースを配備す
るか、または配備したアプリケーションで新しいデータベースを作成します。

参照

●「Ultra Light アプリケーションのビルドと配備の仕様」『Ultra Light データベース管理とリファ
レンス』

●「Ultra Light および Ultra Light Java Edition データベースの配備に関する制限事項」『Ultra Light
データベース管理とリファレンス』

● ConfigPersistent.setCreationString メソッド [Android] [Ultra Light J]97 ページ
● ConfigPersistent.setConnectionString メソッド [Android] [Ultra Light J]97 ページ

BlackBerry 用 Ultra Light J アプリケーションの配備
メソッド呼び出しを使用して適切な作成パラメータ、接続パラメータ、同期パラメータ、プロト
コルオプションを指定し、適切なファイルを配備することで、Ultra Light J アプリケーションが
BlackBerry スマートフォンで正常に稼動するようにします。

前提条件

この作業を実行するための前提条件はありません。

♦ タスク

1. データベースの作成および接続時に次のメソッドを呼び出します。

●難読化を使用している場合は、ConfigPersistent.enableObfuscation。

●AES 暗号化を使用している場合は、ConfigPersistent.EnableAesDBEncryption と
ConfigPersistent.setEncryptionKey。

2. 同期を使用している場合は、同期ストリームを指定するために、SyncParms.HTTP_STREAM
定数または SyncParms.HTTPS_STREAM 定数を Connection.createSyncParms メソッドに渡し
てから、StreamHTTPParms インタフェースまたは StreamHTTPSParms インタフェースを使用
します。

3. 前の手順で選択したインタフェースを通じてストリームの圧縮と暗号化のオプションを設定
します。

●ZLIB 圧縮の場合は、setZlibCompression メソッドを呼び出します。

●RSA E2EE 暗号化の場合は、setE2eePublicKey メソッドを呼び出します。

4. 次のファイルを配備します。これらは %SQLANY16%¥UltraLite¥UltraLiteJ¥BlackBerry4.2 ディ
レクトリにあります。

●UltraLiteJ16.cod

●UltraLiteJ16.jad

Ultra Light J アプリケーションの構築と配備
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UltraLiteJ16.jad が必要なのは、無線配信 (OTA：over-the-air) で配備の場合だけです。また、
アプリケーションとともに Ultra Light J を配備する独自の .jad ファイルを作成することもで
きます。

5. RSA E2EE 暗号化を使用している場合は、DER でコード化されたファイルを FileTransfer イン
タフェースを使用して転送するか、またはファイルを SD カードに保存します。

結果

Ultra Light J アプリケーションは配備先の BlackBerry スマートフォンで正常に稼動します。

次の手順

アプリケーションが配備された BlackBerry スマートフォンに Ultra Light Java Edition データベー
スを配備するか、または配備したアプリケーションで新しいデータベースを作成します。

参照

●「Ultra Light アプリケーションのビルドと配備の仕様」『Ultra Light データベース管理とリファ
レンス』

●「Ultra Light および Ultra Light Java Edition データベースの配備に関する制限事項」『Ultra Light
データベース管理とリファレンス』

● ConfigPersistent インタフェース [Ultra Light J]91 ページ
● StreamHTTPParms インタフェース [Ultra Light J]223 ページ
● StreamHTTPSParms インタフェース [Ultra Light J]236 ページ
● FileTransfer インタフェース [Ultra Light J]157 ページ

サンプルコード
この項では、Ultra Light J API を使用する Java コードのサンプルを示します。これらのサンプル
では、デバッグのためにメッセージを表示し、ULjException オブジェクトを処理するデモクラ
スを使用しています。

すべてのサンプルコードは %SQLANYSAMP16%¥UltraLiteJ¥J2SE ディレクトリにあります。ファ
イルの内容を変更する前に、元のソースコードのバックアップコピーを作成することをおすすめ
します。

これらのサンプルコードは、Windows デスクトップ環境用に作成されていますが、その概念は、
特に指定がないかぎり、すべての Ultra Light J プラットフォームに適用されます。

これらのサンプルを実行するには、JAVA_HOME 環境変数をインストールされたバージョンの
JDK 1.6 に設定します。その後、サンプルの名前を使用して rundemo.cmd を実行できます。

%SQLANYSAMP16%¥UltraLiteJ¥J2SE¥Demo.java にあるデモクラスは、この項に記載されている
すべてのサンプルで使用されています。

たとえば、次のコマンドは CreateDb サンプルを実行します。

rundemo CreateDb
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このコマンドは次の出力を生成します。

Executing:
CREATE TABLE department
( dept_no INT NOT NULL PRIMARY KEY
, name VARCHAR(50)
)

Executing:
CREATE TABLE Employee
( number INT NOT NULL PRIMARY KEY
, last_name VARCHAR(32)
, first_name VARCHAR(32)
, age INT
, dept_no INT
, FOREIGN KEY fk_emp_to_dept( dept_no ) REFERENCES department( dept_no ))

CreateDb completed successfully

出力は demos.out というファイルに保存されます。

BlackBerry サンプル

次のデモは、BlackBerry 開発者が利用できるものであり、%SQLANYSAMP16%¥UltraLiteJ
¥BlackBerry ディレクトリにあります。

●BinaryStoreAsFile デモは、外部ファイルをデータベースの一部として関連付ける機能の使用方
法を示しています。

●CustDB デモは、モバイル顧客の注文アプリケーションを示しています。

●BlackBerryEncryption デモは、非常に機密性の高い Ultra Light J データベースに関する高度な概
念を示しています。

●HelloBlackBerry デモ。

HelloBlackBerry デモに基づいたチュートリアルを利用できます。

Android のサンプル

CustDB サンプルデータベースを使用するサンプル Eclipse プロジェクトが %SQLANYSAMP16%
¥UltraLiteJ¥Android¥CustDB ディレクトリに用意されています。ソースコードは
%SQLANYSAMP16%¥UltraLiteJ¥Android¥CustDB¥src¥com¥sybase¥custdb にあります。

例に基づいたチュートリアルを利用できます。

参照

●「チュートリアル：BlackBerry アプリケーションの構築」49 ページ
●「チュートリアル：Android アプリケーションの構築」41 ページ

Java SE の例：データベースの作成
この Java SE サンプルを実行すると、Java SE Java 環境でのファイルシステムデータベーススト
アの作成方法がわかります。

サンプルコード
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前提条件

この作業を実行するための前提条件はありません。

内容と備考

データベースの作成には、Configuration オブジェクトを使用します。作成すると、Connection オ
ブジェクトが返されます。テーブルを作成するには、schemaUpdateBegin メソッドを呼び出して
基本となるスキーマへの変更を開始し、schemaUpdateComplete メソッドでスキーマの変更を完了
します。

♦ タスク

1. 次のディレクトリに移動します。%SQLANYSAMP16%¥UltraLiteJ¥J2SE.

2. CreateDb サンプルを実行します。

rundemo CreateDb

結果

アプリケーションが正常に実行されます。Ultra Light Java Edition のファイルシステムデータ
ベースストアが作成されます。

Java SE の例：ローの挿入
この Java SE サンプルを実行すると、Ultra Light Java Edition データベースへのローの挿入方法が
わかります。

前提条件

この作業を実行するための前提条件はありません。

♦ タスク

1. 次のディレクトリに移動します。%SQLANYSAMP16%¥UltraLiteJ¥J2SE.

2. CreateDb サンプルを実行します。

rundemo CreateDb

3. 次のコマンドを実行します (コマンドでは大文字と小文字が区別されます)。

rundemo LoadDb

結果

アプリケーションが正常に実行されます。ローがデータベースに挿入されます。

挿入されたデータは、Connection オブジェクトから commit メソッドが呼び出されたときに初め
てデータベースで永続的になります。
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ローが挿入され、まだコミットされていなくても、他の接続からそのローを参照できます。この
ため、ある接続によって、実際にコミットされていないローデータが取り出される可能性があり
ます。

参照

●「Java SE の例：データベースの作成」31 ページ

Java SE の例：テーブルの読み込み
この Java SE サンプルを実行すると、テーブルの読み込み方法がわかります。

前提条件

この作業を実行するための前提条件はありません。

内容と備考

このサンプルでは、接続から PreparedStatement オブジェクトを取り出し、PreparedStatement オブ
ジェクトから ResultSet オブジェクトを取利出しています。次のローが取得可能であると、
ResultSet の next メソッドはそのたびに true を返します。true が返されると、ResultSet オブジェ
クトから現在のローのカラムの値を取得できます。

♦ タスク

1. 次のディレクトリに移動します。%SQLANYSAMP16%¥UltraLiteJ¥J2SE.

2. CreateDb サンプルを実行します。

rundemo CreateDb

3. LoadDb サンプルを実行します。

rundemo LoadDb

4. 次のコマンドを実行します (コマンドでは大文字と小文字が区別されます)。

rundemo ReadSeq

結果

アプリケーションが正常に実行されます。ResultSet が作成されると、結果セットの最初のローの
前に配置されます。ReadSeq アプリケーションが結果セットを順番に読み込み、表示します。

参照

●「Java SE の例：データベースの作成」31 ページ
●「Java SE の例：ローの挿入」32 ページ

サンプルコード
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Java SE の例：内部ジョイン操作
この Java SE サンプルを実行すると、内部ジョイン操作の実行方法がわかります。

前提条件

この作業を実行するための前提条件はありません。

内容と備考

すべての従業員には、対応する部署の情報があります。ジョイン操作によって、従業員
(Employee) テーブルのデータを部署 (Department) テーブルのそれに対応するデータと関連付け
ます。関連付けは従業員テーブルの部署番号を基準にして行われ、部署テーブル内の関連情報を
特定します。

♦ タスク

1. 次のディレクトリに移動します。%SQLANYSAMP16%¥UltraLiteJ¥J2SE.

2. CreateDb サンプルを実行します。

rundemo CreateDb

3. LoadDb サンプルを実行します。

rundemo LoadDb

4. 次のコマンドを実行します (コマンドでは大文字と小文字が区別されます)。

rundemo ReadInnerJoin

結果

アプリケーションが正常に実行されます。Employee テーブルが読み込まれ、各ローが
Department テーブルの対応するローとジョインされます。

参照

●「Java SE の例：データベースの作成」31 ページ
●「Java SE の例：ローの挿入」32 ページ

Java SE の例：販売データベースの作成
この Java SE サンプルを実行すると、データベースの作成方法がわかります。

前提条件

この作業を実行するための前提条件はありません。
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♦ タスク

1. 次のディレクトリに移動します。%SQLANYSAMP16%¥UltraLiteJ¥J2SE.

2. 次のコマンドを実行します (コマンドでは大文字と小文字が区別されます)。

rundemo CreateSales

結果

サンプルアプリケーションが正常に実行されます。販売データベースが作成されます。

Java SE の例：集約とグループ化
この Java SE サンプルを実行すると、結果の集約とグループ化の処理方法がわかります。

前提条件

この作業を実行するための前提条件はありません。

♦ タスク

1. 次のディレクトリに移動します。%SQLANYSAMP16%¥UltraLiteJ¥J2SE.

2. CreateSales サンプルを実行します。

rundemo CreateSales

3. 次のコマンドを実行します (コマンドでは大文字と小文字が区別されます)。

rundemo SalesReport

結果

サンプルアプリケーションが正常に実行されます。販売レポートが生成されます。

参照

●「Java SE の例：販売データベースの作成」34 ページ

Java SE の例：別の順序でのローの取り出し
この Java SE サンプルを実行すると、別の順序でのローの処理方法がわかります。

前提条件

この作業を実行するための前提条件はありません。

サンプルコード
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♦ タスク

1. 次のディレクトリに移動します。%SQLANYSAMP16%¥UltraLiteJ¥J2SE.

2. CreateSales サンプルを実行します。

rundemo CreateSales

3. 次のコマンドを実行します (コマンドでは大文字と小文字が区別されます)。

rundemo SortTransactions

結果

サンプルアプリケーションが正常に実行されます。テーブルカラムが選択時に製造番号順にな
ります。

参照

●「Java SE の例：販売データベースの作成」34 ページ

Java SE の例：テーブル定義の変更
この Java SE サンプルを実行すると、Ultra Light J のテーブル定義の変更方法がわかります。

前提条件

この作業を実行するための前提条件はありません。

内容と備考

Invoice テーブルが変更され、カラム長が 50 文字から 100 文字に拡張されます。

♦ タスク

1. 次のディレクトリに移動します。%SQLANYSAMP16%¥UltraLiteJ¥J2SE.

2. CreateSales サンプルを実行します。

rundemo CreateSales

3. 次のコマンドを実行します (コマンドでは大文字と小文字が区別されます)。

rundemo Reorg

結果

サンプルアプリケーションが正常に実行されます。Invoice テーブルの name カラムが変更され
ます。
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参照

●「Java SE の例：販売データベースの作成」34 ページ

Java SE の例：データの暗号化
この Java SE サンプルを実行すると、Ultra Light Java Edition データベースのデータの暗号化方法
およびデータの復号化によるパフォーマンスの低下についてわかります。

前提条件

この作業を実行するための前提条件はありません。

内容と備考

このサンプルは Java SE 用です。BlackBerry 暗号化の完全なサンプルは、%SQLANYSAMP16%
¥UltraLiteJ¥BlackBerryEncryption にあります。

♦ タスク

1. 次のディレクトリに移動します。%SQLANYSAMP16%¥UltraLiteJ¥J2SE.

2. 次のコマンドを実行します (コマンドでは大文字と小文字が区別されます)。

rundemo Encrypted

結果

サンプルアプリケーションが正常に実行されます。Ultra Light Java Edition データベースに暗号
化されたデータが挿入され、そのデータを選択すると復号化されます。

Java SE の例：データベースのスキーマ情報の表示
この Java SE サンプルを実行すると、Ultra Light Java Edition データベースシステムテーブルをト
ラバースしてスキーマ情報を調べる方法がわかります。

前提条件

この作業を実行するための前提条件はありません。

♦ タスク

1. 次のディレクトリに移動します。%SQLANYSAMP16%¥UltraLiteJ¥J2SE.

2. CreateSales サンプルを実行します。

rundemo CreateSales

3. 次のコマンドを実行します (コマンドでは大文字と小文字が区別されます)。

rundemo DumpSchema

サンプルコード
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結果

テーブルの各ローのデータも表示されます。次の出力が表示されます。

Metadata options:

Option[ date_format ] = 'YYYY-MM-DD'
Option[ date_order ] = 'YMD'
Option[ global_database_id ] = '0'
Option[ nearest_century ] = '50'
Option[ precision ] = '30'
Option[ scale ] = '6'
Option[ time_format ] = 'HH:NN:SS.SSS'
Option[ timestamp_format ] = 'YYYY-MM-DD HH:NN:SS.SSS'
Option[ timestamp_increment ] = '1'

Metadata tables:

Table[0] name = "systable"  id = 0 flags = 0xc000,SYSTEM,NO_SYNC
  column[0 ]: name = "table_id" flags = 0x1,IN-PRIMARY-INDEX domain = INTEGER
  column[1 ]: name = "table_name" flags = 0x0 domain = VARCHAR(128)
  column[2 ]: name = "table_flags" flags = 0x0 domain = UNSIGNED-SHORT
  column[3 ]: name = "table_data" flags = 0x0 domain = INTEGER
  column[4 ]: name = "table_autoinc" flags = 0x0 domain = BIG
  index[0 ]: name = "primary" flags = 0xf,UNIQUE-KEY,UNIQUE-INDEX,PERSISTENT,PRIMARY-
INDEX
    key[0 ]: name = "table_id" flags = 0x1,FORWARD

Table[1] name = "syscolumn"  id = 1 flags = 0xc000,SYSTEM,NO_SYNC
  column[0 ]: name = "table_id" flags = 0x1,IN-PRIMARY-INDEX domain = INTEGER
  column[1 ]: name = "column_id" flags = 0x1,IN-PRIMARY-INDEX domain = INTEGER
  column[2 ]: name = "column_name" flags = 0x0 domain = VARCHAR(128)
  column[3 ]: name = "column_flags" flags = 0x0 domain = TINY
  column[4 ]: name = "column_domain" flags = 0x0 domain = TINY
  column[5 ]: name = "column_length" flags = 0x0 domain = INTEGER
  column[6 ]: name = "column_default" flags = 0x0 domain = TINY
  index[0 ]: name = "primary" flags = 0xf,UNIQUE-KEY,UNIQUE-INDEX,PERSISTENT,PRIMARY-
INDEX
    key[0 ]: name = "table_id" flags = 0x1,FORWARD
    key[1 ]: name = "column_id" flags = 0x1,FORWARD

Table[2] name = "sysindex"  id = 2 flags = 0xc000,SYSTEM,NO_SYNC
  column[0 ]: name = "table_id" flags = 0x1,IN-PRIMARY-INDEX domain = INTEGER
  column[1 ]: name = "index_id" flags = 0x1,IN-PRIMARY-INDEX domain = INTEGER
  column[2 ]: name = "index_name" flags = 0x0 domain = VARCHAR(128)
  column[3 ]: name = "index_flags" flags = 0x0 domain = TINY
  column[4 ]: name = "index_data" flags = 0x0 domain = INTEGER
  index[0 ]: name = "primary" flags = 0xf,UNIQUE-KEY,UNIQUE-INDEX,PERSISTENT,PRIMARY-
INDEX
    key[0 ]: name = "table_id" flags = 0x1,FORWARD
    key[1 ]: name = "index_id" flags = 0x1,FORWARD

Table[3] name = "sysindexcolumn"  id = 3 flags = 0xc000,SYSTEM,NO_SYNC
  column[0 ]: name = "table_id" flags = 0x1,IN-PRIMARY-INDEX domain = INTEGER
  column[1 ]: name = "index_id" flags = 0x1,IN-PRIMARY-INDEX domain = INTEGER
  column[2 ]: name = "order" flags = 0x1,IN-PRIMARY-INDEX domain = INTEGER
  column[3 ]: name = "column_id" flags = 0x0 domain = INTEGER
  column[4 ]: name = "index_column_flags" flags = 0x0 domain = TINY
  index[0 ]: name = "primary" flags = 0xf,UNIQUE-KEY,UNIQUE-INDEX,PERSISTENT,PRIMARY-
INDEX
    key[0 ]: name = "table_id" flags = 0x1,FORWARD
    key[1 ]: name = "index_id" flags = 0x1,FORWARD
    key[2 ]: name = "order" flags = 0x1,FORWARD
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Table[4] name = "sysinternal"  id = 4 flags = 0xc000,SYSTEM,NO_SYNC
  column[0 ]: name = "name" flags = 0x1,IN-PRIMARY-INDEX domain = VARCHAR(128)
  column[1 ]: name = "value" flags = 0x0 domain = VARCHAR(128)
  index[0 ]: name = "primary" flags = 0xf,UNIQUE-KEY,UNIQUE-INDEX,PERSISTENT,PRIMARY-
INDEX
    key[0 ]: name = "name" flags = 0x1,FORWARD

Table[5] name = "syspublications"  id = 5 flags = 0xc000,SYSTEM,NO_SYNC
  column[0 ]: name = "publication_id" flags = 0x1,IN-PRIMARY-INDEX domain = INTEGER
  column[1 ]: name = "publication_name" flags = 0x0 domain = VARCHAR(128)
  column[2 ]: name = "download_timestamp" flags = 0x0 domain = TIMESTAMP
  column[3 ]: name = "last_sync_sent" flags = 0x0 domain = INTEGER
  column[4 ]: name = "last_sync_confirmed" flags = 0x0 domain = INTEGER
  index[0 ]: name = "primary" flags = 0xf,UNIQUE-KEY,UNIQUE-INDEX,PERSISTENT,PRIMARY-
INDEX
    key[0 ]: name = "publication_id" flags = 0x1,FORWARD

Table[6] name = "sysarticles"  id = 6 flags = 0xc000,SYSTEM,NO_SYNC
  column[0 ]: name = "publication_id" flags = 0x1,IN-PRIMARY-INDEX domain = INTEGER
  column[1 ]: name = "table_id" flags = 0x1,IN-PRIMARY-INDEX domain = INTEGER
  index[0 ]: name = "primary" flags = 0xf,UNIQUE-KEY,UNIQUE-INDEX,PERSISTENT,PRIMARY-
INDEX
    key[0 ]: name = "publication_id" flags = 0x1,FORWARD
    key[1 ]: name = "table_id" flags = 0x1,FORWARD

Table[7] name = "sysforeignkey"  id = 7 flags = 0xc000,SYSTEM,NO_SYNC
  column[0 ]: name = "table_id" flags = 0x1,IN-PRIMARY-INDEX domain = INTEGER
  column[1 ]: name = "foreign_table_id" flags = 0x0 domain = INTEGER
  column[2 ]: name = "foreign_key_id" flags = 0x1,IN-PRIMARY-INDEX domain = INTEGER
  column[3 ]: name = "name" flags = 0x0 domain = VARCHAR(128)
  column[4 ]: name = "index_name" flags = 0x0 domain = VARCHAR(128)
  index[0 ]: name = "primary" flags = 0xf,UNIQUE-KEY,UNIQUE-INDEX,PERSISTENT,PRIMARY-
INDEX
    key[0 ]: name = "table_id" flags = 0x1,FORWARD
    key[1 ]: name = "foreign_key_id" flags = 0x1,FORWARD

Table[8] name = "sysfkcol"  id = 8 flags = 0xc000,SYSTEM,NO_SYNC
  column[0 ]: name = "table_id" flags = 0x1,IN-PRIMARY-INDEX domain = INTEGER
  column[1 ]: name = "foreign_key_id" flags = 0x1,IN-PRIMARY-INDEX domain = INTEGER
  column[2 ]: name = "item_no" flags = 0x1,IN-PRIMARY-INDEX domain = SHORT
  column[3 ]: name = "column_id" flags = 0x0 domain = INTEGER
  column[4 ]: name = "foreign_column_id" flags = 0x0 domain = INTEGER
  index[0 ]: name = "primary" flags = 0xf,UNIQUE-KEY,UNIQUE-INDEX,PERSISTENT,PRIMARY-
INDEX
    key[0 ]: name = "table_id" flags = 0x1,FORWARD
    key[1 ]: name = "foreign_key_id" flags = 0x1,FORWARD
    key[2 ]: name = "item_no" flags = 0x1,FORWARD

参照

●「Java SE の例：販売データベースの作成」34 ページ

Java SE の例：データベースの同期
Mobile Link サーバに接続する Java SE サンプルを実行します。このサンプルによって、クライア
ントデータベースを統合 SQL Anywhere データベースと同期する方法がわかります。

サンプルコード
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前提条件

この作業を実行するための前提条件はありません。

♦ タスク

1. 次のディレクトリに移動します。%SQLANYSAMP16%¥UltraLiteJ¥J2SE.

2. CreateSales サンプルを実行します。

rundemo CreateSales

3. 次のコマンドを実行して、Mobile Link サーバを起動します。

start_ml

4. 次のコマンドを実行します (コマンドでは大文字と小文字が区別されます)。

rundemo Sync

結果

サンプルアプリケーションが正常に実行されます。クライアントデータベースが統合データ
ベースと同期されます。

次の手順

Mobile Link サーバをシャットダウンします。

参照

●「Java SE の例：販売データベースの作成」34 ページ
●「Mobile Link サーバのシャットダウン」『Mobile Link サーバ管理』
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チュートリアル：Android アプリケーションの構
築

このチュートリアルでは、Ultra Light J API および Eclipse 環境を使用して、Android スマートフォ
ン用のアプリケーションを開発する方法について説明します。このチュートリアルでは、
Windows Simulator 上でアプリケーションを実行します。

このチュートリアルで使用するアプリケーションは、%SQLANYSAMP16%¥UltraLiteJ¥Android
¥CustDB¥ ディレクトリにあります。src¥com¥sybase¥custdb ディレクトリにあるアプリケーショ
ンコードで、Ultra Light J API で行う次の操作を参照できます。

●Ultra Lite のリモートデータベースの作成。

●データベースでの SQL の操作。

●Mobile Link を使用した SQL Anywhere CustDB サンプルデータベースとのデータの同期。

res¥menu および res¥layout ディレクトリは、Android のメニュー項目とインタフェースの作成方
法を示します。新しい Android プロジェクトを作成するときに、Eclipse を介して、これらのファ
イルを表示できます。

Android アプリケーションからネットワークにアクセスできるように AndroidManifest.xml プロ
ジェクトファイルが変更されました。これはデータ同期に必要です。次のパーミッション文が
追加されました。

<uses-permission android:name="android.permission.INTERNET" />

必要なソフトウェア

● Eclipse 3.5.2 以降
● Android SDK Starter Package
● Android Development Tools (ADT) Plug-in for Eclipse 1.1 以降
● SQL Anywhere 16 サンプル
● Ultra Light J API

前提知識と経験

● Java の知識
● Eclipse の知識

参照

● http://developer.android.com/sdk/installing.html#Installing
● http://developer.android.com/sdk/eclipse-adt.html#installing
● http://developer.android.com/sdk/adding-components.html
●「Ultra Light J API リファレンス」79 ページ
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レッスン 1：新しい Android プロジェクトの設定
このレッスンでは、Eclipse 統合開発環境を介して、新しい Android プロジェクトを作成します。

前提条件

このレッスンでは、必要なソフトウェアをすでにインストールしていることを前提としていま
す。「チュートリアル：Android アプリケーションの構築」41 ページを参照してください。

内容と備考

このチュートリアルは、開発者が Java と Eclipse に精通していることを前提としています。

♦ タスク

1. Android ライブラリを、Android CustDB サンプルディレクトリにコピーします。

コマンドプロンプトを開いて、%SQLANYSAMP16%¥UltraLiteJ¥Android¥CustDB¥ ディレクト
リに移動し、次のコマンドを実行します。

setup.bat

UltraLiteJNI16.jar および libultralitej16.so ファイルは、Android¥CustDB¥libs ディレクトリおよ
び Android¥CustDB¥libs¥armeabi ディレクトリにコピーされます。

2. Eclipse を実行します。

デフォルトのアプリケーションパスは C:¥Eclipse¥eclipse.exe です。

3. [Workspace] フィールドで、CustDB サンプルディレクトリ以外の作業ディレクトリを指定し
て、[OK] をクリックします。

4. Eclipse への CustDB プロジェクトのインポート

a. [File] » [Import] をクリックします。

b. [General] ディレクトリを展開し、[Existing Projects into Workspace] を選択します。
[Next] をクリックします。

c. [Select Root Directory] フィールドに、%SQLANYSAMP16%¥UltraLiteJ¥Android
¥CustDB と入力します。[Copy Projects Into Workspace] を選択して、[Finish] をクリック
します。

5. Eclipse で適切な Android SDK パスが指定されていることを確認します。

注意

パスを指定する前に Android SDK をインストールする必要があります。 チュートリアルの
前提条件の詳細については、「チュートリアル：Android アプリケーションの構築」41 ページ
を参照してください。

a. [Window] » [Preferences] をクリックします。

チュートリアル：Android アプリケーションの構築
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b. 左ウィンドウ枠で、[Android] をクリックします。

c. [SDK Location] フィールドで、Android SDK のロケーションを入力し、[Apply] をクリッ
クします。

利用可能なビルドターゲットのリストが表示されます。

d. [OK] をクリックします。

6. Eclipse で Ultra Light J ライブラリパスが指定されていることを確認します。

a. [File] » [Properties] をクリックします。

b. 左ウィンドウ枠で、[Java Build Path] » [User libraries] をクリックします。

c. [Libraries] タブをクリックします。

d. [UltraLiteJNI16.jar] をクリックし、[Edit] をクリックします。

e. 作業ディレクトリから、¥CustDB¥libs¥UltraLiteJNI16.jar ファイルを開きます。

f. [OK] をクリックします。

7. プロジェクトに UltraLite JNI Javadoc マニュアルへのパスを追加します。

a. 左ウィンドウ枠で、[Javadoc Location] をクリックします。

b. [Browse] をクリックして、%SQLANY16%¥UltraLite¥UltraLiteJ¥Android¥html を開きます。

c. [OK] をクリックします。

d. [OK] をクリックして、ウィンドウを閉じます。

8. プロジェクトの構築

[Project] » [Clean] をクリックし、[OK] をクリックします。

プロジェクトはエラーを発生させずに構築する必要がありますが、[問題] タブの下に警告が
表示されることがあります。

結果

Ultra Light J API が新しい Android アプリケーションで機能します。

次の手順

「レッスン 2：Mobile Link サーバの起動」43 ページに進みます。

レッスン 2：Mobile Link サーバの起動
このレッスンでは、Mobile Link サーバを起動して、同期を実行します。

前提条件

このレッスンは、受講者がこれまでのすべてのレッスンを終了していることを前提としていま
す。 「レッスン 1：新しい Android プロジェクトの設定」42 ページを参照してください。

レッスン 2：Mobile Link サーバの起動
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♦ タスク

● Mobile Link を起動するには、%SQLANYSAMP16%¥MobiLink¥CustDB¥ から次のコマンドを発
行します。

mlsrv16 -v+ -zu+ -c "DSN=SQL Anywhere 16 CustDB;UID=ml_server;PWD=sql" -x http(port=80) -ot 
ml.mls

-c オプションは、Mobile Link を SQL Anywhere CustDB データベースに接続します。-v+ オプ
ションは、高い冗長レベルを設定して、処理中の内容を Mobile Link のサーバメッセージウィ
ンドウで確認できるようにします。-x オプションは、通信に使用されているポート番号を指
定します。-ot オプションは、ログファイル (ml.mls) が、Mobile Link サーバを起動したディレ
クトリに作成されるように指定します。

結果

Mobile Link サーバが起動します。

次の手順

「レッスン 3：Android アプリケーションの実行」44 ページに進みます。

参照

●「Mobile Link サーバオプション」『Mobile Link サーバ管理』

レッスン 3：Android アプリケーションの実行
このレッスンでは、Android Simulator 上でアプリケーションを実行します。

前提条件

このレッスンは、受講者がこれまでのすべてのレッスンを終了していることを前提としていま
す。 「レッスン 1：新しい Android プロジェクトの設定」42 ページを参照してください。

♦ タスク

1. Eclipse で Android の仮想デバイスを設定します。

a. [Window] » [AVD Manager] をクリックします。

b. [New] をクリックします。

[Create New Android Virtual Device (AVD)] ウィンドウが表示されます。

c. [Name] フィールドに my_avd と入力します。

d. [Target] フィールドで、[Android 2.2 - API Level 8] をクリックします。

e. [Create AVD] をクリックします。

f. [AVD Manager] ウィンドウを閉じます。

2. [Package Explorer] ウィンドウで、CustDB を選択します。

チュートリアル：Android アプリケーションの構築
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3. [Run] メニューで、[Run As] » [Android Application] を選択します。

Android Simulator がロードされます。

4. [Menu] をクリックします。

Android アプリケーションがロードされます。

結果

シミュレートされた Android スマートフォンに Ultra Light アプリケーションがロードされます。

次の手順

「レッスン 4：Android アプリケーションのテストと同期」45 ページに進みます。

レッスン 4：Android アプリケーションのテストと同期
このレッスンでは、Android アプリケーションを使用して、Ultra Light のリモートデータベース
を更新し、CustDB 統合データベースと同期します。

前提条件

このレッスンは、受講者がこれまでのすべてのレッスンを終了していることを前提としていま
す。 「レッスン 1：新しい Android プロジェクトの設定」42 ページを参照してください。

♦ タスク

1. [Employee ID] フィールドが 50、[Host] フィールドが 10.0.2.2、[Port] フィールドが 80 になっ
ていることを確認し、[Save] をクリックします。

アプリケーションは自動的に同期を実行し、一連の顧客、製品、注文情報が CustDB 統合デー
タベースからアプリケーションにダウンロードされます。

2. Simulator で [メニュー] » [新規] をクリックします。

3. [Customer] フィールドで [Ace Properties] を選択します。

4. [Product] フィールドで [4x8 Drywall x100] を選択します。

5. [Quantity] フィールドに [999] と入力します。

6. [Discount] フィールドに [25] と入力します。

7. [OK] をクリックし、新規注文を追加します。

8. CustDB 統合データベースとアプリケーションを同期します。

Simulator で [Menu] をクリックし、[Sync] を選択します。

レッスン 4：Android アプリケーションのテストと同期
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9. Interactive SQL を CustDB 統合データベースに接続します。

a. [スタート] » [プログラム] » [SQL Anywhere 16] » [管理ツール] » [Interactive SQL] をク
リックするか、次のコマンドを実行します。

dbisql

b. [ODBC データソース名] をクリックし、SQL Anywhere 16 CustDB を選択します。

c. [接続] をクリックします。

10. 同期が成功したことを確認します。

Interactive SQL で次の SQL 文を実行します。

SELECT order_id, disc, quant, notes, status, c.cust_id, 
    cust_name, p.prod_id, prod_name, price 
  FROM ULOrder o, ULCustomer c, ULProduct p 
  WHERE o.cust_id = c.cust_id 
  AND o.prod_id = p.prod_id 
  AND c.cust_name = 'Ace Properties'
  AND p.prod_name = '4x8 Drywall x100'

Interactive SQL に注文にエントリが表示されたら、同期が成功しています。

11. [Simulator] ウィンドウを閉じます。

結果

シミュレータに加えた変更は CustDB 統合データベースと同期されます。

次の手順

「クリーンアップ」46 ページに進みます。

クリーンアップ
最近作成したチュートリアルをコンピュータから削除します。

前提条件

このレッスンは、受講者がこれまでのすべてのレッスンを終了していることを前提としていま
す。 「レッスン 1：新しい Android プロジェクトの設定」42 ページを参照してください。

♦ タスク

1. Eclipse を終了します。

[File] » [Exit] をクリックします。

2. タスクバー上で、Mobile Link、Interactive SQL、同期クライアントの各ウィンドウを右クリッ
クし、[終了] または [シャットダウン] をクリックします。
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3. CustDB データベースをリセットします。

%SQLANYSAMP16%¥UltraLite¥CustDB ディレクトリから次のコマンドを実行します。

makedbs

結果

チュートリアルがコンピュータから削除され、このチュートリアルを最初のレッスンから再び繰
り返すことができます。

クリーンアップ
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チュートリアル：BlackBerry アプリケーション
の構築

このチュートリアルでは、Ultra Light J API および Eclipse 環境を使用して、BlackBerry スマート
フォン用のアプリケーションを開発する方法について説明します。このチュートリアルでは、ア
プリケーションを Windows シミュレータで実行してから BlackBerry スマートフォンに配備しま
す。チュートリアル全体に渡ってコード例を示しています。また、チュートリアルの最後にすべ
てのコードを示します。

必要なソフトウェア

● Eclipse 3.5 以降
● BlackBerry Java Plug-in for Eclipse 1.1 以降
● BlackBerry Email および MDS Services Simulator Package v4.1.4
● BlackBerry JDE 6.0 以降
● Ultra Light J API

前提知識と経験

● Java の知識
● Eclipse の知識

参照

● http://us.blackberry.com/developers/javaappdev/
● http://us.blackberry.com/developers/javaappdev/javadevenv.jsp

第 1 部：新しい BlackBerry アプリケーションの作成
第 1 部では、Ultra Light Java Edition データベースで名前のリストを管理する BlackBerry アプリ
ケーションを作成する方法について説明します。第 2 部では、アプリケーションを Mobile Link
サーバと同期する方法について説明します。

レッスン 1：新しい BlackBerry プロジェクトの設定
このレッスンでは、Eclipse 統合開発環境を介して、新しい BlackBerry プロジェクトを作成しま
す。

前提条件

このレッスンでは、必要なソフトウェアをすでにインストールしていることを前提としていま
す。「チュートリアル：BlackBerry アプリケーションの構築」49 ページを参照してください。

内容と備考

このチュートリアルは、開発者が Java と Eclipse に精通していることを前提としています。
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♦ タスク

1. Eclipse を実行します。

デフォルトのアプリケーションパスは C:¥Eclipse¥eclipse.exe です。

2. Workspace フィールドで、作業ディレクトリを指定して、[OK] をクリックします。

このチュートリアルでは、作業を C:¥HelloBlackBerry ディレクトリで行っていることを前提
としています。

3. 新規プロジェクトを作成します。

[File] » [New] » [Project] をクリックします。

4. [BlackBerry] フォルダを展開してから、[BlackBerry Project] を選択します。

5. [Next] をクリックします。

6. [Project Name] フィールドに、HelloBlackBerry と入力します。

7. [Finish] をクリックします。

8. プロジェクトに Ultra Light J JAR ファイルを追加します。

a. Eclipse で [Package Explorer] ウィンドウが表示されていな場合は表示します。

[Window] » [Show View] » [Package Explorer] をクリックします。

b. プロジェクトのパッケージプロパティにアクセスします。

[Package Explorer] ウィンドウの HelloBlackBerry をクリックし、[File] » [Properties] を
クリックします。

c. 左側のウィンドウ枠で [Java Build Path] をクリックし、[Libraries] タブをクリックしま
す。

d. [Add External Jars] をクリックして、SQL Anywhere インストールディレクトリから
¥UltraLite¥UltraLiteJ¥BlackBerry4.2¥UltraLiteJ16.jar を開きます。

9. プロジェクトに Ultra Light J Javadoc マニュアルへのパスを追加します。

a. [JARs And Class Folders On The Build Path] リストで、UltraLiteJ16.jar を展開し、
[JavaDoc Location] をクリックします。

b. [編集] をクリックします。

[Javadoc For UltraLiteJ16.Jar] ウィンドウが表示されます。

c. [Browse] をクリックして、SQL Anywhere インストールディレクトリから ¥UltraLite
¥UltraLiteJ¥BlackBerry4.2¥html を開きます。

d. [OK] をクリックして、[Javadoc For UltraLiteJ16.Jar] ウィンドウを閉じます。

10. [OK] をクリックして、ウィンドウを閉じます。

チュートリアル：BlackBerry アプリケーションの構築
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結果

Ultra Light J API が新しい BlackBerry アプリケーションで機能します。

次の手順

「レッスン 2：BlackBerry アプリケーションの作成とテスト」51 ページに進みます。

レッスン 2：BlackBerry アプリケーションの作成とテスト
このレッスンでは、HomeScreen クラスを開く Eclipse の main メソッドを持つクラスを作成しま
す。このクラスにはタイトルとステータスメッセージが含まれています。その後、アプリケー
ションをコンパイルしてテストします。

前提条件

このレッスンは、受講者がこれまでのすべてのレッスンを終了していることを前提としていま
す。 「レッスン 1：新しい BlackBerry プロジェクトの設定」49 ページを参照してください。

♦ タスク

1. プロジェクトに Application クラスを追加します。

a. [Package Explorer] ウィンドウで、HelloBlackBerry を展開して [src] をクリックします。

b. [File] » [New] » [Class] をクリックします。

[New Java Class] ウィンドウが表示されます。

c. [Name] フィールドに Application と入力します。

d. [Which method stubs would you like to create?] オプションで、[Public Static Void
Main([String() Args])] を選択します。

e. [Finish] をクリックします。

Application.java ファイルが [Package Explorer] ウィンドウで作成中のプロジェクトの下
に表示されます。

2. Application クラスを変更します。

[Package Explorer] ウィンドウの Application.java をダブルクリックしてから、コンストラク
タと main メソッドを追加します。

Application.java コードは、次のコードのようになります。

class Application extends net.rim.device.api.ui.UiApplication {
    public static void main( String[] args )
    {
        Application instance = new Application();
        instance.enterEventDispatcher();
    }
    Application() {
        pushScreen( new HomeScreen() );
    }
}

第 1 部：新しい BlackBerry アプリケーションの作成
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3. プロジェクトに HomeScreen クラスを追加します。

a. [Package Explorer] ウィンドウで、HelloBlackBerry を展開して [src] をクリックします。

b. [File] » [New] » [Class] をクリックします。

[New Java Class] ウィンドウが表示されます。

c. [Name] フィールドに HomeScreen と入力します。

d. [Finish] をクリックします。

HomeScreen.java ファイルが [Package Explorer] ウィンドウで作成中のプロジェクトの下
に表示されます。

4. タイトルとステータスメッセージが表示されるように、HomeScreen クラスを変更します。

[Package Explorer] ウィンドウで HomeScreen.java をダブルクリックしてから、タイトルとス
テータスメッセージが表示されるようにコードを更新します。

HomeScreen.java コードは、次のコードのようになります。

import net.rim.device.api.ui.*;
import net.rim.device.api.ui.component.*;
import net.rim.device.api.ui.container.*;
import java.util.*;

class HomeScreen extends MainScreen {

    HomeScreen() {
        
        // Set the window title
        LabelField applicationTitle = new LabelField("Hello BlackBerry");
        setTitle(applicationTitle);
        
        // Add a label to show application status
        _statusLabel = new LabelField( "Status: Started" );
        add( _statusLabel );
    }
    private LabelField _statusLabel;
}

_statusLabel は、アプリケーションの他の部分からアクセスできるように、クラス変数とし
て定義します。

5. シミュレータを実行します。

[Package Explorer] ウィンドウで Application.java をクリックしてから、[Run] » [Run As] »
[BlackBerry Simulator] をクリックします。

注意

ワークスペースで複数のプロジェクトを開いている場合は、[Run] » [Run Configurations] を
クリックし、HelloBlackBerry を選択してから [Run] をクリックします。

HelloBlackBerry プロジェクトがコンパイルされ、シミュレータウィンドウが表示されます。

Eclipse の [Problems] タブを選択して、プロジェクトがエラーなくコンパイルされたことを確
認します。

チュートリアル：BlackBerry アプリケーションの構築

52 Copyright © 2013, SAP AG or an SAP affiliate company. - SAP Sybase SQL Anywhere 16.0



6. シミュレータメニューで、[Simulate] » [Set IT Policy] をクリックします。

[Set IT Policy] ウィンドウが表示されます。

7. [Policy] フィールドで、[Allow Third Party Apps To Use Persistent Store] » [>>] をクリックし
ます。

8. [Set] をクリックしてから、[Close] をクリックします。

9. アプリケーションを起動します。

シミュレータウィンドウで、[Downloads] に移動してから HelloBlackBerry アプリケーション
を実行します。

Hello BlackBerry タイトルバーと Status: Started テキストを示す画面が表示されます。

10. シミュレーションを停止します。

シミュレータウィンドウで、[File] » [Exit] をクリックします。

結果

BlackBerry アプリケーションはシミュレータで正常に稼動します。

次の手順

「レッスン 3：Ultra Light Java Edition のデータベースの作成」53 ページに進みます。

レッスン 3：Ultra Light Java Edition のデータベースの作成
このレッスンでは、Ultra Light Java Edition データベースを作成し、そのデータベースに接続する
コードを記述します。

前提条件

このレッスンは、受講者がこれまでのすべてのレッスンを終了していることを前提としていま
す。 「レッスン 1：新しい BlackBerry プロジェクトの設定」49 ページを参照してください。

内容と備考

新しいデータベースを作成するコードは、DataAccess というシングルトンクラスで定義され、
HomeScreen コンストラクタから呼び出されます。シングルトンクラスを使用すると、データ
ベースへの接続が、一度に 1 つしか開かれないよう制御できます。Ultra Light API は複数の接続
をサポートしていますが、一般的な設計パターンでは 1 つの接続を使用します。

♦ タスク

1. HomeScreen クラスを変更して DataAccess オブジェクトをインスタンス化します。

次に示すのは、完全で更新された HomeScreen クラスコードリストです。

第 1 部：新しい BlackBerry アプリケーションの作成
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import net.rim.device.api.ui.*;
import net.rim.device.api.ui.component.*;
import net.rim.device.api.ui.container.*;
import java.util.*;

class HomeScreen extends MainScreen {

    HomeScreen() {
        
        // Set the window title
        LabelField applicationTitle = new LabelField("Hello BlackBerry");
        setTitle(applicationTitle);
        
        // Add a label to show application status
        _statusLabel = new LabelField("Status: Started");
        add(_statusLabel);
        
        // Create database and connect
        try {
            _da = DataAccess.getDataAccess(true);
            _statusLabel.setText("Status: Connected");
        }
        catch(Exception ex)
        {
            _statusLabel.setText("Exception: " + ex.toString());
        }        
    }
    private LabelField _statusLabel;
    private DataAccess _da;
}

Eclipse が DataAccess が解決できないという警告を表示する可能性があります。DataAccess
オブジェクトは、コードの他の部分からアクセスできるように、クラスレベル変数として格
納されます。DataAccess クラスは、次の手順で作成します。

2. プロジェクトに DataAccess クラスを追加します。

a. [Package Explorer] ウィンドウで、HelloBlackBerry を展開して [src] をクリックします。

b. [File] » [New] » [Class] をクリックします。

[New Java Class] ウィンドウが表示されます。

c. [Name] フィールドに DataAccess と入力します。

d. [Finish] をクリックします。

DataAccess.java ファイルが [Package Explorer] ウィンドウで作成中のプロジェクトの下
に表示されます。

3. DataAccess クラスを変更して、単一のデータベース接続を確実にする getDataAccess メソッ
ドを含むようにします。

[Package Explorer] ウィンドウの DataAccess.java をダブルクリックしてから、次の抜粋部分
とコードを置き換えます。

import com.ianywhere.ultralitej16.*;
import net.rim.device.api.ui.component.*;
import java.util.*;

class DataAccess {
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    DataAccess() {
    }
    
    public static synchronized DataAccess getDataAccess(boolean reset) 
        throws Exception
    {   
        if (_da == null) {
            _da = new DataAccess();
            ConfigObjectStore config = DatabaseManager.createConfigurationObjectStore("HelloDB");
            if (reset) {
                _conn = DatabaseManager.createDatabase(config);
                // _da.createDatabaseSchema();
            } 
            else {
                try {
                    _conn = DatabaseManager.connect(config);
                }
                catch (ULjException uex1) {
                    if (uex1.getErrorCode() != 
ULjException.SQLE_ULTRALITE_DATABASE_NOT_FOUND) {
                        Dialog.alert("Exception: " + uex1.toString() + ". Recreating database...");
                    }
                    _conn = DatabaseManager.createDatabase(config);
                    // _da.createDatabaseSchema();
                }
            }
        }
        return _da;        
    }
    private static Connection _conn;
    private static DataAccess _da;
}

このクラスは、UltraLiteJ16.jar ファイルから com.ianywhere.ultralitej16 パッケージをイン
ポートします。次の手順は、Ultra Light Java Edition データベースを作成したり、そのデータ
ベースに接続するために必要です。

a. 設定を定義します。このチュートリアルでは、設定オブジェクトは ConfigObjectStore イ
ンタフェースによって定義されます。このインタフェースによって、BlackBerry オブ
ジェクトストア上に存在する永続的なデータベースを設定できます。

b. データベースへの接続を試行します。このチュートリアルでは、データベースは、接続
が失敗したときに createDatabase メソッドを使って作成されます。このメソッドが、開
いた接続を返します。

4. [File] » [Save] をクリックします。

5. シミュレータを実行します。

[Package Explorer] ウィンドウで Application.java をクリックしてから、[Run] » [Run As] »
[BlackBerry Simulator] をクリックします。

注意

ワークスペースで複数のプロジェクトを開いている場合は、[Run] » [Run Configurations] を
クリックし、HelloBlackBerry を選択してから [Run] をクリックします。

HelloBlackBerry プロジェクトがコンパイルされ、シミュレータウィンドウが表示されます。
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Eclipse の [Problems] タブを選択して、プロジェクトがエラーなくコンパイルされたことを確
認します。

6. シミュレータメニューで、[File] » [Load Java Program] をクリックします。

7. SQL Anywhere インストール環境の ¥UltraLite¥UltraLiteJ¥BlackBerry4.2¥ ディレクトリに移動
して、UltraLiteJ16.cod ファイルを開きます。

注意

場合によっては、アプリケーションを実行するために、UltraLiteJ16.cod と DBG ファイルを
作業用のシミュレータディレクトリ (C:¥Eclipse¥plugins
¥net.rim.ejde.componentpack6.0.0_6.0.0.0.26¥components¥simulator¥ など) にコピーする必要が
あります。コピーが完了したら、シミュレータメニューから Java プログラムをロードする必
要はありません。

8. シミュレータメニューで、[Simulate] » [Set IT Policy] をクリックします。

[Set IT Policy] ウィンドウが表示されます。

9. [Policy] フィールドで、[Allow Third Party Apps to Use Persistent Store] をクリックし、[>>]
をクリックします。

10. [Set] をクリックしてから、[Close] をクリックします。

11. アプリケーションを起動します。

シミュレータウィンドウで、[Downloads] に移動してから HelloBlackBerry アプリケーション
を実行します。

Hello BlackBerry タイトルバーと Status: Connected テキストを示す画面が表示されます。画
面には、アプリケーションが Ultra Light Java Edition データベースに正常に接続されたことが
表示されます。

12. シミュレーションを停止します。

シミュレータウィンドウで、[File] » [Exit] をクリックします。

結果

アプリケーションはシミュレータで実行され、このコードによって Ultra Light Java Edition デー
タベースが作成されます。

次の手順

「レッスン 4：データベースでのテーブルの作成」57 ページに進みます。

参照

● ConfigObjectStore インタフェース [BlackBerry] [Ultra Light J]89 ページ
● DatabaseManager.createDatabase メソッド [Ultra Light J]140 ページ
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レッスン 4：データベースでのテーブルの作成
このレッスンでは、アプリケーションコードを更新して、Ultra Light Java Edition データベース
に Names という名前のテーブルを作成します。

前提条件

このレッスンは、受講者がこれまでのすべてのレッスンを終了していることを前提としていま
す。 「レッスン 1：新しい BlackBerry プロジェクトの設定」49 ページを参照してください。

♦ タスク

1. Names テーブルを作成する DataAccess クラスに新しいメソッドを追加します。

[Package Explorer] ウィンドウの DataAccess.java をダブルクリックしてから、getDataAccess
メソッドの後ろに次のコードを挿入します。

    private void createDatabaseSchema() {
        try {
            String sql = "CREATE TABLE Names (ID UNIQUEIDENTIFIER DEFAULT NEWID(), Name 
VARCHAR(254), " +
                "PRIMARY KEY (ID))";
            PreparedStatement ps = _conn.prepareStatement(sql);
            ps.execute();
            ps.close();
        }
        catch (ULjException uex1) {
            Dialog.alert("ULjException: " + uex1.toString());
        }
        catch (Exception ex1) {
            Dialog.alert("Exception: " + ex1.toString());
        }
    }

このメソッドは、データベースに Names テーブルがすでに存在する場合は、例外をスローし
ます。

このテーブルには、次のプロパティを持つ 2 つのカラムがあります。

カラム名 データ型 NULL 入力可 デフォルト プライマリキー

ID UUID いいえ なし あり

Name varchar(254) いいえ なし なし

2. getDataAccess メソッドから createDatabaseSchema メソッドを呼び出します。

createDatabaseSchema 呼び出しが次のコード抜粋に似たかたちになるように、getDataAccess
メソッドからコードコメントを削除します。

_da.createDatabaseSchema()

3. 作成した DataAccess コードと DataAccess クラスの完全なコードリストと比較して、同一で
あることを確認します。
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4. [File] » [Save] をクリックします。

5. シミュレータを実行して、アプリケーションがコンパイルされ、実行されることを確認しま
す。

[Package Explorer] ウィンドウで Application.java をクリックしてから、[Run] » [Run As] »
[BlackBerry Simulator] をクリックします。

注意

ワークスペースで複数のプロジェクトを開いている場合は、[Run] » [Run Configurations] を
クリックし、HelloBlackBerry を選択してから [Run] をクリックします。

HelloBlackBerry プロジェクトがコンパイルされ、シミュレータウィンドウが表示されます。

Eclipse の [Problems] タブを選択して、プロジェクトがエラーなくコンパイルされたことを確
認します。

6. シミュレータメニューで、[File] » [Load Java Program] をクリックします。

7. SQL Anywhere インストール環境の ¥UltraLite¥UltraLiteJ¥BlackBerry4.2¥ ディレクトリに移動
して、UltraLiteJ16.cod ファイルを開きます。

注意

場合によっては、アプリケーションを実行するために、UltraLiteJ16.cod と DBG ファイルを
作業用のシミュレータディレクトリ (C:¥Eclipse¥plugins
¥net.rim.ejde.componentpack6.0.0_6.0.0.0.26¥components¥simulator¥ など) にコピーする必要が
あります。コピーが完了したら、シミュレータメニューから Java プログラムをロードする必
要はありません。

8. シミュレータメニューで、[Simulate] » [Set IT Policy] をクリックします。

[Set IT Policy] ウィンドウが表示されます。

9. [Policy] » [Allow Third Party Apps to Use Persistent Store] をクリックし、[>>] をクリックしま
す。

10. [Set] をクリックしてから、[Close] をクリックします。

11. アプリケーションを起動します。

シミュレータウィンドウで、[Downloads] に移動してから HelloBlackBerry アプリケーション
を実行します。

Hello BlackBerry タイトルバーと Status: Connected テキストを示す画面が表示されます。画
面には、アプリケーションが Ultra Light Java Edition データベースに正常に接続されたことが
示されます。

12. シミュレーションを停止します。

シミュレータウィンドウで、[File] » [Exit] をクリックします。
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結果

アプリケーションで新しいコードが実行され、Ultra Light Java Edition データベースに Names
テーブルが作成されます。

次の手順

「レッスン 5：テーブルへのデータの追加」59 ページに進みます。

参照

●「DataAccess.java」74 ページ

レッスン 5：テーブルへのデータの追加
このレッスンでは、アプリケーションにいくつかのコントロールを追加し、Names テーブルに
データを挿入するコードを実装します。シミュレータでアプリケーションを実行してから、コン
トロールを使用してデータを入力することで、Ultra Light Java Edition データベースにデータを入
力します。

前提条件

このレッスンは、受講者がこれまでのすべてのレッスンを終了していることを前提としていま
す。 「レッスン 1：新しい BlackBerry プロジェクトの設定」49 ページを参照してください。

♦ タスク

1. HomeScreen クラスを更新して制御を追加します。

[Package Explorer] ウィンドウの HomeScreen.java をダブルクリックしてから、getDataAccess
メソッドを呼び出す try-catch 文の前に次のコードを挿入します。

        // Add an edit field for entering new names
        _nameEditField = new EditField( "Name: ", "", 50, EditField.USE_ALL_WIDTH );
        add (_nameEditField );

        // Add an ObjectListField for displaying a list of names
        _nameListField = new ObjectListField();
        add( _nameListField );

        // Add a menu item
        addMenuItem(_addToListMenuItem);

2. _nameEditField と _nameListField のクラスレベルの宣言を追加してから、run メソッドで
MenuItem を定義します (現在は空です)。これらの宣言は、_statusLabel と _da の宣言の次に
あります。

次のコードを private DataAccess _da; 文の下に挿入します。

    private EditField _nameEditField;
    private ObjectListField _nameListField;

    private MenuItem _addToListMenuItem = new MenuItem("Add", 1, 1){
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        public void run() {
            // TODO
        }
    };

3. テーブルにローを挿入する DataAccess クラスに新しいメソッドを追加します。

[Package Explorer] ウィンドウの DataAccess.java をダブルクリックしてから、
createDatabaseSchema メソッドの後ろに次のコードを挿入します。

    public void insertName(String name){
        try {
            UUIDValue nameID = _conn.createUUIDValue();
            String sql = "INSERT INTO Names(ID, Name) VALUES(?, ?)";           
            PreparedStatement ps = _conn.prepareStatement(sql);
            ps.set(1, nameID);
            ps.set(2, name);
            ps.execute();
            _conn.commit();
            ps.close();
        }
        catch(ULjException uex) {
            Dialog.alert("ULjException: " + uex.toString());
        }
        catch( Exception ex ){
            Dialog.alert("Exception: " + ex.toString());
        }  
    }

4. プロジェクトに NameRow クラスを追加します。

a. [Package Explorer] ウィンドウで、HelloBlackBerry を展開して [src] をクリックします。

b. [File] » [New] » [Class] をクリックします。

[New Java Class] ウィンドウが表示されます。

c. [Name] フィールドに NameRow と入力します。

d. [Finish] をクリックします。

NameRow.java ファイルが [Package Explorer] ウィンドウで作成中のプロジェクトの下に
表示されます。

5. Names テーブルにオブジェクトとしてローを格納できるように、NameRow クラスを更新し
ます。

[Package Explorer] ウィンドウの NameRow.java をダブルクリックしてから、次の抜粋部分と
コードを置き換えます。

class NameRow {
    
    public NameRow( String nameID, String name ) {  
        _nameID = nameID;
        _name = name;
    }
    
    public String getNameID(){
        return _nameID;
    }
    

チュートリアル：BlackBerry アプリケーションの構築

60 Copyright © 2013, SAP AG or an SAP affiliate company. - SAP Sybase SQL Anywhere 16.0



    public String getName(){
        return _name;
    }
       
    public String toString(){
        return _name;
    }
    
    private String _nameID;
    private String _name;
    
}

toString メソッドは、ObjectListField コントロールによって使用されます。

6. オブジェクトのベクトルにローを読み込む DataAccess クラスに新しいメソッドを追加しま
す。

[Package Explorer] ウィンドウの DataAccess.java をダブルクリックしてから、insertName メ
ソッドの後ろに次のコードを挿入します。

    public Vector getNameVector(){
        Vector nameVector = new Vector();
        try {
            String sql = "SELECT ID, Name FROM Names";
            PreparedStatement ps = _conn.prepareStatement(sql);
            ResultSet rs = ps.executeQuery();
            while (rs.next()) {
                String nameID = rs.getString(1);
                String name = rs.getString(2);
                NameRow nr = new NameRow(nameID, name);
                nameVector.addElement(nr);
            }
        }
        catch(ULjException uex) {
            Dialog.alert("ULjException: " + uex.toString());
        }
        catch(Exception ex) {
            Dialog.alert("Exception: " + ex.toString());
        }
        return nameVector;
    }

7. 画面に表示されているリストの内容を再表示する新しいメソッドを HomeScreen クラスに追
加します。

[Package Explorer] ウィンドウの HomeScreen.java をダブルクリックしてから、
_addToListMenuItem メソッドの後ろに次のコードを挿入します。

    public void refreshNameList() {
        //Clear the list
        _nameListField.setSize(0);

        //Refill from the list of names
        Vector nameVector = _da.getNameVector();
        for( Enumeration e = nameVector.elements(); e.hasMoreElements(); ){
            NameRow nr = ( NameRow )e.nextElement();
            _nameListField.insert(0, nr);
        }
    }
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8. refreshNameList メソッドを呼び出せるように HomeScreen クラスを更新して、アプリケー
ションが開始したときにリストに値が入っているようにします。

HomeScreen コンストラクタの最後の前に次のコードを挿入します。

        // Fill the ObjectListField
        refreshNameList();

9. 画面のリストにローを追加する新しいメソッドを HomeScreen クラスに追加します。

次のコードを refreshNameList メソッドの後ろに挿入します。

    private void onAddToList(){
        String name = _nameEditField.getText();
        _da.insertName(name);
        this.refreshNameList();
        _nameEditField.setText("");
        _statusLabel.setText(name + " added to list");
    }

10. onAddToList メソッドを呼び出すように、HomeScreen クラスの run メソッドを更新します。

¥¥ TODO を示すコードの行を次のコード抜粋と置き換えます。

            onAddToList();

11. [ファイル] » [すべて保存] をクリックします。

12. シミュレータを実行して、アプリケーションがコンパイルされ、実行されることを確認しま
す。

[Package Explorer] ウィンドウで Application.java をクリックしてから、[Run] » [Run As] »
[BlackBerry Simulator] をクリックします。

注意

ワークスペースで複数のプロジェクトを開いている場合は、[Run] » [Run Configurations] を
クリックし、HelloBlackBerry を選択してから [Run] をクリックします。

HelloBlackBerry プロジェクトがコンパイルされ、シミュレータウィンドウが表示されます。

Eclipse の [Problems] タブを選択して、プロジェクトがエラーなくコンパイルされたことを確
認します。

13. シミュレータメニューで、[File] » [Load Java Program] をクリックします。

14. SQL Anywhere インストール環境の ¥UltraLite¥UltraLiteJ¥BlackBerry4.2¥ ディレクトリに移動
して、UltraLiteJ16.cod ファイルを開きます。
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注意

場合によっては、アプリケーションを実行するために、UltraLiteJ16.cod と DBG ファイルを
作業用のシミュレータディレクトリ (C:¥Eclipse¥plugins
¥net.rim.ejde.componentpack6.0.0_6.0.0.0.26¥components¥simulator¥ など) にコピーする必要が
あります。コピーが完了したら、シミュレータメニューから Java プログラムをロードする必
要はありません。

15. シミュレータメニューで、[Simulate] » [Set IT Policy] をクリックします。

[Set IT Policy] ウィンドウが表示されます。

16. [Policy] フィールドで、[Allow Third Party Apps To Use Persistent Store] » [>>] をクリックし
ます。

17. [Set] をクリックしてから、[Close] をクリックします。

18. アプリケーションを起動します。

シミュレータウィンドウで、[Downloads] に移動してから HelloBlackBerry アプリケーション
を実行します。

Hello BlackBerry タイトルバー、Status: Connected テキスト、Name フィールドを示す画面が
表示されます。

19. [Name] フィールドに John Smith と入力します。

20. *EMPTY* をクリックし、Add を選択します。

リストに John Smith が表示され、これは、データベースの Names テーブルに追加された名
前のエントリを示しています。

名前は、追加した時点でデータベースに格納されます。アプリケーションを閉じたり再度開
いたりするときに、名前がデータベースから検索され、リストに追加されます。

21. シミュレーションを停止します。

シミュレータウィンドウで、[File] » [Exit] をクリックします。

結果

入力されたデータは、Ultra Light Java データベースの Names テーブルに挿入されます。

次の手順

「レッスン 6：BlackBerry スマートフォンへのアプリケーションの配備」64 ページに進みます。

第 1 部：新しい BlackBerry アプリケーションの作成

Copyright © 2013, SAP AG or an SAP affiliate company. - SAP Sybase SQL Anywhere 16.0 63



レッスン 6：BlackBerry スマートフォンへのアプリケーション
の配備

このレッスンでは、BlackBerry Desktop Manager を利用した、ソフトウェアへの署名方法とその
ソフトウェアの配備方法について説明します。

前提条件

このレッスンは、受講者がこれまでのすべてのレッスンを終了していることを前提としていま
す。 「レッスン 1：新しい BlackBerry プロジェクトの設定」49 ページを参照してください。

BlackBerry Signature Tool を使用してアプリケーションに署名できるように、RIM からキーを取
得してください。キーの取得については、BlackBerry Developer Program の次の Web サイトを参
照してください。http://na.blackberry.com/eng/developers/.

内容と備考

BlackBerry 上で実行するアプリケーションは、BlackBerry Signature Tool を使用して署名する必要
があります。このツールは、BlackBerry JDE Component Package の一部として Research in Motion
(RIM) から入手できます。UltraLiteJ16.cod ファイルはすでに署名されていますが、
HelloBlackBerry.cod ファイルは署名する必要があります。

♦ タスク

1. BlackBerry Signature Tool を起動します。

2. BlackBerry JDE インストール環境 (例：C:¥Program Files¥Research in Motion¥BlackBerry JDE
6.0.0¥bin) の ¥bin ディレクトリから次のコマンドを実行します。

start javaw -jar SignatureTool.jar

3. C:¥HelloBlackBerry まで移動して、コンパイル済みアプリケーションである
HelloBlackBerry.cod ファイルを選択します。

4. [Request To Sign The File] をクリックします。

5. [Close] をクリックして Signature Tool を閉じます。

6. USB ケーブルを使用して BlackBerry をコンピュータに接続し、BlackBerry Desktop Manager か
らデバイスを認識できることを確認します。

7. [Application Loader] をクリックして、ウィザードの指示に従います。

8. HelloBlackBerry.alx ファイルを参照し、デバイスに追加します。

9. BlackBerry4.2¥UltraLiteJ.alx ファイルを参照し、デバイスに追加します。

結果

アプリケーションが配備され、BlackBerry スマートフォンでアプリケーションを実行できます。
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次の手順

「第 2 部：Mobile iLink を使用した BlackBerry アプリケーションの同期」65 ページに進みます。

第 2 部：Mobile iLink を使用した BlackBerry アプリ
ケーションの同期

チュートリアルの第 2 部では、BlackBerry アプリケーションを拡張して Mobile Link 同期をサ
ポートできるようにします。次のタスクを完了します。

●Ultra Light Java Edition データベースで同期できる SQL Anywhere データベースを作成します。

●同期を扱うように、Mobile Link サーバを開始します。

●Mobile Link 同期をサポートするために BlackBerry アプリケーションを更新します。

●BlackBerry アプリケーションを統合データベースと同期します。

レッスン 1：Mobile Link 統合データベースの設定
このレッスンでは、SQL Anywhere データベースを作成します。

前提条件

このレッスンでは、必要なソフトウェアがすでにインストールされ、このチュートリアルの第 1
部が完了していると仮定しています。「チュートリアル：BlackBerry アプリケーションの構築」
49 ページを参照してください。

内容と備考

データの同期には、Ultra Light データベースが同期する Mobile Link 統合データベースが必要で
す。

♦ タスク

1. SQL Anywhere データベースに格納する作業ディレクトリを作成します。

このチュートリアルでは、作業を c:¥HelloBlackBerry¥database ディレクトリで行っているこ
とを前提としています。

2. 次のコマンドを実行して、DBA ユーザ ID が DBA でパスワードが sql の、空の SQL Anywhere
データベースを作成します。

dbinit -dba DBA,sql HelloBlackBerry.db

3. ODBC データソースを作成してデータベースに接続します。

a. [スタート] » [プログラム] » [SQL Anywhere 16] » [管理ツール] » [ODBC データソースア
ドミニストレータ] をクリックします。
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b. [ユーザ DSN] タブをクリックしてから、[追加] をクリックします。

c. [データ ソースの新規作成] ウィンドウで、[SQL Anywhere 16] をクリックし、[完了] を
クリックします。

d. [ODBC] タブをクリックします。

e. [データソース名] フィールドに HelloBlackBerry と入力します。

f. [ログイン] タブをクリックします。

g. [ユーザ ID] フィールドに DBA と入力します。

h. [パスワード] フィールドに sql と入力します。

i. [アクション] リストで、[このコンピュータのデータベースを起動して接続] をクリック
します。

j. [データベースファイル] フィールドに c:¥tutorial¥database¥HelloBlackBerry.db を入力し
ます。

k. [サーバ名] フィールドに HelloBlackBerry と入力します。

l. [最終切断後にデータベースを停止] オプションを無効にします。

m. [OK] をクリックします。

n. [ODBC データソースアドミニストレータ] ウィンドウで [OK] をクリックします。

4. 次のコマンドを実行して、Interactive SQL を起動し、SQL Anywhere データベースに接続しま
す。

dbisql -c dsn=HelloBlackBerry

5. Interactive SQL で次の SQL 文を実行し、統合データベースに Names テーブルを作成します。

CREATE TABLE Names (
    ID UNIQUEIDENTIFIER NOT NULL DEFAULT newID(),
    Name varchar(254), 
    PRIMARY KEY (ID)
)

6. Interactive SQL を閉じます。

[File] » [Exit] をクリックします。

結果

SQL Anywhere データベースが作成されます。

次の手順

「レッスン 2：Mobile Link サーバの設定と同期モデルの配備」66 ページに進みます。

レッスン 2：Mobile Link サーバの設定と同期モデルの配備
このレッスンでは、Sybase Central を使用して、同期する統合データベースを準備します。
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前提条件

このレッスンは、受講者がこれまでのすべてのレッスンを終了していることを前提としていま
す。 「レッスン 1：Mobile Link 統合データベースの設定」65 ページを参照してください。

♦ タスク

1. [スタート] » [プログラム] » [SQL Anywhere 16] » [管理ツール] » [Sybase Central] をクリック
します。

2. [ツール] » [Mobile Link 16] » [新しいプロジェクト] をクリックします。

プロジェクト作成ウィザードが表示されます。

3. [名前] フィールドに rim_project と入力します。

4. [保存場所] フィールドに C:¥HelloBlackBerry¥database と入力し、[次へ] をクリックします。

5. [データベースの表示名] フィールドに HelloBlackBerry と入力します。

6. [編集] をクリックします。

7. [汎用 ODBC データベースに接続] ページで次のタスクを実行します。

a. [ユーザ ID] フィールドに、DBA と入力します。

b. [パスワード] フィールドに、sql と入力します。

c. [ODBC データソース名] フィールドで、[参照] をクリックして HelloBlackBerry を選択し
ます。

d. [OK] をクリックし、[保存] をクリックします。

8. [パスワードを記憶] オプションを選択し、[次へ] をクリックします。

9. [リモートデータベースに含める統合データベースのテーブルとカラムを指定してくださ
い。] リストで Names テーブルのみが選択されていることを確認してから、残りのすべてのダ
イアログで [次へ] をクリックしてウィザードを終了します。

同期モデルが作成されました。

10. 新しい同期モデルを右クリックし、[プロパティ] を選択します。

11. 最初のテキストフィールドに、HelloBlackBerrySyncModel を入力し、[適用] をクリックして
から [Ok] をクリックします。

12. [Mobile Link 16] の下にある Sybase Central の左ウィンドウ枠で、rim_project、[同期モデル]、
HelloBlackBerrySyncModel を展開します。

13. [ファイル] » [展開] をクリックします。

14. [次の 1 つまたは複数の項目の展開の詳細を指定する] オプションの下で、[統合データベー
ス] オプションが選択されていることを確認します。[次へ] をクリックします。
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15. [統合データベースの展開先] ページで、次のタスクを実行します。

a. [次の SQL ファイルに変更を保存する] を選択し、ファイルのデフォルトロケーションを
そのまま使用します。

Mobile Link により、同期を設定するために統合データベースを変更する .sql ファイルが
生成されます。以降で .sql ファイルを確認し、独自の変更を加えることもできます。こ
の場合、.sql ファイルを手動で実行する必要があります。

b. 統合データベースに変更をすぐに適用します。

[統合データベースに接続して変更を直接適用する] を選択します。

c. リストから HelloBlackBerry 統合データベースを選択します。

d. [次へ] をクリックします。

consolidated ディレクトリを作成するかどうかを確認するプロンプトが表示されます。[はい]
をクリックします。

16. [Mobile Link ユーザおよび同期プロファイル] ページで、ユーザ名に mluser、パスワードに
mlpassword を入力し、その後、[完了] をクリックします。

結果

Mobile Link プロジェクトが作成され、統合データベースの同期モデルを配備できるようになり
ました。

次の手順

「レッスン 3：BlackBerry アプリケーションに対する Mobile Link のサポート」68 ページに進み
ます。

レッスン 3：BlackBerry アプリケーションに対する Mobile
Link のサポート

このレッスンでは、アプリケーションに同期機能を追加します。

前提条件

このレッスンは、受講者がこれまでのすべてのレッスンを終了していることを前提としていま
す。 「レッスン 1：Mobile Link 統合データベースの設定」65 ページを参照してください。

♦ タスク

1. HomeScreen クラスを更新して Sync メニュー項目を追加します。

[Package Explorer] ウィンドウの HomeScreen.java をダブルクリックしてから、try-catch メ
ソッドを呼び出す getDataAccess 文の前に次のコードを挿入します。

        // Add sync menu item
        addMenuItem(_syncMenuItem);
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2. HomeScreen クラスを更新して、クラス変数宣言にメニュー項目を定義する新しいメソッド
を追加します。

次のコードを _addToListMenuItem メソッドの下に挿入します。

    private MenuItem _syncMenuItem = new MenuItem("Sync", 2, 1) {
        public void run() {
            onSync();
        }
    };

3. HomeScreen クラスを更新して、前の手順で呼び出された onSync メソッドを追加します。

次のコードを onAddToList メソッドの下に挿入します。

    private void onSync() {
        try {
            if(_da.sync()) {
                _statusLabel.setText("Synchronization succeeded");
            } else {
                _statusLabel.setText("Synchronization failed");
            }
            refreshNameList();
        } catch (Exception ex) {
            Dialog.alert(ex.toString());
        }
    }

4. DataAccess クラスを更新して _syncParms 変数を定義します。

[Package Explorer] ウィンドウの DataAccess.java をダブルクリックしてから、private static
DataAccess _da; 呼び出しの下に次のコードを挿入します。

    private static SyncParms _syncParms;

5. DataAccess クラスを更新して sync メソッドを追加します。

次のコードを getNameVector メソッドの下に挿入します。

注意

your-host-name を使用しているコンピュータ名と置き換える必要があります。この用語はア
プリケーションには使用できません。

    public boolean sync() {
        try {
            if(_syncParms == null){
                _syncParms = _conn.createSyncParms(SyncParms.HTTP_STREAM, 
                                "mluser", 
                                "HelloBlackBerrySyncModel");
                _syncParms.setPassword("mlpassword");
                _syncParms.getStreamParms().setHost("your-host-name"); // USE YOUR OWN
                _syncParms.getStreamParms().setPort(8081); // USE YOUR OWN
            }
            _conn.synchronize(_syncParms);
            return true;
        }
        catch(ULjException uex) {
            Dialog.alert("Exception: " + uex.toString());
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            return false;
        }
    }

同期パラメータオブジェクト _syncParms には、同期モデルの展開時に指定したユーザ名と
パスワードが含まれています。また、作成した同期モデルの名前も含まれています。Mobile
Link では、この名前は統合データベースに展開された同期バージョン (同期論理セット) を参
照できます。

ストリームパラメータオブジェクト StreamHTTPParms は、Mobile Link サーバのホスト名と
ポート番号を示します。次のレッスンで Mobile Link サーバを起動するときに、シミュレータ
のテスト用に自分のコンピュータ名を使用し、使用可能なポートを選択します。

注意

デバイスを使用する場合は、外部で表示可能なコンピュータを使用するか、自分のデバイス
とペアになっている BlackBerry Enterprise Server (Sybase をホストとする Relay Server など) か
らアクセスできるコンピュータを使用してください。 Relay Server の詳細については、「Relay
Server の概要」『Relay Server』を参照してください。

6. [File] » [Save All] をクリックします。

結果

BlackBerry アプリケーションと統合データベースを同期できます。

次の手順

「レッスン 4：Mobile Link サーバの起動とアプリケーションの同期」70 ページに進みます。

レッスン 4：Mobile Link サーバの起動とアプリケーションの同
期

このレッスンでは、Mobile Link サーバを起動し、Ultra Light Java Edition データベースと SQL
Anywhere 統合データベースを同期します。

前提条件

このレッスンは、受講者がこれまでのすべてのレッスンを終了していることを前提としていま
す。 「レッスン 1：Mobile Link 統合データベースの設定」65 ページを参照してください。

内容と備考

BlackBerry アプリケーションを実行して同期する前に、Mobile Link サーバが実行中である必要
があります。Device Simulator と Mobile Link 間の通信チャネルを提供するためには、MDS
Simulator も実行中である必要があります。
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♦ タスク

1. c:¥HelloBlackBerry¥database¥ から次のコマンドを実行して Mobile Link を起動します。

mlsrv16 -c "DSN=HelloBlackBerry" -v+ -x http(port=8081) -ot ml.mls

-c オプションは、Mobile Link を SQL Anywhere データベースに接続します。-v+ オプション
は、高い冗長レベルを設定して、処理中の内容を Mobile Link のサーバメッセージウィンドウ
で確認できるようにします。-x オプションは、通信に使用されているポート番号を示しま
す。-ot オプションは、ログファイル (ml.mls) が、Mobile Link サーバを起動したディレクトリ
に作成されるように指定します。

2. BlackBerry シミュレータがネットワーク経由で通信できるように、MDS シミュレータを実行
します。

[スタート] » [プログラム] » [Research In Motion] » [BlackBerry Email And MDS Services
Simulator 4.1.4] » [MDS] をクリックします。

3. 同期時にアプリケーションによって Ultra Light Java Edition データベースが更新されるよう
に、Mobile Link 統合データベースに名前を追加します。

a. 次のコマンドを実行して、Interactive SQL を起動し、SQL Anywhere データベースに接続
します。

dbisql -c dsn=HelloBlackBerry

b. Interactive SQL で次の SQL 文を実行し、Names テーブルに名前を追加します。

INSERT Names (Name) VALUES ('Jane Smith');
INSERT Names (Name) VALUES ('David Smith');
COMMIT;

c. Interactive SQL を閉じます。

[File] » [Exit] をクリックします。

4. Eclipse からシミュレータを実行します。

[Package Explorer] ウィンドウで Application.java をクリックしてから、[Run] » [Run As] »
[BlackBerry Simulator] をクリックします。

注意

ワークスペースで複数のプロジェクトを開いている場合は、[Run] » [Run Configurations] を
クリックし、HelloBlackBerry を選択してから [Run] をクリックします。

HelloBlackBerry プロジェクトがコンパイルされ、シミュレータウィンドウが表示されます。

Eclipse の [Problems] タブを選択して、プロジェクトがエラーなくコンパイルされたことを確
認します。

5. シミュレータメニューで、[File] » [Load Java Program] をクリックします。

6. SQL Anywhere インストール環境の ¥UltraLite¥UltraLiteJ¥BlackBerry4.2¥ ディレクトリに移動
して、UltraLiteJ16.cod ファイルを開きます。
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注意

場合によっては、アプリケーションを実行するために、UltraLiteJ16.cod と DBG ファイルを
作業用のシミュレータディレクトリ (C:¥Eclipse¥plugins
¥net.rim.ejde.componentpack6.0.0_6.0.0.0.26¥components¥simulator¥ など) にコピーする必要が
あります。コピーが完了したら、シミュレータメニューから Java プログラムをロードする必
要はありません。

7. シミュレータメニューで、[Simulate] » [Set IT Policy] をクリックします。

[Set IT Policy] ウィンドウが表示されます。

8. [Policy] フィールドで、[Allow Third Party Apps To Use Persistent Store] » [>>] をクリックし
ます。

9. [Set] をクリックしてから、[Close] をクリックします。

10. アプリケーションを起動します。

シミュレータウィンドウで、[Downloads] に移動してから HelloBlackBerry アプリケーション
を実行します。

Hello BlackBerry タイトルバー、Status: Connected テキスト、Name フィールドを示す画面が
表示されます。

11. アプリケーションを Mobile Link サーバと同期させます。

*EMPTY* をクリックし、Sync を選択します。

Jane Smith と David Smith がリストに表示され、アプリケーションが Mobile Link 統合データ
ベースと同期できたことを示します。Interactive SQL から Names テーブル内の名前を問い合
わせると、これまでにシミュレータに入力した名前がすべてサーバに到達していることが確
認できます。

12. シミュレーションを停止します。

シミュレータウィンドウで、[File] » [Exit] をクリックします。

結果

Ultra Light Java Edition と SQL Anywhere 統合データベースが同期されます。

次の手順

「クリーンアップ」72 ページに進みます。

クリーンアップ
最近作成したチュートリアルをコンピュータから削除します。
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前提条件

このレッスンは、受講者がこれまでのすべてのレッスンを終了していることを前提としていま
す。 「第 1 部：新しい BlackBerry アプリケーションの作成」49 ページを参照してください。

♦ タスク

1. Eclipse を終了します。

[File] » [Exit] をクリックします。

2. MDS シミュレータを実行しているコマンドウィンドウを閉じます。

3. Sybase Central および Interactive SQL のそれぞれのタスクバーを右クリックして閉じ、[終了]
を選択します。

4. 次のように HelloBlackBerry データソースを削除します。

a. ODBC データソースアドミニストレータを起動します。

[スタート] » [プログラム] » [SQL Anywhere 16] » [管理ツール] » [ODBC データソースア
ドミニストレータ] をクリックします。

b. [ユーザデータソース] リストから HelloBlackBerry を選択し、[削除] をクリックします。

c. ODBC データソースアドミニストレータを閉じます。

5. C:¥HelloBlackBerry ディレクトリを削除します。

結果

チュートリアルがコンピュータから削除され、このチュートリアルを最初のレッスンから再び繰
り返すことができます。

チュートリアルのコードリスト
このセクションでは、ここまでのチュートリアルで使用したコードをすべて示します。チュート
リアルで使用した Java クラスは 4 つあります。これらのクラスは、%SQLANYSAMP16%
¥UltraLiteJ¥BlackBerry¥HelloBlackBerry¥myapp にあります。

参照

●「第 1 部：新しい BlackBerry アプリケーションの作成」49 ページ
●「第 2 部：Mobile iLink を使用した BlackBerry アプリケーションの同期」65 ページ

Application.java
// ***************************************************************************
// Copyright © 2013 SAP AG or an SAP affiliate company. All rights reserved.
// ***************************************************************************
// This sample code is provided AS IS, without warranty or liability
// of any kind.
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//
// You may use, reproduce, modify and distribute this sample code
// without limitation, on the condition that you retain the foregoing
// copyright notice and disclaimer as to the original code.
//
// *********************************************************************
package myapp;

class Application extends net.rim.device.api.ui.UiApplication {
    public static void main( String[] args )
    {
        Application instance = new Application();
        instance.enterEventDispatcher();
    }
    Application() {
        pushScreen( new HomeScreen() );
    }
}

DataAccess.java
// ***************************************************************************
// Copyright © 2013 SAP AG or an SAP affiliate company. All rights reserved.
// ***************************************************************************
// This sample code is provided AS IS, without warranty or liability
// of any kind.
//
// You may use, reproduce, modify and distribute this sample code
// without limitation, on the condition that you retain the foregoing
// copyright notice and disclaimer as to the original code.
//
// *********************************************************************
package myapp;

import com.ianywhere.ultralitej16.*;

import net.rim.device.api.ui.component.*;
import java.util.*;

class DataAccess {
    DataAccess() {
    }
    
    public static synchronized DataAccess getDataAccess(boolean reset) 
        throws Exception
    {   
        if (_da == null) {
            _da = new DataAccess();
            ConfigObjectStore config = DatabaseManager.createConfigurationObjectStore("HelloDB");
            if (reset) {
                _conn = DatabaseManager.createDatabase(config);
                _da.createDatabaseSchema();
            } 
            else {
                try {
                    _conn = DatabaseManager.connect(config);
                }
                catch (ULjException uex1) {
                    if (uex1.getErrorCode() != ULjException.SQLE_ULTRALITE_DATABASE_NOT_FOUND) {
                        Dialog.alert("Exception: " + uex1.toString() + ". Recreating database...");
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                    }
                    _conn = DatabaseManager.createDatabase(config);
                    _da.createDatabaseSchema();
                }
            }
        }
        return _da;
    }

    private void createDatabaseSchema() {
        try {
            String sql = "CREATE TABLE Names (ID UNIQUEIDENTIFIER DEFAULT NEWID(), Name 
VARCHAR(254), " +
                "PRIMARY KEY (ID))";
            PreparedStatement ps = _conn.prepareStatement(sql);
            ps.execute();
            ps.close();
        }
        catch (ULjException uex1) {
            Dialog.alert("ULjException: " + uex1.toString());
        }
        catch (Exception ex1) {
            Dialog.alert("Exception: " + ex1.toString());
        }
    }
    public void insertName(String name){
        try {
            UUIDValue nameID = _conn.createUUIDValue();
            String sql = "INSERT INTO Names(ID, Name) VALUES(?, ?)";           
            PreparedStatement ps = _conn.prepareStatement(sql);
            ps.set(1, nameID);
            ps.set(2, name);
            ps.execute();
            _conn.commit();
            ps.close();
        }
        catch(ULjException uex) {
            Dialog.alert("ULjException: " + uex.toString());
        }
        catch( Exception ex ){
            Dialog.alert("Exception: " + ex.toString());
        }  
    }
    public Vector getNameVector(){
        Vector nameVector = new Vector();
        try {
            String sql = "SELECT ID, Name FROM Names";
            PreparedStatement ps = _conn.prepareStatement(sql);
            ResultSet rs = ps.executeQuery();
            while ( rs.next() ){
                String nameID = rs.getString(1);
                String name = rs.getString(2);
                NameRow nr = new NameRow( nameID, name);
                nameVector.addElement(nr);
            }
        }
        catch( ULjException uex ){
            Dialog.alert("ULjException: " + uex.toString());
        }
        catch( Exception ex ){
            Dialog.alert("Exception: " + ex.toString());
        }
        return nameVector;
    }
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    public boolean sync() {
        try {
            if(_syncParms == null){
                _syncParms = _conn.createSyncParms(SyncParms.HTTP_STREAM, 
                                "mluser", 
                                "HelloBlackBerrySyncModel");
                _syncParms.setPassword("mlpassword");
                _syncParms.getStreamParms().setHost("your-host-name"); // USE YOUR OWN
                _syncParms.getStreamParms().setPort(8081); // USE YOUR OWN
            }
            _conn.synchronize(_syncParms);
            return true;
        }
        catch(ULjException uex) {
            Dialog.alert("Exception: " + uex.toString());
            return false;
        }
    }
    
    private static Connection _conn;
    private static DataAccess _da;
    private static SyncParms _syncParms;
}

HomeScreen.java
// ***************************************************************************
// Copyright © 2013 SAP AG or an SAP affiliate company. All rights reserved.
// ***************************************************************************
// This sample code is provided AS IS, without warranty or liability
// of any kind.
//
// You may use, reproduce, modify and distribute this sample code
// without limitation, on the condition that you retain the foregoing
// copyright notice and disclaimer as to the original code.
//
// *********************************************************************
package myapp;

import net.rim.device.api.ui.*;
import net.rim.device.api.ui.component.*;
import net.rim.device.api.ui.container.*;
import java.util.*;

class HomeScreen extends MainScreen {

    HomeScreen() {
        
        // Set the window title
        LabelField applicationTitle = new LabelField("Hello BlackBerry");
        setTitle(applicationTitle);
        
        // Add a label to show application status
        _statusLabel = new LabelField("Status: Started");
        add(_statusLabel);
        
        // Add an edit field for entering new names
        _nameEditField = new EditField( "Name: ", "", 50, EditField.USE_ALL_WIDTH );
        add (_nameEditField );
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        // Add an ObjectListField for displaying a list of names
        _nameListField = new ObjectListField();
        add( _nameListField );

        // Add a menu item
        addMenuItem(_addToListMenuItem);
        
        // Add sync menu item
        addMenuItem(_syncMenuItem);
        
        // Create database and connect
        try{
            _da = DataAccess.getDataAccess(true);
            _statusLabel.setText("Status: Connected");
        }
        catch(Exception ex)
        {
            _statusLabel.setText("Exception: " + ex.toString());
        }
        // Fill the ObjectListField
        refreshNameList();
    }

    private LabelField _statusLabel;
    private DataAccess _da;
    private EditField _nameEditField;
    private ObjectListField _nameListField;

    private MenuItem _addToListMenuItem = new MenuItem("Add", 1, 1){
        public void run() {
            onAddToList();
        }
    };
    private MenuItem _syncMenuItem = new MenuItem("Sync", 2, 1){
        public void run() {
            onSync();
        }
    };
    
    public void refreshNameList() {
        //Clear the list
        _nameListField.setSize(0);

        //Refill from the list of names
        Vector nameVector = _da.getNameVector();
        for( Enumeration e = nameVector.elements(); e.hasMoreElements(); ){
            NameRow nr = ( NameRow )e.nextElement();
            _nameListField.insert(0, nr);
        }
    }

    private void onAddToList(){
        String name = _nameEditField.getText();
        _da.insertName(name);
        this.refreshNameList();
        _nameEditField.setText("");
        _statusLabel.setText(name + " added to list");
    }
    
    private void onSync() {
        try {
            if(_da.sync()) {
                _statusLabel.setText("Synchronization succeeded");
            } else {
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                _statusLabel.setText("Synchronization failed");
            }
            refreshNameList();
        } catch (Exception ex) {
            Dialog.alert(ex.toString());
        }
    }
}

NameRow.java
// ***************************************************************************
// Copyright © 2013 SAP AG or an SAP affiliate company. All rights reserved.
// ***************************************************************************
// This sample code is provided AS IS, without warranty or liability
// of any kind.
//
// You may use, reproduce, modify and distribute this sample code
// without limitation, on the condition that you retain the foregoing
// copyright notice and disclaimer as to the original code.
//
// *********************************************************************package myapp;

class NameRow {
    
    public NameRow( String nameID, String name ) {  
        _nameID = nameID;
        _name = name;
    }
    
    public String getNameID(){
        return _nameID;
    }
    
    public String getName(){
        return _name;
    }
       
    public String toString(){
        return _name;
    }
    
    private String _nameID;
    private String _name;
    
}
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Ultra Light J API リファレンス
次に、よく使用される API オブジェクトの一部を示します。

● DatabaseManager データベース接続を管理するメソッド (CreateDatabase、connect など) を
提供します。

● Connection Ultra Light データベースへの接続を表します。Connection オブジェクトは 1 つ
または複数作成できます。

● SyncParms Ultra Light データベースを Mobile Link サーバと同期させます。

● PreparedStatement、ResultSet 動的 SQL 文の作成、クエリの記述、INSERT、UPDATE、
DELETE 文の実行、プログラムによるデータベースの結果セットの制御を行います。

パッケージ [Android]
com.ianywhere.ultralitejni16

パッケージ [BlackBerry]
com.ianywhere.ultralitej16

参照

●「Android と BlackBerry のセットアップの考慮事項」4 ページ
● DatabaseManager クラス [Ultra Light J]136 ページ
● Connection インタフェース [Ultra Light J]103 ページ
● SyncParms クラス [Ultra Light J]248 ページ
● PreparedStatement インタフェース [Ultra Light J]179 ページ
● ResultSet インタフェース [Ultra Light J]195 ページ

ColumnSchema インタフェース
カラムのスキーマを指定します。

構文

public interface ColumnSchema

メンバー

継承されたメンバーを含む ColumnSchema インタフェースのすべてのメンバー。

名前 説明

COLUMN_DEFAULT_AUTOFILENAME 変数 AUTOFILENAME カラムのデフォルト属性を
示します。
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名前 説明

COLUMN_DEFAULT_AUTOINC 変数 AUTOINCREMENT カラムのデフォルト属性
を示します。

COLUMN_DEFAULT_CONSTANT 変数 カラムのデフォルト属性が constant である事
を示します。

COLUMN_DEFAULT_CURRENT_DATE 変数 カラムのデフォルト属性が current date (年、
月、日) である事を示します。

COLUMN_DEFAULT_CURRENT_TIME 変数 CURRENT TIME カラムのデフォルト属性を
示します。

COLUMN_DEFAULT_CURRENT_TIMESTA
MP 変数

CURRENT TIMESTAMP カラムのデフォルト
属性を示します。

COLUMN_DEFAULT_CURRENT_UTC_TIME
STAMP 変数

CURRENT UTC TIMESTAMP カラムのデフォ
ルト属性を示します。

COLUMN_DEFAULT_GLOBAL_AUTOINC 変
数

GLOBAL AUTOINCREMENT カラムのデフォ
ルト属性を示します。

COLUMN_DEFAULT_NONE 変数 カラムにデフォルト属性が存在しない事を示
します。

COLUMN_DEFAULT_UNIQUE_ID 変数 カラムのデフォルト属性が新しいユニーク
ID である事を示します。

備考

このインタフェースには、システムテーブル syscolumn の column_default カラムに格納されるさ
まざまなカラムデフォルト値の定数のみが含まれています。

COLUMN_DEFAULT_AUTOFILENAME 変数
AUTOFILENAME カラムのデフォルト属性を示します。

構文

final byte ColumnSchema.COLUMN_DEFAULT_AUTOFILENAME

備考

VARCHAR カラムにこのデフォルト値がある場合、カラムは外部 blob 定義のファイル名のカラ
ムになります。

カラムにこのタイプのデフォルトがある場合、システムテーブル TableSchema.SYS_COLUMNS
の column_default_value カラムには、外部 blob 定義にあるプレフィクスと拡張子の文字列が
'prefix|extension' の形式で含まれます。
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既存のテーブルのデフォルト値は、システムテーブル TableSchema.SYS_COLUMNS の
column_default カラムに問い合わせることで確認できます。

参照

● TableSchema.SYS_COLUMNS 変数 [Ultra Light J]279 ページ

COLUMN_DEFAULT_AUTOINC 変数
AUTOINCREMENT カラムのデフォルト属性を示します。

構文

final byte ColumnSchema.COLUMN_DEFAULT_AUTOINC

備考

AUTOINCREMENT 属性を使用する場合、カラムは整数データ型の 1 つ、または真数値型にしま
す。INSERT 時に AUTOINCREMENT のカラムに値を指定しないと、カラム内のほかの値より大
きいユニーク値が生成されます。INSERT で、カラムの現在の最大値より大きい値を指定した場
合、この値が後続の挿入処理の開始ポイントとして使用されます。

Ultra Light J では、テーブルが作成された時点でのオートインクリメントの初期値は 0 ではあり
ません。カラムに符号付きデータ型が指定されている場合は、AUTOINCREMENT 属性によって
負の値が生成されます。このため、オートインクリメントを適用するカラムを符号なし整数とし
て宣言し、負の値が生成されないようにしてください。

既存のテーブルのデフォルト値は、システムテーブル TableSchema.SYS_COLUMNS の
column_default カラムに問い合わせることで確認できます。

参照

● TableSchema.SYS_COLUMNS 変数 [Ultra Light J]279 ページ

COLUMN_DEFAULT_CONSTANT 変数
カラムのデフォルト属性が constant である事を示します。

構文

final byte ColumnSchema.COLUMN_DEFAULT_CONSTANT

備考

既存のテーブルのデフォルト値は、システムテーブル TableSchema.SYS_COLUMNS の
column_default カラムに問い合わせることで確認できます。

参照

● TableSchema.SYS_COLUMNS 変数 [Ultra Light J]279 ページ
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COLUMN_DEFAULT_CURRENT_DATE 変数
カラムのデフォルト属性が current date (年、月、日) である事を示します。

構文

final byte ColumnSchema.COLUMN_DEFAULT_CURRENT_DATE

備考

SQL Anywhere のマニュアルセットで、「Ultra Light の特別値」の下の「CURRENT DATE 特別
値」を参照してください。

既存のテーブルのデフォルト値は、システムテーブル TableSchema.SYS_COLUMNS の
column_default カラムに問い合わせることで確認できます。

参照

● TableSchema.SYS_COLUMNS 変数 [Ultra Light J]279 ページ

COLUMN_DEFAULT_CURRENT_TIME 変数
CURRENT TIME カラムのデフォルト属性を示します。

構文

final byte ColumnSchema.COLUMN_DEFAULT_CURRENT_TIME

備考

SQL Anywhere のマニュアルセットで、「Ultra Light の特別値」の下の「CURRENT TIME 特別値」
を参照してください。

既存のテーブルのデフォルト値は、システムテーブル TableSchema.SYS_COLUMNS の
column_default カラムに問い合わせることで確認できます。

参照

● TableSchema.SYS_COLUMNS 変数 [Ultra Light J]279 ページ

COLUMN_DEFAULT_CURRENT_TIMESTAMP 変数
CURRENT TIMESTAMP カラムのデフォルト属性を示します。

構文

final byte ColumnSchema.COLUMN_DEFAULT_CURRENT_TIMESTAMP

備考

この定数は、CURRENT DATE と CURRENT TIME の値を結合して、TIMESTAMP 値を形成しま
す。この値は、年、月、日、時、分、秒、秒の小数位で構成されます。秒の精度は小数点以下
第 3 位に設定されます。この定数の精度はシステムクロックの精度によって制限されます。
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SQL Anywhere のマニュアルセットで、「Ultra Light の特別値」の下の「CURRENT TIMESTAMP
特別値」を参照してください。

既存のテーブルのデフォルト値は、システムテーブル TableSchema.SYS_COLUMNS の
column_default カラムに問い合わせることで確認できます。

参照

● TableSchema.SYS_COLUMNS 変数 [Ultra Light J]279 ページ

COLUMN_DEFAULT_CURRENT_UTC_TIMESTAMP 変数
CURRENT UTC TIMESTAMP カラムのデフォルト属性を示します。

構文

final byte ColumnSchema.COLUMN_DEFAULT_CURRENT_UTC_TIMESTAMP

備考

この定数は、CURRENT DATE と CURRENT TIME の値を結合して、UTC TIMESTAMP 値を形成
します。この値は、GMT での年、月、日、時、分、秒、秒の小数位で構成されます。秒の精度
は小数点以下第 3 位に設定されます。この定数の精度はシステムクロックの精度によって制限
されます。

SQL Anywhere のマニュアルセットで、「Ultra Light の特別値」の下の「CURRENT UTC
TIMESTAMP 特別値」を参照してください。

既存のテーブルのデフォルト値は、システムテーブル TableSchema.SYS_COLUMNS の
column_default カラムに問い合わせることで確認できます。

参照

● TableSchema.SYS_COLUMNS 変数 [Ultra Light J]279 ページ

COLUMN_DEFAULT_GLOBAL_AUTOINC 変数
GLOBAL AUTOINCREMENT カラムのデフォルト属性を示します。

構文

final byte ColumnSchema.COLUMN_DEFAULT_GLOBAL_AUTOINC

備考

この定数は AUTOINCREMENT 属性と同じですが、ドメインはパーティションに分割されます。
各分割には同じ数の値が含まれます。データベースの各コピーにユニークなグローバルデータ
ベース ID 番号を割り当てる必要があります。Ultra Light J では、データベースのデフォルト値
は、そのデータベース番号でユニークに識別された分割から設定されます。

既存のテーブルのデフォルト値は、システムテーブル TableSchema.SYS_COLUMNS の
column_default カラムに問い合わせることで確認できます。
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参照

● TableSchema.SYS_COLUMNS 変数 [Ultra Light J]279 ページ
● Connection.setDatabaseId メソッド [Ultra Light J]118 ページ

COLUMN_DEFAULT_NONE 変数
カラムにデフォルト属性が存在しない事を示します。

構文

final byte ColumnSchema.COLUMN_DEFAULT_NONE

備考

デフォルト属性を指定しない場合、次のデフォルト値が適用されます。

●NULL 入力可のカラムのデフォルト値は NULL

●NULL 入力不可の数値カラムのデフォルト値は 0

●NULL 入力不可の可変長カラムのデフォルト値は長さ 0 の値

既存のテーブルのデフォルト値は、システムテーブル TableSchema.SYS_COLUMNS の
column_default カラムに問い合わせることで確認できます。

参照

● TableSchema.SYS_COLUMNS 変数 [Ultra Light J]279 ページ

COLUMN_DEFAULT_UNIQUE_ID 変数
カラムのデフォルト属性が新しいユニーク ID である事を示します。

構文

final byte ColumnSchema.COLUMN_DEFAULT_UNIQUE_ID

備考

UUID を使用して、テーブルのローをユニークに識別できます。生成される値は、すべてのコン
ピュータまたはデバイスでユニークになります。つまり、同期やレプリケーション環境でキーと
して使用できます。

既存のテーブルのデフォルト値は、システムテーブル TableSchema.SYS_COLUMNS の
column_default カラムに問い合わせることで確認できます。

参照

● TableSchema.SYS_COLUMNS 変数 [Ultra Light J]279 ページ
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ConfigFile インタフェース
ファイルに保存される永続的なデータベース用の Configuration オブジェクトを確立します。

構文

public interface ConfigFile

基本クラス

● ConfigPersistent インタフェース [Ultra Light J]91 ページ

派生クラス

● ConfigFileAndroid インタフェース [Android] [Ultra Light J]87 ページ

メンバー

継承されたメンバーを含む ConfigFile インタフェースのすべてのメンバー。

名前 説明

enableAesDBEncryption メソッド データベースの AES 暗号化を有効にします。

enableObfuscation メソッド データベースの難読化を有効にします。

getCacheSize メソッド データベースのキャッシュサイズ (バイト単
位) を返します。

getConnectionString メソッド [Android] SetConnectionString メソッドで登録された接
続文字列を取得します。

getCreationString メソッド [Android] SetCreationString メソッドで登録された作成
文字列を取得します。

getDatabaseName メソッド データベース名を返します。

getEncryptionKey メソッド setEncryptionKey メソッドで登録されたデー
タベース暗号化キーを取得します。

getLazyLoadIndexes メソッド [BlackBerry] インデックスの遅延ロードがオンになってい
るかどうかを確認します。

getPageSize メソッド データベースのページサイズ (バイト単位) を
返します。

getRowScoreFlushSize メソッド [BlackBerry] 現在のロースコアのフラッシュサイズを返し
ます。

getRowScoreMaximum メソッド [BlackBerry] 現在のロースコアの最大サイズを返します。

ConfigFile インタフェース
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名前 説明

getUserName メソッド [Android] setUserName メソッドで設定されたユーザの
名前を取得します。

hasShadowPaging メソッド [BlackBerry] シャドウページングがオンになっているかど
うかを確認します。

setCacheSize メソッド データベースのキャッシュサイズ (バイト単
位) を設定します。

setConnectionString メソッド [Android] データベースの作成または接続に使用される
接続文字列を設定します。

setCreationString メソッド [Android] データベースを作成するために使用される作
成文字列を設定します。

setDatabaseName メソッド データベース名を設定します。

setEncryptionKey メソッド 暗号化キーを設定します。

setLazyLoadIndexes メソッド [BlackBerry] 必要なときにインデックスをロードするか、
起動時にすべてのインデックスを一度にロー
ドするかを設定します。

setPageSize メソッド データベースのページサイズを設定します。

setPassword メソッド データベースのパスワードを設定します。

setRowScoreFlushSize メソッド [BlackBerry] 古いローの削除に使用されるスコアを指定す
ることによって、ロー制限を有効にします。

setRowScoreMaximum メソッド [BlackBerry] メモリに保持する最大ロースコアのスレッ
ショルドを設定します。

setUserName メソッド [Android] ユーザの名前を設定します。

備考

ConfigFile インタフェースを実装するオブジェクトは、DatabaseManager.createConfigurationFile メ
ソッドを使用して作成されます。

参照

● DatabaseManager クラス [Ultra Light J]136 ページ
● DatabaseManager.createConfigurationFile メソッド [Ultra Light J]138 ページ
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ConfigFileAndroid インタフェース [Android]
Android デバイス上のファイルに保存される永続的なデータベース用の Configuration オブジェ
クトを確立します。

構文

public interface ConfigFileAndroid

基本クラス

● ConfigFile インタフェース [Ultra Light J]85 ページ

メンバー

継承されたメンバーを含む ConfigFileAndroid インタフェースのすべてのメンバー。

名前 説明

enableAesDBEncryption メソッド データベースの AES 暗号化を有効にします。

enableObfuscation メソッド データベースの難読化を有効にします。

getCacheSize メソッド データベースのキャッシュサイズ (バイト単
位) を返します。

getConnectionString メソッド [Android] setConnectionString メソッドで登録された接
続文字列を取得します。

getCreationString メソッド [Android] setCreationString メソッドで登録された作成
文字列を取得します。

getDatabaseName メソッド データベース名を返します。

getEncryptionKey メソッド setEncryptionKey メソッドで登録されたデー
タベース暗号化キーを取得します。

getLazyLoadIndexes メソッド [BlackBerry] インデックスの遅延ロードがオンになってい
るかどうかを確認します。

getPageSize メソッド データベースのページサイズ (バイト単位) を
返します。

getRowScoreFlushSize メソッド [BlackBerry] 現在のロースコアのフラッシュサイズを返し
ます。

getRowScoreMaximum メソッド [BlackBerry] 現在のロースコアの最大サイズを返します。

getUserName メソッド [Android] setUserName メソッドで設定されたユーザの
名前を取得します。

ConfigFileAndroid インタフェース [Android]
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名前 説明

hasShadowPaging メソッド [BlackBerry] シャドウページングがオンになっているかど
うかを確認します。

setCacheSize メソッド データベースのキャッシュサイズ (バイト単
位) を設定します。

setConnectionString メソッド [Android] データベースの作成または接続に使用される
接続文字列を設定します。

setCreationString メソッド [Android] データベースを作成するために使用される作
成文字列を設定します。

setDatabaseName メソッド データベース名を設定します。

setEncryptionKey メソッド 暗号化キーを設定します。

setLazyLoadIndexes メソッド [BlackBerry] 必要なときにインデックスをロードするか、
起動時にすべてのインデックスを一度にロー
ドするかを設定します。

setPageSize メソッド データベースのページサイズを設定します。

setPassword メソッド データベースのパスワードを設定します。

setRowScoreFlushSize メソッド [BlackBerry] 古いローの削除に使用されるスコアを指定す
ることによって、ロー制限を有効にします。

setRowScoreMaximum メソッド [BlackBerry] メモリに保持する最大ロースコアのスレッ
ショルドを設定します。

setUserName メソッド [Android] ユーザの名前を設定します。

備考

ConfigFileAndroid インタフェースを実装するオブジェクトは、
DatabaseManager.createConfigurationFileAndroid メソッドを使用して作成されます。

参照

● DatabaseManager クラス [Ultra Light J]136 ページ
● DatabaseManager.createConfigurationFileAndroid メソッド [Ultra Light J]139 ページ

ConfigNonPersistent インタフェース [BlackBerry]
非永続的な (メモリ内) データベース用の Configuration オブジェクトを確立します。
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構文

public interface ConfigNonPersistent

基本クラス

● Configuration インタフェース [Ultra Light J]100 ページ

メンバー

継承されたメンバーを含む ConfigNonPersistent インタフェースのすべてのメンバー。

名前 説明

getDatabaseName メソッド データベース名を返します。

getPageSize メソッド データベースのページサイズ (バイト単位) を
返します。

setDatabaseName メソッド データベース名を設定します。

setPageSize メソッド データベースのページサイズを設定します。

setPassword メソッド データベースのパスワードを設定します。

備考

ConfigNonPersistent インタフェースを実装するオブジェクトは、
DatabaseManager.createConfigurationNonPersistent メソッドを使用して作成されます。

NonPersistent オブジェクトを作成すると、メモリ内だけに存在するデータベースストアが構成さ
れます。データベースは起動時に作成され、アプリケーションの実行中に使用され、アプリケー
ションの終了時に破棄されます。アプリケーションの終了時には、非永続ストアに含まれるデー
タがすべて削除されます。

参照

● DatabaseManager クラス [Ultra Light J]136 ページ

ConfigObjectStore インタフェース [BlackBerry]
オブジェクトストアに保存される永続的なデータベース用の Configuration オブジェクトを確立
します。

構文

public interface ConfigObjectStore

基本クラス

● ConfigPersistent インタフェース [Ultra Light J]91 ページ

ConfigObjectStore インタフェース [BlackBerry]
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メンバー

継承されたメンバーを含む ConfigObjectStore インタフェースのすべてのメンバー。

名前 説明

enableAesDBEncryption メソッド データベースの AES 暗号化を有効にします。

enableObfuscation メソッド データベースの難読化を有効にします。

getCacheSize メソッド データベースのキャッシュサイズ (バイト単
位) を返します。

getConnectionString メソッド [Android] setConnectionString メソッドで登録された接
続文字列を取得します。

getCreationString メソッド [Android] setCreationString メソッドで登録された作成
文字列を取得します。

getDatabaseName メソッド データベース名を返します。

getEncryptionKey メソッド setEncryptionKey メソッドで登録されたデー
タベース暗号化キーを取得します。

getLazyLoadIndexes メソッド [BlackBerry] インデックスの遅延ロードがオンになってい
るかどうかを確認します。

getPageSize メソッド データベースのページサイズ (バイト単位) を
返します。

getRowScoreFlushSize メソッド [BlackBerry] 現在のロースコアのフラッシュサイズを返し
ます。

getRowScoreMaximum メソッド [BlackBerry] 現在のロースコアの最大サイズを返します。

getUserName メソッド [Android] setUserName メソッドで設定されたユーザの
名前を取得します。

hasShadowPaging メソッド [BlackBerry] シャドウページングがオンになっているかど
うかを確認します。

setCacheSize メソッド データベースのキャッシュサイズ (バイト単
位) を設定します。

setConnectionString メソッド [Android] データベースの作成または接続に使用される
接続文字列を設定します。

setCreationString メソッド [Android] データベースを作成するために使用される作
成文字列を設定します。
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名前 説明

setDatabaseName メソッド データベース名を設定します。

setEncryptionKey メソッド 暗号化キーを設定します。

setLazyLoadIndexes メソッド [BlackBerry] 必要なときにインデックスをロードするか、
起動時にすべてのインデックスを一度にロー
ドするかを設定します。

setPageSize メソッド データベースのページサイズを設定します。

setPassword メソッド データベースのパスワードを設定します。

setRowScoreFlushSize メソッド [BlackBerry] 古いローの削除に使用されるスコアを指定す
ることによって、ロー制限を有効にします。

setRowScoreMaximum メソッド [BlackBerry] メモリに保持する最大ロースコアのスレッ
ショルドを設定します。

setUserName メソッド [Android] ユーザの名前を設定します。

備考

ConfigObjectStore インタフェースを実装するオブジェクトは、
DatabaseManager.createConfigurationObjectStore メソッドを使用して作成されます。

参照

● DatabaseManager クラス [Ultra Light J]136 ページ
● DatabaseManager.createConfigurationObjectStore メソッド [BlackBerry] [Ultra Light J]140 ページ

ConfigPersistent インタフェース
永続的なデータベース用の Configuration オブジェクトを確立します。

構文

public interface ConfigPersistent

基本クラス

● Configuration インタフェース [Ultra Light J]100 ページ

派生クラス

● ConfigFile インタフェース [Ultra Light J]85 ページ
● ConfigObjectStore インタフェース [BlackBerry] [Ultra Light J]89 ページ
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メンバー

継承されたメンバーを含む ConfigPersistent インタフェースのすべてのメンバー。

名前 説明

enableAesDBEncryption メソッド データベースの AES 暗号化を有効にします。

enableObfuscation メソッド データベースの難読化を有効にします。

getCacheSize メソッド データベースのキャッシュサイズ (バイト単
位) を返します。

getConnectionString メソッド [Android] setConnectionString メソッドで登録された接
続文字列を取得します。

getCreationString メソッド [Android] setCreationString メソッドで登録された作成
文字列を取得します。

getDatabaseName メソッド データベース名を返します。

getEncryptionKey メソッド setEncryptionKey メソッドで登録されたデー
タベース暗号化キーを取得します。

getLazyLoadIndexes メソッド [BlackBerry] インデックスの遅延ロードがオンになってい
るかどうかを確認します。

getPageSize メソッド データベースのページサイズ (バイト単位) を
返します。

getRowScoreFlushSize メソッド [BlackBerry] 現在のロースコアのフラッシュサイズを返し
ます。

getRowScoreMaximum メソッド [BlackBerry] 現在のロースコアの最大サイズを返します。

getUserName メソッド [Android] setUserName メソッドで設定されたユーザの
名前を取得します。

hasShadowPaging メソッド [BlackBerry] シャドウページングがオンになっているかど
うかを確認します。

setCacheSize メソッド データベースのキャッシュサイズ (バイト単
位) を設定します。

setConnectionString メソッド [Android] データベースの作成または接続に使用される
接続文字列を設定します。

setCreationString メソッド [Android] データベースを作成するために使用される作
成文字列を設定します。
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名前 説明

setDatabaseName メソッド データベース名を設定します。

setEncryptionKey メソッド 暗号化キーを設定します。

setLazyLoadIndexes メソッド [BlackBerry] 必要なときにインデックスをロードするか、
起動時にすべてのインデックスを一度にロー
ドするかを設定します。

setPageSize メソッド データベースのページサイズを設定します。

setPassword メソッド データベースのパスワードを設定します。

setRowScoreFlushSize メソッド [BlackBerry] 古いローの削除に使用されるスコアを指定す
ることによって、ロー制限を有効にします。

setRowScoreMaximum メソッド [BlackBerry] メモリに保持する最大ロースコアのスレッ
ショルドを設定します。

setUserName メソッド [Android] ユーザの名前を設定します。

備考

デフォルトでは、トランザクションのコミット時またはインデックス作成時、あるいはキャッ
シュされたページがメモリからページングされるときに更新されるシャドウページング永続ス
トアがデータベースに使用されます。

遅延ロード、ロースコアのフラッシュサイズ、ロースコアの最大サイズなどのオプションは、
シャドウページング永続データベースのみに適用されます。

enableAesDBEncryption メソッド
データベースの AES 暗号化を有効にします。

構文

void ConfigPersistent.enableAesDBEncryption()

備考

データベースの作成時またはデータベースへの接続時に DBKEY 接続パラメータを指定するか、
setEncryptionKey メソッドを使用します。

参照

● ConfigPersistent.setEncryptionKey メソッド [Ultra Light J]98 ページ
●「Ultra Light DBKEY 接続パラメータ」『Ultra Light データベース管理とリファレンス』
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enableObfuscation メソッド
データベースの難読化を有効にします。

構文

void ConfigPersistent.enableObfuscation()

getCacheSize メソッド
データベースのキャッシュサイズ (バイト単位) を返します。

構文

int ConfigPersistent.getCacheSize()

戻り値

キャッシュサイズ。

参照

● ConfigPersistent.setCacheSize メソッド [Ultra Light J]96 ページ

getConnectionString メソッド [Android]
setConnectionString メソッドで登録された接続文字列を取得します。

構文

String ConfigPersistent.getConnectionString()

戻り値

SetConnectionString メソッドで登録された接続文字列。

参照

● ConfigPersistent.setConnectionString メソッド [Android] [Ultra Light J]97 ページ

getCreationString メソッド [Android]
setCreationString メソッドで登録された作成文字列を取得します。

構文

String ConfigPersistent.getCreationString()

戻り値

SetCreationString メソッドで登録された作成文字列。
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参照

● ConfigPersistent.setCreationString メソッド [Android] [Ultra Light J]97 ページ

getEncryptionKey メソッド
setEncryptionKey メソッドで登録されたデータベース暗号化キーを取得します。

構文

String ConfigPersistent.getEncryptionKey()

戻り値

setEncryptionKey メソッドで登録されたデータベース暗号化キー

参照

● ConfigPersistent.setEncryptionKey メソッド [Ultra Light J]98 ページ
● Connection.changeEncryptionKey メソッド [Ultra Light J]108 ページ

getLazyLoadIndexes メソッド [BlackBerry]
インデックスの遅延ロードがオンになっているかどうかを確認します。

構文

boolean ConfigPersistent.getLazyLoadIndexes()

戻り値

遅延ロードがオンの場合は true、それ以外の場合は false。

参照

● ConfigPersistent.setLazyLoadIndexes メソッド [BlackBerry] [Ultra Light J]98 ページ

getRowScoreFlushSize メソッド [BlackBerry]
現在のロースコアのフラッシュサイズを返します。

構文

int ConfigPersistent.getRowScoreFlushSize()

戻り値

現在のロースコアのフラッシュサイズ。

参照

● ConfigPersistent.setRowScoreFlushSize メソッド [BlackBerry] [Ultra Light J]99 ページ
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getRowScoreMaximum メソッド [BlackBerry]
現在のロースコアの最大サイズを返します。

構文

int ConfigPersistent.getRowScoreMaximum()

戻り値

現在のロースコアの最大サイズ。

参照

● ConfigPersistent.setRowScoreMaximum メソッド [BlackBerry] [Ultra Light J]99 ページ

getUserName メソッド [Android]
setUserName メソッドで設定されたユーザの名前を取得します。

構文

String ConfigPersistent.getUserName()

戻り値

setUserName メソッドで設定されたユーザの名前。

参照

● ConfigPersistent.setUserName メソッド [Android] [Ultra Light J]100 ページ

hasShadowPaging メソッド [BlackBerry]
シャドウページングがオンになっているかどうかを確認します。

構文

boolean ConfigPersistent.hasShadowPaging()

戻り値

シャドウページングがオンの場合は true、それ以外の場合は false。

setCacheSize メソッド
データベースのキャッシュサイズ (バイト単位) を設定します。

構文

ConfigPersistent ConfigPersistent.setCacheSize(
    int cache_size
) throws ULjException
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パラメータ

● cache_size キャッシュサイズ。すべてのプラットフォームで、デフォルトのキャッシュサ
イズは 20480 (20 KB) です。

戻り値

キャッシュサイズが指定された ConfigPersistent オブジェクト。

備考

キャッシュサイズによって、ページキャッシュに常駐するデータベースのページ数が決まりま
す。サイズを拡大すると、データベースページの読み込みと書き込みの回数が減りますが、
キャッシュ内でページを検索する時間が長くなります。

参照

● ConfigPersistent.getCacheSize メソッド [Ultra Light J]94 ページ

setConnectionString メソッド [Android]
データベースの作成または接続に使用される接続文字列を設定します。

構文

void ConfigPersistent.setConnectionString(String connection_string)

パラメータ

● connection_string データベース接続および作成で使用される接続文字列。

備考

この設定に設定されている他の項目もすべて、データベースの作成または接続のために渡されま
す。

setCreationString メソッド [Android]
データベースを作成するために使用される作成文字列を設定します。

構文

void ConfigPersistent.setCreationString(String creation_string)

パラメータ

● creation_string データベースの作成に使用される作成文字列。

備考

この設定に設定されている他の項目もすべて、データベースの作成のために渡されます。
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setEncryptionKey メソッド
暗号化キーを設定します。

構文

void ConfigPersistent.setEncryptionKey(String encryption_key)

パラメータ

● encryption_key 暗号化キーに使用する文字列。

参照

● ConfigPersistent.getEncryptionKey メソッド [Ultra Light J]95 ページ
● ConfigPersistent.enableAesDBEncryption メソッド [Ultra Light J]93 ページ
● Connection.changeEncryptionKey メソッド [Ultra Light J]108 ページ

setLazyLoadIndexes メソッド [BlackBerry]
必要なときにインデックスをロードするか、起動時にすべてのインデックスを一度にロードする
かを設定します。

構文

ConfigPersistent ConfigPersistent.setLazyLoadIndexes(
    boolean lazy_load
) throws ULjException

パラメータ

● lazy_load 必要なときにインデックスをロードする場合は true、起動時にすべてのインデッ
クスを一度にロードする場合は false に設定します。

戻り値

インデックスのロードスキーマが指定された ConfigPersistent オブジェクト。

備考

このオプションを有効にすると、データベースの起動時間が短くなりますが、その後の操作が低
速になる可能性があります。

遅延ロードをオフにすると、ロースコアのフラッシュサイズがゼロに設定され、ロー制限もオフ
になります。

参照

● ConfigPersistent.getLazyLoadIndexes メソッド [BlackBerry] [Ultra Light J]95 ページ
● ConfigPersistent.setRowScoreFlushSize メソッド [BlackBerry] [Ultra Light J]99 ページ
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setRowScoreFlushSize メソッド [BlackBerry]
古いローの削除に使用されるスコアを指定することによって、ロー制限を有効にします。

構文

ConfigPersistent ConfigPersistent.setRowScoreFlushSize(
    int flushSize
) throws ULjException

パラメータ

● flushSize 削除するロー数の決定に使用されるロースコアの値。デフォルトは 0 (ロー数の
制限なし) です。

戻り値

フラッシュサイズの値が指定された ConfigPersistent オブジェクト。

備考

ロースコアは、最近使用されたローをメモリ内に保持するために使用される、参照を計るもので
す。メモリ内の各ローには、ローのカラム数とそのタイプに基づいてスコアが割り当てられ、カ
ラムで使用できる最大参照数が概算されます。

ほとんどのカラムのスコアは 1 ですが、varchar binary、long binary、UUID のスコアは 2、long
varchar のスコアは 4 になります。

最大ロースコアのスレッショルドに達すると、フラッシュサイズを使用して、削除する古いロー
数が決定されます。

大幅な中断を回避するため、フラッシュサイズ (ロースコアとして測定) を適切な値 (1000 未満)
に保持します。

ロー制限が有効な状態でアクセスされるデータベースでは、常にインデックスが遅延ロードされ
ます。遅延ロードをオフにすると、ロースコアのフラッシュサイズがゼロに設定され、ロー制限
もオフになります。

参照

● ConfigPersistent.setRowScoreMaximum メソッド [BlackBerry] [Ultra Light J]99 ページ
● ConfigPersistent.setLazyLoadIndexes メソッド [BlackBerry] [Ultra Light J]98 ページ

setRowScoreMaximum メソッド [BlackBerry]
メモリに保持する最大ロースコアのスレッショルドを設定します。

構文

ConfigPersistent ConfigPersistent.setRowScoreMaximum(
    int threshold
) throws ULjException
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パラメータ

● threshold スレッショルドの最大値。最大値は 200,000、デフォルト値は 50,000 です。

戻り値

最大スレッショルドの値が指定された ConfigPersistent オブジェクト。

備考

ロー制限が有効な状態でアクセスされるデータベースでは、常にインデックスが遅延ロードされ
ます。

参照

● ConfigPersistent.setRowScoreFlushSize メソッド [BlackBerry] [Ultra Light J]99 ページ
● ConfigPersistent.setLazyLoadIndexes メソッド [BlackBerry] [Ultra Light J]98 ページ

setUserName メソッド [Android]
ユーザの名前を設定します。

構文

void ConfigPersistent.setUserName(String user_name)

パラメータ

● user_name ユーザの名前。

備考

この名前は、接続文字列に UID= 句を使用してネイティブデータベースに接続、またはネイティ
ブデータベースを作成する場合に使用されます。

Configuration インタフェース
データベース用の Configuration オブジェクトを確立します。

構文

public interface Configuration

派生クラス

● ConfigNonPersistent インタフェース [BlackBerry] [Ultra Light J]88 ページ
● ConfigPersistent インタフェース [Ultra Light J]91 ページ

メンバー

継承されたメンバーを含む Configuration インタフェースのすべてのメンバー。

Ultra Light J API リファレンス

100 Copyright © 2013, SAP AG or an SAP affiliate company. - SAP Sybase SQL Anywhere 16.0



名前 説明

getDatabaseName メソッド データベース名を返します。

getPageSize メソッド データベースのページサイズ (バイト単位) を
返します。

setDatabaseName メソッド データベース名を設定します。

setPageSize メソッド データベースのページサイズを設定します。

setPassword メソッド データベースのパスワードを設定します。

備考

一部の属性は、データベースの作成時にのみ使用されます。その他の属性は、データベースへの
最初の接続に適用されます。データベースの作成後、またはデータベースへの接続後に設定され
た属性は無視されます。

getDatabaseName メソッド
データベース名を返します。

構文

String Configuration.getDatabaseName()

戻り値

データベースの名前。

getPageSize メソッド
データベースのページサイズ (バイト単位) を返します。

構文

int Configuration.getPageSize()

戻り値

ページサイズ。

setDatabaseName メソッド
データベース名を設定します。
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構文

Configuration Configuration.setDatabaseName(
    String db_name
) throws ULjException

パラメータ

● db_name データベースの名前。

戻り値

データベース名が指定された Configuration オブジェクト。

setPageSize メソッド
データベースのページサイズを設定します。

構文

Configuration Configuration.setPageSize(
    int page_size
) throws ULjException

パラメータ

● page_size ページサイズ (バイト単位)

戻り値

ページサイズが指定された Configuration オブジェクト。

備考

ページサイズの設定を使用して、永続的なデータベースに格納されるローの最大サイズが決定さ
れます。また、このページサイズによって、インデックスページのサイズが確立され、各ページ
の子の数が決まります。

既存のデータベースを使用する場合は、データベースの作成時のページサイズにすでに設定され
ています。このメソッドを使用して、既存のデータベースのページサイズをリセットすることは
できません。

Android スマートフォンの場合、ページサイズは 1024、2048、4096、8192、または 16384 バイト
に設定できます。デフォルトは 4096 バイトです。

BlackBerry スマートフォンの場合、ページサイズは 256 ～ 16384 バイトの範囲内で設定できま
す。デフォルトは 1024 バイトです。ページサイズは、常に 32 の倍数に調整されます。

setPassword メソッド
データベースのパスワードを設定します。
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構文

Configuration Configuration.setPassword(
    String password
) throws ULjException

パラメータ

● password 新しいデータベースのパスワード、または既存のデータベースにアクセスする
ためのパスワード。

戻り値

データベースパスワードが設定された Configuration オブジェクト。

備考

このパスワードを使用してデータベースへのアクセスが許可されます。このパスワードは、デー
タベースの作成時に指定されたパスワードと一致する必要があります。デフォルトは "dba" で
す。

Connection インタフェース
データベース接続を表します。データベース操作を開始するには接続が必要です。

構文

public interface Connection

メンバー

継承されたメンバーを含む Connection インタフェースのすべてのメンバー。

名前 説明

cancelWaitForEvent メソッド [Android] この Connection オブジェクトの waitForEvent
呼び出しをすべてキャンセルします。

changeEncryptionKey メソッド Ultra Light データベースのデータベース暗号
化キーを変更します。

commit メソッド データベースの変更内容をコミットします。

createDecimalNumber メソッド 新しい DecimalNumber オブジェクトを作成し
ます。

createSyncParms メソッド 同期パラメータセットを作成します。

createUUIDValue メソッド UUID 値を作成します。

dropDatabase メソッド データベースを削除します。

Connection インタフェース

Copyright © 2013, SAP AG or an SAP affiliate company. - SAP Sybase SQL Anywhere 16.0 103



名前 説明

emergencyShutdown メソッド [BlackBerry] 接続しているデータベースを緊急停止しま
す。

getDatabaseId メソッド [BlackBerry] データベース ID の値を返します。

getDatabaseInfo メソッド データベースプロパティに関する情報を含む
DataInfo オブジェクトを返します。

getDatabaseProperty メソッド データベースプロパティを返します。

getLastDownloadTime メソッド 指定されたパブリケーションの最後のダウン
ロードの時刻を返します。

getLastIdentity メソッド DEFAULT AUTOINCREMENT カラムまたは
DEFAULT GLOBAL AUTOINCREMENT カラ
ムに挿入された最新の値が取得されます。最
新の INSERT トランザクションが、このよう
なカラムがないテーブルに対して行われた場
合は 0 になります。

getLastWarning メソッド この接続で最後に実行された SQL 文に関す
る情報を返します。

getOption メソッド [BlackBerry] データベースオプションを返します。

getState メソッド 接続のステータスを返します。

getSyncObserver メソッド この Connection オブジェクトに対して現在登
録されている SyncObserver オブジェクトを返
します。

getSyncResult メソッド 前回の SYNCHRONIZE SQL 文の結果を返し
ます。

isSynchronizationDeleteDisabled メソッド
[BlackBerry]

削除の同期が無効になっているかどうかを確
認します。

prepareStatement メソッド 実行する文を準備します。

registerForEvent メソッド [Android] システムイベントを登録して通知を受信しま
す。

release メソッド この接続を解放します。

resetLastDownloadTime メソッド 指定されたパブリケーションのダウンロード
時刻をリセットします。
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名前 説明

rollback メソッド データベースへの変更を取り消すロールバッ
クをコミットします。

rollbackPartialDownload メソッド [Android] 失敗した同期からの変更をロールバックしま
す。

setDatabaseId メソッド グローバルオートインクリメントのデータ
ベース ID を設定します。

setOption メソッド データベースオプションを設定します。

setSyncObserver メソッド この接続で同期の進行状況をモニタする
SyncObserver オブジェクトを設定します。

synchronize メソッド データベースを Mobile Link サーバと同期さ
せます。

unregisterForEvent メソッド [Android] システムイベントの登録を解除して通知の受
信を停止します。

validateDatabase メソッド [Android] この接続でのデータベースを検証します。

waitForEvent メソッド [Android] イベント通知が発生するまで待ちます。

CONNECTED 変数 接続されている状態を示します。

NOT_CONNECTED 変数 接続されていない状態を示します。

OPTION_BLOB_FILE_BASE_DIR 変数
[BlackBerry]

データベースオプション：blob ファイルの
ベースディレクトリ。

OPTION_DATABASE_ID 変数 [BlackBerry] データベースオプション：データベース ID。

OPTION_DATE_FORMAT 変数 データベースオプション：日付形式。

OPTION_DATE_ORDER 変数 データベースオプション：日付順。

OPTION_MAX_HASH_SIZE 変数 データベースオプション：最大ハッシュサイ
ズ。

OPTION_ML_REMOTE_ID 変数 [BlackBerry] データベースオプション：ML リモート ID。

OPTION_ML_SERVER_VERSION 変数
[BlackBerry]

データベースオプション：Mobile Link サーバ
のプロトコルバージョン。

OPTION_NEAREST_CENTURY 変数 データベースオプション：基準年。
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名前 説明

OPTION_PRECISION 変数 データベースオプション：精度。

OPTION_SCALE 変数 データベースオプション：位取り。

OPTION_TIME_FORMAT 変数 データベースオプション：時間形式。

OPTION_TIMESTAMP_FORMAT 変数 データベースオプション：タイムスタンプ形
式。

OPTION_TIMESTAMP_INCREMENT 変数 データベースオプション：タイムスタンプイ
ンクリメント。

OPTION_TIMESTAMP_WITH_TIME_ZONE_F
ORMAT 変数

データベースオプション：タイムゾーン付き
タイムスタンプ形式。

PROPERTY_DATABASE_NAME 変数 データベースプロパティ：データベース名。

PROPERTY_PAGE_SIZE 変数 データベースプロパティ：ページサイズ。

SYNC_ALL 変数 データベース内の全テーブルの同期を要求す
るために使用するパブリケーションのリスト
です。どのパブリケーションにも含まれない
テーブルも含まれます。

SYNC_ALL_DB_PUB_NAME 変数 SYNC_ALL_DB パブリケーションの予約名
です。

SYNC_ALL_PUBS 変数 データベース内の全パブリケーションの同期
を要求するために使用するパブリケーション
のリストです。

ULVF_DATABASE 変数 [Android] データベースを検証するために使用します。

ULVF_EXPRESS 変数 [Android] 完全ではないが、高速な検証を実行するため
に使用します。

ULVF_FULL_VALIDATE 変数 [Android] データベース上ですべてのタイプの検証を実
行します。

ULVF_INDEX 変数 [Android] インデックスを検証するために使用します。

ULVF_TABLE 変数 [Android] テーブルを検証するために使用します。
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備考

接続は、DatabaseManager クラスの connect メソッドまたは createDatabase メソッドを使用して取
得します。接続が不要になったら release メソッドを使用します。データベースのすべての接続
を解放したら、データベースは終了します。

Connection オブジェクトには、次の機能があります。

●新しいスキーマの作成 (テーブル、インデックス、パブリケーション)

●新しい値とドメインオブジェクトの作成

●データベースへの変更の永続的なコミット

●実行する SQL 文の準備

●コミットされていないデータベースへの変更のロールバック

次の例は、単純なデータベースのために作成された Connection オブジェクト conn を使用して、
このデータベースのスキーマを作成する方法を示しています。データベースにはテーブル T1
と T2 があります。T1 には num という整数のプライマリキーカラムが 1 つあります。T2 には
num という整数のプライマリキーカラムと quantity という整数カラムがあります。T2 の
quantity には追加インデックスがあります。T1 は PubA というパブリケーションに含まれます。

// Assumes a valid connection object, conn, for the current database.

PreparedStatement ps;

ps = conn.prepareStatement( "CREATE TABLE T1 ( num INT NOT NULL PRIMARY KEY )" );
ps.execute();
ps.close();

ps = conn.prepareStatement( "CREATE TABLE T2 ( num INT NOT NULL PRIMARY KEY, quantity 
INT)" );
ps.execute();
ps.close();

ps = conn.prepareStatement( "CREATE INDEX index1 ON T2( quantity )" );
ps.execute();
ps.close();

ps = conn.prepareStatement( "CREATE Publication PubA ( Table T1 )" );
ps.execute();
ps.close();

参照

● DatabaseManager クラス [Ultra Light J]136 ページ
● DatabaseManager.createDatabase メソッド [Ultra Light J]140 ページ
● DatabaseManager.connect メソッド [Ultra Light J]138 ページ
● Connection.release メソッド [Ultra Light J]117 ページ

cancelWaitForEvent メソッド [Android]
この Connection オブジェクトの waitForEvent 呼び出しをすべてキャンセルします。
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構文

void Connection.cancelWaitForEvent() throws ULjException

参照

● Connection.waitForEvent メソッド [Android] [Ultra Light J]122 ページ

changeEncryptionKey メソッド
Ultra Light データベースのデータベース暗号化キーを変更します。

構文

void Connection.changeEncryptionKey(String newKey) throws ULjException

パラメータ

● newKey データベースの新しい暗号化キー。

備考

このメソッドを呼び出すアプリケーションでは、データベースが同期されていること、または信
頼できるバックアップコピーが作成されていることを、先に確認しておく必要があります。
changeEncryptionKey メソッドは、完了させることが必要な操作であるため、信頼できるデータ
ベース バックアップを作成しておくことが重要です。データベース暗号化キーを変更すると、
まずデータベースのすべてのローは古いキーを使用して復号され、次に新しいキーを使用して再
度暗号化されて、書き込まれます。この操作は元に戻せません。暗号化変更処理が完了しなかっ
た場合、データベースは無効な状態のままになり、再度アクセスすることはできなくなります。

commit メソッド
データベースの変更内容をコミットします。

構文

void Connection.commit() throws ULjException

備考

このメソッドを呼び出すと、最後のコミット後またはロールバック後に行われたテーブルデータ
への変更がすべて永続的になります。

createDecimalNumber メソッド
新しい DecimalNumber オブジェクトを作成します。
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オーバーロードリスト

名前 説明

createDecimalNumber(int, int) メソッド DecimalNumber オブジェクトを作成します。

createDecimalNumber(int, int, String) メソッド DecimalNumber オブジェクトを作成します。

createDecimalNumber(int, int) メソッド
DecimalNumber オブジェクトを作成します。

構文

DecimalNumber Connection.createDecimalNumber(
    int precision,
    int scale
) throws ULjException

パラメータ

● precision 数値の桁数。

● scale 数値の小数点以下の桁数。

戻り値

指定された型の DecimalNumber オブジェクト。

参照

● DecimalNumber インタフェース [Ultra Light J]144 ページ

createDecimalNumber(int, int, String) メソッド
DecimalNumber オブジェクトを作成します。

構文

DecimalNumber Connection.createDecimalNumber(
    int precision,
    int scale,
    String value
) throws ULjException

パラメータ

● precision 数値の桁数。

● scale 数値の小数点以下の桁数。

● value 設定する値。
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戻り値

指定された型の DecimalNumber オブジェクト。

参照

● DecimalNumber インタフェース [Ultra Light J]144 ページ

createSyncParms メソッド
同期パラメータセットを作成します。

オーバーロードリスト

名前 説明

createSyncParms(int, String, String) メソッド HTTP 同期用の同期パラメータセットを作成
します。

createSyncParms(String, String) メソッド HTTP 同期用の同期パラメータセットを作成
します。

createSyncParms(int, String, String) メソッド
HTTP 同期用の同期パラメータセットを作成します。

構文

SyncParms Connection.createSyncParms(
    int streamType,
    String userName,
    String version
) throws ULjException

パラメータ

● streamType 同期ストリームのタイプの指定に使用する、SyncParms クラス内で定義されて
いる定数の 1 つ。

● userName Mobile Link ユーザ名。

● version Mobile Link スクリプトのバージョン。

戻り値

SyncParms オブジェクト。

参照

● Connection.createSyncParms メソッド [Ultra Light J]110 ページ
● SyncParms.HTTP_STREAM 変数 [Ultra Light J]266 ページ
● SyncParms.HTTPS_STREAM 変数 [Ultra Light J]266 ページ
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createSyncParms(String, String) メソッド
HTTP 同期用の同期パラメータセットを作成します。

構文

SyncParms Connection.createSyncParms(
    String userName,
    String version
) throws ULjException

パラメータ

● userName このクライアントデータベース用のユニークな Mobile Link ユーザ名。

● version Mobile Link スクリプトのバージョン。

戻り値

SyncParms オブジェクト。

参照

● Connection.createSyncParms メソッド [Ultra Light J]110 ページ
● SyncParms.setUserName メソッド [Ultra Light J]265 ページ

createUUIDValue メソッド
UUID 値を作成します。

構文

UUIDValue Connection.createUUIDValue() throws ULjException

戻り値

ドメインの UUIDValue インスタンス。

dropDatabase メソッド
データベースを削除します。

構文

void Connection.dropDatabase() throws ULjException

備考

接続によって参照されているデータベースを消去し、接続を解放します。削除するデータベース
への有効な接続が、この接続だけである必要があります。
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emergencyShutdown メソッド [BlackBerry]
接続しているデータベースを緊急停止します。

構文

void Connection.emergencyShutdown() throws ULjException

備考

このメソッドは、重大なエラーが発生したときにのみ呼び出してください。物理的なハードウェ
アまたはデータが壊れた場合にのみ使用してください。

このメソッドは、開いている接続をすべて閉じ、接続しているデータベースを停止します。

getDatabaseId メソッド [BlackBerry]
データベース ID の値を返します。

構文

int Connection.getDatabaseId() throws ULjException

戻り値

データベース ID。

例外

● ULjException クラス データベース ID が設定されていない場合。

参照

● Connection.getLastIdentity メソッド [Ultra Light J]113 ページ

getDatabaseInfo メソッド
データベースプロパティに関する情報を含む DataInfo オブジェクトを返します。

構文

DatabaseInfo Connection.getDatabaseInfo() throws ULjException

戻り値

DatabaseInfo オブジェクト。

getDatabaseProperty メソッド
データベースプロパティを返します。
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構文

String Connection.getDatabaseProperty(String name) throws ULjException

パラメータ

● name データベースプロパティの名前。Android デバイスの場合、このパラメータにサポー
ト対象の任意の Ultra Light データベースプロパティ名を設定できます。BlackBerry デバイス
の場合、このパラメータに、接続インタフェース内の PROPERTY_ プレフィクスが付いてい
る任意の定数を設定できます。

戻り値

指定された名前に対応するプロパティの値。

参照

● Connection.PROPERTY_DATABASE_NAME 変数 [Ultra Light J]129 ページ
● Connection.PROPERTY_PAGE_SIZE 変数 [Ultra Light J]129 ページ
●「Ultra Light データベースプロパティ」『Ultra Light データベース管理とリファレンス』

getLastDownloadTime メソッド
指定されたパブリケーションの最後のダウンロードの時刻を返します。

構文

Date Connection.getLastDownloadTime(String pub_name) throws ULjException

パラメータ

● pub_name チェックするパブリケーションの名前。このパラメータは、1 つのパブリケー
ションを参照するか、データベース全体を最後にダウンロードしたときの特殊な
Connection.SYNC_ALL_DB_PUB_NAME パブリケーションである必要があります。

戻り値

最後のダウンロードのタイムスタンプ。

参照

● Connection.SYNC_ALL_DB_PUB_NAME 変数 [Ultra Light J]130 ページ
● Connection.resetLastDownloadTime メソッド [Ultra Light J]117 ページ

getLastIdentity メソッド
DEFAULT AUTOINCREMENT カラムまたは DEFAULT GLOBAL AUTOINCREMENT カラムに
挿入された最新の値が取得されます。最新の INSERT トランザクションが、このようなカラムが
ないテーブルに対して行われた場合は 0 になります。

構文

long Connection.getLastIdentity()
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戻り値

直前に使用した identity の値。

備考

テーブルに複数の (GLOBAL) AUTOINCREMENT 型のカラムが含まれている場合、この値が属し
ているカラムは特定されません。

getLastWarning メソッド
この接続で最後に実行された SQL 文に関する情報を返します。

構文

SQLInfo Connection.getLastWarning()

戻り値

最後に実行された SQL 文の SQLInfo

getOption メソッド [BlackBerry]
データベースオプションを返します。

構文

String Connection.getOption(String option_name) throws ULjException

パラメータ

● option_name 取得するオプションの名前。

● option_name 取得するオプションの名前。このパラメータには、接続インタフェース内
の OPTION_ プレフィクスが付いている任意の定数を設定できます。

戻り値

データベースオプションの値。

備考

データベースオプションはデータベース内に格納され、オプションの設定後にデータベースに接
続したときにも取得できます。

データベースの作成時に、一連の必須オプションが作成されます。

参照

● Connection.setOption メソッド [Ultra Light J]119 ページ

Ultra Light J API リファレンス

114 Copyright © 2013, SAP AG or an SAP affiliate company. - SAP Sybase SQL Anywhere 16.0



getState メソッド
接続のステータスを返します。

構文

byte Connection.getState() throws ULjException

戻り値

接続のステータスを示すバイト数。

備考

次の例は、接続状態を確認し、接続を解放する方法を示しています。

if( _conn.getState() == Connection.CONNECTED ){
    _conn.release();
}

参照

● Connection インタフェース [Ultra Light J]103 ページ

getSyncObserver メソッド
この Connection オブジェクトに対して現在登録されている SyncObserver オブジェクトを返しま
す。

構文

SyncObserver Connection.getSyncObserver()

戻り値

SyncObserver、または observer が存在しない場合は NULL。

参照

● Connection.setSyncObserver メソッド [Ultra Light J]120 ページ

getSyncResult メソッド
前回の SYNCHRONIZE SQL 文の結果を返します。

構文

SyncResult Connection.getSyncResult()

戻り値

前回の SYNCHRONIZE SQL 文の結果を示す SyncResult オブジェクト。
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備考

次に、前回の SYNCHRONIZE SQL 文の結果を取得する例を示します。

PreparedStatement ps = conn.prepareStatement("SYNCHRONIZE PROFILE myprofile");
ps.execute();
ps.close();
SyncResult result = conn.getSyncResult();
display(
    "*** Synchronized *** sent=" + result.getSentRowCount()
    + ", received=" + result.getReceivedRowCount()
);

注意

このメソッドでは、前回の Connection.synchronize メソッド呼び出しの結果は返されません。前
回の Connection.synchronize(SyncParms) メソッド呼び出しの SyncResult オブジェクトを取得する
には、渡された SyncParms オブジェクトで getSyncResult メソッドを使用します。

参照

● SyncResult クラス [Ultra Light J]266 ページ
● SyncParms.getSyncResult メソッド [Ultra Light J]255 ページ

isSynchronizationDeleteDisabled メソッド [BlackBerry]
削除の同期が無効になっているかどうかを確認します。

構文

boolean Connection.isSynchronizationDeleteDisabled()

戻り値

削除の同期が無効になっている場合にのみ、True。

prepareStatement メソッド
実行する文を準備します。

構文

PreparedStatement Connection.prepareStatement(
    String sql
) throws ULjException

パラメータ

● sql 準備する SQL 文。

戻り値

PreparedStatement オブジェクト。
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参照

● PreparedStatement インタフェース [Ultra Light J]179 ページ

registerForEvent メソッド [Android]
システムイベントを登録して通知を受信します。

構文

void Connection.registerForEvent(
    short event_type,
    String object_name
) throws ULjException

パラメータ

● event_type 登録するイベントのタイプ

● object_name イベントを適用するオブジェクト (テーブル名など)。

参照

● ULjEvent インタフェース [Android] [Ultra Light J]282 ページ

release メソッド
この接続を解放します。

構文

void Connection.release() throws ULjException

備考

一度解放した接続は、データベースへのアクセスに使用できなくなります。

コミットされていないトランザクションがある接続を解放しようとするとエラーが発生します。

resetLastDownloadTime メソッド
指定されたパブリケーションのダウンロード時刻をリセットします。

構文

void Connection.resetLastDownloadTime(
    String pub_name
) throws ULjException

パラメータ

● pub_name チェックするパブリケーションの名前。
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備考

データベース全体が同期されたダウンロード時刻をリセットするには、特殊なパブリケーショ
ン Connection.SYNC_ALL_DB_PUB_NAME を使用します。

このメソッドを使用するには、現在の接続に、コミットされていないトランザクションがないこ
とが必要です。

rollback メソッド
データベースへの変更を取り消すロールバックをコミットします。

構文

void Connection.rollback() throws ULjException

備考

このメソッドを呼び出すと、この Connection オブジェクトで、最後のコミット後またはロール
バック後に行われたテーブルデータへの変更がすべて取り消されます。

rollbackPartialDownload メソッド [Android]
失敗した同期からの変更をロールバックします。

構文

void Connection.rollbackPartialDownload() throws ULjException

備考

このメソッドが影響するのは、再開可能なダウンロードだけです
(SyncParms.setKeepPartialDownload を true に設定して同期を実行した場合)。

KeepPartialDownload パラメータが true に設定されていて、同期のダウンロード段階で通信エ
ラーが発生した場合、ダウンロード済みの変更が保持され、ダウンロードが中断された位置から
同期を再開できます。

ダウンロードの再開が必要ない場合は、このメソッドで部分ダウンロードを削除します。

参照

● SyncParms.setKeepPartialDownload メソッド [Android] [Ultra Light J]259 ページ

setDatabaseId メソッド
グローバルオートインクリメントのデータベース ID を設定します。

構文

void Connection.setDatabaseId(int id) throws ULjException
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パラメータ

● id データベース ID。

備考

データベース ID にはデフォルト値はありません。

データベース ID を明示的に設定しないかぎり、INSERT 時に GLOBAL AUTOINCREMENT カラ
ムに NULL 値が挿入されます。

参照

● Connection.getDatabaseId メソッド [BlackBerry] [Ultra Light J]112 ページ

setOption メソッド
データベースオプションを設定します。

構文

void Connection.setOption(
    String option_name,
    String option_value
) throws ULjException

パラメータ

● option_name 設定するオプションの名前。Android デバイスの場合、このパラメータにサ
ポート対象の任意の Ultra Light データベースオプション名を設定できます。BlackBerry デバ
イスの場合、このパラメータに、接続インタフェース内の OPTION_ プレフィクスが付いて
いる任意の定数を設定できます。

● option_value オプションの新しい値。

備考

オプションが現在データベースに格納されていない場合は作成されます。

この接続にコミットされていないトランザクションがあるときに、このメソッドを呼び出すこと
はできません。
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参照

● Connection.getOption メソッド [BlackBerry] [Ultra Light J]114 ページ
● Connection.OPTION_BLOB_FILE_BASE_DIR 変数 [BlackBerry] [Ultra Light J]123 ページ
● Connection.OPTION_DATABASE_ID 変数 [BlackBerry] [Ultra Light J]123 ページ
● Connection.OPTION_DATE_FORMAT 変数 [Ultra Light J]123 ページ
● Connection.OPTION_DATE_ORDER 変数 [Ultra Light J]124 ページ
● Connection.OPTION_ML_REMOTE_ID 変数 [BlackBerry] [Ultra Light J]125 ページ
● Connection.OPTION_NEAREST_CENTURY 変数 [Ultra Light J]125 ページ
● Connection.OPTION_PRECISION 変数 [Ultra Light J]126 ページ
● Connection.OPTION_SCALE 変数 [Ultra Light J]126 ページ
● Connection.OPTION_TIME_FORMAT 変数 [Ultra Light J]127 ページ
● Connection.OPTION_TIMESTAMP_FORMAT 変数 [Ultra Light J]127 ページ
● Connection.OPTION_TIMESTAMP_INCREMENT 変数 [Ultra Light J]128 ページ
● Connection.OPTION_TIMESTAMP_WITH_TIME_ZONE_FORMAT 変数 [Ultra Light

J]128 ページ

setSyncObserver メソッド
この接続で同期の進行状況をモニタする SyncObserver オブジェクトを設定します。

構文

void Connection.setSyncObserver(SyncObserver so)

パラメータ

● so SyncObserver オブジェクト、または現在登録されている SyncObserver オブジェクトを削
除する場合はヌル。

備考

この SyncObserver オブジェクトは、以降の SYNCHRONIZE SQL 文に使用されます。

デフォルトは NULL で、これは observer なしを示します。

参照

● SyncObserver インタフェース [Ultra Light J]242 ページ

synchronize メソッド
データベースを Mobile Link サーバと同期させます。

構文

void Connection.synchronize(SyncParms config) throws ULjException

パラメータ

● config 同期に使用するパラメータが含まれている SyncParms オブジェクト。
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参照

● SyncParms クラス [Ultra Light J]248 ページ

unregisterForEvent メソッド [Android]
システムイベントの登録を解除して通知の受信を停止します。

構文

void Connection.unregisterForEvent(
    short event_type,
    String object_name
) throws ULjException

パラメータ

● event_type 登録を解除するイベントのタイプ。

● object_name イベントを適用するオブジェクト (テーブル名など)。

参照

● ULjEvent インタフェース [Android] [Ultra Light J]282 ページ

validateDatabase メソッド [Android]
この接続でのデータベースを検証します。

構文

void Connection.validateDatabase(
    int flags,
    ValidateDatabaseProgressListener listener,
    String tableName
) throws ULjException

パラメータ

● flags 検証のタイプを制御するフラグ。

● listener 検証の進行状況の情報を受け取るリスナ。

● tableName 検証する特定のテーブル。すべてのテーブルの場合は NULL。

備考

このルーチンに渡されるフラグに応じて、テーブル、インデックス、およびデータベースページ
を検証できます。検証中に情報を受け取るには、コールバック関数を実装し、アドレスをこの
ルーチンに渡します。検証対象を特定のテーブルに限定するには、テーブルの名前または ID を
最後のパラメータとして渡します。

flags パラメータは、次のいずれかの値の組み合わせです。
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●ULVF_TABLE

●ULVF_INDEX

●ULVF_DATABASE

●ULVF_EXPRESS

●ULVF_FULL_VALIDATE

次の例は、エクスプレスモードでのテーブルとインデックスの検証を示します。

flags = ULVF_TABLE | ULVF_INDEX | ULVF_EXPRESS;

参照

● Connection.ULVF_TABLE 変数 [Android] [Ultra Light J]131 ページ
● Connection.ULVF_INDEX 変数 [Android] [Ultra Light J]131 ページ
● Connection.ULVF_DATABASE 変数 [Android] [Ultra Light J]130 ページ
● Connection.ULVF_EXPRESS 変数 [Android] [Ultra Light J]130 ページ
● Connection.ULVF_FULL_VALIDATE 変数 [Android] [Ultra Light J]131 ページ

waitForEvent メソッド [Android]
イベント通知が発生するまで待ちます。

構文

ULjEvent Connection.waitForEvent(int wait_ms) throws ULjException

パラメータ

● wait_ms 返す前に、待機 (ブロック) する時間 (ミリ秒単位)。無限に待機する場合は、-1 に
設定します。

戻り値

待機期間内に発生したイベント。待機期間内に通知を受信しなかった場合は NULL。

備考

この呼び出しは、通知が受信されるか、または指定された待機期間が終了するまでブロックしま
す。待機を取り消す場合は、cancelWaitForEvent メソッドを使用します。

参照

● ULjEvent インタフェース [Android] [Ultra Light J]282 ページ
● Connection.cancelWaitForEvent メソッド [Android] [Ultra Light J]107 ページ

CONNECTED 変数
接続されている状態を示します。
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構文

final byte Connection.CONNECTED

NOT_CONNECTED 変数
接続されていない状態を示します。

構文

final byte Connection.NOT_CONNECTED

OPTION_BLOB_FILE_BASE_DIR 変数 [BlackBerry]
データベースオプション：blob ファイルのベースディレクトリ。

構文

final String Connection.OPTION_BLOB_FILE_BASE_DIR

備考

BlackBerry デバイスの場合、対応するオプションのデフォルト値は "file:///SDCard/"、BlackBerry
デバイス以外の場合は "" です。

参照

● Connection.setOption メソッド [Ultra Light J]119 ページ
●「Ultra Light Java Edition の blob_file_base_dir オプション」『Ultra Light データベース管理とリ

ファレンス』

OPTION_DATABASE_ID 変数 [BlackBerry]
データベースオプション：データベース ID。

構文

final String Connection.OPTION_DATABASE_ID

備考

デフォルト値は指定されません。明示的に割り当てる必要があります。

参照

● Connection.setOption メソッド [Ultra Light J]119 ページ

OPTION_DATE_FORMAT 変数
データベースオプション：日付形式。
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構文

final String Connection.OPTION_DATE_FORMAT

備考

BlackBerry スマートフォンの場合は、この定数を Connection.setOption メソッドで使用します。

Android スマートフォンの場合は、ConfigPersistent.setCreationString メソッドのデータベース作成
文字列のみにこのオプションを設定します。

対応するオプションのデフォルト値は "YYYY-MM-DD" です。

参照

● Connection.setOption メソッド [Ultra Light J]119 ページ
● ConfigPersistent.setCreationString メソッド [Android] [Ultra Light J]97 ページ
●「Ultra Light Java Edition の date_format オプション」『Ultra Light データベース管理とリファレ

ンス』

OPTION_DATE_ORDER 変数
データベースオプション：日付順。

構文

final String Connection.OPTION_DATE_ORDER

備考

BlackBerry スマートフォンの場合は、この定数を Connection.setOption メソッドで使用します。

Android スマートフォンの場合は、このオプションをデータベース作成文字列の中で
ConfigPersistent.setCreationString メソッドにのみ設定します。

対応するオプションのデフォルト値は "YMD" です。

参照

● Connection.setOption メソッド [Ultra Light J]119 ページ
● ConfigPersistent.setCreationString メソッド [Android] [Ultra Light J]97 ページ
●「Ultra Light Java Edition の date_order オプション」『Ultra Light データベース管理とリファレン

ス』

OPTION_MAX_HASH_SIZE 変数
データベースオプション：最大ハッシュサイズ。

構文

final String Connection.OPTION_MAX_HASH_SIZE
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備考

BlackBerry スマートフォンの場合は、Connection.setOption メソッドとともにこの定数を使用し、
MaxHashSize データベースを適切に設定します。

Android スマートフォンの場合は、このオプションをデータベース作成文字列の中で
ConfigPersistent.setCreationString メソッドにのみ設定します。このオプションの名前は
max_hash_size です。

対応するオプションのデフォルト値は "4" です。

インデックスを作成する SQL 文でハッシュサイズが指定されないと、デフォルトとしてこのオ
プションの指定値が使用されます。

参照

● Connection.setOption メソッド [Ultra Light J]119 ページ
● ConfigPersistent.setCreationString メソッド [Android] [Ultra Light J]97 ページ
●「インデックスのハッシュ」『Ultra Light データベース管理とリファレンス』

OPTION_ML_REMOTE_ID 変数 [BlackBerry]
データベースオプション：ML リモート ID。

構文

final String Connection.OPTION_ML_REMOTE_ID

備考

デフォルト値は指定されません。最初の Mobile Link 同期の後で値が設定されます。

参照

● Connection.setOption メソッド [Ultra Light J]119 ページ

OPTION_ML_SERVER_VERSION 変数 [BlackBerry]
データベースオプション：Mobile Link サーバのプロトコルバージョン。

構文

final String Connection.OPTION_ML_SERVER_VERSION

参照

● Connection.setOption メソッド [Ultra Light J]119 ページ

OPTION_NEAREST_CENTURY 変数
データベースオプション：基準年。

Connection インタフェース

Copyright © 2013, SAP AG or an SAP affiliate company. - SAP Sybase SQL Anywhere 16.0 125



構文

final String Connection.OPTION_NEAREST_CENTURY

備考

BlackBerry スマートフォンの場合は、この定数を Connection.setOption メソッドで使用します。

Android スマートフォンの場合は、このオプションをデータベース作成文字列の中で
ConfigPersistent.setCreationString メソッドにのみ設定します。

対応するオプションのデフォルト値は "50" です。

参照

● Connection.setOption メソッド [Ultra Light J]119 ページ
● ConfigPersistent.setCreationString メソッド [Android] [Ultra Light J]97 ページ
●「Ultra Light Java Edition の nearest_century オプション」『Ultra Light データベース管理とリファ

レンス』

OPTION_PRECISION 変数
データベースオプション：精度。

構文

final String Connection.OPTION_PRECISION

備考

BlackBerry スマートフォンの場合は、この定数を Connection.setOption メソッドで使用します。

Android スマートフォンの場合は、このオプションをデータベース作成文字列の中で
ConfigPersistent.setCreationString メソッドにのみ設定します。

対応するオプションのデフォルト値は "30" です。

参照

● Connection.setOption メソッド [Ultra Light J]119 ページ
● ConfigPersistent.setCreationString メソッド [Android] [Ultra Light J]97 ページ
●「Ultra Light Java Edition の precision オプション」『Ultra Light データベース管理とリファレン

ス』

OPTION_SCALE 変数
データベースオプション：位取り。

構文

final String Connection.OPTION_SCALE
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備考

BlackBerry スマートフォンの場合は、この定数を Connection.setOption メソッドで使用します。

Android スマートフォンの場合は、このオプションをデータベース作成文字列の中で
ConfigPersistent.setCreationString メソッドにのみ設定します。

対応するオプションのデフォルト値は "6" です。

参照

● Connection.setOption メソッド [Ultra Light J]119 ページ
● ConfigPersistent.setCreationString メソッド [Android] [Ultra Light J]97 ページ
●「Ultra Light Java Edition の scale オプション」『Ultra Light データベース管理とリファレンス』

OPTION_TIME_FORMAT 変数
データベースオプション：時間形式。

構文

final String Connection.OPTION_TIME_FORMAT

備考

BlackBerry スマートフォンの場合は、この定数を Connection.setOption メソッドで使用します。

Android スマートフォンの場合は、このオプションをデータベース作成文字列の中で
ConfigPersistent.setCreationString メソッドにのみ設定します。

対応するオプションのデフォルト値は "HH:NN:SS.SSS" です。

参照

● Connection.setOption メソッド [Ultra Light J]119 ページ
● ConfigPersistent.setCreationString メソッド [Android] [Ultra Light J]97 ページ
●「Ultra Light Java Edition の time_format オプション」『Ultra Light データベース管理とリファレ

ンス』

OPTION_TIMESTAMP_FORMAT 変数
データベースオプション：タイムスタンプ形式。

構文

final String Connection.OPTION_TIMESTAMP_FORMAT

備考

BlackBerry スマートフォンの場合は、この定数を Connection.setOption メソッドで使用します。

Android スマートフォンの場合は、このオプションをデータベース作成文字列の中で
ConfigPersistent.setCreationString メソッドにのみ設定します。
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対応するオプションのデフォルト値は "YYYY-MM-DD HH:NN:SS.SSS" です。

参照

● Connection.setOption メソッド [Ultra Light J]119 ページ
● ConfigPersistent.setCreationString メソッド [Android] [Ultra Light J]97 ページ
●「Ultra Light Java Edition の timestamp_format オプション」『Ultra Light データベース管理とリ

ファレンス』

OPTION_TIMESTAMP_INCREMENT 変数
データベースオプション：タイムスタンプインクリメント。

構文

final String Connection.OPTION_TIMESTAMP_INCREMENT

備考

BlackBerry スマートフォンの場合は、この定数を Connection.setOption メソッドで使用します。

Android スマートフォンの場合は、このオプションをデータベース作成文字列の中で
ConfigPersistent.setCreationString メソッドにのみ設定します。

対応するオプションのデフォルト値は "1" です。

参照

● Connection.setOption メソッド [Ultra Light J]119 ページ
● ConfigPersistent.setCreationString メソッド [Android] [Ultra Light J]97 ページ
●「Ultra Light Java Edition の timestamp_increment オプション」『Ultra Light データベース管理と

リファレンス』

OPTION_TIMESTAMP_WITH_TIME_ZONE_FORMAT 変数
データベースオプション：タイムゾーン付きタイムスタンプ形式。

構文

final String Connection.OPTION_TIMESTAMP_WITH_TIME_ZONE_FORMAT

備考

BlackBerry スマートフォンの場合は、この定数を Connection.setOption メソッドで使用します。

Android スマートフォンの場合は、このオプションをデータベース作成文字列の中で
ConfigPersistent.setCreationString メソッドにのみ設定します。

対応するオプションのデフォルト値は "YYYY-MM-DD HH:NN:SS.SSS+HH:NN" です。
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参照

● Connection.setOption メソッド [Ultra Light J]119 ページ
● ConfigPersistent.setCreationString メソッド [Android] [Ultra Light J]97 ページ
●「Ultra Light Java Edition の timestamp_with_time_zone_format オプション」『Ultra Light データ

ベース管理とリファレンス』

PROPERTY_DATABASE_NAME 変数
データベースプロパティ：データベース名。

構文

final String Connection.PROPERTY_DATABASE_NAME

備考

Configuration.setDatabaseName メソッドでこのプロパティを設定します。

参照

● Configuration.setDatabaseName メソッド [Ultra Light J]101 ページ
● Connection.getDatabaseProperty メソッド [Ultra Light J]112 ページ

PROPERTY_PAGE_SIZE 変数
データベースプロパティ：ページサイズ。

構文

final String Connection.PROPERTY_PAGE_SIZE

備考

Configuration.setPageSize メソッドでこのプロパティを設定します。

参照

● Configuration.setPageSize メソッド [Ultra Light J]102 ページ
● Connection.getDatabaseProperty メソッド [Ultra Light J]112 ページ

SYNC_ALL 変数
データベース内の全テーブルの同期を要求するために使用するパブリケーションのリストです。
どのパブリケーションにも含まれないテーブルも含まれます。

構文

final String Connection.SYNC_ALL
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備考

NoSync と指定されているテーブルは同期されません。

この定数は、NULL 参照または空の文字列と同じです。

SYNC_ALL_DB_PUB_NAME 変数
SYNC_ALL_DB パブリケーションの予約名です。

構文

final String Connection.SYNC_ALL_DB_PUB_NAME

参照

● Connection.getLastDownloadTime メソッド [Ultra Light J]113 ページ
● Connection.resetLastDownloadTime メソッド [Ultra Light J]117 ページ

SYNC_ALL_PUBS 変数
データベース内の全パブリケーションの同期を要求するために使用するパブリケーションのリ
ストです。

構文

final String Connection.SYNC_ALL_PUBS

備考

NoSync と指定されているテーブルは同期されません。

ULVF_DATABASE 変数 [Android]
データベースを検証するために使用します。

構文

final int Connection.ULVF_DATABASE

備考

ページのチェックサムやその他のチェックを使用してデータベースページを検証します。

参照

● Connection.validateDatabase メソッド [Android] [Ultra Light J]121 ページ

ULVF_EXPRESS 変数 [Android]
完全ではないが、高速な検証を実行するために使用します。
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構文

final int Connection.ULVF_EXPRESS

備考

このフラグは他のフラグと組み合わせることで動作を変更させます。

参照

● Connection.validateDatabase メソッド [Android] [Ultra Light J]121 ページ

ULVF_FULL_VALIDATE 変数 [Android]
データベース上ですべてのタイプの検証を実行します。

構文

final int Connection.ULVF_FULL_VALIDATE

参照

● Connection.validateDatabase メソッド [Android] [Ultra Light J]121 ページ

ULVF_INDEX 変数 [Android]
インデックスを検証するために使用します。

構文

final int Connection.ULVF_INDEX

備考

インデックスの整合性をチェックします。

参照

● Connection.validateDatabase メソッド [Android] [Ultra Light J]121 ページ

ULVF_TABLE 変数 [Android]
テーブルを検証するために使用します。

構文

final int Connection.ULVF_TABLE

備考

テーブルとインデックスのローカウントが一致しているかどうかをチェックします。
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参照

● Connection.validateDatabase メソッド [Android] [Ultra Light J]121 ページ

DatabaseInfo インタフェース
Connection オブジェクトに関連付けられ、データベース情報を公開するメソッドを提供します。

構文

public interface DatabaseInfo

メンバー

継承されたメンバーを含む DatabaseInfo インタフェースのすべてのメンバー。

名前 説明

getCommitCount メソッド [BlackBerry] データベースに対して実行されたコミット操
作の合計数を返します。

getDbFormat メソッド [BlackBerry] データベースのバージョン番号を返します。

getDbSize メソッド [BlackBerry] データベースサイズを返します。

getLogSize メソッド [BlackBerry] トランザクションログの合計サイズ (バイト
単位) を返します。

getNumberRowsToUpload メソッド アップロードを待機しているローの数を返し
ます。

getPageReads メソッド ページの読み込み数を返します。

getPageSize メソッド データベースのページサイズ (バイト単位) を
返します。

getPageWrites メソッド ページの書き込み数を返します。

getRelease メソッド ソフトウェアのリリース番号を返します。

備考

このインタフェースは、Connection オブジェクトの getDatabaseInfo メソッドを使用して呼び出し
ます。

参照

● Connection インタフェース [Ultra Light J]103 ページ
● Connection.getDatabaseInfo メソッド [Ultra Light J]112 ページ
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getCommitCount メソッド [BlackBerry]
データベースに対して実行されたコミット操作の合計数を返します。

構文

int DatabaseInfo.getCommitCount()

戻り値

コミット操作の合計数。

getDbFormat メソッド [BlackBerry]
データベースのバージョン番号を返します。

構文

int DatabaseInfo.getDbFormat()

戻り値

バージョン番号。

getDbSize メソッド [BlackBerry]
データベースサイズを返します。

構文

int DatabaseInfo.getDbSize()

戻り値

データベースが永続的でない場合は -1。これ以外の場合は、永続ストアの現在のサイズが返され
ます。

getLogSize メソッド [BlackBerry]
トランザクションログの合計サイズ (バイト単位) を返します。

構文

int DatabaseInfo.getLogSize()

戻り値

トランザクションログのサイズ。
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getNumberRowsToUpload メソッド
アップロードを待機しているローの数を返します。

オーバーロードリスト

名前 説明

getNumberRowsToUpload() メソッド アップロードを待機しているローの数を返し
ます。

getNumberRowsToUpload(String, int) メソッド
[Android]

指定したスレッショルドまでアップロードを
待機しているローの数を返します。

getNumberRowsToUpload() メソッド
アップロードを待機しているローの数を返します。

構文

int DatabaseInfo.getNumberRowsToUpload()

戻り値

ローの数。

getNumberRowsToUpload(String, int) メソッド [Android]
指定したスレッショルドまでアップロードを待機しているローの数を返します。

構文

int DatabaseInfo.getNumberRowsToUpload(String pubList, int threshold)

パラメータ

● pubList チェック対象となるパブリケーションのカンマ区切りのリストを含む文字列。空
の文字列 (UL_SYNC_ALL マクロ) は、no sync とマーク付けされたものを除くすべてのテー
ブルを表します。アスタリスクのみの文字列 (UL_SYNC_ALL_PUBS マクロ) は、いずれかの
パブリケーションで参照されているすべてのテーブルを表します。一部のテーブルは、どの
パブリケーションの一部でもないため、この値が * の場合は含まれません。

● threshold カウントするローの最大数。この呼び出しの所要時間を制限します。threshold
が 0 の場合、制限はありません (つまり、同期する必要のあるすべてのローをカウントしま
す)。threshold が 1 の場合、同期の必要なローがあるかどうかを簡単に判別するために使用で
きます。

戻り値

指定されたパブリケーションのセットまたはデータベース全体のいずれかで、同期を必要とする
ローの数。
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getPageReads メソッド
ページの読み込み数を返します。

構文

int DatabaseInfo.getPageReads()

戻り値

ページ読み込み数。

備考

Android の場合、この数はページ読み込みの累積合計であり、このクラスのインスタンス変数に
格納されます。Blackberry と J2SE の場合、この数はページ読み込みの累積合計であり、データ
ベースに格納されます。

getPageSize メソッド
データベースのページサイズ (バイト単位) を返します。

構文

int DatabaseInfo.getPageSize()

戻り値

ページサイズ。

getPageWrites メソッド
ページの書き込み数を返します。

構文

int DatabaseInfo.getPageWrites()

戻り値

ページ書き込み数。Android の場合、この数はページ書き込みの累積合計であり、このクラスの
インスタンス変数に格納されます。Blackberry と J2SE の場合、この数はページ書き込みの累積
合計であり、データベースに格納されます。

getRelease メソッド
ソフトウェアのリリース番号を返します。

構文

String DatabaseInfo.getRelease()
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戻り値

リリース番号。

備考

たとえば、ソフトウェアリリースの値 "12.0.1.1234" は、リリースが 12.0.1、ビルド番号が 1234
であることを示します。

DatabaseManager クラス
基本設定を取得したり、新しいデータベースを作成したり、既存のデータベースに接続したりす
るための静的メソッドを提供します。

構文

public class DatabaseManager

メンバー

継承されたメンバーを含む DatabaseManager クラスのすべてのメンバー。

名前 説明

connect メソッド 設定に基づいて既存のデータベースに接続し
ます。

createConfigurationNonPersistent メソッド
[BlackBerry]

非永続的なデータベースストア用の
Configuration オブジェクトを作成し、
ConfigNonPersist オブジェクトを返します。

createConfigurationObjectStore メソッド
[BlackBerry]

RIM オブジェクトストア用の Configuration
オブジェクトを作成し、ConfigObjectStore オ
ブジェクトを返します。

createDatabase メソッド 設定セットに基づいて新しいデータベースを
作成し、データベースに接続します。

createFileTransfer メソッド Mobile Link との間でファイルを転送するた
めの FileTransfer オブジェクトを作成します。

createFileTransferAndroid メソッド [Android] Mobile Link との間でファイルを転送するた
めの FileTransfer オブジェクトを作成します。

createObjectStoreTransfer メソッド
[BlackBerry]

Mobile Link との間で Ultra Light Java Edition
データベースを転送し、RIM オブジェクトス
トアに格納するための FileTransfer オブジェ
クトを作成します。
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名前 説明

createSISHTTPListener メソッド [BlackBerry] サーバ起動同期用の SISListener オブジェクト
を作成します。

release メソッド DatabaseManager オブジェクトを閉じてすべ
ての接続を解放し、すべてのデータベースを
停止します。

setErrorLanguage メソッド エラーメッセージに使用する言語を設定しま
す。

備考

次の例は、J2SE プラットフォーム上で既存のデータベースを開く方法、または存在しない場合
に新規のデータベースを作成する方法を示しています。

Connection conn;
ConfigFile config = DatabaseManager.createConfigurationFile(
        "test.ulj"
    );
try {
    conn = DatabaseManager.connect(config);
} catch(ULjException ex) {
    conn = DatabaseManager.createDatabase(config);
    // Create the schema here.
}

次の例は、BlackBerry デバイス上で既存のデータベースを開く方法、または存在しない場合に新
規のデータベースを作成する方法を示しています。

Connection conn;
ConfigObjectStore config = DatabaseManager.createConfigurationObjectStore(
        "test.ulj"
    );
try {
    conn = DatabaseManager.connect(config);
} catch(ULjException ex) {
    conn = DatabaseManager.createDatabase(config);
    // Create the schema here.
}

次の例は、Android デバイス上で既存のデータベースを開く方法、または存在しない場合に新規
のデータベースを作成する方法を示しています。

Connection conn = null;
ConfigFileAndroid config = null;

try {
    config = DatabaseManager.createConfigurationFileAndroid(
         "test.udb", getApplicationContext()
    );
    conn = DatabaseManager.connect(config);
} catch(ULjException ex) {
    if (config != null) {
        try {
            conn = DatabaseManager.createDatabase(config);
            // Create the schema here.
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        } catch(ULjException exception) {
            // An error has occurred.
        }
    }
}

参照

● Connection インタフェース [Ultra Light J]103 ページ
● Configuration インタフェース [Ultra Light J]100 ページ

connect メソッド
設定に基づいて既存のデータベースに接続します。

構文

Connection DatabaseManager.connect(
    Configuration config
) throws ULjException

パラメータ

● config 既存のデータベースの仕様が含まれている Configuration オブジェクト。

戻り値

データベースへの接続を確立する Connection オブジェクト。

備考

1 つの Ultra Light Java データベースに同時に接続できるアプリケーションは 1 つだけです。

参照

● Configuration インタフェース [Ultra Light J]100 ページ
● Connection インタフェース [Ultra Light J]103 ページ
●「Ultra Light および Ultra Light Java Edition のデータベースの作成および接続方法」5 ページ

createConfigurationFile メソッド
ファイルから物理データベースストア用の Configuration オブジェクトを作成し、ConfigFile オブ
ジェクトを返します。

構文

ConfigFile DatabaseManager.createConfigurationFile(
    String file_name
) throws ULjException

パラメータ

● file_name 使用または作成するファイルの名前。
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戻り値

データベースの設定に使用された ConfigFile オブジェクト。

参照

● ConfigFile インタフェース [Ultra Light J]85 ページ

createConfigurationFileAndroid メソッド
Android デバイス上のファイルから物理データベースストア用の Configuration オブジェクトを
作成し、ConfigFileAndroid オブジェクトを返します。

構文

ConfigFileAndroid DatabaseManager.createConfigurationFileAndroid(
    String file_name,
    android.content.Context context
) throws ULjException

パラメータ

● file_name 使用または作成するデータベースファイルの名前。データベースパスへのアク
セス権があること。このファイルのデフォルトパスは、/data/data/your-application-package-
name/ です。your-application-package-name はアプリケーションに割り当てたパッケージ名で
す。ファイル名に絶対パスを含めることでデータベースの別の場所を指定できます。

● context Android アプリケーションからの Context オブジェクト。このパラメータを NULL
にすることはできません。

戻り値

データベースの設定に使用された ConfigFileAndroid オブジェクト。

参照

● ConfigFileAndroid インタフェース [Android] [Ultra Light J]87 ページ

createConfigurationNonPersistent メソッド [BlackBerry]
非永続的なデータベースストア用の Configuration オブジェクトを作成し、ConfigNonPersist オブ
ジェクトを返します。

構文

ConfigNonPersistent DatabaseManager.createConfigurationNonPersistent(
    String db_name
) throws ULjException

パラメータ

● db_name 非永続的なデータベースの名前。
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戻り値

データベースの設定に使用された ConfigNonPersistent オブジェクト。

参照

● ConfigNonPersistent インタフェース [BlackBerry] [Ultra Light J]88 ページ

createConfigurationObjectStore メソッド [BlackBerry]
RIM オブジェクトストア用の Configuration オブジェクトを作成し、ConfigObjectStore オブジェク
トを返します。

構文

ConfigObjectStore DatabaseManager.createConfigurationObjectStore(
    String db_name
) throws ULjException

パラメータ

● db_name データベースの名前。

戻り値

データベースの設定に使用された ConfigObjectStore オブジェクト。

参照

● ConfigObjectStore インタフェース [BlackBerry] [Ultra Light J]89 ページ

createDatabase メソッド
設定セットに基づいて新しいデータベースを作成し、データベースに接続します。

構文

Connection DatabaseManager.createDatabase(
    Configuration config
) throws ULjException

パラメータ

● config 新規のデータベースの仕様が含まれている Configuration オブジェクト。

戻り値

新規のデータベースへの接続を確立する Connection オブジェクト。

備考

このメソッドは、デバイス上の同じ名前の既存データベースを置換します。
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参照

● Configuration インタフェース [Ultra Light J]100 ページ
● Connection インタフェース [Ultra Light J]103 ページ

createFileTransfer メソッド
Mobile Link との間でファイルを転送するための FileTransfer オブジェクトを作成します。

構文

FileTransfer DatabaseManager.createFileTransfer(
    String fileName,
    int streamType,
    String userName,
    String version
) throws ULjException

パラメータ

● fileName 転送するサーバファイルの名前。このパラメータにパス情報を含めることはで
きません。

● streamType 通信ストリームタイプの識別に使用する、SyncParms クラス内で定義されてい
る定数の 1 つ。

● userName Mobile Link ユーザ名。

● version Mobile Link スクリプトのバージョン。

戻り値

FileTransfer オブジェクト。

参照

● SyncParms クラス [Ultra Light J]248 ページ

createFileTransferAndroid メソッド [Android]
Mobile Link との間でファイルを転送するための FileTransfer オブジェクトを作成します。

構文

FileTransfer DatabaseManager.createFileTransferAndroid(
    android.content.Context context,
    String fileName,
    int streamType,
    String userName,
    String version
) throws ULjException
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パラメータ

● context Android アプリケーションからの Context オブジェクト。このパラメータを NULL
にすることはできません。

● fileName 転送するサーバファイルの名前。このパラメータにパス情報を含めることはで
きません。

● streamType 通信ストリームタイプの識別に使用する、SyncParms クラス内で定義されてい
る定数の 1 つ。

● userName Mobile Link ユーザ名。

● version Mobile Link スクリプトのバージョン。

戻り値

FileTransfer オブジェクト。

備考

Android には、このメソッドを推奨します。createConfigurationFileAndroid メソッドでデータベー
ス接続が作成されていない場合はこのメソッドを使用する必要があります。

参照

● DatabaseManager.createConfigurationFileAndroid メソッド [Ultra Light J]139 ページ

createObjectStoreTransfer メソッド [BlackBerry]
Mobile Link との間で Ultra Light Java Edition データベースを転送し、RIM オブジェクトストアに
格納するための FileTransfer オブジェクトを作成します。

構文

FileTransfer DatabaseManager.createObjectStoreTransfer(
    String fileName,
    int streamType,
    String userName,
    String version
) throws ULjException

パラメータ

● fileName 転送するサーバファイルの名前。このパラメータにパス情報を含めることはで
きません。

● streamType 通信ストリームタイプの識別に使用する、SyncParms クラス内で定義されてい
る定数の 1 つ。

● userName Mobile Link ユーザ名。

● version Mobile Link スクリプトのバージョン。
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戻り値

FileTransfer オブジェクト。

参照

● SyncParms クラス [Ultra Light J]248 ページ

createSISHTTPListener メソッド [BlackBerry]
サーバ起動同期用の SISListener オブジェクトを作成します。

構文

SISListener DatabaseManager.createSISHTTPListener(
    SISRequestHandler handler,
    int port,
    String httpOptions
) throws ULjException

パラメータ

● handler サーバ起動同期要求を処理するために指定された SISRequestHandler オブジェク
ト。

● port サーバメッセージを受信する HTTP ポート。

● httpOptions サーバに接続するための HTTP オプション。

戻り値

サーバ起動同期に使用される SISListener オブジェクト。

備考

推奨されるポート設定は 4400 です。

BlackBerry シミュレータに推奨される HTTP オプションは "deviceside=false" です。

BlackBerry HTTP SISListener の Mobile Link .側では、BES 対応デバイスなどの BlackBerry
Enterprise Server にターゲットデバイスを関連付ける必要があります。

release メソッド
DatabaseManager オブジェクトを閉じてすべての接続を解放し、すべてのデータベースを停止し
ます。

構文

void DatabaseManager.release() throws ULjException

備考

Android では、このメソッドは DatabaseManager で作成されたすべての接続を解放します。

DatabaseManager クラス
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コミットされていないトランザクションはロールバックされます。

setErrorLanguage メソッド
エラーメッセージに使用する言語を設定します。

構文

void DatabaseManager.setErrorLanguage(String lang)

パラメータ

● lang 2 文字で表される言語コード。

備考

認識される言語は EN、DE、FR、JA、ZH です。指定された言語を認識できなかった場合は、デ
フォルトの言語である EN に戻ります。

J2SE と BlackBerry の各環境では、現在のロケールを使用してデフォルトの言語が決定されます。

DecimalNumber インタフェース
正確な decimal 値を表し、java.math.BigDecimal を使用できない Java プラットフォームに 10 進法
計算のサポートを提供します。

構文

public interface DecimalNumber

メンバー

継承されたメンバーを含む DecimalNumber インタフェースのすべてのメンバー。

名前 説明

add メソッド 2 つの DecimalNumber オブジェクトを加算
し、その和を返します。

divide メソッド 最初の DecimalNumber オブジェクトを 2 番目
の DecimalNumber オブジェクトで割って、そ
の商を返します。

getString メソッド DecimalNumber オブジェクトの String 表現を
返します。

isNull メソッド DecimalNumber オブジェクトが NULL かどう
かを確認します。
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名前 説明

multiply メソッド 2 つの DecimalNumber オブジェクトを乗算
し、その積を返します。

set メソッド DecimalNumber オブジェクトに String 値を設
定します。

setNull メソッド DecimalNumber オブジェクトを NULL に設定
します。

subtract メソッド 2 番目の DecimalNumber オブジェクトを最初
の DecimalNumber オブジェクトから減算し、
その差を返します。

add メソッド
2 つの DecimalNumber オブジェクトを加算し、その和を返します。

構文

DecimalNumber DecimalNumber.add(
    DecimalNumber num1,
    DecimalNumber num2
) throws ULjException

パラメータ

● num1 1 つの数値。

● num2 別の数値。

戻り値

num1 と num2 の和。

divide メソッド
最初の DecimalNumber オブジェクトを 2 番目の DecimalNumber オブジェクトで割って、その商
を返します。

構文

DecimalNumber DecimalNumber.divide(
    DecimalNumber num1,
    DecimalNumber num2
) throws ULjException

パラメータ

● num1 被除数。

DecimalNumber インタフェース
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● num2 除数。

戻り値

num1 を num2 で割った商。

getString メソッド
DecimalNumber オブジェクトの String 表現を返します。

構文

String DecimalNumber.getString() throws ULjException

戻り値

String 値。

isNull メソッド
DecimalNumber オブジェクトが NULL かどうかを確認します。

構文

boolean DecimalNumber.isNull()

戻り値

オブジェクトが NULL の場合は true、NULL 以外の場合は false。

multiply メソッド
2 つの DecimalNumber オブジェクトを乗算し、その積を返します。

構文

DecimalNumber DecimalNumber.multiply(
    DecimalNumber num1,
    DecimalNumber num2
) throws ULjException

パラメータ

● num1 被乗数。

● num2 乗数。

戻り値

num1 と num2 の積。
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set メソッド
DecimalNumber オブジェクトに String 値を設定します。

構文

void DecimalNumber.set(String value) throws ULjException

パラメータ

● value String として表した数値。

setNull メソッド
DecimalNumber オブジェクトを NULL に設定します。

構文

void DecimalNumber.setNull() throws ULjException

subtract メソッド
2 番目の DecimalNumber オブジェクトを最初の DecimalNumber オブジェクトから減算し、その差
を返します。

構文

DecimalNumber DecimalNumber.subtract(
    DecimalNumber num1,
    DecimalNumber num2
) throws ULjException

パラメータ

● num1 被減数。

● num2 減数。

戻り値

num1 と num2 の差。

Domain インタフェース
テーブル内のカラムの Domain オブジェクトの型情報を表します。

構文

public interface Domain

Domain インタフェース
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メンバー

継承されたメンバーを含む Domain インタフェースのすべてのメンバー。

名前 説明

BIG 変数 64 ビット整数 (BIGINT SQL 型) のドメイン
ID 定数です。

BINARY 変数 最大 size バイトの可変長のバイナリオブジェ
クト (BINARY (size) SQL 型) のドメイン ID
定数です。

BIT 変数 ビット (BIT SQL 型) のドメイン ID 定数です。

DATE 変数 日付 (DATE SQL 型) のドメイン ID 定数で
す。

DOMAIN_MAX 変数 Domain 型の最大数です。

DOUBLE 変数 8 バイトの浮動小数点数 (DOUBLE SQL 型)
のドメイン ID 定数です。

INTEGER 変数 32 ビット整数 (INTEGER SQL 型) のドメイン
ID 定数です。

LONGBINARY 変数 任意の長いブロックのバイナリデータ
(BLOB) (LONG BINARY SQL 型) のドメイン
ID 定数です。

LONGBINARYFILE 変数 任意のデータファイルのドメイン ID 定数で
す。

LONGVARCHAR 変数 任意の長いブロックの文字データ (CLOB)
(LONG VARCHAR SQL 型) のドメイン ID 定
数です。

NUMERIC 変数 合計桁数が固定 precision (サイズ)、小数点以
下の桁数が scale 桁の数値
(NUMERIC(precision,scale) SQL 型) のドメイ
ン ID 定数です。

REAL 変数 4 バイトの浮動小数点数 (REAL SQL 型) のド
メイン ID 定数です。

SHORT 変数 16 ビット整数 (SMALLINT SQL 型) のドメイ
ン ID 定数です。

ST_GEOMETRY 変数 ジオメトリ (GEOMETRY SQL 型) のドメイン
ID 定数です。
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名前 説明

TIME 変数 時刻 (TIME SQL 型) のドメイン ID 定数です。

TIMESTAMP 変数 タイムスタンプ (TIMESTAMP SQL 型) のド
メイン ID 定数です。

TIMESTAMP_ZONE 変数 タイムゾーン付きタイムスタンプ
(DATETIMEOFFSET SQL 型) のドメイン ID
定数です。

TINY 変数 符号なし 8 ビット整数 (TINYINT SQL 型) の
ドメイン ID 定数です。

UNSIGNED_BIG 変数 符号なし 64 ビット整数 (UNSIGNED BIGINT
SQL 型) のドメイン ID 定数です。

UNSIGNED_INTEGER 変数 符号なし 32 ビット整数 (UNSIGNED
INTEGER SQL 型) のドメイン ID 定数です。

UNSIGNED_SHORT 変数 符号なし 16 ビット整数 (UNSIGNED
SMALLINT SQL 型) のドメイン ID 定数です。

UUID 変数 UniqueIdentifier (UNIQUEIDENTIFIER SQL
型) のドメイン ID 定数です。

VARCHAR 変数 最大 size バイトの可変長文字オブジェクト
(VARCHAR (size) SQL 型) のドメイン ID 定数
です。

備考

このインタフェースには、さまざまなドメインを表す定数と、Domain オブジェクトから情報を
抽出するためのメソッドがあります。

単純なデータベースのスキーマの作成例については、Connection インタフェースを参照してくだ
さい。

型は次のように分類できます。

整数型：

ドメイン定数 SQL 型 値の範囲

BIT BIT 0 または 1

TINY TINYINT 0 ～ 255 (1 バイトの記憶領域
を使用する符号なし整数)

Domain インタフェース
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ドメイン定数 SQL 型 値の範囲

SHORT SMALLINT -32768 ～ 32767 (2 バイトの
記憶領域を使用する符号付き
整数)

UNSIGNED_SHORT UNSIGNED SMALLINT 0 ～ 65535 (2 バイトの記憶領
域を使用する符号なし整数)

INTEGER INTEGER -231 ～ 231 - 1、または
-2147483648 ～ 2147483647 (4
バイトの記憶領域を使用する
符号付き整数)

UNSIGNED_INTEGER UNSIGNED INTEGER 0 ～ 232 - 1、または 0 ～
4294967295 (4 バイトの記憶
領域を使用する符号なし整
数)

BIG BIGINT -263 ～ 263 - 1、または
-9223372036854775808 ～
9223372036854775807 (8 バイ
トの記憶領域を使用する符号
付き整数)

UNSIGNED_BIG UNSIGNED BIGINT 0 ～ 264 - 1、または 0 ～
18446744073709551615 (8 バ
イトの記憶領域を使用する符
号なし整数)

整数以外の数値型：

ドメイン定数 SQL 型 値の範囲

REAL REAL -3.402823e+38 ～ 3.402823e
+38、0 に最も近い最小の数値
は 1.175495e-38 (4 バイトの記
憶領域を使用する単精度の浮
動小数点数、6 桁目の後に丸
め誤差が生じる可能性があり
ます)
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ドメイン定数 SQL 型 値の範囲

DOUBLE DOUBLE -1.79769313486231e+308 ～
1.79769313486231e+308、0 に
最も近い最小の数値は
2.22507385850721e-308 (8 バ
イトの記憶領域を使用する単
精度の浮動小数点数、15 桁目
の後に丸め誤差が生じる可能
性があります)

NUMERIC NUMERIC(precision,scale) 合計桁数が precision (サイ
ズ)、小数点以下の桁数が
scale 桁の任意の 10 進数
(precision 内の丸めなし)

文字型とバイナリ型：

ドメイン定数 SQL 型 サイズの範囲

VARCHAR VARCHAR(size) 1 ～ 32767 バイト (文字は 1
～ 3 バイトの UTF-8 文字と
して格納)。式を評価すると
きのテンポラリ文字値の最大
長は 2048 バイトです。

LONGVARCHAR LONG VARCHAR 任意の長さ (メモリで許容さ
れる範囲内)。LONG
VARCHAR カラムで実行可
能な演算は、これらの挿入、
更新、削除、またはクエリの
select リストへのこれらの指
定のみです。

BINARY BINARY(size) 1 ～ 32767 バイト。式を評価
するときのテンポラリ文字値
の最大長は 2048 バイトです。

LONGBINARY LONG BINARY 任意の長さ (メモリで許容さ
れる範囲内)。LONG
BINARY カラムで実行可能な
演算は、これらの挿入、更新、
削除、またはクエリの select
リストへのこれらの指定のみ
です。

Domain インタフェース
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ドメイン定数 SQL 型 サイズの範囲

UUID UNIQUEIDENTIFIER 常に 16 バイトの解釈が特殊
なバイナリ

日付型と時間型：

ドメイン定数 SQL 型 値

DATE DATE 年、月、日。

TIME TIME 時、分、秒 (小数位あり) で構
成される時刻。

TIMESTAMP TIMESTAMP DATE と TIME。

TIMESTAMP_ZONE TIMESTAMP_ZONE タイムゾーン付きの DATE
と TIME。

BIT カラムはデフォルトでは NULL 入力不可です。その他の型はデフォルトで NULL 入力可で
す。

参照

● Connection インタフェース [Ultra Light J]103 ページ

BIG 変数
64 ビット整数 (BIGINT SQL 型) のドメイン ID 定数です。

構文

final short Domain.BIG

参照

● Domain インタフェース [Ultra Light J]147 ページ

BINARY 変数
最大 size バイトの可変長のバイナリオブジェクト (BINARY (size) SQL 型) のドメイン ID 定数で
す。

構文

final short Domain.BINARY

参照

● Domain インタフェース [Ultra Light J]147 ページ
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BIT 変数
ビット (BIT SQL 型) のドメイン ID 定数です。

構文

final short Domain.BIT

備考

BIT カラムはデフォルトでは NULL 入力不可です。

参照

● Domain インタフェース [Ultra Light J]147 ページ

DATE 変数
日付 (DATE SQL 型) のドメイン ID 定数です。

構文

final short Domain.DATE

参照

● Domain インタフェース [Ultra Light J]147 ページ

DOMAIN_MAX 変数
Domain 型の最大数です。

構文

final short Domain.DOMAIN_MAX

DOUBLE 変数
8 バイトの浮動小数点数 (DOUBLE SQL 型) のドメイン ID 定数です。

構文

final short Domain.DOUBLE

参照

● Domain インタフェース [Ultra Light J]147 ページ

INTEGER 変数
32 ビット整数 (INTEGER SQL 型) のドメイン ID 定数です。

Domain インタフェース
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構文

final short Domain.INTEGER

参照

● Domain インタフェース [Ultra Light J]147 ページ

LONGBINARY 変数
任意の長いブロックのバイナリデータ (BLOB) (LONG BINARY SQL 型) のドメイン ID 定数で
す。

構文

final short Domain.LONGBINARY

参照

● Domain インタフェース [Ultra Light J]147 ページ

LONGBINARYFILE 変数
任意のデータファイルのドメイン ID 定数です。

構文

final short Domain.LONGBINARYFILE

参照

● Domain インタフェース [Ultra Light J]147 ページ

LONGVARCHAR 変数
任意の長いブロックの文字データ (CLOB) (LONG VARCHAR SQL 型) のドメイン ID 定数です。

構文

final short Domain.LONGVARCHAR

参照

● Domain インタフェース [Ultra Light J]147 ページ

NUMERIC 変数
合計桁数が固定 precision (サイズ)、小数点以下の桁数が scale 桁の数値
(NUMERIC(precision,scale) SQL 型) のドメイン ID 定数です。
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構文

final short Domain.NUMERIC

参照

● Domain インタフェース [Ultra Light J]147 ページ

REAL 変数
4 バイトの浮動小数点数 (REAL SQL 型) のドメイン ID 定数です。

構文

final short Domain.REAL

参照

● Domain インタフェース [Ultra Light J]147 ページ

SHORT 変数
16 ビット整数 (SMALLINT SQL 型) のドメイン ID 定数です。

構文

final short Domain.SHORT

参照

● Domain インタフェース [Ultra Light J]147 ページ

ST_GEOMETRY 変数
ジオメトリ (GEOMETRY SQL 型) のドメイン ID 定数です。

構文

final short Domain.ST_GEOMETRY

参照

● Domain インタフェース [Ultra Light J]147 ページ

TIME 変数
時刻 (TIME SQL 型) のドメイン ID 定数です。

構文

final short Domain.TIME

Domain インタフェース
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参照

● Domain インタフェース [Ultra Light J]147 ページ

TIMESTAMP 変数
タイムスタンプ (TIMESTAMP SQL 型) のドメイン ID 定数です。

構文

final short Domain.TIMESTAMP

参照

● Domain インタフェース [Ultra Light J]147 ページ

TIMESTAMP_ZONE 変数
タイムゾーン付きタイムスタンプ (DATETIMEOFFSET SQL 型) のドメイン ID 定数です。

構文

final short Domain.TIMESTAMP_ZONE

参照

● Domain インタフェース [Ultra Light J]147 ページ

TINY 変数
符号なし 8 ビット整数 (TINYINT SQL 型) のドメイン ID 定数です。

構文

final short Domain.TINY

参照

● Domain インタフェース [Ultra Light J]147 ページ

UNSIGNED_BIG 変数
符号なし 64 ビット整数 (UNSIGNED BIGINT SQL 型) のドメイン ID 定数です。

構文

final short Domain.UNSIGNED_BIG

参照

● Domain インタフェース [Ultra Light J]147 ページ
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UNSIGNED_INTEGER 変数
符号なし 32 ビット整数 (UNSIGNED INTEGER SQL 型) のドメイン ID 定数です。

構文

final short Domain.UNSIGNED_INTEGER

参照

● Domain インタフェース [Ultra Light J]147 ページ

UNSIGNED_SHORT 変数
符号なし 16 ビット整数 (UNSIGNED SMALLINT SQL 型) のドメイン ID 定数です。

構文

final short Domain.UNSIGNED_SHORT

参照

● Domain インタフェース [Ultra Light J]147 ページ

UUID 変数
UniqueIdentifier (UNIQUEIDENTIFIER SQL 型) のドメイン ID 定数です。

構文

final short Domain.UUID

参照

● Domain インタフェース [Ultra Light J]147 ページ

VARCHAR 変数
最大 size バイトの可変長文字オブジェクト (VARCHAR (size) SQL 型) のドメイン ID 定数です。

構文

final short Domain.VARCHAR

参照

● Domain インタフェース [Ultra Light J]147 ページ

FileTransfer インタフェース
クライアントと Mobile Link サーバ間のファイル転送メカニズムを提供します。

FileTransfer インタフェース
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構文

public interface FileTransfer

メンバー

継承されたメンバーを含む FileTransfer インタフェースのすべてのメンバー。

名前 説明

downloadFile メソッド このオブジェクトの指定されたプロパティの
ファイルをダウンロードします。

getAuthenticationParms メソッド カスタムのユーザ認証スクリプトに渡される
パラメータを返します。

getAuthStatus メソッド 前回行われたファイル転送の認証ステータス
コードを返します。

getAuthValue メソッド カスタムユーザ認証同期スクリプトで指定さ
れている値を返します。

getFileAuthCode メソッド 前回行われたファイル転送の
authenticate_file_transfer スクリプトからの戻
り値を返します。

getLivenessTimeout メソッド 活性タイムアウトの長さを秒単位で返しま
す。

getLocalFileName メソッド ローカルファイル名を決定します。

getLocalPath メソッド ローカルファイルシステムにおけるファイル
の検索場所または格納場所を指定します。

getPassword メソッド setUserName メソッドで指定されたユーザの
Mobile Link パスワードを返します。

getRemoteKey メソッド 現在のリモートキーの値を決定します。

getServerFileName メソッド サーバ上のファイルの名前を返します。

getStreamErrorCode メソッド ストリームによってレポートされたエラー
コードを返します。

getStreamErrorMessage メソッド ストリーム自体によってレポートされるエ
ラーメッセージを返します。

getStreamParms メソッド 同期ストリームの設定に使用するパラメータ
を返します。

Ultra Light J API リファレンス

158 Copyright © 2013, SAP AG or an SAP affiliate company. - SAP Sybase SQL Anywhere 16.0



名前 説明

getUserName メソッド Mobile Link サーバがクライアントをユニー
クに識別する Mobile Link ユーザ名を返しま
す。

getVersion メソッド 使用する同期スクリプトを返します。

isResumePartialTransfer メソッド 前の部分的な転送を再開するか、破棄するか
を決定します。

isTransferredFile メソッド 前回行われたファイル転送時にファイルが実
際にダウンロードされたかどうかを確認しま
す。

setAuthenticationParms メソッド カスタムユーザ認証スクリプト (Mobile Link
authenticate_parameters 接続イベント) のパラ
メータを指定します。

setLivenessTimeout メソッド 活性タイムアウトの長さを秒単位で設定しま
す。

setLocalFileName メソッド ファイルのローカル名を指定します。

setLocalPath メソッド ローカルファイルシステムにおけるファイル
の検索場所または格納場所を指定します。

setPassword メソッド setUserName メソッドで指定されたユーザの
Mobile Link パスワードを設定します。

setRemoteKey メソッド リモートキーを指定します。

setResumePartialTransfer メソッド 前の部分的な転送を再開するか、破棄するか
を指定します。

setServerFileName メソッド サーバ上のファイルの名前を指定します。

setUserName メソッド Mobile Link サーバがクライアントをユニー
クに識別する Mobile Link ユーザ名を設定し
ます。

setVersion メソッド 使用する同期スクリプトを設定します。

uploadFile メソッド このオブジェクトの指定されたプロパティの
ファイルをアップロードします。
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備考

FileTransfer オブジェクトは、DatabaseManager.createFileTransfer メソッドまたは
DatabaseManager.createObjectStoreTransfer [BlackBerry] メソッドを呼び出すことによって取得し
ます。

createFileTransfer メソッドによって返されたインスタンスを使用して、Mobile Link とローカル
ファイルシステム間で任意のファイルを転送できます。

Android デバイスとシミュレータの場合、ローカルファイルシステムは、メディアカードか、ま
たはアプリケーションに適切なパーミッションがある内部フラッシュファイルシステム (/
sdcard/Android/data/your.package.name/files/など) のいずれかになります。

createObjectStoreTransfer メソッドから返されたインスタンスを使用して、ローカルの BlackBerry
オブジェクトストアへの Ultra Light Java データベースファイルのダウンロード (またはその逆)
を実行できます。

転送できるのは、有効で暗号化されていない Ultra Light Java Edition データベースファイルのみ
です。Ultra Light Java Edition データベース以外のファイルをダウンロードしようとすると、例外
がスローされます。

注意

アプリケーションで、同じローカルファイルに対して、2 つのダウンロードを同時に行うことは
できません。

参照

● DatabaseManager.createFileTransfer メソッド [Ultra Light J]141 ページ
● DatabaseManager.createObjectStoreTransfer メソッド [BlackBerry] [Ultra Light J]142 ページ

downloadFile メソッド
このオブジェクトの指定されたプロパティのファイルをダウンロードします。

オーバーロードリスト

名前 説明

downloadFile() メソッド このオブジェクトの指定されたプロパティの
ファイルをダウンロードします。

downloadFile(FileTransferProgressListener) メ
ソッド

指定されたリスナに送信されるプログレスイ
ベントとともに、このオブジェクトのプロパ
ティで指定されたファイルをダウンロードし
ます。

downloadFile() メソッド
このオブジェクトの指定されたプロパティのファイルをダウンロードします。
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構文

abstract boolean FileTransfer.downloadFile() throws ULjException

戻り値

ダウンロードに成功した場合は true、そうでない場合は ULjException がスローされメソッドは正
常に返されません。

備考

setServerFileName メソッドで指定されたファイルは、指定のストリーム、userName、パスワー
ド、スクリプトバージョンを使用して、setLocalPath メソッドで指定されたパスに、Mobile Link
サーバからダウンロードされます。

setLocalFileName()、setAuthenticationParms()、setResumePartialTransfer() の各メソッドでは、他の
オプションも指定できます。

ファイルが破損することを防ぐため、デスクトップおよび BlackBerry ファイルシステムのダウ
ンロードでは、Ultra Light J はテンポラリファイルにダウンロードし、ダウンロードが完了した
ときにのみローカルファイルと置換します。

BlackBerry オブジェクトストアのダウンロードでは、Ultra Light J はローカルストアに直接書き
込みを開始します。これは、この場合、アトミックテンポラリオブジェクトを作成できないから
です。同じ名前の既存のローカルデータベースストアは、transferFile メソッドを呼び出した時点
で破損されます。

getAuthStatus()、getAuthValue()、getFileAuthCode()、isTransferredFile()、getStreamErrorCode()、
getStreamErrorMessage() の各メソッドを使用して、結果の詳細なステータスを取得できます。

downloadFile(FileTransferProgressListener) メソッド
指定されたリスナに送信されるプログレスイベントとともに、このオブジェクトのプロパティで
指定されたファイルをダウンロードします。

構文

abstract boolean FileTransfer.downloadFile(
    FileTransferProgressListener listener
) throws ULjException

パラメータ

● listener ファイル転送プログレスイベントを受信するオブジェクト。

戻り値

ダウンロードに成功した場合は true、そうでない場合は ULjException がスローされメソッドは正
常に返されません。

備考

エラーが発生すると、リスナにはデータが送信されないことがあります。
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参照

● FileTransfer.downloadFile メソッド [Ultra Light J]160 ページ

getAuthenticationParms メソッド
カスタムのユーザ認証スクリプトに渡されるパラメータを返します。

構文

abstract String FileTransfer.getAuthenticationParms()

戻り値

認証パラメータのリスト、またはパラメータが指定されていない場合は NULL。

参照

● FileTransfer.setAuthenticationParms メソッド [Ultra Light J]167 ページ

getAuthStatus メソッド
前回行われたファイル転送の認証ステータスコードを返します。

構文

abstract int FileTransfer.getAuthStatus()

戻り値

AuthStatusCode クラスの値。

getAuthValue メソッド
カスタムユーザ認証同期スクリプトで指定されている値を返します。

構文

abstract long FileTransfer.getAuthValue()

戻り値

カスタムユーザ認証同期スクリプトから返された整数。

getFileAuthCode メソッド
前回行われたファイル転送の authenticate_file_transfer スクリプトからの戻り値を返します。

構文

abstract int FileTransfer.getFileAuthCode()
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戻り値

前回行われたファイル転送の authenticate_file_transfer スクリプトから返された整数。

getLivenessTimeout メソッド
活性タイムアウトの長さを秒単位で返します。

構文

abstract int FileTransfer.getLivenessTimeout()

戻り値

タイムアウト。

参照

● FileTransfer.setLivenessTimeout メソッド [Ultra Light J]167 ページ

getLocalFileName メソッド
ローカルファイル名を決定します。

構文

abstract String FileTransfer.getLocalFileName()

戻り値

ダウンロードしたファイルのローカルファイル名。

備考

ファイルのダウンロードの場合は、ダウンロードしたファイルの名前になります。ファイルの
アップロードの場合は、アップロードするファイルの名前になります。

参照

● FileTransfer.setLocalFileName メソッド [Ultra Light J]168 ページ

getLocalPath メソッド
ローカルファイルシステムにおけるファイルの検索場所または格納場所を指定します。

構文

abstract String FileTransfer.getLocalPath()

戻り値

ローカルディレクトリ。
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参照

● FileTransfer.setLocalPath メソッド [Ultra Light J]168 ページ

getPassword メソッド
setUserName メソッドで指定されたユーザの Mobile Link パスワードを返します。

構文

abstract String FileTransfer.getPassword()

戻り値

Mobile Link ユーザのパスワード。

参照

● FileTransfer.setPassword メソッド [Ultra Light J]169 ページ

getRemoteKey メソッド
現在のリモートキーの値を決定します。

構文

abstract String FileTransfer.getRemoteKey()

戻り値

リモートキーの値、またはリモートキーが指定されていない場合は NULL。

参照

● FileTransfer.setRemoteKey メソッド [Ultra Light J]170 ページ

getServerFileName メソッド
サーバ上のファイルの名前を返します。

構文

abstract String FileTransfer.getServerFileName()

戻り値

サーバ側のファイルの名前。

備考

ファイルのダウンロードの場合は、ダウンロードしたファイルの名前になります。ファイルの
アップロードの場合は、アップロードするファイルの名前になります。
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参照

● FileTransfer.setServerFileName メソッド [Ultra Light J]171 ページ

getStreamErrorCode メソッド
ストリームによってレポートされたエラーコードを返します。

構文

abstract int FileTransfer.getStreamErrorCode()

戻り値

通信ストリームエラーがなかった場合は 0、それ以外の場合はサーバからの応答コードを返しま
す。

備考

エラーコードは HTTP の応答コードです。

getStreamErrorMessage メソッド
ストリーム自体によってレポートされるエラーメッセージを返します。

構文

abstract String FileTransfer.getStreamErrorMessage()

戻り値

メッセージがない場合は NULL、それ以外の場合は応答メッセージを返します。

備考

これは HTTP 応答メッセージです。

getStreamParms メソッド
同期ストリームの設定に使用するパラメータを返します。

構文

abstract StreamHTTPParms FileTransfer.getStreamParms()

戻り値

HTTP または HTTPS ストリームのパラメータを指定する StreamHTTPParms または
StreamHTTPSParms オブジェクト。オブジェクトは参照で返されます。

備考

同期ストリームのタイプは、FileTransfer オブジェクトの作成時に指定します。
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getUserName メソッド
Mobile Link サーバがクライアントをユニークに識別する Mobile Link ユーザ名を返します。

構文

abstract String FileTransfer.getUserName()

戻り値

Mobile Link ユーザ名。

参照

● FileTransfer.setUserName メソッド [Ultra Light J]171 ページ

getVersion メソッド
使用する同期スクリプトを返します。

構文

abstract String FileTransfer.getVersion()

戻り値

スクリプトバージョン。

参照

● FileTransfer.setVersion メソッド [Ultra Light J]172 ページ

isResumePartialTransfer メソッド
前の部分的な転送を再開するか、破棄するかを決定します。

構文

abstract boolean FileTransfer.isResumePartialTransfer()

戻り値

ダウンロードを再開する場合は true、それ以外の場合は false。

参照

● FileTransfer.setResumePartialTransfer メソッド [Ultra Light J]170 ページ

isTransferredFile メソッド
前回行われたファイル転送時にファイルが実際にダウンロードされたかどうかを確認します。
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構文

abstract boolean FileTransfer.isTransferredFile()

戻り値

ファイルが転送された場合は true、それ以外の場合は false。

備考

transferFile() メソッドが呼び出された時点でファイルがすでに最新だった場合、isTransferredFile()
メソッドでは false が返されますが、このメソッドでは true が返されます。

エラーが発生し、transferFile() メソッドによって例外がスローされる場合は、isTransferredFile()
メソッドにより false が返されます。

setAuthenticationParms メソッド
カスタムユーザ認証スクリプト (Mobile Link authenticate_parameters 接続イベント) のパラメータ
を指定します。

構文

abstract void FileTransfer.setAuthenticationParms(
    String authParms
) throws ULjException

パラメータ

● authParms 認証パラメータのカンマ区切りのリスト、または NULL 参照。カンマ区切りの
リストの詳細については、SyncParms クラスの説明を参照してください。

備考

最初の 255 文字列のみが使用されます。また、各文字列は 128 文字以下である必要があります
(長すぎる文字列は、Mobile Link に送信されるときにトランケートされます)。

参照

● FileTransfer.getAuthenticationParms メソッド [Ultra Light J]162 ページ

setLivenessTimeout メソッド
活性タイムアウトの長さを秒単位で設定します。

構文

abstract void FileTransfer.setLivenessTimeout(
    int timeout
) throws ULjException

パラメータ

● timeout 新しい活性タイムアウト値。
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備考

活性タイムアウトは、サーバで許容される、リモートのアイドル時間の長さです。リモートが 1
秒間サーバと通信しなかった場合、サーバはリモートとの接続が失われたとみなし、ファイル転
送を終了します。リモートは、接続を継続するために、自動的に定期メッセージをサーバに送信
します。

負の値を設定すると、例外がスローされます。値は Mobile Link サーバによって予告なく変更さ
れる場合があります。変更は、値が低すぎるか高すぎる場合に行われます。

デフォルト値は、BlackBerry/J2SE プラットフォームでは 100 秒、Android プラットフォームで
は 240 秒です。

参照

● FileTransfer.getLivenessTimeout メソッド [Ultra Light J]163 ページ

setLocalFileName メソッド
ファイルのローカル名を指定します。

構文

abstract void FileTransfer.setLocalFileName(String localFileName)

パラメータ

● localFileName ダウンロードファイルのローカル名を指定する文字列。値が NULL 参照の
場合は、fileName が使用されます。デフォルトは NULL 参照です。

備考

ファイルのダウンロードの場合は、ダウンロードしたファイルの名前になります。ファイルの
アップロードの場合は、アップロードするファイルの名前になります。ファイル名にドライブま
たはパスの情報を含めることはできません。

参照

● FileTransfer.getLocalFileName メソッド [Ultra Light J]163 ページ
● FileTransfer.setLocalPath メソッド [Ultra Light J]168 ページ

setLocalPath メソッド
ローカルファイルシステムにおけるファイルの検索場所または格納場所を指定します。

構文

abstract void FileTransfer.setLocalPath(String localPath)

パラメータ

● localPath ファイルのローカルディレクトリを指定する文字列。デフォルトは NULL 参照
です。
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備考

ローカルディレクトリの構文は、プラットフォームによって異なります。

●デスクトップの場合の構文は、"C:¥¥ulj¥¥" のようになります。

●BlackBerry ファイルシステムの場合の構文は、"file:///SDCard/ulj/" のようになります。

●BlackBerry オブジェクトストアの場合、このオプションは無視されます。

●Android ファイルシステムの場合の構文は、"/sdcard/Android/data/your.package.name/files/" のよ
うになります。

デフォルトのローカルディレクトリも、デバイスのオペレーティングシステムによって異なりま
す。

●デスクトップコンピュータでは、localPath パラメータが NULL の場合、ファイルは現在のディ
レクトリに格納されます。

●BlackBerry ファイルシステムストアの場合、localPath パラメータにデフォルトの値がないの
で、明示的に設定する必要があります。

●Android ファイルシステムストアの場合、localPath パラメータにデフォルトの値がないので、
明示的に設定する必要があります。

参照

● FileTransfer.getLocalPath メソッド [Ultra Light J]163 ページ
● FileTransfer.setLocalFileName メソッド [Ultra Light J]168 ページ

setPassword メソッド
setUserName メソッドで指定されたユーザの Mobile Link パスワードを設定します。

構文

abstract void FileTransfer.setPassword(
    String password
) throws ULjException

パラメータ

● password Mobile Link ユーザのパスワード。

備考

このユーザ名とパスワードは、データベースのユーザ ID とパスワードとは異なります。このメ
ソッドは、Mobile Link サーバに対してアプリケーションを認証するために使用されます。

デフォルトは空の文字列で、これはパスワードなしを示します。
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参照

● FileTransfer.getPassword メソッド [Ultra Light J]164 ページ
● FileTransfer.setUserName メソッド [Ultra Light J]171 ページ

setRemoteKey メソッド
リモートキーを指定します。

構文

abstract void FileTransfer.setRemoteKey(String remoteKey)

パラメータ

● remoteKey リモートキーの値、またはリモートキーが指定されていない場合は NULL。

備考

リモートキーは、サーバの authenticate_file_upload スクリプトに渡されるパラメータです。

スクリプトでは、このパラメータを使用して、サーバに格納するファイルの名前と場所を決定し
ます。

この値が指定されていない場合は、getFileName() の値がリモートキーとして使用されます。

参照

● FileTransfer.getRemoteKey メソッド [Ultra Light J]164 ページ

setResumePartialTransfer メソッド
前の部分的な転送を再開するか、破棄するかを指定します。

構文

abstract void FileTransfer.setResumePartialTransfer(boolean resume)

パラメータ

● resume 前回の部分的なダウンロードを再開する場合は true、破棄する場合は false に設定
します。

備考

デフォルトは true です。

Ultra Light J では、通信エラーや、ユーザによる FileTransferProgressListener オブジェクトからの
アボートが原因で失敗したファイル転送を再起動できます。

ファイルのダウンロードの場合、Ultra Light は、ダウンロードを受信しながら処理します。ダウ
ンロードが中断した場合は、部分的なダウンロードファイルが保持されるため、次の転送中に再
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開できます。ファイルがサーバ上で更新されている場合は、部分的なダウンロードは破棄され、
新しくダウンロードが開始されます。

ファイルのアップロードの場合、以降のファイルのアップロードで前回のアップロードを再開で
きるようにするため、Mobile Link サーバは部分的にアップロードされたファイルを保持します。
ただし、ファイルがローカルで更新されている場合は、部分的なアップロードは破棄され、新し
くアップロードが開始されます。

参照

● FileTransfer.isResumePartialTransfer メソッド [Ultra Light J]166 ページ

setServerFileName メソッド
サーバ上のファイルの名前を指定します。

構文

abstract void FileTransfer.setServerFileName(
    String fileName
) throws ULjException

パラメータ

● fileName Mobile Link サーバによって認識されたファイルの名前を指定する文字列。

備考

ファイルのダウンロードの場合は、ダウンロードしたファイルの名前になります。ファイルの
アップロードの場合は、アップロードするファイルの名前になります。

このパラメータは、FileTransfer オブジェクトの作成時に初期化されます。

Mobile Link は、指定されたファイルを最初に userName サブディレクトリで、次にルートディレ
クトリで検索します。ルートダウンロードディレクトリは、Mobile Link サーバの -ftr オプション
で指定され、ルートアップロードディレクトリは -ftru オプションで指定されます。

fileName にはドライブまたはパスの情報を含めないでください。そのような情報を含めると、
ファイルが見つからなくなります。たとえば、"myfile.txt" は有効ですが、"somedir¥myfile.txt"、
"..¥myfile.txt"、"c:¥myfile.txt" は無効です。

参照

● FileTransfer.getServerFileName メソッド [Ultra Light J]164 ページ

setUserName メソッド
Mobile Link サーバがクライアントをユニークに識別する Mobile Link ユーザ名を設定します。
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構文

abstract void FileTransfer.setUserName(
    String userName
) throws ULjException

パラメータ

● userName Mobile Link ユーザ名。

備考

Mobile Link サーバは、この値を使用して、サーバ側でファイルを特定します。Mobile Link ユー
ザ名とパスワードは他のデータベースユーザ ID やパスワードとは別のもので、アプリケーショ
ンを Mobile Link サーバに対して識別し、認証するために使用されます。

このパラメータは、FileTransfer オブジェクトの作成時に初期化されます。

参照

● FileTransfer.getUserName メソッド [Ultra Light J]166 ページ
● FileTransfer.setPassword メソッド [Ultra Light J]169 ページ

setVersion メソッド
使用する同期スクリプトを設定します。

構文

abstract void FileTransfer.setVersion(
    String version
) throws ULjException

パラメータ

● version スクリプトバージョン。

備考

統合データベースの同期スクリプトは、それぞれバージョン文字列で区別されます。Ultra Light
J アプリケーションは、バージョン文字列により、同期スクリプトのセットから選択できます。

このパラメータは、FileTransfer オブジェクトの作成時に初期化されます。

参照

● FileTransfer.getVersion メソッド [Ultra Light J]166 ページ

uploadFile メソッド
このオブジェクトの指定されたプロパティのファイルをアップロードします。
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オーバーロードリスト

名前 説明

uploadFile() メソッド このオブジェクトの指定されたプロパティの
ファイルをアップロードします。

uploadFile(FileTransferProgressListener) メソッ
ド

指定されたリスナに送信されるプログレスイ
ベントとともに、このオブジェクトのプロパ
ティで指定されたファイルをアップロードし
ます。

uploadFile() メソッド
このオブジェクトの指定されたプロパティのファイルをアップロードします。

構文

abstract boolean FileTransfer.uploadFile() throws ULjException

戻り値

アップロードに成功した場合は true、そうでない場合は ULjException がスローされメソッドは正
常に返されません。

備考

setLocalFileName メソッドと setLocalPath メソッドで指定されたファイルは、指定のストリーム、
ユーザ名、パスワード、スクリプトバージョンを使用して、Mobile Link サーバの、
setServerFileName メソッドで指定されたファイルにアップロードされます。

setAuthenticationParms() メソッドと setResumePartialTransfer() メソッドでは、他のオプションも指
定できます。

getAuthStatus()、getAuthValue()、getFileAuthCode()、isTransferredFile()、getStreamErrorCode()、
getStreamErrorMessage() の各メソッドを使用して、結果の詳細なステータスを取得できます。

uploadFile(FileTransferProgressListener) メソッド
指定されたリスナに送信されるプログレスイベントとともに、このオブジェクトのプロパティで
指定されたファイルをアップロードします。

構文

abstract boolean FileTransfer.uploadFile(
    FileTransferProgressListener listener
) throws ULjException

パラメータ

● listener ファイル転送プログレスイベントを受信するオブジェクト。
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戻り値

アップロードに成功した場合は true、そうでない場合は ULjException がスローされメソッドは正
常に返されません。

備考

エラーが発生した場合、リスナにデータが送信されないことがあります。

参照

● FileTransfer.uploadFile メソッド [Ultra Light J]172 ページ

FileTransferProgressData インタフェース
ファイル転送の進行状況のモニタリングデータを通知します。

構文

public interface FileTransferProgressData

メンバー

継承されたメンバーを含む FileTransferProgressData インタフェースのすべてのメンバー。

名前 説明

getBytesTransferred メソッド 現在までに転送されたバイト数を返します。

getFileSize メソッド 転送されるファイルのサイズを返します。

getResumedAtSize メソッド 転送が再開されるファイル内のポイントを返
します。

getBytesTransferred メソッド
現在までに転送されたバイト数を返します。

構文

abstract long FileTransferProgressData.getBytesTransferred()

戻り値

現在までに転送されたバイト数。

備考

このメソッドでは、現在のファイル転送セッションによって転送されたバイト数のカウントに、
以前に中断された転送によって転送されたバイト数が加算されます。
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getResumedAtSize メソッドによって返された値を引くと、現在のセッションによって転送された
バイト数を算出できます。

参照

● FileTransferProgressData.getResumedAtSize メソッド [Ultra Light J]175 ページ

getFileSize メソッド
転送されるファイルのサイズを返します。

構文

abstract long FileTransferProgressData.getFileSize()

戻り値

ファイルのサイズ (バイト単位)。

備考

戻り値は、ファイル転送セッションの継続中は一定の値になります。

getResumedAtSize メソッド
転送が再開されるファイル内のポイントを返します。

構文

abstract long FileTransferProgressData.getResumedAtSize()

戻り値

以前に転送されたバイト数。

備考

戻り値は、ファイル転送セッションの継続中は一定の値になります。

FileTransferProgressListener インタフェース
ファイル転送の進行状況イベントを受信します。

構文

public interface FileTransferProgressListener

メンバー

継承されたメンバーを含む FileTransferProgressListener インタフェースのすべてのメンバー。

FileTransferProgressListener インタフェース
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名前 説明

fileTransferProgressed メソッド ユーザに転送の進行状況を通知するために、
ファイル転送中に呼び出されます。

備考

ファイル転送中に進行状況レポートを受信するために、新しいクラスが作成されます。

次の例は、FileTransferProgressListener インタフェースを実装する単純な SyncObserver インタ
フェースを示しています。

class MyObserver implements FileTransferProgressListener {
   public boolean fileTransferProgressed( FileTransferProgressData data ) {
       System.out.println(
           "file transfer progress "
           + " bytes received = " + data.getBytesTransferred()
       );
       return false;   // Always continue file transfer.
   }
   public MyObserver() {} // The default constructor.
 }

fileTransferProgressed メソッド
ユーザに転送の進行状況を通知するために、ファイル転送中に呼び出されます。

構文

boolean FileTransferProgressListener.fileTransferProgressed(
    FileTransferProgressData data
)

パラメータ

● data 最新のファイル転送プログレスデータを保持している FileTransferProgressData オブ
ジェクト。

戻り値

転送をキャンセルする場合は true を、続行する場合は false を返します。

備考

リスナは、次の状況で呼び出されます。

●最初のディスク書き込みの前

●ディスク書き込みごとまたは 0.5 秒ごとのどちらか後のほう

●ファイルのダウンロードの完了後

通常、キャンセル要求は Ultra Light J API で受け入れられます。その結果、errorCode が
ULjException.SQLE_INTERRUPTED 定数に設定された ULjException オブジェクトがスローされ
ます。
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ただし、BlackBerry オブジェクトストアに対してダウンロードが完了した場合、Ultra Light J は
転送をキャンセルしません。

fileTransferProgressed の呼び出し中に、Ultra Light J API のメソッドを呼び出さないでください。

IndexSchema インタフェース
インデックスのスキーマを指定し、システムテーブルの問い合わせに便利な定数を提供します。

構文

public interface IndexSchema

メンバー

継承されたメンバーを含む IndexSchema インタフェースのすべてのメンバー。

名前 説明

ASCENDING 変数 カラムのインデックスが昇順でソートされま
す。

DESCENDING 変数 カラムのインデックスが降順でソートされま
す。

PERSISTENT 変数 インデックスが永続的であることを示しま
す。

PRIMARY_INDEX 変数 インデックスがプライマリキーであることを
示します。

UNIQUE_INDEX 変数 インデックスがユニークインデックスである
ことを示します。

UNIQUE_KEY 変数 インデックスがユニークキーであることを示
します。

備考

このインタフェースには、インデックスのフラグやとソート順など、インデックス関連の定数の
みが含まれます。

参照

● TableSchema.SYS_INDEXES 変数 [Ultra Light J]280 ページ

ASCENDING 変数
カラムのインデックスが昇順でソートされます。
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構文

final byte IndexSchema.ASCENDING

DESCENDING 変数
カラムのインデックスが降順でソートされます。

構文

final byte IndexSchema.DESCENDING

PERSISTENT 変数
インデックスが永続的であることを示します。

構文

final byte IndexSchema.PERSISTENT

備考

この値は、SYS_TABLES システムテーブルの table_flags カラムで他のフラグと論理的に組み合
わせることができます。

参照

● TableSchema.SYS_INDEXES 変数 [Ultra Light J]280 ページ

PRIMARY_INDEX 変数
インデックスがプライマリキーであることを示します。

構文

final byte IndexSchema.PRIMARY_INDEX

備考

この値は、SYS_TABLES システムテーブルの table_flags カラムで他のフラグと論理的に組み合
わせることができます。

参照

● TableSchema.SYS_INDEXES 変数 [Ultra Light J]280 ページ

UNIQUE_INDEX 変数
インデックスがユニークインデックスであることを示します。
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構文

final byte IndexSchema.UNIQUE_INDEX

備考

この値は、SYS_TABLES システムテーブルの table_flags カラムで他のフラグと論理的に組み合
わせることができます。

参照

● TableSchema.SYS_INDEXES 変数 [Ultra Light J]280 ページ

UNIQUE_KEY 変数
インデックスがユニークキーであることを示します。

構文

final byte IndexSchema.UNIQUE_KEY

備考

この値は、SYS_TABLES システムテーブルの table_flags カラムで他のフラグと論理的に組み合
わせることができます。

参照

● TableSchema.SYS_INDEXES 変数 [Ultra Light J]280 ページ

PreparedStatement インタフェース
SQL クエリを実行して ResultSet オブジェクトを生成するか、準備された SQL 文をデータベース
に対して実行するメソッドを提供します。

構文

public interface PreparedStatement

メンバー

継承されたメンバーを含む PreparedStatement インタフェースのすべてのメンバー。

名前 説明

close メソッド PreparedStatement を閉じて、関連付けられて
いるメモリリソースを解放します。

execute メソッド 準備された SQL 文を実行します。

executeQuery メソッド 準備された SQL SELECT 文を実行し、
ResultSet オブジェクトを返します。
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名前 説明

getBlobOutputStream メソッド OutputStream オブジェクトを返します。

getClobWriter メソッド Writer オブジェクトを返します。

getOrdinal メソッド name で指定された値の (1 から始まる) 順序
を返します。

getParameterCount メソッド [Android] この文の入力パラメータの数を取得します。

getParameterType メソッド [Android] パラメータのドメインの型を取得します。

getPlan メソッド SQL クエリ実行プランのテキストベースの記
述を返します。

getPlanTree メソッド SQL クエリ実行プランのテキストベースの記
述をツリー形式で返します。

getResultSet メソッド 準備された SQL 文の ResultSet オブジェクト
を返します。

getUpdateCount メソッド 最後の実行文の後に挿入、更新、または削除
されたロー数を返します。

hasResultSet メソッド PreparedStatement オブジェクトに ResultSet オ
ブジェクトが含まれるかどうかを確認しま
す。

set メソッド SQL 文のホスト変数に値を設定します。

setNull メソッド SQL 文のホスト変数に NULL 値を設定しま
す。

備考

次の例は、PreparedStatement オブジェクトを実行し、SELECT 文によって ResultSet オブジェクト
が作成されたかどうかを確認し、ResultSet オブジェクトをローカル変数に格納し、
PreparedStatement を閉じる方法を示しています。

// Create a new PreparedStatement object from an existing connection.
String sql_string = "SELECT * FROM SampleTable";
PreparedStatement ps = conn.prepareStatement(sql_string);

// Result returns true if the statement runs successfully.
boolean result = ps.execute();

// Check if the PreparedStatement object contains a ResultSet object.
if (ps.hasResultSet()) {
     // Store the ResultSet in the rs variable.
     ResultSet rs = ps.getResultSet;
}
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// Close the PreparedStatement object to release resources.
ps.close();

文に式が含まれる場合、カラム名があるところにはどこでもホスト変数が含まれる可能性があり
ます。ホスト変数は、? 文字 (名前なしホスト変数) または :name (名前付きホスト変数) のいずれ
かとして入力されます。

次の例には、対象の SQL 文用に準備された PreparedStatement オブジェクトを使って設定できる
2 つのホスト変数があります。

SELECT * FROM SampleTable WHERE pk > :bound AND pk < ?

参照

● Connection インタフェース [Ultra Light J]103 ページ
● Connection.prepareStatement メソッド [Ultra Light J]116 ページ

close メソッド
PreparedStatement を閉じて、関連付けられているメモリリソースを解放します。

構文

void PreparedStatement.close() throws ULjException

備考

このオブジェクトに対してこれ以上メソッドを使用できなくなります。PreparedStatement オブ
ジェクトに ResultSet オブジェクトが含まれている場合は、両方のオブジェクトが閉じます。

execute メソッド
準備された SQL 文を実行します。

構文

boolean PreparedStatement.execute() throws ULjException

戻り値

文が正常に実行された場合は true、それ以外の場合は false。

参照

● ResultSet インタフェース [Ultra Light J]195 ページ

executeQuery メソッド
準備された SQL SELECT 文を実行し、ResultSet オブジェクトを返します。

構文

ResultSet PreparedStatement.executeQuery() throws ULjException
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戻り値

準備された SQL SELECT 文のクエリの結果を含む ResultSet オブジェクト。

参照

● ResultSet インタフェース [Ultra Light J]195 ページ

getBlobOutputStream メソッド
OutputStream オブジェクトを返します。

オーバーロードリスト

名前 説明

getBlobOutputStream(int) メソッド OutputStream オブジェクトを返します。

getBlobOutputStream(String) メソッド OutputStream オブジェクトを返します。

getBlobOutputStream(int) メソッド
OutputStream オブジェクトを返します。

構文

java.io.OutputStream PreparedStatement.getBlobOutputStream(
    int ordinal
) throws ULjException

パラメータ

● ordinal SQL 文でのホスト変数の順序を表す 1 から始まる整数。

戻り値

指定された値の OutputStream オブジェクト。

getBlobOutputStream(String) メソッド
OutputStream オブジェクトを返します。

構文

java.io.OutputStream PreparedStatement.getBlobOutputStream(
    String name
) throws ULjException

パラメータ

● name ホスト変数名を表す文字列。
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戻り値

指定された値の OutputStream オブジェクト。

getClobWriter メソッド
Writer オブジェクトを返します。

オーバーロードリスト

名前 説明

getClobWriter(int) メソッド Writer オブジェクトを返します。

getClobWriter(String) メソッド Writer オブジェクトを返します。

getClobWriter(int) メソッド
Writer オブジェクトを返します。

構文

java.io.Writer PreparedStatement.getClobWriter(
    int ordinal
) throws ULjException

パラメータ

● ordinal SQL 文でのホスト変数の順序を表す 1 から始まる整数。

戻り値

指定された値の Writer オブジェクト。

getClobWriter(String) メソッド
Writer オブジェクトを返します。

構文

java.io.Writer PreparedStatement.getClobWriter(
    String name
) throws ULjException

パラメータ

● name ホスト変数名を表す文字列。

戻り値

指定された値の Writer オブジェクト。
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getOrdinal メソッド
name で指定された値の (1 から始まる) 順序を返します。

構文

int PreparedStatement.getOrdinal(String name) throws ULjException

パラメータ

● name テーブルのカラム名を表す文字列。

戻り値

name で指定された値の (1 から始まる) 順序。

getParameterCount メソッド [Android]
この文の入力パラメータの数を取得します。

構文

short PreparedStatement.getParameterCount() throws ULjException

戻り値

この文の入力パラメータの数。

getParameterType メソッド [Android]
パラメータのドメインの型を取得します。

構文

short PreparedStatement.getParameterType(
    int ordinal
) throws ULjException

パラメータ

● ordinal パラメータの、1 から始まる序数。

戻り値

指定したパラメータのドメインタイプ。

getPlan メソッド
SQL クエリ実行プランのテキストベースの記述を返します。

構文

String PreparedStatement.getPlan() throws ULjException
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戻り値

プランの String 表現。

備考

このメソッドは、開発中の使用を目的とします。

このプランには、getPlanTree メソッドで示される情報と同じものが含まれます。違いは表示形式
です。

プランがない場合は、空の文字列を返します。準備された文が SQL クエリの場合には、プラン
が存在します。

関連するクエリの実行前にプランが取得された場合は、クエリの実行に使用される操作がプラン
に表示されます。また、クエリの実行後にプランが取得された場合は、各操作で生成されるロー
数も表示されます。このプランを使用して、クエリの実行に関する理解を深めることができま
す。

次に、String として表されたプランツリーの例を示します。構造を表す '|' 文字を使用して複数行
に表示されます。

SELECT * FROM tab1, tab2 WHERE col1 > pk2
row: 2 20 10 banana
row: 3 30 10 banana
row: 4 40 10 banana
row: 4 40 30 peach
row: 5 50 10 banana
row: 5 50 30 peach
row: 5 50 40 apple
plan: root:7(inner-join:7(table-scan:5[tab1,prime_key],index-scan:7[tab2,prime_key]))

参照

● PreparedStatement.getPlanTree メソッド [Ultra Light J]185 ページ

getPlanTree メソッド
SQL クエリ実行プランのテキストベースの記述をツリー形式で返します。

構文

String PreparedStatement.getPlanTree() throws ULjException

戻り値

ツリーで表されるプランの String 表現。

備考

このメソッドは、開発中の使用を目的とします。

このプランには、getPlan メソッドで示される情報と同じものが含まれます。違いは表示形式で
す。
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プランがない場合は、空の文字列を返します。準備された文が SQL クエリの場合には、プラン
が存在します。

関連するクエリの実行前にプランが取得された場合は、クエリの実行に使用される操作がプラン
に表示されます。また、クエリの実行後にプランが取得された場合は、各操作で生成されるロー
数も表示されます。このプランを使用して、クエリの実行に関する理解を深めることができま
す。

次に、String として表されたプランツリーの例を示します。構造を表す '|' 文字を使用して複数行
に表示されます。

SELECT * FROM tab1, tab2 WHERE col1 > pk2
row: 2 20 10 banana
row: 3 30 10 banana
row: 4 40 10 banana
row: 4 40 30 peach
row: 5 50 10 banana
row: 5 50 30 peach
row: 5 50 40 apple
plan:
 root:7
 |
 inner-join:7
 | |
 | index-scan:7[tab2,prime_key]
 |
 table-scan:5[tab1,prime_key]

参照

● PreparedStatement.getPlan メソッド [Ultra Light J]184 ページ

getResultSet メソッド
準備された SQL 文の ResultSet オブジェクトを返します。

構文

ResultSet PreparedStatement.getResultSet() throws ULjException

戻り値

準備された SQL 文のクエリの結果を含む ResultSet オブジェクト。

参照

● ResultSet インタフェース [Ultra Light J]195 ページ

getUpdateCount メソッド
最後の実行文の後に挿入、更新、または削除されたロー数を返します。

構文

int PreparedStatement.getUpdateCount() throws ULjException

Ultra Light J API リファレンス

186 Copyright © 2013, SAP AG or an SAP affiliate company. - SAP Sybase SQL Anywhere 16.0



戻り値

文で変更を実行できない場合は -1 を返し、そうでない場合は変更されたロー数を返します。

hasResultSet メソッド
PreparedStatement オブジェクトに ResultSet オブジェクトが含まれるかどうかを確認します。

構文

boolean PreparedStatement.hasResultSet() throws ULjException

戻り値

ResultSet が見つかった場合は true、それ以外の場合は false。

参照

● ResultSet インタフェース [Ultra Light J]195 ページ

set メソッド
SQL 文のホスト変数に値を設定します。

オーバーロードリスト

名前 説明

set(int, boolean) メソッド SQL 文内の ordinal で定義されたホスト変数
に boolean 値を設定します。

set(int, byte[]) メソッド SQL 文内の ordinal で定義されたホスト変数
に byte 配列値を設定します。

set(int, Date) メソッド SQL 文内の ordinal で定義されたホスト変数
に java.util.Date を設定します。

set(int, DecimalNumber) メソッド SQL 文内の ordinal で定義されたホスト変数
に DecimalNumber オブジェクトを設定しま
す。

set(int, double) メソッド SQL 文内の ordinal で定義されたホスト変数
に double 値を設定します。

set(int, float) メソッド SQL 文内の ordinal で定義されたホスト変数
に float 値を設定します。

set(int, int) メソッド SQL 文内の ordinal で定義されたホスト変数
に int 値を設定します。
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名前 説明

set(int, long) メソッド SQL 文内の ordinal で定義されたホスト変数
に long integer 値を設定します。

set(int, String) メソッド SQL 文内の ordinal で定義されたホスト変数
に String 値を設定します。

set(int, UUIDValue) メソッド SQL 文内の ordinal で定義されたホスト変数
に UUIDValue 値を設定します。

set(String, boolean) メソッド SQL 文内の name で定義されたホスト変数に
boolean 値を設定します。

set(String, byte[]) メソッド SQL 文内の name で定義されたホスト変数に
byte 配列値を設定します。

set(String, Date) メソッド SQL 文内の namel で定義されたホスト変数に
java.util.Date を設定します。

set(String, DecimalNumber) メソッド SQL 文内の name で定義されたホスト変数に
DecimalNumber をオブジェクトを設定しま
す。

set(String, double) メソッド SQL 文内の name で定義されたホスト変数に
double 値を設定します。

set(String, float) メソッド SQL 文内の name で定義されたホスト変数に
float 値を設定します。

set(String, int) メソッド SQL 文内の name で定義されたホスト変数に
int 値を設定します。

set(String, long) メソッド SQL 文内の name で定義されたホスト変数に
long integer 値を設定します。

set(String, String) メソッド SQL 文内の name で定義されたホスト変数に
String 値を設定します。

set(String, UUIDValue) メソッド SQL 文内の name で定義されたホスト変数に
UUIDValue 値を設定します。

set(int, boolean) メソッド
SQL 文内の ordinal で定義されたホスト変数に boolean 値を設定します。
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構文

void PreparedStatement.set(
    int ordinal,
    boolean value
) throws ULjException

パラメータ

● ordinal SQL 文でのホスト変数の順序を表す 1 から始まる整数。

● value 設定する値。

set(int, byte[]) メソッド
SQL 文内の ordinal で定義されたホスト変数に byte 配列値を設定します。

構文

void PreparedStatement.set(
    int ordinal,
    byte[] value
) throws ULjException

パラメータ

● ordinal SQL 文でのホスト変数の順序を表す 1 から始まる整数。

● value 設定する値。

set(int, Date) メソッド
SQL 文内の ordinal で定義されたホスト変数に java.util.Date を設定します。

構文

void PreparedStatement.set(
    int ordinal,
    java.util.Date value
) throws ULjException

パラメータ

● ordinal SQL 文でのホスト変数の順序を表す 1 から始まる整数。

● value 設定する値。

set(int, DecimalNumber) メソッド
SQL 文内の ordinal で定義されたホスト変数に DecimalNumber オブジェクトを設定します。
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構文

void PreparedStatement.set(
    int ordinal,
    DecimalNumber value
) throws ULjException

パラメータ

● ordinal SQL 文でのホスト変数の順序を表す 1 から始まる整数。

● value 設定する DecimalNumber の値。

set(int, double) メソッド
SQL 文内の ordinal で定義されたホスト変数に double 値を設定します。

構文

void PreparedStatement.set(
    int ordinal,
    double value
) throws ULjException

パラメータ

● ordinal SQL 文でのホスト変数の順序を表す 1 から始まる整数。

● value 設定する値。

set(int, float) メソッド
SQL 文内の ordinal で定義されたホスト変数に float 値を設定します。

構文

void PreparedStatement.set(int ordinal, float value) throws ULjException

パラメータ

● ordinal SQL 文でのホスト変数の順序を表す 1 から始まる整数。

● value 設定する値。

set(int, int) メソッド
SQL 文内の ordinal で定義されたホスト変数に int 値を設定します。

構文

void PreparedStatement.set(int ordinal, int value) throws ULjException
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パラメータ

● ordinal SQL 文でのホスト変数の順序を表す 1 から始まる整数。

● value 設定する値。

set(int, long) メソッド
SQL 文内の ordinal で定義されたホスト変数に long integer 値を設定します。

構文

void PreparedStatement.set(int ordinal, long value) throws ULjException

パラメータ

● ordinal SQL 文でのホスト変数の順序を表す 1 から始まる整数。

● value 設定する値。

set(int, String) メソッド
SQL 文内の ordinal で定義されたホスト変数に String 値を設定します。

構文

void PreparedStatement.set(
    int ordinal,
    String value
) throws ULjException

パラメータ

● ordinal SQL 文でのホスト変数の順序を表す 1 から始まる整数。

● value 設定する値。

set(int, UUIDValue) メソッド
SQL 文内の ordinal で定義されたホスト変数に UUIDValue 値を設定します。

構文

void PreparedStatement.set(
    int ordinal,
    UUIDValue value
) throws ULjException

パラメータ

● ordinal SQL 文でのホスト変数の順序を表す 1 から始まる整数。

● value 設定する値。
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set(String, boolean) メソッド
SQL 文内の name で定義されたホスト変数に boolean 値を設定します。

構文

void PreparedStatement.set(
    String name,
    boolean value
) throws ULjException

パラメータ

● name ホスト変数名を表す文字列。

● value 設定する値。

set(String, byte[]) メソッド
SQL 文内の name で定義されたホスト変数に byte 配列値を設定します。

構文

void PreparedStatement.set(
    String name,
    byte[] value
) throws ULjException

パラメータ

● name ホスト変数名を表す文字列。

● value 設定する値。

set(String, Date) メソッド
SQL 文内の namel で定義されたホスト変数に java.util.Date を設定します。

構文

void PreparedStatement.set(
    String name,
    java.util.Date value
) throws ULjException

パラメータ

● name ホスト変数名を表す文字列。

● value 設定する値。
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set(String, DecimalNumber) メソッド
SQL 文内の name で定義されたホスト変数に DecimalNumber をオブジェクトを設定します。

構文

void PreparedStatement.set(
    String name,
    DecimalNumber value
) throws ULjException

パラメータ

● name ホスト変数名を表す文字列。

● value 設定する DecimalNumber の値。

set(String, double) メソッド
SQL 文内の name で定義されたホスト変数に double 値を設定します。

構文

void PreparedStatement.set(
    String name,
    double value
) throws ULjException

パラメータ

● name ホスト変数名を表す文字列。

● value 設定する値。

set(String, float) メソッド
SQL 文内の name で定義されたホスト変数に float 値を設定します。

構文

void PreparedStatement.set(String name, float value) throws ULjException

パラメータ

● name ホスト変数名を表す文字列。

● value 設定する値。

set(String, int) メソッド
SQL 文内の name で定義されたホスト変数に int 値を設定します。
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構文

void PreparedStatement.set(String name, int value) throws ULjException

パラメータ

● name ホスト変数名を表す文字列。

● value 設定する値。

set(String, long) メソッド
SQL 文内の name で定義されたホスト変数に long integer 値を設定します。

構文

void PreparedStatement.set(String name, long value) throws ULjException

パラメータ

● name ホスト変数名を表す文字列。

● value 設定する値。

set(String, String) メソッド
SQL 文内の name で定義されたホスト変数に String 値を設定します。

構文

void PreparedStatement.set(
    String name,
    String value
) throws ULjException

パラメータ

● name ホスト変数名を表す文字列。

● value 設定する値。

set(String, UUIDValue) メソッド
SQL 文内の name で定義されたホスト変数に UUIDValue 値を設定します。

構文

void PreparedStatement.set(
    String name,
    UUIDValue value
) throws ULjException
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パラメータ

● name ホスト変数名を表す文字列。

● value 設定する値。

setNull メソッド
SQL 文のホスト変数に NULL 値を設定します。

オーバーロードリスト

名前 説明

setNull(int) メソッド SQL 文内の ordinal で定義されたホスト変数
に NULL 値を設定します。

setNull(String) メソッド SQL 文内の name で定義されたホスト変数に
NULL 値を設定します。

setNull(int) メソッド
SQL 文内の ordinal で定義されたホスト変数に NULL 値を設定します。

構文

void PreparedStatement.setNull(int ordinal) throws ULjException

パラメータ

● ordinal SQL 文でのホスト変数の順序を表す 1 から始まる整数。

setNull(String) メソッド
SQL 文内の name で定義されたホスト変数に NULL 値を設定します。

構文

void PreparedStatement.setNull(String name) throws ULjException

パラメータ

● name ホスト変数名を表す文字列。

ResultSet インタフェース
テーブルをローごとにトラバースし、カラムデータにアクセスするメソッドを提供します。
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構文

public interface ResultSet

メンバー

継承されたメンバーを含む ResultSet インタフェースのすべてのメンバー。

名前 説明

afterLast メソッド [Android] カーソルを最後のローの後に移動します。

beforeFirst メソッド [Android] カーソルを最初のローの前に移動します。

close メソッド ResultSet オブジェクトを閉じて、関連付けら
れているメモリリソースを解放します。

first メソッド [Android] カーソルを最初のローに移動します。

getBlobInputStream メソッド ファイルベースの long binary を含む、long
binary 型の InputStream オブジェクトを返し
ます。

getBoolean メソッド boolean 値を返します。

getBytes メソッド byte 配列を返します。

getClobReader メソッド Reader オブジェクトを返します。

getDate メソッド java.util.Date オブジェクトを返します。

getDecimalNumber メソッド DecimalNumber オブジェクトを返します。

getDouble メソッド カラム番号に基づいた double 値を返します。

getFloat メソッド float 値を返します。

getInt メソッド integer 値を返します。

getLong メソッド long integer 値を返します。

getOrdinal メソッド String で表現された値の (1 から始まる) 順序
を返します。

getResultSetMetadata メソッド ResultSet オブジェクトのメタデータを含む
ResultSetMetadata オブジェクトを返します。

getRowCount メソッド [Android] テーブルのローの数を取得します。

getSize メソッド 結果セットカラムの実際のサイズを取得しま
す。
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名前 説明

getString メソッド String 値を返します。

getUUIDValue メソッド UUIDValue オブジェクトを返します。

isNull メソッド 指定されたカラムの値が NULL かどうかをテ
ストします。

last メソッド [Android] カーソルを最後のローに移動します。

next メソッド ResultSet オブジェクト内の次のデータローを
フェッチします。

previous メソッド ResultSet オブジェクト内の前のデータローを
フェッチします。

relative メソッド [Android] カーソルを、現在のカーソルの位置から、
offset で指定したロー数分移動します。

備考

ResultSet オブジェクトは、SQL SELECT 文により、PreparedStatement オブジェクト上で execute
または executeQuery メソッドが呼び出されたときに生成されます。

次の例は、ResultSet オブジェクトでローをフェッチし、指定したカラムのデータにアクセスする
方法を示しています。

// Define a new SQL SELECT statement.
String sql_string = "SELECT column1, column2 FROM SampleTable";

// Create a new PreparedStatement from an existing connection.
PreparedStatement ps = conn.prepareStatement(sql_string);

// Create a new ResultSet to contain the query results of the SQL statement.
ResultSet rs = ps.executeQuery();

// Check if the PreparedStatement contains a ResultSet.
if (ps.hasResultSet()) {
     // Retrieve the column1 value from the first row using getString.
     String row1_col1 = rs.getString(1);
     // Get the next row in the table.
     if (rs.next) {
          // Retrieve the value of column1 from the second row.
          String row2_col1 = rs.getString(1);
     }
}

rs.close();
ps.close();
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参照

● PreparedStatement インタフェース [Ultra Light J]179 ページ
● PreparedStatement.execute メソッド [Ultra Light J]181 ページ
● PreparedStatement.executeQuery メソッド [Ultra Light J]181 ページ
● Connection インタフェース [Ultra Light J]103 ページ

afterLast メソッド [Android]
カーソルを最後のローの後に移動します。

構文

boolean ResultSet.afterLast() throws ULjException

戻り値

成功した場合は true、失敗した場合は false。

beforeFirst メソッド [Android]
カーソルを最初のローの前に移動します。

構文

boolean ResultSet.beforeFirst() throws ULjException

戻り値

成功した場合は true、失敗した場合は false。

close メソッド
ResultSet オブジェクトを閉じて、関連付けられているメモリリソースを解放します。

構文

void ResultSet.close() throws ULjException

備考

以降で、閉じた ResultSet オブジェクトからローをフェッチしようとするとエラーが発生します。

first メソッド [Android]
カーソルを最初のローに移動します。

構文

boolean ResultSet.first() throws ULjException

Ultra Light J API リファレンス

198 Copyright © 2013, SAP AG or an SAP affiliate company. - SAP Sybase SQL Anywhere 16.0



戻り値

成功した場合は true、失敗した場合は false。

getBlobInputStream メソッド
ファイルベースの long binary を含む、long binary 型の InputStream オブジェクトを返します。

オーバーロードリスト

名前 説明

getBlobInputStream(int) メソッド ファイルベースの long binary を含む、long
binary 型の InputStream オブジェクトを返し
ます。

getBlobInputStream(String) メソッド ファイルベースの long binary を含む、long
binary 型の InputStream オブジェクトを返し
ます。

getBlobInputStream(int) メソッド
ファイルベースの long binary を含む、long binary 型の InputStream オブジェクトを返します。

構文

java.io.InputStream ResultSet.getBlobInputStream(
    int ordinal
) throws ULjException

パラメータ

● ordinal SQL 文でのカラムの順序を表す 1 から始まる整数。

戻り値

指定された値の InputStream オブジェクトの表現。

getBlobInputStream(String) メソッド
ファイルベースの long binary を含む、long binary 型の InputStream オブジェクトを返します。

構文

java.io.InputStream ResultSet.getBlobInputStream(
    String name
) throws ULjException

パラメータ

● name テーブルのカラム名を表す文字列。
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戻り値

指定された値の InputStream オブジェクトの表現。

getBoolean メソッド
boolean 値を返します。

オーバーロードリスト

名前 説明

getBoolean(int) メソッド boolean 値を返します。

getBoolean(String) メソッド boolean 値を返します。

getBoolean(int) メソッド
boolean 値を返します。

構文

boolean ResultSet.getBoolean(int ordinal) throws ULjException

パラメータ

● ordinal SQL 文でのカラムの順序を表す 1 から始まる整数。

戻り値

指定された値の boolean 表現。

getBoolean(String) メソッド
boolean 値を返します。

構文

boolean ResultSet.getBoolean(String name) throws ULjException

パラメータ

● name ResultSet オブジェクトでテーブルのカラム名を表す文字列。

戻り値

指定された値の boolean 表現。
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getBytes メソッド
byte 配列を返します。

オーバーロードリスト

名前 説明

getBytes(int) メソッド byte 配列を返します。

getBytes(String) メソッド byte 配列を返します。

getBytes(int) メソッド
byte 配列を返します。

構文

byte[] ResultSet.getBytes(int ordinal) throws ULjException

パラメータ

● ordinal SQL 文でのカラムの順序を表す 1 から始まる整数。

戻り値

指定された値の byte 配列表現。

getBytes(String) メソッド
byte 配列を返します。

構文

byte[] ResultSet.getBytes(String name) throws ULjException

パラメータ

● name テーブルのカラム名を表す文字列。

戻り値

指定された値の byte 配列表現。

getClobReader メソッド
Reader オブジェクトを返します。
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オーバーロードリスト

名前 説明

getClobReader(int) メソッド Reader オブジェクトを返します。

getClobReader(String) メソッド Reader オブジェクトを返します。

getClobReader(int) メソッド
Reader オブジェクトを返します。

構文

java.io.Reader ResultSet.getClobReader(int ordinal) throws ULjException

パラメータ

● ordinal SQL 文でのカラムの順序を表す 1 から始まる整数。

戻り値

指定された値の Reader オブジェクト表現。

getClobReader(String) メソッド
Reader オブジェクトを返します。

構文

java.io.Reader ResultSet.getClobReader(String name) throws ULjException

パラメータ

● name テーブルのカラム名を表す文字列。

戻り値

指定された値の Reader オブジェクト表現。

getDate メソッド
java.util.Date オブジェクトを返します。

オーバーロードリスト

名前 説明

getDate(int) メソッド java.util.Date オブジェクトを返します。

getDate(String) メソッド java.util.Date オブジェクトを返します。
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getDate(int) メソッド
java.util.Date オブジェクトを返します。

構文

java.util.Date ResultSet.getDate(int ordinal) throws ULjException

パラメータ

● ordinal SQL 文でのカラムの順序を表す 1 から始まる整数。

戻り値

指定された値の java.util.Date オブジェクト表現。

getDate(String) メソッド
java.util.Date オブジェクトを返します。

構文

java.util.Date ResultSet.getDate(String name) throws ULjException

パラメータ

● name テーブルのカラム名を表す文字列。

戻り値

指定された値の java.util.date オブジェクト表現。

getDecimalNumber メソッド
DecimalNumber オブジェクトを返します。

オーバーロードリスト

名前 説明

getDecimalNumber(int) メソッド DecimalNumber オブジェクトを返します。

getDecimalNumber(String) メソッド DecimalNumber オブジェクトを返します。

getDecimalNumber(int) メソッド
DecimalNumber オブジェクトを返します。
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構文

DecimalNumber ResultSet.getDecimalNumber(
    int ordinal
) throws ULjException

パラメータ

● ordinal SQL 文でのカラムの順序を表す 1 から始まる整数。

戻り値

指定された値の DecimalNumber オブジェクト表現。

参照

● DecimalNumber インタフェース [Ultra Light J]144 ページ

getDecimalNumber(String) メソッド
DecimalNumber オブジェクトを返します。

構文

DecimalNumber ResultSet.getDecimalNumber(
    String name
) throws ULjException

パラメータ

● name テーブルのカラム名を表す文字列。

戻り値

指定された値の DecimalNumber オブジェクト表現。

参照

● DecimalNumber インタフェース [Ultra Light J]144 ページ

getDouble メソッド
カラム番号に基づいた double 値を返します。

オーバーロードリスト

名前 説明

getDouble(int) メソッド カラム番号に基づいた double 値を返します。

getDouble(String) メソッド カラム名に基づいた double 値を返します。
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getDouble(int) メソッド
カラム番号に基づいた double 値を返します。

構文

double ResultSet.getDouble(int ordinal) throws ULjException

パラメータ

● ordinal SQL 文でのカラムの順序を表す 1 から始まる整数。

戻り値

指定された値の double 表現。

getDouble(String) メソッド
カラム名に基づいた double 値を返します。

構文

double ResultSet.getDouble(String name) throws ULjException

パラメータ

● name テーブルのカラム名を表す文字列。

戻り値

指定された値の double 表現。

getFloat メソッド
float 値を返します。

オーバーロードリスト

名前 説明

getFloat(int) メソッド float 値を返します。

getFloat(String) メソッド float 値を返します。

getFloat(int) メソッド
float 値を返します。

構文

float ResultSet.getFloat(int ordinal) throws ULjException

ResultSet インタフェース
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パラメータ

● ordinal SQL 文でのカラムの順序を表す 1 から始まる整数。

戻り値

指定された値の float 表現。

getFloat(String) メソッド
float 値を返します。

構文

float ResultSet.getFloat(String name) throws ULjException

パラメータ

● name テーブルのカラム名を表す文字列。

戻り値

指定された値の float 表現。

getInt メソッド
integer 値を返します。

オーバーロードリスト

名前 説明

getInt(int) メソッド integer 値を返します。

getInt(String) メソッド integer 値を返します。

getInt(int) メソッド
integer 値を返します。

構文

int ResultSet.getInt(int ordinal) throws ULjException

パラメータ

● ordinal SQL 文でのカラムの順序を表す 1 から始まる整数。

戻り値

指定された値の integer 表現。
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getInt(String) メソッド
integer 値を返します。

構文

int ResultSet.getInt(String name) throws ULjException

パラメータ

● name テーブルのカラム名を表す文字列。

戻り値

指定された値の integer 表現。

getLong メソッド
long integer 値を返します。

オーバーロードリスト

名前 説明

getLong(int) メソッド long integer 値を返します。

getLong(String) メソッド long integer 値を返します。

getLong(int) メソッド
long integer 値を返します。

構文

long ResultSet.getLong(int ordinal) throws ULjException

パラメータ

● ordinal SQL 文でのカラムの順序を表す 1 から始まる整数。

戻り値

指定された値の long integer 表現。

getLong(String) メソッド
long integer 値を返します。

構文

long ResultSet.getLong(String name) throws ULjException

ResultSet インタフェース
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パラメータ

● name テーブルのカラム名を表す文字列。

戻り値

指定された値の long integer 表現。

getOrdinal メソッド
String で表現された値の (1 から始まる) 順序を返します。

構文

int ResultSet.getOrdinal(String name) throws ULjException

パラメータ

● name テーブルのカラム名を表す文字列。

戻り値

順序の値。

getResultSetMetadata メソッド
ResultSet オブジェクトのメタデータを含む ResultSetMetadata オブジェクトを返します。

構文

ResultSetMetadata ResultSet.getResultSetMetadata() throws ULjException

戻り値

ResultSetMetadata オブジェクト。

getRowCount メソッド [Android]
テーブルのローの数を取得します。

構文

long ResultSet.getRowCount(long threshold) throws ULjException

パラメータ

● threshold カウントするローの数の制限。0 はエラーがないことを示します。

戻り値

テーブル内のローの数。
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備考

このメソッドは、"SELECT COUNT(*) FROM table" を実行するのと同じです。

getSize メソッド
結果セットカラムの実際のサイズを取得します。

オーバーロードリスト

名前 説明

getSize(int) メソッド 結果セットカラムの実際のサイズを取得しま
す。

getSize(String) メソッド 結果セットカラムの実際のサイズを取得しま
す。

getSize(int) メソッド
結果セットカラムの実際のサイズを取得します。

構文

int ResultSet.getSize(int ordinal) throws ULjException

パラメータ

● ordinal SQL 文でのカラムの順序を表す 1 から始まる整数。

戻り値

結果セットカラムの実際のサイズ。

getSize(String) メソッド
結果セットカラムの実際のサイズを取得します。

構文

int ResultSet.getSize(String name) throws ULjException

パラメータ

● name テーブルのカラム名を表す文字列。

戻り値

結果セットカラムの実際のサイズ。

ResultSet インタフェース
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getString メソッド
String 値を返します。

オーバーロードリスト

名前 説明

getString(int) メソッド String 値を返します。

getString(String) メソッド String 値を返します。

getString(int) メソッド
String 値を返します。

構文

String ResultSet.getString(int ordinal) throws ULjException

パラメータ

● ordinal SQL 文でのカラムの順序を表す 1 から始まる整数。

戻り値

指定された値の String 表現。

getString(String) メソッド
String 値を返します。

構文

String ResultSet.getString(String name) throws ULjException

パラメータ

● name テーブルのカラム名を表す文字列。

戻り値

指定された値の String 表現。

getUUIDValue メソッド
UUIDValue オブジェクトを返します。
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オーバーロードリスト

名前 説明

getUUIDValue(int) メソッド UUIDValue オブジェクトを返します。

getUUIDValue(String) メソッド UUIDValue オブジェクトを返します。

getUUIDValue(int) メソッド
UUIDValue オブジェクトを返します。

構文

UUIDValue ResultSet.getUUIDValue(int ordinal) throws ULjException

パラメータ

● ordinal SQL 文でのカラムの順序を表す 1 から始まる整数。

戻り値

指定された値の UUIDValue オブジェクト表現。

参照

● UUIDValue インタフェース [Ultra Light J]290 ページ

getUUIDValue(String) メソッド
UUIDValue オブジェクトを返します。

構文

UUIDValue ResultSet.getUUIDValue(String name) throws ULjException

パラメータ

● name テーブルのカラム名を表す文字列。

戻り値

指定された値の UUIDValue オブジェクト表現。

isNull メソッド
指定されたカラムの値が NULL かどうかをテストします。

ResultSet インタフェース
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オーバーロードリスト

名前 説明

isNull(int) メソッド 指定されたカラムの値が NULL かどうかをテ
ストします。

isNull(String) メソッド 指定されたカラム名が NULL かどうかをテス
トします。

isNull(int) メソッド
指定されたカラムの値が NULL かどうかをテストします。

構文

boolean ResultSet.isNull(int ordinal) throws ULjException

パラメータ

● ordinal SQL 文でのカラムの順序を表す 1 から始まる整数。

戻り値

値が NULL の場合は true、それ以外の場合は false。

isNull(String) メソッド
指定されたカラム名が NULL かどうかをテストします。

構文

boolean ResultSet.isNull(String name) throws ULjException

パラメータ

● name テーブルのカラム名を表す文字列。

戻り値

値が NULL の場合は true、それ以外の場合は false。

last メソッド [Android]
カーソルを最後のローに移動します。

構文

boolean ResultSet.last() throws ULjException
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戻り値

成功した場合は true、失敗した場合は false。

next メソッド
ResultSet オブジェクト内の次のデータローをフェッチします。

構文

boolean ResultSet.next() throws ULjException

戻り値

次のローが正常にフェッチされた場合は true、それ以外の場合は false。

参照

● ResultSetMetadata インタフェース [Ultra Light J]213 ページ

previous メソッド
ResultSet オブジェクト内の前のデータローをフェッチします。

構文

boolean ResultSet.previous() throws ULjException

戻り値

前のローが正常にフェッチされた場合は true、それ以外の場合は false。

relative メソッド [Android]
カーソルを、現在のカーソルの位置から、offset で指定したロー数分移動します。

構文

boolean ResultSet.relative(int offset) throws ULjException

パラメータ

● offset 移動するローの数。

戻り値

成功した場合は true、失敗した場合は false。

ResultSetMetadata インタフェース
ResultSet オブジェクトに関連付けられ、カラム情報を提供するメソッドが含まれます。

ResultSetMetadata インタフェース
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構文

public interface ResultSetMetadata

メンバー

継承されたメンバーを含む ResultSetMetadata インタフェースのすべてのメンバー。

名前 説明

getAliasName メソッド カラムのエイリアス名を返します。

getColumnCount メソッド ResultSet オブジェクト内のカラムの合計数を
返します。

getCorrelationName メソッド カラムの相関名を返します。

getDomainName メソッド ドメインの名前を返します。

getDomainPrecision メソッド ドメイン値の精度を返します。

getDomainScale メソッド ドメイン値の位取りを返します。

getDomainSize メソッド ドメイン値のサイズを返します。

getDomainType メソッド ドメインの型を返します。

getQualifiedName メソッド カラムの修飾名を返します。

getTableColumnName メソッド テーブルまたは派生テーブルのカラム名を返
します。

getTableName メソッド カラムのテーブル名を返します。

getWrittenName メソッド カラムの書き込み名を返します。

備考

このインタフェースは、ResultSet.getResultSetMetadata メソッドによって取得されます。

ResultSet オブジェクトの選択リストのカラムが簡略名または複合名 (table-name.column-name、
correlation-name.column-name) の場合、名前に関する次の情報が存在すると、その情報が抽出さ
れます。

●エイリアス名

●相関名

●名前の修飾バージョン

●テーブル名
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●書き込まれる名前

ResultSet オブジェクトの選択リストのカラムごとに、そのカラムのドメインに関する次の情報を
取得できます。

●カラム型：ドメインインタフェースの整数

●ドメインの名前

●ドメインのサイズ (VARCHAR ドメインと BINARY ドメインの場合)

●位取りと精度 (NUMERIC ドメインの場合)

参照

● Domain インタフェース [Ultra Light J]147 ページ
● ResultSet インタフェース [Ultra Light J]195 ページ
● ResultSet.getResultSetMetadata メソッド [Ultra Light J]208 ページ

getAliasName メソッド
カラムのエイリアス名を返します。

構文

String ResultSetMetadata.getAliasName(int column_no) throws ULjException

パラメータ

● column_no 選択リストの (1 から始まる) カラム番号。

戻り値

カラムにエイリアス名がない場合は NULL、そうでない場合はカラムのエイリアス名を返しま
す。

備考

エイリアス名 ([AS] 名) は、カラムを参照するために指定できます。

getColumnCount メソッド
ResultSet オブジェクト内のカラムの合計数を返します。

構文

int ResultSetMetadata.getColumnCount() throws ULjException

戻り値

カラムの数。

ResultSetMetadata インタフェース
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getCorrelationName メソッド
カラムの相関名を返します。

構文

String ResultSetMetadata.getCorrelationName(
    int column_no
) throws ULjException

パラメータ

● column_no 選択リストの (1 から始まる) カラム番号。

戻り値

カラムに相関名がない場合は NULL、そうでない場合はカラムの相関名を返します。

備考

FROM 句で指定した相関名 ([AS] correlation-name) により、派生テーブルなどのテーブル表現を
指定します。

getDomainName メソッド
ドメインの名前を返します。

構文

String ResultSetMetadata.getDomainName(
    int column_no
) throws ULjException

パラメータ

● column_no 選択リストの (1 から始まる) カラム番号。

戻り値

ドメイン名。

getDomainPrecision メソッド
ドメイン値の精度を返します。

構文

int ResultSetMetadata.getDomainPrecision(
    int column_no
) throws ULjException

パラメータ

● column_no 選択リストの (1 から始まる) カラム番号。
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戻り値

精度。

getDomainScale メソッド
ドメイン値の位取りを返します。

構文

int ResultSetMetadata.getDomainScale(int column_no) throws ULjException

パラメータ

● column_no 選択リストの (1 から始まる) カラム番号。

戻り値

位取り。

getDomainSize メソッド
ドメイン値のサイズを返します。

構文

int ResultSetMetadata.getDomainSize(int column_no) throws ULjException

パラメータ

● column_no 選択リストの (1 から始まる) カラム番号。

戻り値

サイズ。

getDomainType メソッド
ドメインの型を返します。

構文

short ResultSetMetadata.getDomainType(int column_no) throws ULjException

パラメータ

● column_no 選択リストの (1 から始まる) カラム番号。

戻り値

整数で表したドメインの型。

ResultSetMetadata インタフェース
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getQualifiedName メソッド
カラムの修飾名を返します。

構文

String ResultSetMetadata.getQualifiedName(
    int column_no
) throws ULjException

パラメータ

● column_no 選択リストの (1 から始まる) カラム番号。

戻り値

カラムに修飾名がない場合は NULL、そうでない場合はカラムの修飾名を返します。

備考

ResultSet カラムがテーブルのカラムを参照している場合、相関名 (相関名が指定されていない場
合はテーブル名) の後にテーブルのカラム名が続く複合名が返されます。

ResultSet カラムがテーブルのカラムを参照していない場合、エイリアスが指定されていれば、エ
イリアス名が返されます。

getTableColumnName メソッド
テーブルまたは派生テーブルのカラム名を返します。

構文

String ResultSetMetadata.getTableColumnName(
    int column_no
) throws ULjException

パラメータ

● column_no 選択リストの (1 から始まる) カラム番号。

戻り値

カラムにテーブル名がない場合は NULL、そうでない場合はカラムのテーブル名を返します。

getTableName メソッド
カラムのテーブル名を返します。

構文

String ResultSetMetadata.getTableName(int column_no) throws ULjException
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パラメータ

● column_no 選択リストの (1 から始まる) カラム番号。

戻り値

カラムにテーブル名がない場合は NULL、そうでない場合はカラムのテーブル名を返します。

備考

テーブルは、ResultSet カラムが参照するテーブル名 (相関名の可能性あり) です。

getWrittenName メソッド
カラムの書き込み名を返します。

構文

String ResultSetMetadata.getWrittenName(
    int column_no
) throws ULjException

パラメータ

● column_no 選択リストの (1 から始まる) カラム番号。

戻り値

カラムに書き込み名がない場合は NULL、そうでない場合はカラムの書き込み名を返します。

備考

書き込み名は、選択リストに指示カラムとして指定された単純名または複合名です。

SISListener インタフェース [BlackBerry]
サーバ起動同期のメッセージを受信します。

構文

public interface SISListener

メンバー

継承されたメンバーを含む SISListener インタフェースのすべてのメンバー。

名前 説明

startListening メソッド 受信スレッドを作成し、開始します。

stopListening メソッド 受信スレッドを停止します。

SISListener インタフェース [BlackBerry]
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備考

アプリケーションは、適切な DatabaseManager.createSISHTTPListener メソッドを使用して、
SISListener インタフェースのインスタンスを作成します。

参照

● DatabaseManager.createSISHTTPListener メソッド [BlackBerry] [Ultra Light J]143 ページ

startListening メソッド
受信スレッドを作成し、開始します。

構文

void SISListener.startListening()

stopListening メソッド
受信スレッドを停止します。

構文

void SISListener.stopListening()

SISRequestHandler インタフェース [BlackBerry]
サーバ起動同期の要求を処理します。

構文

public interface SISRequestHandler

メンバー

継承されたメンバーを含む SISRequestHandler インタフェースのすべてのメンバー。

名前 説明

onError メソッド 受信中に発生したサーバ起動同期エラーを処
理します。

onRequest メソッド ワーカスレッド上でサーバ起動同期の要求を
処理します。

参照

● SISListener インタフェース [BlackBerry] [Ultra Light J]219 ページ
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onError メソッド
受信中に発生したサーバ起動同期エラーを処理します。

構文

void SISRequestHandler.onError(String text)

パラメータ

● text 例外の string 表現。

備考

受信を停止するには、SISListener インタフェースの stopListening メソッドを明示的に呼び出しま
す。

onRequest メソッド
ワーカスレッド上でサーバ起動同期の要求を処理します。

構文

void SISRequestHandler.onRequest(String text)

パラメータ

● text 要求によって送信された文字列。

SQLInfo インタフェース [Android]
実行された SQL 文についての情報を示します。

構文

public interface SQLInfo

メンバー

継承されたメンバーを含む SQLInfo インタフェースのすべてのメンバー。

名前 説明

getMessage メソッド SQL コードに関連付けられたメッセージを返
します。

getParameter メソッド 指定されたパラメータを返します。

GetParameterCount メソッド メッセージのパラメータの数を返します。

SQLInfo インタフェース [Android]
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名前 説明

GetSQLCode メソッド 実行された SQL 文のコード (SQLCODE) を取
得します。

getSQLCount メソッド 実行された SQL 文の結果によって異なる値
を返します。

getMessage メソッド
SQL コードに関連付けられたメッセージを返します。

構文

String SQLInfo.getMessage()

getParameter メソッド
指定されたパラメータを返します。

構文

String SQLInfo.getParameter(short param_no)

パラメータ

● param_no 1 から始まるパラメータ番号。

戻り値

パラメータ。

GetParameterCount メソッド
メッセージのパラメータの数を返します。

構文

short SQLInfo.getParameterCount()

戻り値

パラメータ数。

GetSQLCode メソッド
実行された SQL 文のコード (SQLCODE) を取得します。
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構文

int SQLInfo.getSQLCode()

戻り値

SQLCODE 値。

getSQLCount メソッド
実行された SQL 文の結果によって異なる値を返します。

構文

int SQLInfo.getSQLCount()

戻り値

INSERT、UPDATE、または DELETE 文の実行後に、文の影響を受けたローの数。
SQLE_SYNTAX_ERROR が発生した場合の戻り値は、エラーに該当する動的 SQL 文のオフセッ
トです。

StreamHTTPParms インタフェース
HTTP を使用して Mobile Link サーバと通信する方法を定義する HTTP ストリームパラメータを
表します。

構文

public interface StreamHTTPParms

派生クラス

● StreamHTTPSParms インタフェース [Ultra Light J]236 ページ

メンバー

継承されたメンバーを含む StreamHTTPParms インタフェースのすべてのメンバー。

名前 説明

addCustomHTTPHeader メソッド [BlackBerry] メッセージヘッダを各 HTTP 要求に追加しま
す。

getCustomHTTPHeader メソッド [BlackBerry] addCustomHTTPHeader メソッドを使用して指
定した HTTP ヘッダを含む Hashtable オブ
ジェクトを返します。

getE2eePublicKey メソッド [BlackBerry] エンドツーエンドのパブリックキーを含む
ファイルの名前を返します。
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名前 説明

getE2eeType メソッド [BlackBerry] 使用中のエンドツーエンド暗号化タイプを返
します。

getExtraParameters メソッド [Android] 予備の Mobile Link クライアントネットワー
クプロトコルオプションを取得します。

getHost メソッド Mobile Link サーバのホスト名を返します。

getHTTPPassword メソッド [BlackBerry] HTTP パスワードを返します。

getHTTPUserId メソッド [BlackBerry] HTTP ユーザ ID を返します。

getOutputBufferSize メソッド データが Mobile Link サーバに送信される前
に格納される出力バッファのサイズをバイト
単位で返します。

getPort メソッド Mobile Link サーバへの接続に使用されてい
るポート番号を返します。

getURLSuffix メソッド Mobile Link サーバの URL サフィックスを返
します。

isRestartable メソッド 再起動可能な HTTP が使用されているかどう
かを判断します。

setE2eePublicKey メソッド [BlackBerry] エンドツーエンドのパブリックキーを含む
ファイルの名前を指定します。

setE2eeType メソッド [BlackBerry] 使用するエンドツーエンド暗号化タイプを指
定します。

setExtraParameters メソッド [Android] 予備の Mobile Link クライアントネットワー
クプロトコルオプションを設定します。

setHost メソッド Mobile Link サーバのホスト名を設定します。

setHTTPUserIdAndPassword メソッド
[BlackBerry]

RFC 2617 で定められている HTTP 基本認証
で使用されるユーザ ID とパスワードを設定
します。

setOutputBufferSize メソッド データが Mobile Link サーバに送信される前
に格納される出力バッファのサイズをバイト
単位で設定します。

setPort メソッド Mobile Link サーバへの接続に使用するポー
ト番号を設定します。
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名前 説明

setRestartable メソッド 再起動可能な HTTP を有効または無効にしま
す。

setURLSuffix メソッド Mobile Link サーバに接続するための URL サ
フィックスを指定します。

setZlibCompression メソッド ZLIB 圧縮を有効または無効にします。

setZlibDownloadWindowSize メソッド ZLIB 圧縮のダウンロードウィンドウサイズ
を設定します。

setZlibUploadWindowSize メソッド ZLIB 圧縮のアップロードウィンドウサイズ
を設定します。

zlibCompressionEnabled メソッド ZLIB 圧縮が有効かどうかを判断します。

E2EE_RSA 変数[BlackBerry] setE2eeType メソッドに渡されるときの RSA
ベースのエンドツーエンド暗号化を指定しま
す。

備考

次の例では、ホスト名 "MyMLHost" にある Mobile Link サーバと通信するようにストリームパラ
メータを設定しています。サーバは次のパラメータで起動されました。"-x http(port=1234)":

SyncParms syncParms = myConnection.createSyncParms(
    SyncParms.HTTP_STREAM,
    "MyUniqueMLUserID",
    "MyMLScriptVersion"
);
StreamHTTPParms httpParms = syncParms.getStreamParms();
httpParms.setHost("MyMLHost");
httpParms.setPort(1234);

このインタフェースを実装するインスタンスは、SyncParms.getStreamParms メソッドで返されま
す。

参照

● SyncParms クラス [Ultra Light J]248 ページ
● SyncParms.getStreamParms メソッド [Ultra Light J]254 ページ

addCustomHTTPHeader メソッド [BlackBerry]
メッセージヘッダを各 HTTP 要求に追加します。

構文

void StreamHTTPParms.addCustomHTTPHeader(String name, String value)
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パラメータ

● name ヘッダの名前。

● value ヘッダの値。

備考

このメソッドが同じ name パラメータを使用して複数回呼び出される場合、値はカンマ区切りリ
ストに連結されます。

次の標準ヘッダはこのメソッドでは変更できません。

●Connection

●Content-Length

●User-Agent

●Content-Type

その他のヘッダは Java VM で変更できます。

ヘッダ名として Cookie を指定してこのメソッドを呼び出すことにより、カスタム cookie を指定
します。

Android スマートフォンでは、setExtraParameters メソッドで custom_header パラメータを指定し
ます。

参照

● StreamHTTPParms.setExtraParameters メソッド [Android] [Ultra Light J]231 ページ

getCustomHTTPHeader メソッド [BlackBerry]
addCustomHTTPHeader メソッドを使用して指定した HTTP ヘッダを含む Hashtable オブジェク
トを返します。

構文

java.util.Hashtable StreamHTTPParms.getCustomHTTPHeaders()

戻り値

CustomHTTPHeader メソッドで指定した HTTP ヘッダを含む Hashtable キーはヘッダ名、値は
ヘッダ値です。

参照

● StreamHTTPParms.addCustomHTTPHeader メソッド [BlackBerry] [Ultra Light J]225 ページ
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getE2eePublicKey メソッド [BlackBerry]
エンドツーエンドのパブリックキーを含むファイルの名前を返します。

構文

String StreamHTTPParms.getE2eePublicKey()

戻り値

エンドツーエンドのパブリックキーを含むファイルの名前。

参照

● StreamHTTPParms.setE2eePublicKey メソッド [BlackBerry] [Ultra Light J]230 ページ

getE2eeType メソッド [BlackBerry]
使用中のエンドツーエンド暗号化タイプを返します。

構文

short StreamHTTPParms.getE2eeType()

戻り値

エンドツーエンド暗号化タイプ

getExtraParameters メソッド [Android]
予備の Mobile Link クライアントネットワークプロトコルオプションを取得します。

構文

String StreamHTTPParms.getExtraParameters()

戻り値

設定された予備のプロトコルオプション。

getHost メソッド
Mobile Link サーバのホスト名を返します。

構文

String StreamHTTPParms.getHost()

戻り値

ホスト名。
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参照

● StreamHTTPParms.setHost メソッド [Ultra Light J]231 ページ
● StreamHTTPParms.getPort メソッド [Ultra Light J]229 ページ
● StreamHTTPParms.setPort メソッド [Ultra Light J]233 ページ

getHTTPPassword メソッド [BlackBerry]
HTTP パスワードを返します。

構文

String StreamHTTPParms.getHTTPPassword()

戻り値

以前に setHTTPUserIdAndPassword メソッドで設定されたパスワード

参照

● StreamHTTPParms.setHTTPUserIdAndPassword メソッド [BlackBerry] [Ultra Light J]232 ページ

getHTTPUserId メソッド [BlackBerry]
HTTP ユーザ ID を返します。

構文

String StreamHTTPParms.getHTTPUserId()

戻り値

以前に setHTTPUserIdAndPassword メソッドで設定されたユーザ ID

参照

● StreamHTTPParms.setHTTPUserIdAndPassword メソッド [BlackBerry] [Ultra Light J]232 ページ

getOutputBufferSize メソッド
データが Mobile Link サーバに送信される前に格納される出力バッファのサイズをバイト単位で
返します。

構文

int StreamHTTPParms.getOutputBufferSize()

戻り値

バッファサイズの整数値。
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備考

この値を大きくすると、サイズの大きいアップロードの送信に必要なネットワークフラッシュの
回数が減る可能性がありますが、メモリの使用量が増えます。HTTP では、フラッシュごとに大
容量 (約 250 バイト) の HTTP ヘッダが送信されるので、フラッシュの回数が減ると帯域幅の使
用量が削減されます。

参照

● StreamHTTPParms.setOutputBufferSize メソッド [Ultra Light J]232 ページ

getPort メソッド
Mobile Link サーバへの接続に使用されているポート番号を返します。

構文

int StreamHTTPParms.getPort()

戻り値

Mobile Link サーバのポート番号。

参照

● StreamHTTPParms.setPort メソッド [Ultra Light J]233 ページ

getURLSuffix メソッド
Mobile Link サーバの URL サフィックスを返します。

構文

String StreamHTTPParms.getURLSuffix()

戻り値

URL サフィックスを含む文字列。

参照

● StreamHTTPParms.setURLSuffix メソッド [Ultra Light J]233 ページ

isRestartable メソッド
再起動可能な HTTP が使用されているかどうかを判断します。

構文

boolean StreamHTTPParms.isRestartable()

StreamHTTPParms インタフェース

Copyright © 2013, SAP AG or an SAP affiliate company. - SAP Sybase SQL Anywhere 16.0 229



戻り値

再起動可能な HTTP が有効である場合は true、それ以外は false。

参照

● StreamHTTPParms.setRestartable メソッド [Ultra Light J]233 ページ

setE2eePublicKey メソッド [BlackBerry]
エンドツーエンドのパブリックキーを含むファイルの名前を指定します。

構文

void StreamHTTPParms.setE2eePublicKey(String public_key)

パラメータ

● public_key 暗号化に使用する RSA パブリックキーファイルの名前。この名前は DER で
コード化される必要があります。

備考

デフォルトでは、この値は NULL で、エンドツーエンドの暗号化は使用されないことを示しま
す。

このメソッドは e2ee_public_key プロトコルオプションに対応します。

パブリックキーは、SD カードまたはデバイスのオブジェクトストアに格納できます。

SD カードを使用する場合、public_key パラメータは次の形式にしてください。

file://path

path はカード上のこのファイルへの絶対パスです。たとえば、file:///SDCard/ulj/public_key.der は
有効な public_key パラメータです。

オブジェクトストアを使用する場合は、Ultra Light Java Edition Database Transfer ユーティリティ
を使用して Mobile Link サーバからファイルをダウンロードします。キーには、der ファイル拡
張子が必要です。

参照

● StreamHTTPParms.getE2eePublicKey メソッド [BlackBerry] [Ultra Light J]227 ページ
●「e2ee_public_key」『Mobile Link クライアント管理』
●「Ultra Light Java Edition データベース転送ユーティリティ」『Ultra Light データベース管理と

リファレンス』

setE2eeType メソッド [BlackBerry]
使用するエンドツーエンド暗号化タイプを指定します。
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構文

void StreamHTTPParms.setE2eeType(short type)

パラメータ

● type StreamHTTPParms.E2EE_RSA 定数を渡します。StreamHTTPParms.E2EE_RSA がデ
フォルトです。

参照

● StreamHTTPParms.E2EE_RSA 変数 [BlackBerry] [Ultra Light J]236 ページ

setExtraParameters メソッド [Android]
予備の Mobile Link クライアントネットワークプロトコルオプションを設定します。

構文

void StreamHTTPParms.setExtraParameters(String parms)

パラメータ

● parms セミコロンで区切ったプロトコルオプションのリスト。

備考

これらのオプションは、このクラスのメソッドの結果である設定から構築されるリストに付加さ
れます。

このメソッドによって設定されるオプションにより、他のメソッドによって設定された同じオプ
ションは上書きされます。たとえば、予備のパラメータに "host=abc" が含まれている場合、
setHost("xyz") メソッドが呼び出されると、ホストオプションは "abc" になります。

setHost メソッド
Mobile Link サーバのホスト名を設定します。

構文

void StreamHTTPParms.setHost(String v)

パラメータ

● v ホスト名。

備考

デフォルトは NULL で、これは localhost を示します。
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参照

● StreamHTTPParms.getHost メソッド [Ultra Light J]227 ページ
● StreamHTTPParms.getPort メソッド [Ultra Light J]229 ページ
● StreamHTTPParms.setPort メソッド [Ultra Light J]233 ページ

setHTTPUserIdAndPassword メソッド [BlackBerry]
RFC 2617 で定められている HTTP 基本認証で使用されるユーザ ID とパスワードを設定します。

構文

void StreamHTTPParms.setHTTPUserIdAndPassword(
    String userid,
    String password
)

パラメータ

● userid 使用するユーザ ID。

● password 使用するパスワード。

備考

基本的な HTTP 認証ではパスワードはクリアテキストで HTTP ヘッダに含められますが、HTTPS
を使用するとヘッダが暗号化されパスワードを保護できます。

参照

● RFC 2617: HTTP Authentication

setOutputBufferSize メソッド
データが Mobile Link サーバに送信される前に格納される出力バッファのサイズをバイト単位で
設定します。

構文

void StreamHTTPParms.setOutputBufferSize(int size)

パラメータ

● size 新しいバッファのサイズ。

備考

デフォルトは 4096 で、有効な値の範囲は 512 ～ 32768 です。この値を大きくすると Java ランタ
イムから、Mobile Link サーバでは処理できないチャンク形式の HTTP が送信される可能性があ
ります。

Mobile Link サーバから「未知の転送エンコードです」というエラーが出力された場合は、この
値を小さくしてみてください。
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参照

● StreamHTTPParms.getOutputBufferSize メソッド [Ultra Light J]228 ページ

setPort メソッド
Mobile Link サーバへの接続に使用するポート番号を設定します。

構文

void StreamHTTPParms.setPort(int v)

パラメータ

● v 1 ～ 65535 のポート番号。範囲外の値はデフォルト値に変更されます。

備考

デフォルトのポートは HTTP 同期の場合は 80、HTTPS 同期の場合は 443 です。

参照

● StreamHTTPParms.getPort メソッド [Ultra Light J]229 ページ

setRestartable メソッド
再起動可能な HTTP を有効または無効にします。

構文

void StreamHTTPParms.setRestartable(boolean isRestartable)

パラメータ

● isRestartable 再起動可能な HTTP を有効にする場合は、true に設定します。デフォルト値
は false です。

備考

再開可能な HTTP が有効になっている場合、Ultra Light J では信頼性の低いネットワークでネッ
トワークが頻繁に失敗しないよう、ネットワークの割り込みが許容されます。

再起動可能な HTTP を使用するには、Ultra Light J と Mobile Link サーバの両方に CR#690250 が
適用されている必要があります。

参照

● StreamHTTPParms.isRestartable メソッド [Ultra Light J]229 ページ

setURLSuffix メソッド
Mobile Link サーバに接続するための URL サフィックスを指定します。
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構文

void StreamHTTPParms.setURLSuffix(String v)

パラメータ

● v URL サフィックスの文字列。

備考

Ultra Light J は次のフォーマットの URL を形成します。

[http|https]://host-name:port-number/url-suffix

デフォルトでは、url-suffix は "Mobilink/" です。「v」 を NULL に設定することによって、URL
サフィックスをデフォルトに設定できます。

次のコードは、BlackBerry スマートフォンに対して Wi-Fi 接続だけで接続するように指示する
URL サフィックスを指定する方法を示しています。

myHTTPParms.setURLSuffix(";deviceside=true;interface=wifi");

次のコードは、一部の BlackBerry スマートフォンで必要になることがある BlackBerry Enterprise
Server (BES) を使用して HTTPS プロトコル上で同期するように、BlackBerry スマートフォンに指
示する URL を指定する方法を示しています。

myHTTPParms.setURLSuffix(";EndToEndRequired");
 End-to-end encryption is required when the host (MobiLink or relay server) uses a certificate that is not 
trusted by the BES (the certificate's chain may not be trusted or the hostname in the certificate does not 
match the hostname). When end-to-end encryption is required, the certificate needs to be installed and 
trusted on the device.

参照

● StreamHTTPParms.getURLSuffix メソッド [Ultra Light J]229 ページ

setZlibCompression メソッド
ZLIB 圧縮を有効または無効にします。

構文

void StreamHTTPParms.setZlibCompression(boolean enable)

パラメータ

● enable ZLIB 圧縮を有効にする場合は true、無効にする場合は false に設定します。

備考

デフォルトでは、ZLIB 圧縮は無効です。

このメソッドは compression=zlib プロトコルオプションに対応します。
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参照

●「compression」『Mobile Link クライアント管理』

setZlibDownloadWindowSize メソッド
ZLIB 圧縮のダウンロードウィンドウサイズを設定します。

構文

void StreamHTTPParms.setZlibDownloadWindowSize(int size)

パラメータ

● size 圧縮ウィンドウサイズの指定。このパラメータは、ウィンドウサイズ (履歴バッファの
サイズ) を底が 2 の対数で指定します。Android の場合は、9 ～ 15 の有効範囲を指定します。
BlackBerry の場合は、10 ～ 15 の有効範囲を指定します。

備考

このメソッドは、zlib_download_window_size プロトコルオプションに対応します。

参照

●「zlib_download_window_size」『Mobile Link クライアント管理』

setZlibUploadWindowSize メソッド
ZLIB 圧縮のアップロードウィンドウサイズを設定します。

構文

void StreamHTTPParms.setZlibUploadWindowSize(int size)

パラメータ

● size 圧縮ウィンドウサイズの指定。このパラメータは、ウィンドウサイズ (履歴バッファの
サイズ) を底が 2 の対数で指定します。Android の場合は、9 ～ 15 の有効範囲を指定します。
BlackBerry の場合は、8 ～ 15 (両端の値を含む) の有効範囲を指定します。

備考

このメソッドは、zlib_upload_window_size プロトコルオプションに対応します。

参照

●「zlib_upload_window_size」『Mobile Link クライアント管理』

zlibCompressionEnabled メソッド
ZLIB 圧縮が有効かどうかを判断します。
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構文

boolean StreamHTTPParms.zlibCompressionEnabled()

戻り値

有効である場合は true、それ以外の場合は false。

参照

● StreamHTTPParms.setZlibCompression メソッド [Ultra Light J]234 ページ

E2EE_RSA 変数[BlackBerry]
setE2eeType メソッドに渡されるときの RSA ベースのエンドツーエンド暗号化を指定します。

構文

final short StreamHTTPParms.E2EE_RSA

参照

● StreamHTTPParms.setE2eeType メソッド [BlackBerry] [Ultra Light J]230 ページ

StreamHTTPSParms インタフェース
セキュア HTTPS 接続を使用して Mobile Link サーバと通信する方法を定義する HTTPS スト
リームパラメータを表します。

構文

public interface StreamHTTPSParms

基本クラス

● StreamHTTPParms インタフェース [Ultra Light J]223 ページ

メンバー

継承されたメンバーを含む StreamHTTPSParms インタフェースのすべてのメンバー。

名前 説明

addCustomHTTPHeader メソッド [BlackBerry] メッセージヘッダを各 HTTP 要求に追加しま
す。

getCertificateCompany メソッド セキュア接続の検証に使用する証明書の会社
名を返します。

getCertificateName メソッド セキュア接続の検証に使用する証明書の通称
を返します。
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名前 説明

getCertificateUnit メソッド セキュア接続の検証に使用する証明書に記載
される部署名を返します。

getCustomHTTPHeader メソッド [BlackBerry] addCustomHTTPHeader メソッドを使用して指
定した HTTP ヘッダを含む Hashtable オブ
ジェクトを返します。

getE2eePublicKey メソッド [BlackBerry] エンドツーエンドのパブリックキーを含む
ファイルの名前を返します。

getE2eeType メソッド [BlackBerry] 使用中のエンドツーエンド暗号化タイプを返
します。

getExtraParameters メソッド [Android] 予備の Mobile Link クライアントネットワー
クプロトコルオプションを取得します。

getHost メソッド Mobile Link サーバのホスト名を返します。

getHTTPPassword メソッド [BlackBerry] HTTP パスワードを返します。

getHTTPUserId メソッド [BlackBerry] HTTP ユーザ ID を返します。

getOutputBufferSize メソッド データが Mobile Link サーバに送信される前
に格納される出力バッファのサイズをバイト
単位で返します。

getPort メソッド Mobile Link サーバへの接続に使用されてい
るポート番号を返します。

getTrustedCertificates メソッド 安全な同期に使用される信頼できるルート証
明書リストのファイル名を返します。

getURLSuffix メソッド Mobile Link サーバの URL サフィックスを返
します。

isRestartable メソッド 再起動可能な HTTP が使用されているかどう
かを判断します。

setCertificateCompany メソッド セキュア接続の検証に使用する証明書の会社
名を設定します。

setCertificateName メソッド セキュア接続の検証に使用する証明書の通称
を設定します。

setCertificateUnit メソッド セキュア接続の検証に使用する証明書に記載
される部署名を設定します。
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名前 説明

setE2eePublicKey メソッド [BlackBerry] エンドツーエンドのパブリックキーを含む
ファイルの名前を指定します。

setE2eeType メソッド [BlackBerry] 使用するエンドツーエンド暗号化タイプを指
定します。

setExtraParameters メソッド [Android] 予備の Mobile Link クライアントネットワー
クプロトコルオプションを設定します。

setHost メソッド Mobile Link サーバのホスト名を設定します。

setHTTPUserIdAndPassword メソッド
[BlackBerry]

RFC 2617 で定められている HTTP 基本認証
で使用されるユーザ ID とパスワードを設定
します。

setOutputBufferSize メソッド データが Mobile Link サーバに送信される前
に格納される出力バッファのサイズをバイト
単位で設定します。

setPort メソッド Mobile Link サーバへの接続に使用するポー
ト番号を設定します。

setRestartable メソッド 再起動可能な HTTP を有効または無効にしま
す。

setTrustedCertificates メソッド 安全な同期に使用される信頼できるルート証
明書リストのファイルを設定します。

setURLSuffix メソッド Mobile Link サーバに接続するための URL サ
フィックスを指定します。

setZlibCompression メソッド ZLIB 圧縮を有効または無効にします。

setZlibDownloadWindowSize メソッド ZLIB 圧縮のダウンロードウィンドウサイズ
を設定します。

setZlibUploadWindowSize メソッド ZLIB 圧縮のアップロードウィンドウサイズ
を設定します。

zlibCompressionEnabled メソッド ZLIB 圧縮が有効かどうかを判断します。

E2EE_RSA 変数[BlackBerry] setE2eeType メソッドに渡されるときの RSA
ベースのエンドツーエンド暗号化を指定しま
す。
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備考

次の例では、ホスト名 "MyMLHost" にある Mobile Link サーバと通信するようにストリームパラ
メータを設定しています。サーバは次のパラメータで起動されました。"-x
https(port=1234;certificate=RSAServer.crt;certificate_password=x)"

SyncParms syncParms = myConnection.createSyncParms(
        SyncParms.HTTPS_STREAM,
        "MyUniqueMLUserID",
        "MyMLScriptVersion"
    );
StreamHTTPSParms httpsParms =
    (StreamHTTPSParms) syncParms.getStreamParms();
httpsParms.setHost("MyMLHost");
httpsParms.setPort(1234);

上記の例では、RSAServer.crt 内の証明書が、クライアントホストまたはデバイスにインストー
ル済みの信頼できるルート証明書のチェーンに追加されていることを前提としています。

J2SE の場合、次のいずれかの方法で、必要な信用されたルート証明書を配備できます。

1. 信頼できるルート証明書を JRE の lib/security/cacerts キーストアにインストールする。

2. Java の keytool ユーティリティを使用して独自のキーストアを構築し、Java システムプロパ
ティ javax.net.ssl.trustStore をその場所に設定する (javax.net.ssl.trustStorePassword メソッドを
適切な値に設定する)。

3. setTrustedCertificates(String) パラメータを使用して、配備された証明書ファイルを参照する。

セキュリティを強化するには、setCertificateName、setCertificateCompany、setCertificateUnit の各
メソッドを使用して Mobile Link サーバの証明書の検証を有効にします。

このインタフェースを実装するインスタンスは、HTTPS 同期用に SyncParms オブジェクトが作
成されたときに、SyncParms.getStreamParms メソッドによって返されます。

参照

● SyncParms クラス [Ultra Light J]248 ページ
● SyncParms.getStreamParms メソッド [Ultra Light J]254 ページ
● StreamHTTPSParms.setCertificateCompany メソッド [Ultra Light J]240 ページ
● StreamHTTPSParms.setCertificateName メソッド [Ultra Light J]241 ページ
● StreamHTTPSParms.setCertificateUnit メソッド [Ultra Light J]241 ページ
● StreamHTTPSParms.setTrustedCertificates メソッド [Ultra Light J]241 ページ

getCertificateCompany メソッド
セキュア接続の検証に使用する証明書の会社名を返します。

構文

String StreamHTTPSParms.getCertificateCompany()

StreamHTTPSParms インタフェース
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戻り値

証明書の会社名。

getCertificateName メソッド
セキュア接続の検証に使用する証明書の通称を返します。

構文

String StreamHTTPSParms.getCertificateName()

戻り値

証明書の名前。

getCertificateUnit メソッド
セキュア接続の検証に使用する証明書に記載される部署名を返します。

構文

String StreamHTTPSParms.getCertificateUnit()

戻り値

組織単位名。

getTrustedCertificates メソッド
安全な同期に使用される信頼できるルート証明書リストのファイル名を返します。

構文

String StreamHTTPSParms.getTrustedCertificates()

戻り値

信用されたルート証明書ファイルのファイル名。

参照

● StreamHTTPSParms.setTrustedCertificates メソッド [Ultra Light J]241 ページ

setCertificateCompany メソッド
セキュア接続の検証に使用する証明書の会社名を設定します。

構文

void StreamHTTPSParms.setCertificateCompany(String val)
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パラメータ

● val 会社名。

備考

デフォルトは NULL で、この場合、証明書で会社名は検証されません。

setCertificateName メソッド
セキュア接続の検証に使用する証明書の通称を設定します。

構文

void StreamHTTPSParms.setCertificateName(String val)

パラメータ

● val 証明書の通称。

備考

デフォルトは NULL で、この場合、証明書で通称は検証されません。

setCertificateUnit メソッド
セキュア接続の検証に使用する証明書に記載される部署名を設定します。

構文

void StreamHTTPSParms.setCertificateUnit(String val)

パラメータ

● val 会社の組織単位名。

備考

デフォルトは NULL で、この場合、証明書で組織単位名は検証されません。

setTrustedCertificates メソッド
安全な同期に使用される信頼できるルート証明書リストのファイルを設定します。

構文

void StreamHTTPSParms.setTrustedCertificates(
    String filename
) throws ULjException

パラメータ

● filename 信用されたルート証明書のファイル名。
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備考

このメソッドは、プラットフォーム上の Java Runtime Environment で許可される任意の X.509 形
式をサポートします。J2SE ではルート証明書の格納に JKS KeyStore タイプが使用され、Android
スマートフォンでは BKS KeyStore が使用されます。

このメソッドを使用できるのは、J2SE プラットフォームと Android スマートフォン上だけです。

証明書は、次の優先度の規則に従って使用されます。

1. このメソッドが呼び出された場合、指定したファイルの証明書が使用されます。

2. このメソッドが呼び出されず、ulinit または ulload ユーティリティによって証明書がデータ
ベースが設定されている場合、それらの証明書が使用されます。

3. このメソッド、ulinit または ulload ユーティリティのいずれによっても証明書が指定されず、
Android を使用している場合は、証明書はオペレーティングシステムの信頼できる証明書ス
トアから読み込まれます。この証明書ストアは、Web サーバを安全に管理するために
HTTPS を介して接続するときに、Web ブラウザで使用されます。

参照

● StreamHTTPSParms.getTrustedCertificates メソッド [Ultra Light J]240 ページ

SyncObserver インタフェース
同期の進行状況の情報を受け取ります。

構文

public interface SyncObserver

メンバー

継承されたメンバーを含む SyncObserver インタフェースのすべてのメンバー。

名前 説明

syncProgress メソッド ユーザに進行状況を通知します。

備考

同期の進行状況レポートを受け取るには、同期を実行する新しいクラスを作成し、
SyncParms.setSyncObserver メソッドを使用して実装します。

次に、SyncObserver オブジェクトの簡単な実装例を示します。

class MyObserver implements SyncObserver {
  public boolean syncProgress(int state, SyncResult result) {
    System.out.println(
        "sync progress state = " + state
        + " bytes sent = " + result.getSentByteCount()
        + " bytes received = " + result.getReceivedByteCount()
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      );
    return false;   // Always continue synchronization.
  }
  public MyObserver() {} // The default constructor.
}

上記のクラスは、次のメソッドの呼び出しによって有効にできます。

SyncParms.setSyncObserver(new MyObserver());

参照

● SyncParms クラス [Ultra Light J]248 ページ
● SyncParms.setSyncObserver メソッド [Ultra Light J]263 ページ

syncProgress メソッド
ユーザに進行状況を通知します。

構文

boolean SyncObserver.syncProgress(int state, SyncResult data)

パラメータ

● state 同期の現在のステータスを表す SyncOberver.States 定数の 1 つ。

● data 同期の最新の結果を含む SyncResult オブジェクト。

戻り値

同期をキャンセルする場合は true、続行する場合は false を返します。

備考

このメソッドは同期中に呼び出されます。

パケットとして通知されるさまざまなステータスが送受信されます。1 つのパケットで複数の
テーブルがアップロードまたはダウンロードされることがあるので、任意の同期に対するこのメ
ソッドの呼び出しでは、いくつかのステータスが省略される場合があります。

注意

SyncResult メソッドを除き、syncProgress 呼び出し中に他の Ultra Light J API メソッドを呼び出す
ことはできません。

参照

● SyncObserver.States インタフェース [Ultra Light J]244 ページ
● SyncParms.setSyncObserver メソッド [Ultra Light J]263 ページ
● SyncResult クラス [Ultra Light J]266 ページ
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SyncObserver.States インタフェース
observer に通知できる同期ステータスを定義します。

構文

public interface SyncObserver.States

メンバー

継承されたメンバーを含む SyncObserver.States インタフェースのすべてのメンバー。

名前 説明

COMMITTING_DOWNLOAD 変数 ダウンロードされたローがデータベースにコ
ミットされていることを示します。

CONNECTING 変数 同期を開始していることを示します。

DISCONNECTING 変数 同期ストリームを切断していることを示しま
す。

DONE 変数 同期を終了していることを示します。

ERROR 変数 同期は完了しましたが、エラーが発生したこ
とを示します。

FINISHING_UPLOAD 変数 アップロードの完了処理中であることを示し
ます。

RECEIVING_DATA 変数 スキーマ情報またはローデータが受信されて
いることを示します。

RECEIVING_TABLE 変数 新しいテーブルがダウンロードされているこ
とを示します。

RECEIVING_UPLOAD_ACK 変数 アップロードの確認がダウンロードされてい
ることを示します。

ROLLING_BACK_DOWNLOAD 変数 ダウンロードされたローがデータベースにコ
ミットされていることを示します。

SENDING_DATA 変数 スキーマ情報またはローデータが送信されて
いることを示します。

SENDING_DOWNLOAD_ACK 変数 ダウンロード完了の確認が送信されているこ
とを示します。

SENDING_HEADER 変数 同期ストリームが開かれ、ヘッダが送信され
ようとしています。
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名前 説明

SENDING_TABLE 変数 新しいテーブルがアップロードされているこ
とを示します。

STARTING 変数 同期を開始していることを示します。

参照

● SyncParms.setSyncObserver メソッド [Ultra Light J]263 ページ
● SyncObserver インタフェース [Ultra Light J]242 ページ

COMMITTING_DOWNLOAD 変数
ダウンロードされたローがデータベースにコミットされていることを示します。

構文

final int SyncObserver.States.COMMITTING_DOWNLOAD

CONNECTING 変数
同期を開始していることを示します。

構文

final int SyncObserver.States.CONNECTING

備考

処理はまだ行われていません。

DISCONNECTING 変数
同期ストリームを切断していることを示します。

構文

final int SyncObserver.States.DISCONNECTING

DONE 変数
同期を終了していることを示します。

構文

final int SyncObserver.States.DONE

SyncObserver.States インタフェース

Copyright © 2013, SAP AG or an SAP affiliate company. - SAP Sybase SQL Anywhere 16.0 245



備考

その他のステータスはレポートされません。

ERROR 変数
同期は完了しましたが、エラーが発生したことを示します。

構文

final int SyncObserver.States.ERROR

FINISHING_UPLOAD 変数
アップロードの完了処理中であることを示します。

構文

final int SyncObserver.States.FINISHING_UPLOAD

RECEIVING_DATA 変数
スキーマ情報またはローデータが受信されていることを示します。

構文

final int SyncObserver.States.RECEIVING_DATA

RECEIVING_TABLE 変数
新しいテーブルがダウンロードされていることを示します。

構文

final int SyncObserver.States.RECEIVING_TABLE

RECEIVING_UPLOAD_ACK 変数
アップロードの確認がダウンロードされていることを示します。

構文

final int SyncObserver.States.RECEIVING_UPLOAD_ACK

ROLLING_BACK_DOWNLOAD 変数
ダウンロードされたローがデータベースにコミットされていることを示します。
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構文

final int SyncObserver.States.ROLLING_BACK_DOWNLOAD

備考

ダウンロード中にエラーが発生したため、同期によってダウンロードがロールバックされている
ことを示します。

SENDING_DATA 変数
スキーマ情報またはローデータが送信されていることを示します。

構文

final int SyncObserver.States.SENDING_DATA

SENDING_DOWNLOAD_ACK 変数
ダウンロード完了の確認が送信されていることを示します。

構文

final int SyncObserver.States.SENDING_DOWNLOAD_ACK

SENDING_HEADER 変数
同期ストリームが開かれ、ヘッダが送信されようとしています。

構文

final int SyncObserver.States.SENDING_HEADER

備考

同期ストリームが開かれ、ヘッダが送信されようとしていることを示します。

SENDING_TABLE 変数
新しいテーブルがアップロードされていることを示します。

構文

final int SyncObserver.States.SENDING_TABLE

STARTING 変数
同期を開始していることを示します。
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構文

final int SyncObserver.States.STARTING

備考

処理はまだ行われていません。

SyncParms クラス
データベース同期処理中に使用されたパラメータを保持します。

構文

public class SyncParms

メンバー

継承されたメンバーを含む SyncParms クラスのすべてのメンバー。

名前 説明

getAcknowledgeDownload メソッド クライアントがダウンロードの確認を送信し
ているかどうかを判断します。

getAdditionalParms メソッド [Android] 追加の同期パラメータを返します。

getAuthenticationParms メソッド カスタムのユーザ認証スクリプトに渡される
パラメータを返します。

getKeepPartialDownload メソッド [Android] 部分ダウンロードが有効かどうかを判断しま
す。

getLivenessTimeout メソッド 活性タイムアウトの長さを秒単位で返しま
す。

getNewPassword メソッド setUserName メソッドで指定されたユーザの
新しい Mobile Link パスワードを返します。

getPassword メソッド setUserName メソッドで指定されたユーザの
Mobile Link パスワードを返します。

getPublications メソッド 同期させるパブリケーションを返します。

getResumePartialDownload メソッド [Android] 部分ダウンロードを再開する必要があるかど
うかを判断します。

getStreamParms メソッド 同期ストリームの設定に使用するパラメータ
を返します。
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名前 説明

getSyncObserver メソッド 現在指定されている SyncObserver オブジェク
トを返します。

getSyncResult メソッド 同期のステータスを含む SyncResult オブジェ
クトを返します。

getTableOrder メソッド 統合データベースにテーブルがアップロード
される順序を返します。

getUserName メソッド Mobile Link サーバがクライアントをユニー
クに識別する Mobile Link ユーザ名を返しま
す。

getVersion メソッド 使用するスクリプトバージョンを返します。

isDownloadOnly メソッド 同期がダウンロード専用かどうかを確認しま
す。

isPingOnly メソッド クライアントが Mobile Link サーバに対して
ping または同期を実行しているかどうかを確
認します。

isUploadOnly メソッド 同期がアップロード専用かどうかを確認しま
す。

setAcknowledgeDownload メソッド クライアントがダウンロードの確認を送信す
べきかどうかを指定します。

setAdditionalParms メソッド [Android] 「名前=値」のペアをセミコロンで区切ったリ
ストで、追加の同期パラメータを指定します。

setAuthenticationParms メソッド カスタムユーザ認証スクリプト (Mobile Link
authenticate_parameters 接続イベント) のパラ
メータを指定します。

setDownloadOnly メソッド 同期をダウンロード専用に設定します。

setKeepPartialDownload メソッド [Android] 同期中に部分ダウンロードを許可するかどう
かを指定します。

setLivenessTimeout メソッド 活性タイムアウトの長さを秒単位で設定しま
す。

setNewPassword メソッド setUserName メソッドで指定されたユーザの
新しい Mobile Link パスワードを設定します。
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名前 説明

setPassword メソッド setUserName メソッドで指定されたユーザの
Mobile Link パスワードを設定します。

setPingOnly メソッド クライアントが Mobile Link サーバに対して、
同期を実行しないで ping を実行するように
設定します。

setPublications メソッド 同期させるパブリケーションを設定します。

setResumePartialDownload メソッド [Android] 前回の部分ダウンロードを再開するか破棄す
るかを指定します。

setSyncObserver メソッド 同期の進行状況をモニタする SyncObserver オ
ブジェクトを設定します。

setTableOrder メソッド 統合データベースにテーブルがアップロード
される順序を設定します。

setUploadOnly メソッド 同期をアップロード専用に設定します。

setUserName メソッド Mobile Link サーバがクライアントをユニー
クに識別する Mobile Link ユーザ名を設定し
ます。

setVersion メソッド 使用する同期スクリプトを設定します。

HTTP_STREAM 変数 HTTP 同期用の SyncParms オブジェクトを作
成します。

HTTPS_STREAM 変数 セキュア HTTPS 同期用の SyncParms オブ
ジェクトを作成します。

備考

このインタフェースは、Connection.createSyncParms メソッドによって呼び出されます。

同期コマンドは一度に 1 つだけ設定できます。コマンドは、setDownloadOnly、setPingOnly、
setUploadOnly の各メソッドを使用して指定します。このいずれかのメソッドを true に設定する
と、他のメソッドが false に設定されます。

UserName パラメータと Version パラメータは設定する必要があります。UserName はクライア
ントデータベースごとにユニークである必要があります。

通信ストリームは、getStreamParms メソッドを使用して、SyncParms オブジェクトのタイプに基
づいて設定します。たとえば、次のコードでは、HTTP 同期の準備と実行を行っています。

SyncParms syncParms = myConnection.createSyncParms(
    SyncParms.HTTP_STREAM,
    "MyUniqueMLUserID",
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    "MyMLScriptVersion"
);
syncParms.setPassword("ThePWDforMyUniqueMLUserID");
syncParms.getStreamParms().setHost("MyMLHost");
myConnection.synchronize(syncParms);

「カンマ区切りのリスト」

AuthenticationParms、Publications、TableOrder の各パラメータはすべて、値のカンマ区切りのリ
ストを含む文字列値を使用して指定します。リスト内の値は一重引用符または二重引用符で囲
むことができますが、エスケープ文字はありません。引用符がなかった場合、値の前後のスペー
スは無視されます。たとえば、次のコードは Table A、Table B,D、Table C を順に指定します。

syncParms.setTableOrder( "'Table A',¥"Table B,D",Table C );

参照

● SyncParms.getStreamParms メソッド [Ultra Light J]254 ページ
● SyncParms.setUserName メソッド [Ultra Light J]265 ページ
● Connection.createSyncParms メソッド [Ultra Light J]110 ページ
● StreamHTTPParms インタフェース [Ultra Light J]223 ページ
● StreamHTTPSParms インタフェース [Ultra Light J]236 ページ

getAcknowledgeDownload メソッド
クライアントがダウンロードの確認を送信しているかどうかを判断します。

構文

abstract boolean SyncParms.getAcknowledgeDownload()

戻り値

クライアントがダウンロードの確認を送信している場合は true、それ以外の場合は false。

参照

● SyncParms.setAcknowledgeDownload メソッド [Ultra Light J]257 ページ

getAdditionalParms メソッド [Android]
追加の同期パラメータを返します。

構文

abstract String SyncParms.getAdditionalParms()

戻り値

追加パラメータのリスト、またはパラメータが指定されていない場合は NULL。
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参照

● SyncParms.setAdditionalParms メソッド [Android] [Ultra Light J]257 ページ

getAuthenticationParms メソッド
カスタムのユーザ認証スクリプトに渡されるパラメータを返します。

構文

abstract String SyncParms.getAuthenticationParms()

戻り値

認証パラメータのリスト、またはパラメータが指定されていない場合は NULL。

参照

● SyncParms.setAuthenticationParms メソッド [Ultra Light J]258 ページ

getKeepPartialDownload メソッド [Android]
部分ダウンロードが有効かどうかを判断します。

構文

abstract boolean SyncParms.getKeepPartialDownload()

戻り値

部分ダウンロードが有効になっている場合は true、それ以外の場合は false。

参照

● SyncParms.setKeepPartialDownload メソッド [Android] [Ultra Light J]259 ページ

getLivenessTimeout メソッド
活性タイムアウトの長さを秒単位で返します。

構文

abstract int SyncParms.getLivenessTimeout()

戻り値

タイムアウト値。

参照

● SyncParms.setLivenessTimeout メソッド [Ultra Light J]260 ページ
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getNewPassword メソッド
setUserName メソッドで指定されたユーザの新しい Mobile Link パスワードを返します。

構文

abstract String SyncParms.getNewPassword()

戻り値

次の同期後に設定される新しいパスワード。

参照

● SyncParms.setUserName メソッド [Ultra Light J]265 ページ
● SyncParms.setNewPassword メソッド [Ultra Light J]261 ページ

getPassword メソッド
setUserName メソッドで指定されたユーザの Mobile Link パスワードを返します。

構文

abstract String SyncParms.getPassword()

戻り値

Mobile Link ユーザのパスワード。

参照

● SyncParms.setPassword メソッド [Ultra Light J]261 ページ

getPublications メソッド
同期させるパブリケーションを返します。

構文

abstract String SyncParms.getPublications()

戻り値

同期するパブリケーションのセット。

参照

● SyncParms.setPublications メソッド [Ultra Light J]262 ページ

getResumePartialDownload メソッド [Android]
部分ダウンロードを再開する必要があるかどうかを判断します。
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構文

abstract boolean SyncParms.getResumePartialDownload()

戻り値

部分ダウンロードが再開される場合は true、それ以外の場合は false。

参照

● SyncParms.setResumePartialDownload メソッド [Android] [Ultra Light J]263 ページ

getStreamParms メソッド
同期ストリームの設定に使用するパラメータを返します。

構文

abstract StreamHTTPParms SyncParms.getStreamParms()

戻り値

HTTP または HTTPS の同期ストリームのパラメータを指定する StreamHTTPParms または
StreamHTTPSParms オブジェクト。オブジェクトは参照で返されます。

備考

同期ストリームのタイプは、SyncParms オブジェクトの作成時に指定します。

参照

● Connection.createSyncParms メソッド [Ultra Light J]110 ページ
● StreamHTTPParms インタフェース [Ultra Light J]223 ページ
● StreamHTTPSParms インタフェース [Ultra Light J]236 ページ

getSyncObserver メソッド
現在指定されている SyncObserver オブジェクトを返します。

構文

abstract SyncObserver SyncParms.getSyncObserver()

戻り値

SyncObserver オブジェクト、または observer が指定されていない場合は NULL。

参照

● SyncParms.setSyncObserver メソッド [Ultra Light J]263 ページ
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getSyncResult メソッド
同期のステータスを含む SyncResult オブジェクトを返します。

構文

abstract SyncResult SyncParms.getSyncResult()

戻り値

前回の Connection.synchronize メソッドの呼び出しの結果を表す SyncResult オブジェクト。

備考

次の例は、前回の Connection.synchronize メソッド呼び出しの結果セットを取得する方法を示し
ています。

conn.synchronize( mySyncParms );
SyncResult result = mySyncParms.getSyncResult();
display(
    "*** Synchronized *** sent=" + result.getSentRowCount()
    + ", received=" + result.getReceivedRowCount()
);

注意

このメソッドは、前回の SYNCHRONIZE SQL 文の結果を返しません。前回の SYNCHRONIZE
SQL 文の SyncResult オブジェクトを取得するには、渡された Connection オブジェクトで
getSyncResult メソッドを使用します。

参照

● SyncResult クラス [Ultra Light J]266 ページ
● Connection.getSyncResult メソッド [Ultra Light J]115 ページ

getTableOrder メソッド
統合データベースにテーブルがアップロードされる順序を返します。

構文

abstract String SyncParms.getTableOrder()

戻り値

テーブル名のカンマ区切りのリスト、またはテーブルの順序が指定されていない場合は NULL。
カンマ区切りのリストの詳細については、クラスの説明を参照してください。

参照

● SyncParms.setTableOrder メソッド [Ultra Light J]264 ページ
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getUserName メソッド
Mobile Link サーバがクライアントをユニークに識別する Mobile Link ユーザ名を返します。

構文

abstract String SyncParms.getUserName()

戻り値

Mobile Link ユーザ名。

参照

● SyncParms.setUserName メソッド [Ultra Light J]265 ページ

getVersion メソッド
使用するスクリプトバージョンを返します。

構文

abstract String SyncParms.getVersion()

戻り値

スクリプトバージョン。

参照

● SyncParms.setVersion メソッド [Ultra Light J]265 ページ

isDownloadOnly メソッド
同期がダウンロード専用かどうかを確認します。

構文

abstract boolean SyncParms.isDownloadOnly()

戻り値

アップロードが無効になっている場合は true、それ以外の場合は false。

参照

● SyncParms.setDownloadOnly メソッド [Ultra Light J]259 ページ

isPingOnly メソッド
クライアントが Mobile Link サーバに対して ping または同期を実行しているかどうかを確認し
ます。
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構文

abstract boolean SyncParms.isPingOnly()

戻り値

クライアントがサーバに対して ping だけを実行している場合は true、それ以外の場合は false。

参照

● SyncParms.setPingOnly メソッド [Ultra Light J]262 ページ

isUploadOnly メソッド
同期がアップロード専用かどうかを確認します。

構文

abstract boolean SyncParms.isUploadOnly()

戻り値

ダウンロードが無効になっている場合は true、それ以外の場合は false。

参照

● SyncParms.setUploadOnly メソッド [Ultra Light J]264 ページ

setAcknowledgeDownload メソッド
クライアントがダウンロードの確認を送信すべきかどうかを指定します。

構文

abstract void SyncParms.setAcknowledgeDownload(boolean ack)

パラメータ

● ack クライアントからダウンロード確認を送信する場合は true、それ以外の場合は false に
設定します。

備考

デフォルトは false です。

参照

● SyncParms.getAcknowledgeDownload メソッド [Ultra Light J]251 ページ

setAdditionalParms メソッド [Android]
「名前=値」のペアをセミコロンで区切ったリストで、追加の同期パラメータを指定します。
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構文

abstract void SyncParms.setAdditionalParms(String v) throws ULjException

パラメータ

● v 「名前=値」のペアをセミコロンで区切ったリスト形式の文字列。

備考

このメソッドは、SyncParms クラスの既存のメソッドで指定できない同期パラメータをいくつか
追加指定する場合に使用します。

次の例は、SyncParms オブジェクトに AllowDownloadDupRows、CheckpointStore、
DisableConcurrency のパラメータを設定する方法を示します。

SyncParms parms;
...
parms.setAdditionalParms(
   "AllowDownloadDupRows=1;CheckpointStore=1;DisableConcurrency=1" );

参照

● SyncParms.getAdditionalParms メソッド [Android] [Ultra Light J]251 ページ

setAuthenticationParms メソッド
カスタムユーザ認証スクリプト (Mobile Link authenticate_parameters 接続イベント) のパラメータ
を指定します。

構文

abstract void SyncParms.setAuthenticationParms(
    String v
) throws ULjException

パラメータ

● v 認証パラメータのカンマ区切りのリスト、または NULL 参照。カンマ区切りのリストの
詳細については、クラスの説明を参照してください。

備考

最初の 255 文字列のみが使用されます。それぞれの文字列は認証パラメータの Mobile Link サー
バの制限よりも長くはなりません (現在は 4000 UTF8 バイト)。

21K 文字よりも長い文字列は、Mobile Link に送信されたときにトランケートされ、認証パラメー
タ用のサーバ制限を超過する文字列はサーバ側の同期エラーを引き起こします。

参照

● SyncParms.getAuthenticationParms メソッド [Ultra Light J]252 ページ
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setDownloadOnly メソッド
同期をダウンロード専用に設定します。

構文

abstract void SyncParms.setDownloadOnly(boolean v)

パラメータ

● v アップロードを無効にする場合は true、有効にする場合は false に設定します。

備考

デフォルトは false です。true を指定すると、setPingOnly メソッドと setUploadOnly メソッドが自
動的に呼び出され、これらが false に設定されます。

参照

● SyncParms.isDownloadOnly メソッド [Ultra Light J]256 ページ
● SyncParms.setPingOnly メソッド [Ultra Light J]262 ページ
● SyncParms.setUploadOnly メソッド [Ultra Light J]264 ページ

setKeepPartialDownload メソッド [Android]
同期中に部分ダウンロードを許可するかどうかを指定します。

構文

abstract void SyncParms.setKeepPartialDownload(
    boolean c
) throws ULjException

パラメータ

● c 部分ダウンロードを有効にする場合は、true に設定します。

備考

デフォルト設定は false です。同期中に部分ダウンロードを有効にして保存する場合は true に設
定します。そうではなく、部分ダウンロードを無効にしてエラーが発生したときにダウンロード
をロールバックする場合は false に設定します。

Ultra Light で、通信エラーや SyncObserver オブジェクトによるアボートのために失敗したダウン
ロードを、部分的に再開できるようになりました。Ultra Light は、ダウンロードを受信しながら
処理します。ダウンロードが中断した場合は、部分的なダウンロードトランザクションがデータ
ベース内に残るため、次の同期中に再開できます。

Ultra Light で部分的なダウンロードを保存する必要があることを示すには、true を指定します。
指定しないと、エラーが発生した場合にダウンロードがロールバックされます。

部分ダウンロードが維持された場合、Connection.synchronize メソッドの終了時に
SyncResult.getPartialDownloadRetained メソッドが true を返します。
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KeepPartialDownload 同期パラメータが true に設定されていれば、部分ダウンロードを再開でき
ます。部分ダウンロードを再開するには、setResumePartialDownload メソッドを true に設定して、
Connection.synchronize メソッドを呼び出します。

別の通信エラーの発生に備えて、KeepPartialDownload 同期パラメータを true に設定しておくこ
とをおすすめします。ダウンロードが省略された場合は、アップロードは行われません。

再開したダウンロードで受信するダウンロードは、最初にダウンロードを開始したときと同じも
のです。最新のデータが必要な場合は、再開されたダウンロードが完了した直後に、もう一度ダ
ウンロードを行うことができます。

ダウンロードの再開時には、SyncParms クラスで指定される同期パラメータの多くは使用されま
せん。たとえば、Publications パラメータは使用されません。受信するパブリケーションは、最
初のダウンロード時に要求したものです。使用する必要があるのは、setResumePartialDownload
メソッドと setUserName メソッドだけです。setKeepPartialDownload メソッドは必要に応じて使
用できます。

部分的なダウンロードが存在するが、このダウンロードが必要ではなくなった場合は、
Connection.rollbackPartialDownload を呼び出して、失敗したダウンロードトランザクションを
ロールバックできます。また、同期を再試行するときに ResumePartialDownload パラメータを指
定しなかった場合は、次の同期が開始される前に、部分的なダウンロードがロールバックされま
す。

参照

● SyncParms.getKeepPartialDownload メソッド [Android] [Ultra Light J]252 ページ
● SyncParms.setResumePartialDownload メソッド [Android] [Ultra Light J]263 ページ
● SyncParms.setUserName メソッド [Ultra Light J]265 ページ
●「ダウンロードの失敗の再開」『Mobile Link サーバ管理』

setLivenessTimeout メソッド
活性タイムアウトの長さを秒単位で設定します。

構文

abstract void SyncParms.setLivenessTimeout(
    int seconds
) throws ULjException

パラメータ

● seconds 新しい活性タイムアウト値。

備考

活性タイムアウトは、サーバで許容される、リモートのアイドル時間の長さです。リモートが l
秒間サーバと通信しなかった場合、サーバはリモートとの接続が失われたとみなし、同期を終了
します。リモートは、接続を継続するために、自動的に定期メッセージをサーバに送信します。

負の値を設定すると、例外がスローされます。値は Mobile Link サーバによって予告なく変更さ
れる場合があります。変更は、値が低すぎるか高すぎる場合に行われます。
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デフォルト値は、BlackBerry/J2SE プラットフォームでは 100 秒、Android プラットフォームで
は 240 秒です。

参照

● SyncParms.getLivenessTimeout メソッド [Ultra Light J]252 ページ

setNewPassword メソッド
setUserName メソッドで指定されたユーザの新しい Mobile Link パスワードを設定します。

構文

abstract void SyncParms.setNewPassword(String v)

パラメータ

● v Mobile Link ユーザの新しいパスワード。

備考

新しいパスワードが有効になるのは、次の同期の後です。

デフォルトは NULL で、この場合、パスワードは置換されません。

参照

● SyncParms.getNewPassword メソッド [Ultra Light J]253 ページ
● SyncParms.setPassword メソッド [Ultra Light J]261 ページ
● SyncParms.setUserName メソッド [Ultra Light J]265 ページ

setPassword メソッド
setUserName メソッドで指定されたユーザの Mobile Link パスワードを設定します。

構文

abstract void SyncParms.setPassword(String v) throws ULjException

パラメータ

● v Mobile Link ユーザのパスワード。

備考

このユーザ名とパスワードは、データベースのユーザ ID とパスワードとは異なります。このメ
ソッドは、Mobile Link サーバに対してアプリケーションを認証するために使用されます。

デフォルトは空の文字列で、これはパスワードなしを示します。
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参照

● SyncParms.getPassword メソッド [Ultra Light J]253 ページ
● SyncParms.setNewPassword メソッド [Ultra Light J]261 ページ
● SyncParms.setUserName メソッド [Ultra Light J]265 ページ

setPingOnly メソッド
クライアントが Mobile Link サーバに対して、同期を実行しないで ping を実行するように設定し
ます。

構文

abstract void SyncParms.setPingOnly(boolean v)

パラメータ

● v サーバに ping だけを実行する場合は true、同期を実行する場合は false に設定します。

備考

デフォルトは false です。true を指定すると、setDownloadOnly メソッドと setUploadOnly メソッ
ドが自動的に呼び出され、これらが false に設定されます。

参照

● SyncParms.isPingOnly メソッド [Ultra Light J]256 ページ
● SyncParms.setDownloadOnly メソッド [Ultra Light J]259 ページ
● SyncParms.setUploadOnly メソッド [Ultra Light J]264 ページ

setPublications メソッド
同期させるパブリケーションを設定します。

構文

abstract void SyncParms.setPublications(String pubs) throws ULjException

パラメータ

● pubs パブリケーション名のカンマ区切りのリスト。カンマ区切りのリストの詳細につい
ては、クラスの説明を参照してください。

備考

デフォルトでは、データベース内のすべてのテーブルの同期を指定する Connection.SYNC_ALL
定数が設定されます。すべてのパブリケーションを同期するには、このメソッドに
Connection.SYNC_ALL_PUBS 定数を設定します。
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参照

● SyncParms.getPublications メソッド [Ultra Light J]253 ページ
● Connection.SYNC_ALL 変数 [Ultra Light J]129 ページ
● Connection.SYNC_ALL_PUBS 変数 [Ultra Light J]130 ページ

setResumePartialDownload メソッド [Android]
前回の部分ダウンロードを再開するか破棄するかを指定します。

構文

abstract void SyncParms.setResumePartialDownload(
    boolean c
) throws ULjException

パラメータ

● c 以前の部分ダウンロードを再開する場合は true に設定します。

例外

● ULjException クラス 次の同期パラメータ (DownloadOnly、PingOnly、
ResumePartialDownload、UploadOnly) のうち 1 つ以上が true に設定されると、
Connection.synchronize メソッドによって SQLE_SYNC_INFO_INVALID がスローされます。

備考

前回の部分的なダウンロードを再開する場合は true、破棄する場合は false に設定します。デ
フォルト設定は false です。

参照

● SyncParms.getResumePartialDownload メソッド [Android] [Ultra Light J]253 ページ

setSyncObserver メソッド
同期の進行状況をモニタする SyncObserver オブジェクトを設定します。

構文

abstract void SyncParms.setSyncObserver(SyncObserver so)

パラメータ

● so SyncObserver オブジェクト。

備考

デフォルトは NULL で、これは observer なしを示します。

参照

● SyncObserver インタフェース [Ultra Light J]242 ページ
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setTableOrder メソッド
統合データベースにテーブルがアップロードされる順序を設定します。

構文

abstract void SyncParms.setTableOrder(String v) throws ULjException

パラメータ

● v 同期する順序でのテーブル名のカンマ区切りのリスト、またはテーブル順序を指定しな
い場合は NULL。カンマ区切りのリストの詳細については、クラスの説明を参照してくださ
い。

備考

プライマリテーブルをリストの先頭に指定し、統合データベースで外部キー関係を持つすべての
テーブルをリストに含めます。

Publications パラメータによって同期対象として選択されているテーブルはすべて、TableOrder パ
ラメータで指定されているかどうかに関係なく同期されます。指定されていないテーブルは、ク
ライアントデータベースでの外部キー関係の順序で同期されます。これらは、指定したテーブル
の後に同期されます。

デフォルト値は NULL 参照で、テーブルのデフォルトの順序は上書きされません。

参照

● SyncParms.getTableOrder メソッド [Ultra Light J]255 ページ
● SyncParms.setPublications メソッド [Ultra Light J]262 ページ

setUploadOnly メソッド
同期をアップロード専用に設定します。

構文

abstract void SyncParms.setUploadOnly(boolean v)

パラメータ

● v ダウンロードを無効にする場合は true、有効にする場合は false に設定します。

備考

デフォルトは false です。true を指定すると、setDownloadOnly メソッドと setPingOnly メソッド
が自動的に呼び出され、これらが false に設定されます。

参照

● SyncParms.isUploadOnly メソッド [Ultra Light J]257 ページ
● SyncParms.setDownloadOnly メソッド [Ultra Light J]259 ページ
● SyncParms.setPingOnly メソッド [Ultra Light J]262 ページ
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setUserName メソッド
Mobile Link サーバがクライアントをユニークに識別する Mobile Link ユーザ名を設定します。

構文

abstract void SyncParms.setUserName(String v) throws ULjException

パラメータ

● v Mobile Link ユーザ名。

備考

この値は、以下を判別するために使用されます。

●ダウンロードの内容

●同期ステータスを記録するかどうか

●同期中に中断された場合、回復するかどうか

このユーザ名とパスワードは、データベースのユーザ ID とパスワードとは異なります。このメ
ソッドは、Mobile Link サーバに対してアプリケーションを認証するために使用されます。

このパラメータは、SyncParms オブジェクトの作成時に初期化されます。

参照

● SyncParms.getUserName メソッド [Ultra Light J]256 ページ
● SyncParms.setPassword メソッド [Ultra Light J]261 ページ
● SyncParms.setNewPassword メソッド [Ultra Light J]261 ページ
● Connection.createSyncParms メソッド [Ultra Light J]110 ページ

setVersion メソッド
使用する同期スクリプトを設定します。

構文

abstract void SyncParms.setVersion(String v) throws ULjException

パラメータ

● v スクリプトバージョン。

備考

統合データベースの同期スクリプトは、それぞれバージョン文字列で区別されます。たとえば、
異なるバージョン文字列によって特定される 2 つの download_cursor スクリプトが存在する場合
があります。バージョン文字列によって、アプリケーションが同期スクリプトのセットから適切
に選択できます。

このパラメータは、SyncParms オブジェクトの作成時に初期化されます。
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参照

● SyncParms.getVersion メソッド [Ultra Light J]256 ページ
● Connection.createSyncParms メソッド [Ultra Light J]110 ページ

HTTP_STREAM 変数
HTTP 同期用の SyncParms オブジェクトを作成します。

構文

final int SyncParms.HTTP_STREAM

参照

● Connection.createSyncParms メソッド [Ultra Light J]110 ページ

HTTPS_STREAM 変数
セキュア HTTPS 同期用の SyncParms オブジェクトを作成します。

構文

final int SyncParms.HTTPS_STREAM

参照

● Connection.createSyncParms メソッド [Ultra Light J]110 ページ

SyncResult クラス
指定されたデータベース同期のステータス関連の情報をレポートします。

構文

public class SyncResult

メンバー

継承されたメンバーを含む SyncResult クラスのすべてのメンバー。

名前 説明

getAuthMessage メソッド カスタムユーザ認証同期スクリプトで指定さ
れている、前回の同期試行の承認メッセージ
を返します。

getAuthStatus メソッド 前回試行された同期の認証ステータスコード
を返します。
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名前 説明

getAuthValue メソッド カスタムユーザ認証同期スクリプトで指定さ
れている値を返します。

getCurrentTableName メソッド 現在同期中のテーブルの名前を返します。

getIgnoredRows メソッド 前回行われた同期で、アップロードされた
ローが無視されたかどうかを確認します。

getPartialDownloadRetained メソッド [Android] 前回行われた同期で、部分的なダウンロード
が保持されたかどうかを確認します。

getReceivedByteCount メソッド データ同期中に受信したバイト数を返しま
す。

getReceivedDeletes メソッド 受信したローのうち削除されたものの数を返
します。

getReceivedIgnoredDeletes メソッド 受信した削除ローのうち無視されたものの数
を返します。

getReceivedIgnoredUpdates メソッド 受信した更新ローのうち無視されたものの数
を返します。

getReceivedInserts メソッド 受信したローのうち挿入されたものの数を返
します。

getReceivedRowCount メソッド 受信したローの数を返します。

getReceivedTruncateDeletes メソッド 受信したローのうち、ダウンロードされたト
ランケート操作によって削除されたものの数
を返します。

getReceivedUpdates メソッド 受信したローのうち更新として適用されたも
のの数を返します。

getSentByteCount メソッド データ同期中に送信されたバイト数を返しま
す。

getSentDeletes メソッド 送信された削除済みローの数を返します。

getSentInserts メソッド 送信された挿入済みローの数を返します。

getSentUpdates メソッド 送信された更新済みローの数を返します。

getStreamErrorCode メソッド ストリーム自体によってレポートされるエ
ラーコードを返します。
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名前 説明

getStreamErrorMessage メソッド ストリーム自体によってレポートされるエ
ラーメッセージを返します。

getSyncedTableCount メソッド 現在までに同期されたテーブル数を返しま
す。

getTotalDownloadRowCount メソッド ダウンロードで受信するローの合計数を返し
ます。

getTotalTableCount メソッド 同期されるテーブル数を返します。

isUploadOK メソッド 前回のアップロード同期が成功したかどうか
を確認します。

参照

● SyncParms.getSyncResult メソッド [Ultra Light J]255 ページ

getAuthMessage メソッド
カスタムユーザ認証同期スクリプトで指定されている、前回の同期試行の承認メッセージを返し
ます。

構文

abstract String SyncResult.getAuthMessage()

戻り値

最後の同期の認証に関する情報が含まれた文字列。

備考

ブランクまたは空のメッセージは NULL として返されます。

認証ステータスコードとして認証メッセージが返される場合もあります。詳細については、
Mobile Link 名前付きシステムパラメータ authentication_message を参照してください。

getAuthStatus メソッド
前回試行された同期の認証ステータスコードを返します。

構文

abstract int SyncResult.getAuthStatus()

戻り値

AuthStatusCode の値。
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getAuthValue メソッド
カスタムユーザ認証同期スクリプトで指定されている値を返します。

構文

abstract int SyncResult.getAuthValue()

戻り値

カスタムユーザ認証同期スクリプトから返された整数。

getCurrentTableName メソッド
現在同期中のテーブルの名前を返します。

構文

abstract String SyncResult.getCurrentTableName()

戻り値

テーブル名。

getIgnoredRows メソッド
前回行われた同期で、アップロードされたローが無視されたかどうかを確認します。

構文

abstract boolean SyncResult.getIgnoredRows()

戻り値

前回の同期中にアップロードされたローが無視された場合は true、ローが無視されなかった場合
は false。

getPartialDownloadRetained メソッド [Android]
前回行われた同期で、部分的なダウンロードが保持されたかどうかを確認します。

構文

abstract boolean SyncResult.getPartialDownloadRetained()

戻り値

ダウンロードが中断され、部分的なダウンロードが保持された場合は true、ダウンロードが中断
されなかった場合または部分的なダウンロードがロールバックされた場合は false。
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getReceivedByteCount メソッド
データ同期中に受信したバイト数を返します。

構文

abstract long SyncResult.getReceivedByteCount()

戻り値

バイト数。

getReceivedDeletes メソッド
受信したローのうち削除されたものの数を返します。

構文

abstract long SyncResult.getReceivedDeletes()

戻り値

削除が適用されたダウンロード済みローの数。

参照

● SyncResult.getReceivedIgnoredDeletes メソッド [Ultra Light J]270 ページ
● SyncResult.getReceivedIgnoredUpdates メソッド [Ultra Light J]271 ページ
● SyncResult.getReceivedInserts メソッド [Ultra Light J]271 ページ
● SyncResult.getReceivedTruncateDeletes メソッド [Ultra Light J]272 ページ
● SyncResult.getReceivedUpdates メソッド [Ultra Light J]272 ページ

getReceivedIgnoredDeletes メソッド
受信した削除ローのうち無視されたものの数を返します。

構文

abstract long SyncResult.getReceivedIgnoredDeletes()

戻り値

無視されたダウンロード済み削除ローの数。

参照

● SyncResult.getReceivedIgnoredUpdates メソッド [Ultra Light J]271 ページ
● SyncResult.getReceivedDeletes メソッド [Ultra Light J]270 ページ
● SyncResult.getReceivedInserts メソッド [Ultra Light J]271 ページ
● SyncResult.getReceivedTruncateDeletes メソッド [Ultra Light J]272 ページ
● SyncResult.getReceivedUpdates メソッド [Ultra Light J]272 ページ
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getReceivedIgnoredUpdates メソッド
受信した更新ローのうち無視されたものの数を返します。

構文

abstract long SyncResult.getReceivedIgnoredUpdates()

戻り値

無視されたダウンロード済み更新ローの数。Ultra Light Java Edition データベースでは、この値は
常に 0 です。

備考

受信された更新ローが無視されるのは、ダウンロードで重複するプライマリキーが許可されてい
る場合だけです(Android でのみ可能)。これ以外の場合、ダウンロード済みの更新が重複すると、
同期が失敗します。

参照

● SyncResult.getReceivedIgnoredDeletes メソッド [Ultra Light J]270 ページ
● SyncResult.getReceivedDeletes メソッド [Ultra Light J]270 ページ
● SyncResult.getReceivedInserts メソッド [Ultra Light J]271 ページ
● SyncResult.getReceivedTruncateDeletes メソッド [Ultra Light J]272 ページ
● SyncResult.getReceivedUpdates メソッド [Ultra Light J]272 ページ

getReceivedInserts メソッド
受信したローのうち挿入されたものの数を返します。

構文

abstract long SyncResult.getReceivedInserts()

戻り値

挿入として適用されたローの数。

参照

● SyncResult.getReceivedDeletes メソッド [Ultra Light J]270 ページ
● SyncResult.getReceivedIgnoredDeletes メソッド [Ultra Light J]270 ページ
● SyncResult.getReceivedInserts メソッド [Ultra Light J]271 ページ
● SyncResult.getReceivedTruncateDeletes メソッド [Ultra Light J]272 ページ
● SyncResult.getReceivedUpdates メソッド [Ultra Light J]272 ページ

getReceivedRowCount メソッド
受信したローの数を返します。
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構文

abstract long SyncResult.getReceivedRowCount()

戻り値

受け取ったローの数。

備考

この数には、ダウンロード適用時に無視される可能性のあるローが含まれています。

参照

● SyncResult.getTotalDownloadRowCount メソッド [Ultra Light J]275 ページ

getReceivedTruncateDeletes メソッド
受信したローのうち、ダウンロードされたトランケート操作によって削除されたものの数を返し
ます。

構文

abstract long SyncResult.getReceivedTruncateDeletes()

戻り値

トランケートされたローの数。

備考

各ダウンロードトランケート操作は、getReceivedRowCount メソッドでカウントされたダウン
ロードロー内の 1 つのローのように見えますが、ゼロまたは多くのローがトランケートされる可
能性があり、このメソッドでカウントされます。

参照

● SyncResult.getReceivedDeletes メソッド [Ultra Light J]270 ページ
● SyncResult.getReceivedIgnoredDeletes メソッド [Ultra Light J]270 ページ
● SyncResult.getReceivedIgnoredUpdates メソッド [Ultra Light J]271 ページ
● SyncResult.getReceivedInserts メソッド [Ultra Light J]271 ページ
● SyncResult.getReceivedUpdates メソッド [Ultra Light J]272 ページ

getReceivedUpdates メソッド
受信したローのうち更新として適用されたものの数を返します。

構文

abstract long SyncResult.getReceivedUpdates()

戻り値

更新として適用されたローの数。
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参照

● SyncResult.getReceivedDeletes メソッド [Ultra Light J]270 ページ
● SyncResult.getReceivedIgnoredDeletes メソッド [Ultra Light J]270 ページ
● SyncResult.getReceivedIgnoredUpdates メソッド [Ultra Light J]271 ページ
● SyncResult.getReceivedInserts メソッド [Ultra Light J]271 ページ
● SyncResult.getReceivedTruncateDeletes メソッド [Ultra Light J]272 ページ

getSentByteCount メソッド
データ同期中に送信されたバイト数を返します。

構文

abstract long SyncResult.getSentByteCount()

戻り値

送信されたバイト数。

getSentDeletes メソッド
送信された削除済みローの数を返します。

構文

abstract long SyncResult.getSentDeletes()

戻り値

送信された削除済みローの数。

備考

挿入、更新、削除の数は、同期しているテーブルに対して実行された操作の数とは異なる場合が
あります。これは、対象のローに対する操作はすべて 1 つに結合されるからです。

参照

● SyncResult.getSentInserts メソッド [Ultra Light J]273 ページ
● SyncResult.getSentUpdates メソッド [Ultra Light J]274 ページ

getSentInserts メソッド
送信された挿入済みローの数を返します。

構文

abstract long SyncResult.getSentInserts()
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戻り値

送信された挿入済みローの数。

備考

挿入、更新、削除の数は、同期しているテーブルに対して実行された操作の数とは異なる場合が
あります。これは、対象のローに対する操作はすべて 1 つに結合されるからです。

参照

● SyncResult.getSentDeletes メソッド [Ultra Light J]273 ページ
● SyncResult.getSentUpdates メソッド [Ultra Light J]274 ページ

getSentUpdates メソッド
送信された更新済みローの数を返します。

構文

abstract long SyncResult.getSentUpdates()

戻り値

送信された更新済みローの数。

備考

挿入、更新、削除の数は、同期しているテーブルに対して実行された操作の数とは異なる場合が
あります。これは、対象のローに対する操作はすべて 1 つに結合されるからです。

参照

● SyncResult.getSentDeletes メソッド [Ultra Light J]273 ページ
● SyncResult.getSentInserts メソッド [Ultra Light J]273 ページ

getStreamErrorCode メソッド
ストリーム自体によってレポートされるエラーコードを返します。

構文

abstract int SyncResult.getStreamErrorCode()

戻り値

通信ストリームエラーがなかった場合は 0、それ以外の場合はサーバからの応答コードを返しま
す。

備考

このメソッドは、HTTP 応答コードを返します。
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getStreamErrorMessage メソッド
ストリーム自体によってレポートされるエラーメッセージを返します。

構文

abstract String SyncResult.getStreamErrorMessage()

戻り値

メッセージがない場合は NULL、それ以外の場合は応答メッセージを返します。

備考

このメソッドは、HTTP 応答メッセージを返します。

getSyncedTableCount メソッド
現在までに同期されたテーブル数を返します。

構文

abstract int SyncResult.getSyncedTableCount()

戻り値

同期されたテーブル数。

getTotalDownloadRowCount メソッド
ダウンロードで受信するローの合計数を返します。

構文

abstract long SyncResult.getTotalDownloadRowCount()

戻り値

ダウンロードで受信するローの数。この数には、適用されないローが含まれます (クライアント
上にないローの削除など)。

備考

この数には、重複していて無視されるローも含まれます。この値は、同期によって最初のテーブ
ルの SyncObserver.State.RECEIVING_TABLE ステータスが入力されるまで、設定されません。

getTotalTableCount メソッド
同期されるテーブル数を返します。

構文

abstract int SyncResult.getTotalTableCount()
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戻り値

同期するテーブル数。

isUploadOK メソッド
前回のアップロード同期が成功したかどうかを確認します。

構文

abstract boolean SyncResult.isUploadOK()

戻り値

前回のアップロード同期が成功した場合は true、それ以外の場合は false。

SyncResult.AuthStatusCode インタフェース
Mobile Link サーバから返された認証コードを列挙します。

構文

public interface SyncResult.AuthStatusCode

メンバー

継承されたメンバーを含む SyncResult.AuthStatusCode インタフェースのすべてのメンバー。

名前 説明

EXPIRED 変数 ユーザ ID またはパスワードの有効期限が切
れています。

IN_USE 変数 ユーザ ID がすでに使用されています。

INVALID 変数 ユーザ ID またはパスワードが不正です。

UNKNOWN 変数 認証ステータスが不明です。

VALID 変数 ユーザ ID とパスワードは、同期時には有効で
した。

VALID_BUT_EXPIRES_SOON 変数 ユーザ ID とパスワードは、同期時には有効で
したが、まもなく有効期限が切れます。

参照

● SyncResult.getAuthStatus メソッド [Ultra Light J]268 ページ
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EXPIRED 変数
ユーザ ID またはパスワードの有効期限が切れています。

構文

final int SyncResult.AuthStatusCode.EXPIRED

備考

認証に失敗しました。

IN_USE 変数
ユーザ ID がすでに使用されています。

構文

final int SyncResult.AuthStatusCode.IN_USE

備考

認証に失敗しました。

INVALID 変数
ユーザ ID またはパスワードが不正です。

構文

final int SyncResult.AuthStatusCode.INVALID

備考

認証に失敗しました。

UNKNOWN 変数
認証ステータスが不明です。

構文

final int SyncResult.AuthStatusCode.UNKNOWN

備考

このコードは、同期が実行されていないことを示します。

VALID 変数
ユーザ ID とパスワードは、同期時には有効でした。
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構文

final int SyncResult.AuthStatusCode.VALID

VALID_BUT_EXPIRES_SOON 変数
ユーザ ID とパスワードは、同期時には有効でしたが、まもなく有効期限が切れます。

構文

final int SyncResult.AuthStatusCode.VALID_BUT_EXPIRES_SOON

TableSchema インタフェース
テーブルのスキーマを指定し、システムテーブルの名前を定義する定数を提供します。

構文

public interface TableSchema

メンバー

継承されたメンバーを含む TableSchema インタフェースのすべてのメンバー。

名前 説明

SYS_ARTICLES 変数 パブリケーションのアーティクルに関する情
報を含むシステムテーブルの名前です。

SYS_COLUMNS 変数 データベース内のテーブルカラムに関する情
報を含むシステムテーブルの名前です。

SYS_FKEY_COLUMNS 変数 外部キーカラムに関する情報を含むシステム
テーブルの名前です。

SYS_FOREIGN_KEYS 変数 データベース内の外部キーに関する情報を含
むシステムテーブルの名前です。

SYS_INDEX_COLUMNS 変数 データベース内のインデックスカラムに関す
る情報を含むシステムテーブルの名前です。

SYS_INDEXES 変数 データベース内のテーブルインデックスに関
する情報を含むシステムテーブルの名前で
す。

SYS_INTERNAL 変数 内部情報を含むシステムテーブルの名前で
す。

SYS_PRIMARY_INDEX 変数 システムテーブルのプライマリキーインデッ
クスの名前です。
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名前 説明

SYS_PUBLICATIONS 変数 データベースパブリケーションに関する情報
を含むシステムテーブルの名前です。

SYS_TABLES 変数 データベース内のテーブルに関する情報を含
むシステムテーブルの名前です。

SYS_ULDATA 変数 システムの値に関する情報を含むシステム
テーブルの名前です。

SYS_ULDATA_INTERNAL 変数 内部システムデータの型です。

SYS_ULDATA_OPTION 変数 オプションのシステムデータの型です。

SYS_ULDATA_PROPERTY 変数 プロパティシステムデータの型です。

TABLE_IS_DOWNLOAD_ONLY 変数 テーブルがダウンロード専用テーブル (同期
されたときにアップロードされるテーブル)
であることを示します。

TABLE_IS_NOSYNC 変数 テーブルが非同期テーブルであることを示し
ます。

TABLE_IS_SYSTEM 変数 テーブルがシステムテーブルであることを示
します。

備考

このインタフェースにはテーブル関連の定数だけが含まれます。これには、システムテーブル
名、テーブルフラグ、sysuldata システムテーブルのデータ型などがあります。

SYS_ARTICLES 変数
パブリケーションのアーティクルに関する情報を含むシステムテーブルの名前です。

構文

final String TableSchema.SYS_ARTICLES

SYS_COLUMNS 変数
データベース内のテーブルカラムに関する情報を含むシステムテーブルの名前です。

構文

final String TableSchema.SYS_COLUMNS

TableSchema インタフェース
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SYS_FKEY_COLUMNS 変数
外部キーカラムに関する情報を含むシステムテーブルの名前です。

構文

final String TableSchema.SYS_FKEY_COLUMNS

SYS_FOREIGN_KEYS 変数
データベース内の外部キーに関する情報を含むシステムテーブルの名前です。

構文

final String TableSchema.SYS_FOREIGN_KEYS

SYS_INDEX_COLUMNS 変数
データベース内のインデックスカラムに関する情報を含むシステムテーブルの名前です。

構文

final String TableSchema.SYS_INDEX_COLUMNS

SYS_INDEXES 変数
データベース内のテーブルインデックスに関する情報を含むシステムテーブルの名前です。

構文

final String TableSchema.SYS_INDEXES

SYS_INTERNAL 変数
内部情報を含むシステムテーブルの名前です。

構文

final String TableSchema.SYS_INTERNAL

SYS_PRIMARY_INDEX 変数
システムテーブルのプライマリキーインデックスの名前です。

構文

final String TableSchema.SYS_PRIMARY_INDEX

Ultra Light J API リファレンス

280 Copyright © 2013, SAP AG or an SAP affiliate company. - SAP Sybase SQL Anywhere 16.0



SYS_PUBLICATIONS 変数
データベースパブリケーションに関する情報を含むシステムテーブルの名前です。

構文

final String TableSchema.SYS_PUBLICATIONS

SYS_TABLES 変数
データベース内のテーブルに関する情報を含むシステムテーブルの名前です。

構文

final String TableSchema.SYS_TABLES

SYS_ULDATA 変数
システムの値に関する情報を含むシステムテーブルの名前です。

構文

final String TableSchema.SYS_ULDATA

SYS_ULDATA_INTERNAL 変数
内部システムデータの型です。

構文

final String TableSchema.SYS_ULDATA_INTERNAL

SYS_ULDATA_OPTION 変数
オプションのシステムデータの型です。

構文

final String TableSchema.SYS_ULDATA_OPTION

SYS_ULDATA_PROPERTY 変数
プロパティシステムデータの型です。

構文

final String TableSchema.SYS_ULDATA_PROPERTY

TableSchema インタフェース
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TABLE_IS_DOWNLOAD_ONLY 変数
テーブルがダウンロード専用テーブル (同期されたときにアップロードされるテーブル) である
ことを示します。

構文

final short TableSchema.TABLE_IS_DOWNLOAD_ONLY

備考

この値は、TABLE_IS_NOSYNC フラグを除き、SYS_TABLES テーブルの table_flags カラムで他
のフラグと論理的に組み合わせることができます。

TABLE_IS_NOSYNC 変数
テーブルが非同期テーブルであることを示します。

構文

final short TableSchema.TABLE_IS_NOSYNC

備考

この値は、TABLE_IS_DOWNLOAD_ONLY フラグを除き、SYS_TABLES テーブルの table_flags
カラムで他のフラグと論理的に組み合わせることができます。

TABLE_IS_SYSTEM 変数
テーブルがシステムテーブルであることを示します。

構文

final short TableSchema.TABLE_IS_SYSTEM

備考

この値は、SYS_TABLES テーブルの table_flags カラムで他のフラグと論理的に組み合わせるこ
とができます。

ULjEvent インタフェース [Android]
Ultra Light J API システムイベントを示します。

構文

public interface ULjEvent

メンバー

継承されたメンバーを含む ULjEvent インタフェースのすべてのメンバー。
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名前 説明

getParameter メソッド イベントの名前付きパラメータを返します。

getType メソッド イベントタイプを返します。

COMMIT_EVENT 変数 「コミット」イベントタイプを示します。

SYNC_COMPLETE_EVENT 変数 「同期の完了」イベントタイプを示します。

TABLE_MODIFIED_EVENT 変数 「テーブル変更済み」イベントタイプを示しま
す。

getParameter メソッド
イベントの名前付きパラメータを返します。

構文

String ULjEvent.getParameter(String name) throws ULjException

パラメータ

● name 値を取得するイベントの名前

getType メソッド
イベントタイプを返します。

構文

short ULjEvent.getType()

COMMIT_EVENT 変数
「コミット」イベントタイプを示します。

構文

final short ULjEvent.COMMIT_EVENT

SYNC_COMPLETE_EVENT 変数
「同期の完了」イベントタイプを示します。

構文

final short ULjEvent.SYNC_COMPLETE_EVENT

ULjEvent インタフェース [Android]
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TABLE_MODIFIED_EVENT 変数
「テーブル変更済み」イベントタイプを示します。

構文

final short ULjEvent.TABLE_MODIFIED_EVENT

ULjException クラス
データベースからスローされた例外に取って代わります。

構文

public class ULjException

メンバー

継承されたメンバーを含む ULjException クラスのすべてのメンバー。

名前 説明

getCausingException メソッド 例外の原因となっている ULjException オブ
ジェクトを返します。

getErrorCode メソッド この例外に関連付けられているエラーコード
を返します。

getParameter メソッド [Android] 指定されたエラーパラメータを返します。

getParameterCount メソッド [Android] エラーパラメータの数を返します。

getSqlOffset メソッド SQL 文字列内のエラーオフセットを返しま
す。

getCausingException メソッド
例外の原因となっている ULjException オブジェクトを返します。

構文

abstract ULjException ULjException.getCausingException()

戻り値

原因となっている例外がない場合は NULL、それ以外の場合は ULjException オブジェクトを返し
ます。
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getErrorCode メソッド
この例外に関連付けられているエラーコードを返します。

構文

abstract int ULjException.getErrorCode()

戻り値

エラーコード。

getParameter メソッド [Android]
指定されたエラーパラメータを返します。

構文

abstract String ULjException.getParameter(short param_no)

パラメータ

● param_no 1 から始まるパラメータ番号。

戻り値

エラーパラメータ。

getParameterCount メソッド [Android]
エラーパラメータの数を返します。

構文

abstract short ULjException.getParameterCount()

戻り値

エラーパラメータ数。

getSqlOffset メソッド
SQL 文字列内のエラーオフセットを返します。

構文

abstract int ULjException.getSqlOffset()

戻り値

エラーメッセージに関連付けられている SQL 文字列がない場合は -1、それ以外の場合は、文字
列内でエラーが発生した箇所の 0 から始まるオフセットを返します。

ULjException クラス
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Unsigned64 クラス
符号なし 64 ビットのバイナリ値を実装します。

構文

public class Unsigned64

メンバー

継承されたメンバーを含む Unsigned64 クラスのすべてのメンバー。

名前 説明

add メソッド 2 つの値を加算し、結果をそれ自体に配置し
ます。

compare メソッド 2 つの long 値を比較します。

divide メソッド 2 つの値を除算し、結果をそれ自体に配置し
ます。

multiply メソッド 2 つの値を乗算し、結果をそれ自体に配置し
ます。

remainder メソッド 1 つの値を別の値で除算したときの余りを返
します。

subtract メソッド 2 つの値を減算し、結果をそれ自体に配置し
ます。

備考

このクラスの目的は、値を long integer として保持し、これらの値をこのクラスの静的メソッド
を使用して解釈することです。

このクラスはインスタンスを作成できません。

add メソッド
2 つの値を加算し、結果をそれ自体に配置します。

構文

final long Unsigned64.add(long v1, long v2)

パラメータ

● v1 最初のオペランド。

● v2 2 番目のオペランド。
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戻り値

2 つのオペランドの和。

compare メソッド
2 つの long 値を比較します。

オーバーロードリスト

名前 説明

compare(int, int) メソッド 2 つの integer 値を比較します。

compare(long, long) メソッド 2 つの long 値を比較します。

compare(int, int) メソッド
2 つの integer 値を比較します。

構文

final byte Unsigned64.compare(int v1, int v2)

パラメータ

● v1 比較する最初の値。

● v2 比較する 2 番目の値。

戻り値

v2 が v1 より大きい場合は -1、v1 と v2 が等しい場合は 0、v2 が v1 より小さい場合は 1。

compare(long, long) メソッド
2 つの long 値を比較します。

構文

final byte Unsigned64.compare(long v1, long v2)

パラメータ

● v1 比較する最初の値。

● v2 比較する 2 番目の値。

戻り値

v2 が v1 より大きい場合は -1、v1 と v2 が等しい場合は 0、v2 が v1 より小さい場合は 1。

Unsigned64 クラス
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divide メソッド
2 つの値を除算し、結果をそれ自体に配置します。

構文

final long Unsigned64.divide(long v1, long v2)

パラメータ

● v1 最初のオペランド。

● v2 2 番目のオペランド。

戻り値

最初のオペランドを 2 番目のオペランドで割った値。

multiply メソッド
2 つの値を乗算し、結果をそれ自体に配置します。

構文

final long Unsigned64.multiply(long v1, long v2)

パラメータ

● v1 最初のオペランド。

● v2 2 番目のオペランド。

戻り値

v1 と v2 の積。

remainder メソッド
1 つの値を別の値で除算したときの余りを返します。

オーバーロードリスト

名前 説明

remainder(long, long) メソッド 1 つの値を別の値で除算したときの余りを返
します。

remainder(long, long, long) メソッド 指定の指数で乗算した値を別の値から差し引
いた余り (v1 - quot * v2) を返します。
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remainder(long, long) メソッド
1 つの値を別の値で除算したときの余りを返します。

構文

final long Unsigned64.remainder(long v1, long v2)

パラメータ

● v1 被除数。

● v2 除数。

戻り値

long integer として表される余り。

remainder(long, long, long) メソッド
指定の指数で乗算した値を別の値から差し引いた余り (v1 - quot * v2) を返します。

構文

final long Unsigned64.remainder(long v1, long v2, long quot)

パラメータ

● v1 被除数。

● v2 除数。

● quot 商の値。

戻り値

long integer として表される余り。

subtract メソッド
2 つの値を減算し、結果をそれ自体に配置します。

構文

final long Unsigned64.subtract(long v1, long v2)

パラメータ

● v1 最初のオペランド。

● v2 2 番目のオペランド。

Unsigned64 クラス
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戻り値

v1 から v2 を差し引いた値。

UUIDValue インタフェース
ユニーク識別子 (UUID またはユニバーサルユニーク識別子) オブジェクトを記述します。

構文

public interface UUIDValue

メンバー

継承されたメンバーを含む UUIDValue インタフェースのすべてのメンバー。

名前 説明

getString メソッド UUIDValue オブジェクトの String 表現を返し
ます。

isNull メソッド UUIDValue オブジェクトが NULL かどうか
を確認します。

set メソッド UUIDValue オブジェクトに String 値を設定し
ます。

setNull メソッド UUIDValue オブジェクトを NULL に設定し
ます。

備考

このようなエンティティは、ユニーク識別子が必要であり任意の値を指定できる場合に便利で
す。

テーブルのカラムに値が指定されておらず、DEFAULT NEWID() 句を使用してカラムが作成され
た場合、UUIDValue は SQL INSERT 文でも作成できます。

createUUIDValue メソッドを使用して UUIDValue を作成する場合、Connection オブジェクトを使
用できます。

参照

● Connection.createUUIDValue メソッド [Ultra Light J]111 ページ

getString メソッド
UUIDValue オブジェクトの String 表現を返します。
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構文

String UUIDValue.getString() throws ULjException

戻り値

String 値。

isNull メソッド
UUIDValue オブジェクトが NULL かどうかを確認します。

構文

boolean UUIDValue.isNull()

戻り値

オブジェクトが NULL の場合は true、NULL 以外の場合は false。

set メソッド
UUIDValue オブジェクトに String 値を設定します。

構文

void UUIDValue.set(String value) throws ULjException

パラメータ

● value String として表した数値。

setNull メソッド
UUIDValue オブジェクトを NULL に設定します。

構文

void UUIDValue.setNull() throws ULjException

ValidateDatabaseProgressData インタフェース
[Android]

ValidateDatabase プログレスデータをレポートします。

構文

public interface ValidateDatabaseProgressData

ValidateDatabaseProgressData インタフェース [Android]
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メンバー

継承されたメンバーを含む ValidateDatabaseProgressData インタフェースのすべてのメンバー。

名前 説明

getParms メソッド ステータス ID に関連付けられたパラメータ
配列を返します。

getStatusId メソッド 検証操作のステータス ID を返します。

参照

●「Ultra Light データベース検証ユーティリティ (ulvalid)」『Ultra Light データベース管理とリ
ファレンス』

getParms メソッド
ステータス ID に関連付けられたパラメータ配列を返します。

構文

abstract String[] ValidateDatabaseProgressData.getParms()

戻り値

固定サイズのパラメータの配列。パラメータ未使用の場合は NULL。

参照

● ValidateDatabaseProgressData.StatusId インタフェース [Android] [Ultra Light J]292 ページ

getStatusId メソッド
検証操作のステータス ID を返します。

構文

abstract short ValidateDatabaseProgressData.getStatusId()

戻り値

ステータス ID 定数。

ValidateDatabaseProgressData.StatusId インタ
フェース [Android]

Ultra Light データベース検証ユーティリティのステータス ID を指定します。
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構文

public interface ValidateDatabaseProgressData.StatusId

メンバー

継承されたメンバーを含む ValidateDatabaseProgressData.StatusId インタフェースのすべてのメン
バー。

名前 説明

UL_VALID_BAD_ROWID 変数 インデックス内に無効なロー識別子がありま
す。

UL_VALID_CHECKING_INDEX 変数 インデックスをチェックしています。

UL_VALID_CHECKING_PAGE 変数 データベースページのチェック中、定期的に
ステータスメッセージを送信します。

UL_VALID_CHECKING_TABLE 変数 テーブルをチェックしています。

UL_VALID_CONNECT_ERROR 変数 データベースへの接続中にエラーが発生しま
した。

UL_VALID_CORRUPT_PAGE 変数 ページが破損しています。

UL_VALID_CORRUPT_PAGE_TABLE 変数 ページテーブルが破損しています。

UL_VALID_DATABASE_ERROR 変数 データベースにアクセスするときにエラーが
発生しました。

UL_VALID_END 変数 検証を終了します。

UL_VALID_FAILED_CHECKSUM 変数 ページチェックサムが失敗しました。

UL_VALID_INTERRUPTED 変数 検証プロセスが中断されました。

UL_VALID_NO_ERROR 変数 エラーは発生しませんでした。

UL_VALID_ROWCOUNT_MISMATCH 変数 インデックス内のローの数がテーブルのロー
数と異なります。

UL_VALID_START 変数 検証を開始します。

UL_VALID_STARTUP_ERROR 変数 低レベルアクセスを目的とするデータベース
の起動中にエラーが発生しました。

UL_VALID_BAD_ROWID 変数
インデックス内に無効なロー識別子があります。

ValidateDatabaseProgressData.StatusId インタフェース [Android]
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構文

final short ValidateDatabaseProgressData.StatusId.UL_VALID_BAD_ROWID

備考

ValidateDatabaseProgressData.getParms メソッドから返される最初のパラメータは、テーブル名を
追跡します。2 番目のパラメータは、インデックス名を追跡します。

参照

● ValidateDatabaseProgressData.getParms メソッド [Ultra Light J]292 ページ

UL_VALID_CHECKING_INDEX 変数
インデックスをチェックしています。

構文

final short ValidateDatabaseProgressData.StatusId.UL_VALID_CHECKING_INDEX

備考

ValidateDatabaseProgressData.getParms メソッドから返される最初のパラメータは、テーブル名を
格納します。2 番目のパラメータは、インデックス名を格納します。

参照

● ValidateDatabaseProgressData.getParms メソッド [Ultra Light J]292 ページ

UL_VALID_CHECKING_PAGE 変数
データベースページのチェック中、定期的にステータスメッセージを送信します。

構文

final short ValidateDatabaseProgressData.StatusId.UL_VALID_CHECKING_PAGE

備考

ValidateDatabaseProgressData.getParms メソッドから返される最初のパラメータは、ページに関連
付けられた番号を追跡します。順序は定義されていません。

参照

● ValidateDatabaseProgressData.getParms メソッド [Ultra Light J]292 ページ

UL_VALID_CHECKING_TABLE 変数
テーブルをチェックしています。
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構文

final short ValidateDatabaseProgressData.StatusId.UL_VALID_CHECKING_TABLE

備考

ValidateDatabaseProgressData.getParms メソッドから返される最初のパラメータは、テーブル名を
追跡します。

参照

● ValidateDatabaseProgressData.getParms メソッド [Ultra Light J]292 ページ

UL_VALID_CONNECT_ERROR 変数
データベースへの接続中にエラーが発生しました。

構文

final short ValidateDatabaseProgressData.StatusId.UL_VALID_CONNECT_ERROR

UL_VALID_CORRUPT_PAGE 変数
ページが破損しています。

構文

final short ValidateDatabaseProgressData.StatusId.UL_VALID_CORRUPT_PAGE

備考

ValidateDatabaseProgressData.getParms メソッドから返される最初のパラメータは、ページに関連
付けられた番号を追跡します。

参照

● ValidateDatabaseProgressData.getParms メソッド [Ultra Light J]292 ページ

UL_VALID_CORRUPT_PAGE_TABLE 変数
ページテーブルが破損しています。

構文

final short ValidateDatabaseProgressData.StatusId.UL_VALID_CORRUPT_PAGE_TABLE

UL_VALID_DATABASE_ERROR 変数
データベースにアクセスするときにエラーが発生しました。

ValidateDatabaseProgressData.StatusId インタフェース [Android]
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構文

final short ValidateDatabaseProgressData.StatusId.UL_VALID_DATABASE_ERROR

備考

詳細については、SQLCODE を参照してください。

参照

●「SQL Anywhere のエラーメッセージ (SQLCODE 順)」『エラーメッセージ』

UL_VALID_END 変数
検証を終了します。

構文

final short ValidateDatabaseProgressData.StatusId.UL_VALID_END

備考

ValidateDatabaseProgressData.getParms メソッドによって返される最初のパラメータは、成功また
は失敗を示す結果の SQLCODE を追跡します。

参照

● ValidateDatabaseProgressData.getParms メソッド [Ultra Light J]292 ページ
●「SQL Anywhere のエラーメッセージ (SQLCODE 順)」『エラーメッセージ』

UL_VALID_FAILED_CHECKSUM 変数
ページチェックサムが失敗しました。

構文

final short ValidateDatabaseProgressData.StatusId.UL_VALID_FAILED_CHECKSUM

備考

ValidateDatabaseProgressData.getParms メソッドから返される最初のパラメータは、ページに関連
付けられた番号を追跡します。

参照

● ValidateDatabaseProgressData.getParms メソッド [Ultra Light J]292 ページ

UL_VALID_INTERRUPTED 変数
検証プロセスが中断されました。
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構文

final short ValidateDatabaseProgressData.StatusId.UL_VALID_INTERRUPTED

UL_VALID_NO_ERROR 変数
エラーは発生しませんでした。

構文

final short ValidateDatabaseProgressData.StatusId.UL_VALID_NO_ERROR

UL_VALID_ROWCOUNT_MISMATCH 変数
インデックス内のローの数がテーブルのロー数と異なります。

構文

final short ValidateDatabaseProgressData.StatusId.UL_VALID_ROWCOUNT_MISMATCH

備考

ValidateDatabaseProgressData.getParms メソッドから返される最初のパラメータは、テーブル名を
追跡します。2 番目のパラメータは、インデックス名を追跡します。

参照

● ValidateDatabaseProgressData.getParms メソッド [Ultra Light J]292 ページ

UL_VALID_START 変数
検証を開始します。

構文

final short ValidateDatabaseProgressData.StatusId.UL_VALID_START

UL_VALID_STARTUP_ERROR 変数
低レベルアクセスを目的とするデータベースの起動中にエラーが発生しました。

構文

final short ValidateDatabaseProgressData.StatusId.UL_VALID_STARTUP_ERROR

ValidateDatabaseProgressData.StatusId インタフェース [Android]
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ValidateDatabaseProgressListener インタフェース
[Android]

ValidateDatabase プログレスイベントを受信します。

構文

public interface ValidateDatabaseProgressListener

メンバー

継承されたメンバーを含む ValidateDatabaseProgressListener インタフェースのすべてのメン
バー。

名前 説明

validateProgressed メソッド ユーザに検証の進行状況を通知するために、
ValidateDatabase 操作中に呼び出されます。

validateProgressed メソッド
ユーザに検証の進行状況を通知するために、ValidateDatabase 操作中に呼び出されます。

構文

boolean ValidateDatabaseProgressListener.validateProgressed(
    ValidateDatabaseProgressData data
)

パラメータ

● data 最新の検証プログレスデータを保持している ValidateDatabaseProgressData オブジェク
ト。

戻り値

検証プロセスをキャンセルする場合は true、そうでない場合は false。
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